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Chapter 1. Developing Mainframe Jobs
Mainframe jobs consist of individual stages. These stages are used to represent data sources, data targets,
or conversion processes. Stages are added to a job and linked together using the InfoSphere® DataStage®
and QualityStage Designer. The linked stages represent the flow and manipulation of data from one or
more data sources to a final data warehouse.
To develop a mainframe job, you must follow these steps:
v Import or manually create metadata for your mainframe data sources and targets
v Create a mainframe job
v Design job stages
v Edit job properties
Before you start to develop your job, you must plan and set up your project using the InfoSphere
DataStage and QualityStage Administrator.

Importing Metadata
The fastest and easiest way to specify table definitions for your mainframe data sources and targets is to
import metadata from one of the following file formats:
v
v
v
v
v

Assembler File Definitions
COBOL File Definitions
DB2® DCLGen File Definitions
IMS™ Definitions
PL/I File Definitions

You import metadata into the repository using the Designer client. Chapter 4, “Importing Metadata for
Mainframe Jobs,” on page 11 describes how to import metadata for use in mainframe jobs.

Creating a Mainframe Job
After you have set up your project and imported metadata, you are ready to create a job. Jobs are created
using the Designer client.

Procedure
1. Start the Designer client by clicking Start > Programs > IBM InfoSphere Information Server > IBM
InfoSphere DataStage and QualityStage Designer. You can also start the Designer client from the
shortcut icon on the desktop.
2. The Attach to Project dialog box appears. Attach to your project by entering your logon details.
3. The Designer client window opens, with the New dialog box displayed by default. Create a new
mainframe job in either of these ways:
v In the New dialog box, select the Jobs folder, click the Mainframe Job icon, then click OK.
v Click the New arrow on the Designer client toolbar and select Mainframe Job.
The diagram window appears in the right pane of the Designer client, and the tool palette for
mainframe jobs appears in the lower left pane.
The Designer client window consists of the following parts:
v The Diagram window where you design your jobs.
v The Repository window where you view components in a project.
© Copyright IBM Corp. 2000, 2011
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v A Toolbar from where you select Designer client functions.
v A Tool Palette from which you select job components.
v A Status Bar which displays one-line help for the window components, and information about the
current state of job operations.
You can customize the Designer client to create a new mainframe job at startup by following these
steps:
4. Choose Tools > Options. The Options dialog box appears.
5. Select General under the Default branch of the options tree in the left pane.
6. Click Create new and select Mainframe from the list.
Save your job by choosing File > Save. In the Save Mainframe Job As dialog box, type an item name
and click OK to save the job.

Designing Job Stages
Jobs are designed and developed in the Diagram window of the Designer client. Each data source, data
target, and processing step is represented by a stage in the job design. The stages are linked together to
show the flow of data.
A stage can be passive or active. Passive stages handle access to source and target tables for the
extraction or writing of data. Active stages model the flow of data and provide mechanisms for
combining data streams, aggregating data, and converting data from one data type to another.
Stages are added and linked together using the tool palette. The mainframe tool palette organizes stages
into the following groups:
v Database. These stages read or write data in a database.
v File. These stages read or write data in a file or set of files.
v Processing. These stages perform some processing on the data that is passed through them.
The following table lists the available stage types and gives a quick guide to their function:
Type

Stage

Function

Database

IMS

Reads data from IMS databases.

(“IMS Stages” on page 25)
Database

Relational
(“Relational Stages” on page 27)

Database

Teradata Export
(“Teradata Export Stages” on page
34)

Database

Teradata Load
(“Teradata Load Stages” on page 40)

Database

Teradata Relational

File

Complex Flat File
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Reads data from a Teradata database
table on a z/OS platform, using the
Teradata FastExport utility.
Writes data to a sequential file in a
format that is compatible for use
with a Teradata load utility.

Reads data from or writes data to a
Teradata database table on an z/OS
(“Teradata Relational Stages” on page platform.
45)

(“Complex Flat File Stages” on page
52)
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Reads data from or loads data to a
DB2 table on a z/OS platform.

Reads data from a complex flat file
data structure.

Type

Stage

Function

File

DB2 Load Ready Flat File

Writes data to a sequential file or a
delimited file in a format that is
compatible with the IBM® DB2 bulk
loader facility.

(“DB2 Load Ready Flat File Stages”
on page 61)
File

Delimited Flat File
(“Delimited Flat File Stages” on page
65)

File

External Source

File

External Target

File

Fixed-width Flat File

Reads data from an external source
by defining a call to a user-written
(“External Source Stages” on page 70) program.
Writes data to an external target by
defining a call to a user-written
(“External Target Stages” on page 77) program.

(“Fixed-width Flat File Stages” on
page 83)
File

Multi-format Flat File
(“Multi-format Flat File Stages” on
page 89)

Processing

Aggregator
(“Aggregator Stages” on page 94)

Processing

Business Rule
(“Business Rule Stages” on page 99)

Processing

Processing

Reads data from or writes data to a
delimited flat file.

Reads data from or loads data to a
simple flat file.

Reads data from files containing
multiple record types.

Groups incoming data and computes
totals and other summary functions,
then passes the data to another stage
in the job.
Applies SQL business rule logic to
perform complex data
transformations.

(“External Routine Stages” on page
104)

Defines a call to an external COBOL
routine for incoming rows and
outputs the data to another stage in
the job.

FTP

Transfers a file to another machine.

External Routine

(“FTP Stages” on page 112)
Processing

Join
(“Join Stages” on page 113)

Processing

Link Collector
(“Link Collector Stages” on page 120)

Processing

Lookup
(“Lookup Stages” on page 122)

Processing

Sort
(“Sort Stages” on page 139)

Processing

Transformer
(“Transformer Stages” on page 143)

Joins two incoming data streams and
passes the data to another stage in
the job.
Combines data from multiple input
links into a single output link.
Merges data using a table lookup and
passes it to another stage in the job.
Sorts incoming data by ascending or
descending column values and passes
it to another stage in the job.
Filters and transforms incoming data,
then outputs it to another stage in
the job.
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The General group in the tool palette contains buttons for linking stages together and adding diagram
annotations.
A mainframe job must have at least one active stage, and every stage in the job must have at least one
link. Only one chain of stages is allowed in a job. Active stages must have at least one input link and one
output link. Passive stages cannot be linked to passive stages. Relational and Teradata Relational stages
cannot be used in the same job.
Table 1 shows the links that are allowed between mainframe stage types.
Table 1. Mainframe Stage Linkage
TO:
FROM:

Passive Stage Types

Active Stage Types

Complex Flat File

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

Multi-format Flat File

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

IMS

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

Fixed-width Flat File

Aggregator, Business Rule, External Routine,
FTP, Join, Link Collector, Lookup Input,
Lookup Reference, Sort, Transformer

Delimited Flat File

Aggregator, Business Rule, External Routine,
FTP, Join, Link Collector, Lookup Input,
Lookup Reference, Sort, Transformer

DB2 Load Ready Flat
File

FTP

Relational

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

Teradata Relational

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

Teradata Export

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

External Source

Aggregator, Business Rule, External Routine,
Join, Link Collector, Lookup Input, Lookup
Reference, Sort, Transformer

Transformer

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

Business Rule

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

4
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Table 1. Mainframe Stage Linkage (continued)
TO:
FROM:

Passive Stage Types

Active Stage Types

Link Collector

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

Join

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

Lookup

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

Aggregator

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

Sort

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

External Routine

DB2 Load Ready Flat File, Delimited Flat
File, External Target, Fixed-width Flat File,
Relational, Teradata Load, Teradata
Relational

Business Rule, External Routine, Link
Collector, Lookup Input, Transformer

After you add stages and links to the Designer client canvas, you must edit the stages to specify the data
you want to use and how it is handled. Data arrives into a stage on an input link and is output from a
stage on an output link. The properties of the stage and the data on each input and output link are
specified using a stage editor. There are different stage editors for each type of mainframe job stage. The
remaining chapters of this manual describe the stage editors and the individual characteristics of each
stage.

Editing Job Properties
Each job in a project has properties, including job parameters and optional descriptions that provide
job-level documentation. You can define job parameters to be used as global variables throughout the
stages of a job. The actual values for these parameters are maintained in a separate file that is accessed
when the job is run on the mainframe.
Mainframe jobs also have environmental properties that specify information used to generate code. In
addition, you can define JCL extension variables which allow you to customize the JCL that is generated
by InfoSphere DataStage.
Also included in mainframe job properties are settings for flat file null indicators, the century break year,
the default date format, semantic checking in expressions, and generating operational metadata. (Note:
Semantic checking can impact performance in jobs that contain a large number of derivations.)
You can view and edit job properties in the Designer client by opening your job and choosing Edit > Job
Properties.

Chapter 1. Developing Mainframe Jobs
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Chapter 2. After Development
When you have finished developing your mainframe job, you are ready to generate code. The code is
then uploaded to the mainframe machine, where the job is compiled and run.

Generating Code
About this task
To generate code for a mainframe job, open the job in the Designer client and choose File > Generate
Code. Or, click Generate Code on the toolbar. The Code generation dialog box appears. This dialog box
displays the code generation path, COBOL program name, compile JCL file name, and run JCL file name.
There is a Generate button for generating the COBOL code and JCL files, a View button for viewing the
generated code, and an Upload job button for uploading a job after code has been generated. There is
also a progress bar and a display area for status messages.
When you click Generate, your job design is automatically validated before the COBOL source, compile
JCL, and run JCL files are generated.
You can print the program and data flow during program execution by selecting an option in the Trace
runtime information list. In addition, you can customize the COBOL program by selecting the Generate
COPY statements for customization check box. You can also create and manage several versions of the
COPYLIB members by specifying a copy library prefix.
For more information about generating code, see Chapter 6, “Code Generation and Job Upload,” on page
159.

Uploading Jobs
About this task
To upload a job, choose File > Upload Job from the main menu, or click Upload job in the Code
generation dialog box after you've generated code. The Remote System dialog box appears, allowing you
to specify information about connecting to the target mainframe system. After you have successfully
connected to the target machine, the Job Upload dialog box appears, allowing you to actually upload the
job.
For more information about uploading jobs, see Chapter 6, “Code Generation and Job Upload,” on page
159.

Compiling and Uploading Multiple Jobs
The compiler wizard allows you to compile and upload multiple jobs in a project. It can be invoked via
the command line or from within the Designer client. For details about using the wizard, see “Compiling
Multiple Jobs” on page 166.

© Copyright IBM Corp. 2000, 2011
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Chapter 3. Programming Resources
You might need to perform certain programming tasks in your mainframe jobs, such as reading data
from an external source, calling an external routine, writing expressions, or customizing the InfoSphere
DataStage-generated code.
External Source stages allow you to retrieve rows from an external data source. After you write the
external source program, you create an external source routine in the repository. Then you use an
External Source stage to represent the external source program in your job design. The external source
program is called from the InfoSphere DataStage-generated COBOL program. See “External Source
Stages” on page 70 for details about calling external source programs.
External Target stages allow you to write rows to an external data target. After you write the external
target program, you create an external target routine in the repository. Then you use an External Target
stage to represent the external target program in your job design. The external target program is called
from the InfoSphere DataStage-generated COBOL program. See “External Target Stages” on page 77 for
details about calling external target programs.
External Routine stages allow you to incorporate complex processing or functionality specific to your
environment within the InfoSphere DataStage-generated COBOL program. As with External Source or
External Target stages, you first write the external program, then you define an external routine in the
repository, and finally you add an External Routine stage to your job design. For more information, see
“External Routine Stages” on page 104.
Expressions are used to define column derivations, constraints, SQL clauses, stage variables, and
conditions for performing joins and lookups. The InfoSphere DataStage Expression Editor helps you
define column derivations, constraints, and stage variables in Transformer stages, as well as column
derivations and stage variables in Business Rule stages. It is also used to update input columns in
Relational, Teradata Relational, and Teradata Load stages. An expression grid helps you define constraints
in source stages, as well as SQL clauses in Relational, Teradata Relational, Teradata Export, and Teradata
Load stages. It also helps you define key expressions in Join and Lookup stages. Details about defining
expressions are provided in the chapters describing the individual stage editors. In addition, Chapter 7,
“Programmer's Reference,” on page 169 contains reference information about the programming
components that you can use in mainframe expressions.
You can also customize the InfoSphere DataStage-generated COBOL program to meet your shop
standards. Processing can be done at both program initialization and termination. In addition, you can
change the text associated with various warning and error messages, and you can create and manage
several versions of COPYLIB members. For details see “Code Customization” on page 160.
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Chapter 4. Importing Metadata for Mainframe Jobs
This topic explains how to import metadata from mainframe data sources, including table definitions and
IMS definitions. These definitions contain the metadata for each data source and data target in a data
warehouse. They specify the data to be used at each stage of a job.
You can save time and increase the accuracy of your table definitions by importing them into the
InfoSphere DataStage repository. They can then be shared by all the jobs in a project.
If you are not able to import table definitions, you have the option of manually creating definitions in the
repository before you develop a job, or defining columns directly in the stage editors during job design.
Columns entered during job design can be saved as table definitions in the repository by clicking Save
As on the Columns tab, allowing you to use them in other jobs. For details about saving columns as
table definitions during job design, see the chapters on the individual stage editors in this manual.

Importing Table Definitions
Mainframe table definitions include COBOL File Definitions (CFDs), DB2 DCLGen files (DFDs),
Assembler File Definitions (AsmFDs), PL/I File Definitions (PL/I FDs), and Teradata table definitions.

COBOL File Definitions
COBOL File Definitions contain data description statements in a text file that describe a file format in
COBOL terms. You can import CFDs into the InfoSphere DataStage repository directly from a COBOL
program. A CFD file can contain multiple table definitions, and can be either a COBOL copybook or a
COBOL source program.
Before you import a COBOL FD, be sure it contains valid COBOL syntax. InfoSphere DataStage supports
level number 02 to 49 and recognizes the following clauses:
v OCCURS
v OCCURS DEPENDING ON
v PICTURE
v
v
v
v

REDEFINES
SIGN
SYNCHRONIZED
USAGE

The following items are not captured:
v Level numbers 66 and 88 (these become comments for the column)
v Data element names that are SQL reserved words (see Chapter 15, “Reserved Words,” on page 241 for
a list)
At least one 01 level must be defined in a CFD file. The name at the 01 level becomes the default table
name in InfoSphere DataStage. Comments must be designated with an asterisk in the column preceding
the start position.
For details about the native data types that InfoSphere DataStage supports when importing CFDs, see
Chapter 9, “Native Data Types,” on page 197.
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Importing CFDs
You can import a CFD.

Procedure
1. Open the Import Meta Data (CFD) dialog box in either of these ways:
v Choose Import > Table Definitions > COBOL File Definitions from the main menu.
v Right-click the Table Definitions folder in the repository tree and select Import Table Definition >
COBOL File Definitions from the shortcut menu.
2. In the COBOL file description pathname field, type or browse for the path name where the CFD file
is located. The CFD file must either reside on the InfoSphere DataStage client workstation or on a
network that is visible from the client workstation. The default capture file extension is *.cfd.
3. In the Start position field, specify the starting column where the table description begins (the 01
level). The default start position is 8. You can change the start position to any value from 2 to 80.
InfoSphere DataStage allows 64 positions from the start position. For example, if the start position is
2, the last valid column position is 65.
4. In the Column comment association field, specify how to associate comment lines with columns in
the CFD file. The default is to associate a comment line with the column that follows it.
5. Select the items to import in the Tables list. This list appears after you specify the CFD path name.
Click Refresh to refresh the list if necessary. Select a single table by clicking the table name, or select
multiple tables by holding down the Ctrl key and clicking the table names. To select all tables, click
Select all.
To see a summary description of a table, select the table name and click Details. The Details of dialog
box opens, displaying the table name, description, and column names.
6. In the To folder field, specify the name of the repository folder where you want to save the CFD. The
default is Table Definitions\COBOL FD\filename. You can change the folder by typing a different
name or browsing for one.
7. Click Import. The data from the CFD file is extracted and parsed. If any syntactical or semantic errors
are found, the Import Error dialog box opens, allowing you to view and fix the errors, skip the import
of the incorrect item, or stop the import process altogether. See “Viewing and Editing Table
Definitions” on page 20 for details.

DB2 DCLGen Files
DCLGen files provide data definition statements in a text file that describe a file format in DB2 terms.
You can import DCLGen files into the repository after they have been exported from a DB2 database. A
DCLGen file contains only one table definition. InfoSphere DataStage uses the SQL declaration to
determine the column definitions.
When you import a DCLGen file, the following conditions apply:
v Columns are defined in SQL terms.
v Quoted names are not supported for owner, table, or column names.
v DB2 names must not exceed the length allowed in the DB2 version you are using.
v If NOT NULL is not specified, NULL is assumed.
For information about the native SQL data types that InfoSphere DataStage supports when importing
DCLGen files, see Chapter 9, “Native Data Types,” on page 197.

Importing DCLGen Files
You can import a DCLGen file.
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Procedure
1. Open the Import Meta Data (DCLGen) dialog box in either of these ways:
v Choose Import > Table Definitions > DCLGen File Definitions from the main menu.
v Right-click the Table Definitions folder in the repository tree and select Import Table Definition >
DCLGen File Definitions from the shortcut menu.
2. In the DCLGen pathname field, type or browse for the path name where the DCLGen file is located.
The DCLGen file must either reside on the InfoSphere DataStage client workstation or on a network
that is visible from the client workstation. The default capture file extension is *.dfd.
3. Do nothing in the Start position field. This is not used for DCLGen files. InfoSphere DataStage
captures the table definition from the EXEC SQL DECLARE statement.
4. Select the table to import in the Tables list. This list will appear after you specify the DCLGen path
name. Click Refresh to refresh the list if necessary.
5. To see a summary description of a table, select the table name and click Details. The Details of dialog
box opens, displaying the table type, owner, description, and column names.
6. In the To folder field, specify the name of the repository folder where you want to save the DCLGen
file. The default folder is Table Definitions\DB2 Dclgen\filename. You can type a different name or
browse for one.
7. Click Import. The data from the DCLGen file is extracted and parsed. If any syntactical or semantic
errors are found, the Import Error dialog box opens, allowing you to view and fix the errors, skip the
import of the incorrect item, or stop the import process altogether. See “Viewing and Editing Table
Definitions” on page 20 for details.

Assembler File Definitions
Assembler File Definitions use Assembler syntax to describe records in a table definition. An Assembler
file can contain multiple record definitions. Record description entries begin with a DSECT keyword and
can contain elementary items.
You can import both Assembler source files and listing files into the InfoSphere DataStage repository.
Assembler source files have the following default values:
v The begin column is at column 1.
v The end column is at the begin column plus 70.
v The continuation column is at the begin column plus 71.
v The continue column is at the begin column plus 15.
Default values for Assembler listing files are:
v The begin column is at column 42.
v The end column is at the begin column plus 70.
v
v
v
v

The continuation column is at the begin column plus 71.
The continue column is at the begin column plus 15.
Any statements before the begin column are not processed.
Any statements after the continuation indicator are not processed.
Note: Listing file offsets are calculated using the IBM Assembler. If you use another vendor's
Assembler, adjustments might be needed before import.

Comments must be designated with an asterisk in the begin column and must lie within the statement
field. They cannot appear between an instruction statement and its continuation lines. Comments that
appear before the first DSECT keyword become the long description for the table. The fully qualified
path and file name of the AsmFD, as well as the current date and time, are saved as the short description
for the table.
Chapter 4. Importing Metadata for Mainframe Jobs
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The import process creates an InfoSphere DataStage table of type QSAM_SEQ_ COMPLEX. Assembler
data types are converted to COBOL native data types during capture, as described in Table 2.
Table 2. Assembler Data Type Conversion
Assembler Type

COBOL Native Type

COBOL Usage
Representation
1

SQL Type

B

CHARACTER

PIC X(n)

Char

C

CHARACTER

PIC X(n)

Char

D

FLOAT

COMP-2

Decimal

E

FLOAT

COMP-1

Decimal

F

BINARY

PIC S9(9) COMP

Integer

G

NCHAR

PIC N(n)

NChar

H

BINARY

PIC S9(4) COMP

SmallInt

L

CHARACTER

PIC X(n)

Char

P

DECIMAL

COMP-3 SIGNED

Decimal

X

CHARACTER

PIC X(n)

Char

Z

DISPLAY NUMERIC

PIC S9(n)

Decimal

1

(n) is equal to the number of bytes.

The InfoSphere DataStage Expression Editor provides functions for performing bit manipulations.

Importing AsmFDs
You can import AsmFDs.

Procedure
1. Open the Import Meta Data (ASM) dialog box in either of these ways:
v Choose Import > Table Definitions > Assembler File Definitions from the main menu.
v Right-click the Table Definitions folder in the repository tree and select Import Table Definition >
Assembler File Definitions from the pop-up menu.
2. In the Assembler file description pathname field, type or browse for the path name where the
AsmFD is located. The file must either reside on the InfoSphere DataStage client workstation or on a
network that is visible from the client workstation. The default capture file extension is *.asm for
source files and *.lst for listing files.
3. In the Start position field, specify the starting column where the table description begins (level 1).
Defaults to 1 for source files and 42 for listing files.
4. In the Column comment association field, specify how to associate comment lines with columns in
the Assembler file. The default is to associate a comment line with the column that follows it. The
column definition is included with the comment as part of each column description; if you want to
exclude the column definition from the description, clear the Include column description check box.
5. Select the items to import in the Tables list. This list will appear after you specify the source file
pathname. Click Refresh to refresh the list if necessary. Select a single table by clicking the table
name, or select multiple tables by holding down the Ctrl key and clicking the table names. To select
all tables, click Select all.
To see a summary description of a table, select the table name and click Details. The Details of dialog
box opens, displaying the table name, description, and column names.
6. In the To folder field, specify the name of the repository folder where you want to save the AsmFD.
The default folder is Table Definitions\Assembler\filename. You can change the folder by typing a
different name or browsing for one.
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7. Click Import. The data is extracted and parsed. If any syntactical or semantic errors are found, the
Import Error dialog box opens, allowing you to view and fix the errors, skip the import of the
incorrect item, or stop the import process altogether. See “Viewing and Editing Table Definitions” on
page 20 for details.

PL/I File Definitions
PL/I File Definitions use PL/I language constructs to describe records in a table definition. A PL/I FD
can contain multiple record definitions. Record description entries begin with a DECLARE or DCL
keyword and can contain elementary items.
You can import both PL/I source files and listing files into the InfoSphere DataStage repository.
When you import a PL/I FD, the following conditions apply:
v Level numbers 1 to 49 are captured. The first level number must be 1. The maximum number of levels
in a structure is 15 and the maximum level number is 255.
v The level 1 field name becomes the default table name in InfoSphere DataStage if the file does not use
the DEFINED or DEF attribute.
v Field names that exceed the COBOL limit of 30 characters are trimmed.
v Field names cannot be the same as stage or link names and cannot be COBOL or SQL reserved words.
(See Chapter 15, “Reserved Words,” on page 241 for a list.)
v The maximum precision for binary and decimal data is 31 signed or 32 unsigned. The maximum
precision for extended binary float is 53.
v Picture characters are supported only for numeric character data that maps directly to COBOL display
numeric data.
v PL/I macros and complex data items are not supported.
Note: Listing file offsets are calculated using the IBM PL/I compiler. If you use another vendor's PL/I
compiler, adjustments might be needed before import.
Comments must begin with /* and end with */. The fully qualified path and file name of the PL/I FD,
as well as the current date and time, are saved as the short description for the table. Comments that
appear before the first DCL or DECLARE level 1 become the long description. In addition, any comments
defined on the level 1 variable declaration are appended to the short description. Other comments
defined on or between level n (n > 1) variable definitions become column descriptions.
The import process creates an InfoSphere DataStage table of type QSAM_SEQ_COMPLEX. PL/I data
types are converted to COBOL native data types during capture, as described in Table 3 on page 16.
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Table 3. PL/I Data Type Conversion
PL/I Type
1

BIT(n)

COBOL Native Type
CHARACTER

(See “BIT Data Type
Examples” on page 18 for
more information.)

COBOL Usage
Representation
Aligned or unaligned
where previous field is
non-BIT:

SQL Type
Char

PIC X(n/8) or
PIC X((n/8)+1) if n/8
results in a remainder
Unaligned and previous
field is BIT (`p' is the
number of bits in the
previous field):
PIC X((p+n)/8) or
PIC X(((p+n)/8)+1) if
(p+n)/8 results in a
remainder

CHARACTER(n)

CHARACTER

PIC X(n)

Char

CHARACTER(n)
VARYINGZ

CHARACTER

PIC X(n+1)

Char

GRAPHIC(n)

GRAPHIC_N

PIC N(n)

NChar

GRAPHIC(n) VARYINGZ

GRAPHIC_N

PIC N(n+2)

NVarChar

WIDECHAR(n)

GRAPHIC_N

PIC N(n)

NChar

WIDECHAR(n) VARYINGZ GRAPHIC_N

PIC N(n+2)

NVarChar

DECIMAL FIXED (p,s)

Signed: PIC S9(p-s)V9(s)
COMP-3

Decimal

DECIMAL

Unsigned: PIC 9(p-s)V9(s)
COMP-3
BINARY FIXED (p,s)

CHARACTER

Signed: 1 ≤ p ≤ 7 Unsigned:
1≤p≤8
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PIC X(1)

Char

Table 3. PL/I Data Type Conversion (continued)
PL/I Type

COBOL Native Type

BIT(n) VARYING

2-byte BINARY prefix plus
CHARACTER

(See “BIT Data Type
Examples” on page 18 for
more information.)

COBOL Usage
Representation
Aligned or unaligned
where previous field is
non-BIT:

SQL Type
VarChar

PIC S9(4) COMP and
PIC X(n/8) or
PIC X((n/8)+1) if n/8
results in a remainder
Unaligned and previous
field is BIT (`p' is the
number of bits in the
previous field):
PIC S9(4) COMP and
PIC X((p+n)/8) or
PIC X(((p+n)/8)+1) if
(p+n)/8 results in a
remainder

CHARACTER(n) VARYING VARCHAR

PIC S9(4) COMP

VarChar

PIC X(n)
GRAPHIC(n) VARYING

VARGRAPHIC

PIC S9(4) COMP

NVarChar

PIC N(n)
WIDECHAR(n) VARYING

VARGRAPHIC

PIC S9(4) COMP

NVarChar

PIC N(n)
BINARY FIXED (p,s)

2-byte BINARY

4-byte BINARY

Signed: 16 ≤ p ≤ 31
Unsigned: 17 ≤ p ≤ 32
BINARY FLOAT(p)

Decimal

Unsigned: PIC 9(4) COMP

Signed: 8 ≤ p ≤ 15
Unsigned: 9 ≤ p ≤16
BINARY FIXED (p,s)

Signed: PIC S9(4) COMP

Signed: PIC S9(9) COMP

Decimal

Unsigned: PIC 9(9) COMP
4-byte FLOAT

PIC COMP-1

Decimal

CHARACTER

PIC X(4)

Char

8-byte FLOAT

PIC COMP-2

Decimal

CHARACTER

PIC X(8)

Char

DISPLAY NUMERIC

Signed: PIC S9(q)V9(s)

Decimal

1 ≤ p ≤ 21
DECIMAL FLOAT(p)
1≤p≤6
BINARY FLOAT(p)
22 ≤ p ≤ 53
DECIMAL FLOAT(p)
7 ≤ p ≤ 16
PICTURE
`(q)9V(s)9'

Unsigned: PIC 9(q)V9(s)
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Table 3. PL/I Data Type Conversion (continued)
PL/I Type

COBOL Native Type

COBOL Usage
Representation

SQL Type

POINTER

CHARACTER

PIC X(4)

Char

1

(n) is equal to the number of bytes.

BIT Data Type Examples
Certain BIT and BIT VARYING data types require special handling. The following examples illustrate
how InfoSphere DataStage processes these data types during capture.
1. Arrays on BIT columns are multiplied to the column length and the array is dropped. For example:
BITCOL1(16) BIT(01)

becomes
BITCOL1 BIT(16).

2. If an unaligned BIT column can be stored in full bytes (the length is divisible by 8 with no
remainder), the column name is preserved.
For example:
BITCOL1 BIT(8)
BITCOL2 BIT(16) UNALIGNED

becomes
BITCOL1 PIC X(1)
BITCOL2 PIC X(2)

3. If a BIT column follows another BIT column (aligned or unaligned) and cannot be stored in full bytes
(there is a remainder when the length is divided by 8), the second column is merged with the first
column. For example:
BITCOL1 BIT(5)
BITCOL2 BIT(6) UNALIGNED

becomes
BITCOL1 PIC X(2)

4. BIT VARYING columns are not merged.
5. GROUP BIT columns are collapsed to one element. For example:
03 BIT S1
05 S11 BIT(1)
05 S12 BIT(1)
05 S13 BIT(1)
05 S14 BIT(1)
05 S15 BIT(1)
05 S16 BIT(1)
05 S17 BIT(1)
05 S18 BIT(1)
03 BIT S2
05 S21 BIT(1)
05 S22 BIT(1)
05 S23 BIT(1)
05 S24 BIT(1)
05 S25 BIT(1)
05 S26 BIT(1)
05 S27 BIT(1)
05 S28 BIT(1)

is collapsed to this:
03 BIT S1 BIT(8)
03 BIT S2 BIT(8)

which becomes
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PIC X(1)
PIC X(1)

If the number of group elements is not evenly divisible by eight, then the second group column is
merged with the first group column. For example:
03 BIT S1
05 S11
05 S12
05 S13
05 S14
05 S15
03 BIT S2
05 S21
05 S22
05 S23
05 S24
05 S25
05 S26
05 S27

BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)
BIT(1)

is collapsed to this:
03 BIT S1 BIT(5)
03 BIT S2 BIT(7)

The second GROUP column is then merged with the first GROUP column as shown:
03 BIT S1 BIT(12)

The final result is:
PIC X(2)

The InfoSphere DataStage Expression Editor provides functions for performing bit manipulations. For
more information, see Chapter 7, “Programmer's Reference,” on page 169.

Importing PL/I FDs
You can import a PL/I FD.

Procedure
1. Open the Import Meta Data (PL/I) dialog box in either of these ways:
v Choose Import > Table Definitions > PL/1 File Definitions from the main menu.
v Right-click the Table Definitions folder in the repository tree and select Import Table Definition >
PL/1 File Definitions from the shortcut menu.
2. In the PL/I file description pathname field, type or browse for the path name where the PL/I FD is
located. The PL/I FD must either reside on the InfoSphere DataStage client workstation or on a
network that is visible from the client workstation. The default capture file extension is *.pli or *.pl1
for source files and *.lst for listing files.
3. In the Start position field, specify the starting column where the table description begins (level 1).
Defaults to 1 for source files and 15 for listing files.
4. In the Column comment association field, specify how to associate comment lines with columns in
the PL/I FD. The default is to associate a comment line with the column that follows it. The column
definition is included with the comment as part of each column description; if you want to exclude
the column definition from the description, clear the Include column description check box.
5. Select the items to import in the Tables list. This list will appear after you specify the PL/I FD path
name. Click Refresh to refresh the list if necessary. Select a single table by clicking the table name, or
select multiple tables by holding down the Ctrl key and clicking the table names. To select all tables,
click Select all.
To see a summary description of a table, select the table name and click Details. The Details of dialog
box opens, displaying the table name, description, and column names.
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6. In the To folder field, specify the name of the repository folder where you want to save the PL/I FD.
The default folder is Table Definitions\PLI\filename. You can change the folder by typing a different
name or browsing for one.
7. Click Import. The data is extracted and parsed. If any syntactical or semantic errors are found, the
Import Error dialog box opens, allowing you to view and fix the errors, skip the import of the
incorrect item, or stop the import process altogether. See “Viewing and Editing Table Definitions” for
details.

Teradata Tables
About this task
You can import Teradata table definitions into the repository using either the ODBC Table Definitions
menu option or, if you have the Teradata supplemental stage installed for server jobs, you can use the
Plug-in Metadata Definitions menu option. In either case, you must open the Table Definition dialog box
afterward and manually change the mainframe platform type and access type.

Procedure
1. Open the Import Meta Data dialog box in either of these ways:
v Choose Import > Table Definitions > ODBC Table Definitions or Import > Table Definitions >
Plug-in Metadata Definitionsfrom the main menu.
v Right-click the Table Definitions folder in the repository tree and select Import Table Definition >
ODBC Table Definitions or Import Table Definition > Plug-in Metadata Definitions from the
shortcut menu.
Use this dialog box to connect to the Teradata data source (for the Teradata supplemental stage, a
wizard appears and guides you through the process).
2. Fill in the required connection details and click OK. After the connection has been made, the updated
dialog box gives details of the table definitions available for import.
3. Select the table definition to import and click OK. The table definition metadata is imported into the
InfoSphere DataStage repository.
4. Expand the Table Definitions folder in the repository tree and either double-click the Teradata table
definition or select it and choose Properties from the shortcut menu. The Table Definition dialog box
appears.
5. On the General page, change the mainframe platform type to OS390 and the mainframe access type
to Teradata.
6. Click OK to save your changes.

Viewing and Editing Table Definitions
You can view and edit a table definition.

About this task
After you import mainframe table definitions, you can view and edit them in the Designer client.

Procedure
1. Either double-click the table definition in the repository tree, or right-click and select Properties from
the shortcut menu.
2. The Table Definition dialog box appears. This dialog box has up to nine pages, but only the General,
Columns, and Layout pages apply to mainframe table definitions:
v The General page displays the data source type and name, table and file name, mainframe platform
type and access type, owner, and short and long descriptions of the data. You can edit any of these
fields.
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v The Columns page displays the column definitions of the imported data. You can edit the column
metadata in two ways:
– To edit directly in the grid, either double-click the cell you want to change, or right-click and
select Edit cell from the shortcut menu.
– To open the Edit Column Meta Data dialog box, either right-click any cell in the row you want
to change and select Edit row... from the shortcut menu, or press Ctrl-E.
For information about using the Edit Column Meta Data dialog box in mainframe jobs, see
Chapter 10, “Editing Column Metadata,” on page 207.
To delete a column definition, click any cell in the row you want to remove and press the Delete
key or choose Delete row from the shortcut menu.
v The Layout page displays the schema format of the column definitions in a table. Select an option
to view the data representation in one of three formats:
– Parallel. Displays the OSH record schema. You can right-click to save the layout as a text file in
*.osh format.
– COBOL. Displays the COBOL representation, including the COBOL PICTURE clause, starting
and ending offsets, and storage length of each column. You can right-click to save the layout as
an HTML file.
– Standard. Displays the SQL representation, including SQL type, length, and scale.
3. Click OK to save any changes and to close the Table Definition dialog box.

Importing IMS Definitions
You can import IMS definitions into the InfoSphere DataStage repository from Data Base Description
(DBD) files and Program Specification Block (PSB) files. A DBD defines the structure of an IMS database.
A PSB defines an application's view of an IMS database. You must import a DBD before you import its
associated PSBs.
InfoSphere DataStage captures the following clauses from DBD files:
v DBD
v
v
v
v
v
v

DATASET
AREA
SEGM
LCHILD
FIELD
XDFIELD

v DBDGEN
v FINISH
v END
The clauses captured from PSB files include:
v PCB
v SENSEG
v SENFLD
v PSBGEN
v END
You can import IMS definitions from IMS version 5 and above. IMS field types are converted to COBOL
native data types during capture, as described in Table 4 on page 22.
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Table 4. IMS Field Type Conversion
IMS Field Type

COBOL Native Type

COBOL Usage
Representation
1

SQL Type

X

CHARACTER

PIC X(n)

Char

P

DECIMAL

PIC S9(n)V9(0) COMP-3

Decimal

C

CHARACTER

PIC X(n)

Char

F

BINARY

PIC S9(9) COMP

Integer

H

BINARY

PIC S9(4) COMP

SmallInt

1

(n) is equal to the number of bytes.

The InfoSphere DataStage Expression Editor provides functions for performing bit manipulations. For
more information, see Chapter 7, “Programmer's Reference,” on page 169.

Importing IMS Data Base Descriptions
You can import IMS DBDs.

Procedure
1. Choose Import > IMS Definitions > Data Base Description (DBD)from the main menu. The Import
IMS Database (DBD) dialog box opens.
2. In the IMS file description pathname field, type or browse for the path name where the IMS file is
located. The IMS file must either reside on the InfoSphere DataStage client workstation or on a
network that is visible from the client workstation. The default capture file extension is *.dbd for DBD
files. Ensure that you do not include a file delimiter at the end of the path, as this will cause an error.
3. Select the items to import in the Database names list. This list will appear after you specify the IMS
file description path name. Click Refresh to refresh the list if necessary. Select a single database by
clicking the item name, or select multiple databases by holding down the Ctrl key and clicking the
names. To select all databases, click Select all.
To view the details of a database, select it and click View. The default editor (such as WordPad or
Notepad) opens, displaying the details of the database description file.
4. In the To folder field, specify the name of the repository folder where you want to save the item. The
default folder is IMS Databases (DBD)\filename. You can change the folder by typing a different
name or browsing for one.
5. Click Import. The data is extracted and parsed. If any syntactical or semantic errors are found, the
Import Error dialog box opens allowing you to view and fix the errors, skip the import of the
incorrect item, or stop the import process altogether. See “Handling Import Errors” on page 24 for
details.

Importing IMS Program Specification Blocks
You can import an IMS PSB.

Procedure
1. Choose Import > IMS Definitions > Program Specification Block (PSB/PCB) from the main menu.
The Import IMS Viewset (PSB/PCB) dialog box opens.
2. In the IMS file description pathname field, type or browse for the path name where the IMS file is
located. The IMS file must either reside on the InfoSphere DataStage client workstation or on a
network that is visible from the client workstation. The default capture file extension is *.psb for PSB
files.
3. Select the Create associated tables check box to have InfoSphere DataStage create a table in the
repository that corresponds to each sensitive segment in the PSB file, and columns in the table that
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correspond to each sensitive field. If no sensitive fields exist in the PSB, then the created columns
correspond to the segments in the DBD. Only those fields that are defined in the PSB become
columns; fillers are created where necessary to maintain proper field displacement and segment size.
The associated tables are stored in the IMS Viewsets (PSB/PCB) folder of the repository tree.
If you have a CFD with a definition of the complete IMS segment, you can import it to create the
completely defined table, including any columns that were captured as fillers. You can then change
the associated table for each segment in the IMS Viewset Editor; see “IMS Viewset Editor” on page 24
for details.
4. Select the items to import in the Viewset names list. This list will appear after you specify the IMS
file description path name. Click Refresh to refresh the list if necessary. Select a single viewset by
clicking the PSB name, or select multiple items by holding down the Ctrl key and clicking the names.
To select all items, click Select all.
To view the details of a viewset, select it and click View. The default editor (such as WordPad or
Notepad) opens, displaying the details of the viewset file.
5. In the To folder field, specify the name of the repository folder where you want to save the item. The
default folder is IMS Viewsets (PSB/PCB)\filename. You can change the folder by typing a different
name or browsing for one.
6. Click Import. The data is extracted and parsed. If any syntactical or semantic errors are found, the
Import Error dialog box opens, allowing you to view and fix the errors, skip the import of the
incorrect item, or stop the import process altogether. See “Handling Import Errors” on page 24 for
details.

Viewing and Editing IMS Definitions
After you import IMS definitions, you can view and edit them in the Designer client. Editing of IMS
definitions is limited to entering descriptions and creating mappings between viewset segments and their
associated tables. If you want to edit columns, you must open the associated table definition. Tables
associated with IMS definitions are stored in the IMS Viewsets (PSB/PCB) folder of the repository tree.
For details about editing table definitions, see “Viewing and Editing Table Definitions” on page 20.
To open an IMS definition, either double-click the database or viewset name in the repository tree, or
right-click and select Properties from the shortcut menu.
Depending on the type of IMS item you selected, either the IMS Database (DBD) or the IMS Viewset
(PSB/PCB) dialog box appears.

IMS Database Editor
The IMS Database (DBD) dialog box allows you to view and edit IMS databases. This dialog box is
divided into two panes. The left pane displays the IMS database, segments, and datasets in a tree, and
the right pane displays the properties of selected items. Depending on the type of item selected, the right
pane has up to two pages:
v Database. There are two pages for database properties:
– General. Displays the general properties of the database including the name, version number, access
type, organization, and short and long descriptions. All of these fields are read-only except for the
short and long descriptions.
– Hierarchy. Displays the segment hierarchy of the database. You can right-click to view the hierarchy
in detailed mode. This diagram is read-only.
v Segment. There are two pages for segment properties:
– General. Displays the segment name, the parent segment, its minimum and maximum size in bytes,
and a description. All of these fields are read-only except for the description.
– Fields. Displays the fields of the selected segment. The field descriptions are read-only.
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v Dataset. Properties are displayed on one page and include the DD names that are used in the JCL to
read the file. These names are read-only. You can optionally type a description of the dataset.

IMS Viewset Editor
The IMS Viewset (PSB/PCB) dialog box allows you to view and edit IMS viewsets. This dialog box is
divided into two panes. The left pane contains a tree structure displaying the IMS viewset (PSB), its
views (PCBs), and the sensitive segments. The right pane displays the properties of selected items. It has
up to three pages depending on the type of item selected:
v Viewset. Properties are displayed on one page and include the PSB name in the repository. This field is
read-only. You can optionally type short and long descriptions.
v View. There are two pages for view properties:
– General. Displays the PCB name, DBD name, type, and an optional description. If you did not
create associated tables during import or you want to change which tables are associated with PCB
segments, click the Segment/Table Mapping... button. The Segment/Associated Table Mapping
dialog box appears.
To create a table association for a segment, select a table in the left pane and drag it to the segment
in the right pane. The left pane displays available tables in the repository which are of type
QSAM_SEQ_COMPLEX. The right pane displays the segment names and the tables currently
associated with them; you can right-click to clear one or all of the current table mappings.
Be sure that the record length of the associated table matches the buffer length of the segment it
refers to. If the lengths don't match, segment data might be read incorrectly.
Click OK when you are done with the mappings, or click Cancel to discard any changes you have
made and revert back to the original table associations.
– Hierarchy. Displays the PCB segment hierarchy in a read-only diagram. You can right-click to view
the hierarchy in detailed mode.
v Sensitive Segment. There are three pages for sensitive segment properties:
– General. Displays the segment name and its associated table. If you want to change the associated
table, click the browse button next to the Associate table field to select another table.
– Sen Fields. Displays the sensitive fields associated with the sensitive segment. These fields are
read-only.
– Columns. Displays the columns of the associated table. The column descriptions are read-only.

Handling Import Errors
If any syntactical or semantic errors are found when you import a table, the Import Error dialog box
appears. This dialog box displays the number of errors that were found and provides three options:
v Edit... . Allows you to view and fix the errors.
v Skip. Skips the current table and begins importing the next table, if one has been selected.
v Stop. Cancels the import of the current table and any remaining tables.
If you click Edit..., the Edit File dialog box opens, displaying the source file in the top pane and error
information in the bottom pane. For each error, the line number, an error indicator, and an error message
are shown. Double-click an error message to automatically position your cursor at the corresponding line
in the top pane, where you can edit the file.
After you are done making changes, click Save to save your work. If you have not changed the names or
number of tables in the file, you can click Retry to start importing the table again. However, if you
changed a table name or added or removed a table from the file, the Import File dialog box appears. You
can click Re-start to restart the import process or Stop to cancel the import.
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Chapter 5. Mainframe Job Stages
IMS Stages
These topics describe IMS stages, which are used to read data from IMS databases.

Using an IMS Stage
IMS stages are used only as source stages and cannot receive input links. They can have a single output
link to an active stage.
IMS stages cannot be used in the same job with Relational target stages. However, they can be used in
jobs with Relational source stages, including those used as a lookup reference.
When you edit an IMS stage, the IMS Stage dialog box appears. This dialog box has two pages:
v Stage. Displays the stage name, which can be edited. This page has two tabs:
– The General tab allows you to type an optional description of the stage, which appears in the
generated COBOL program.
Select the Generate an end-of-data row check box to add an end-of-data indicator after the last row
is processed on each output link. The indicator is a built-in variable called ENDOFDATA which has
a value of TRUE, meaning the last row of data has been processed. (See “ENDOFDATA” on page
183 for more information about using this variable). In addition, all columns are set to null.
– The View tab allows you to specify details about the IMS source file and view its hierarchy. It
contains the following fields:
IMS id. Type the name of the IMS subsystem. This field is required.
PSB. Select the Program Specification Block that defines the view of the IMS database. The list
displays those PSBs imported into the repository which contain at least one PCB for IMS database
retrieval. This field is required.
PCB. Select the Program Communication Block that is associated with the PSB you selected. The list
displays all PCBs imported into the repository that allow for retrieval from the IMS database. This
field is required.
Note: If there are multiple IMS stages in a job, they must use the same IMS id and PSB. They can
use different PCBs.
Segment hierarchy view. Contains a diagram of the PCB segment hierarchy. The diagram is not
editable. You can view details for individual segments by placing your cursor over a segment until a
tooltip appears, or you can view the entire hierarchy in detailed mode by selecting Details from the
shortcut menu. Detailed mode displays the name of the associated table, its record length, and the
segment key field.
v Outputs. Specifies the column definitions for the data output link.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining IMS Output Data
The output link from an IMS stage represents the data being read from the IMS database. The properties
of this link and the column definitions of the data are described on the Outputs page in the IMS Stage
dialog box.
The Outputs page has the following field and six tabs:
© Copyright IBM Corp. 2000, 2011
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v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Contains an optional description of the output link.
v Path. Allows you to select a hierarchical path of segments to output data from. The columns from the
segments you select become available for output on the Selection tab.
The diagram displays the segments of the PCB you selected on the View tab. Each segment represents
an InfoSphere DataStage table and its associated columns. You can view details for individual segments
by placing your cursor over a segment until a tooltip appears. To view the entire segment hierarchy in
detailed mode, right-click and select Details. The segment name, associated table name, record length,
and key field are displayed. You can place your cursor over the table name to view its location in the
repository.
Select a segment by clicking a box in the diagram. If you select a child segment, all of its parent
segments are also selected. When selected, the background color of a segment and its parent segments
turns blue. To clear the selection of a segment, click it again. The background color of the segment and
its child segments returns to white.
The Process partial paths check box determines how paths are processed. By default this box is not
selected, meaning only complete paths are processed. Complete paths are those path occurrences where
all the segments of the path exist. If this box is selected, then path occurrences with missing children
(called partial paths) are processed. The columns for the missing children are initialized to zeros and
spaces. Note that when a segment is missing, all the segments below it are missing as well.
The flexibility of doing partial path processing can come at the expense of some efficiency. Depending
on the IMS database, it might be more efficient to do complete path processing. This is because the
data for all segments in a complete path can often be returned to the program with a single IMS call.
For partial paths, separate IMS calls must be made for each segment.
Note: InfoSphere DataStage always uses path processing for efficiency, as long as your IMS database
supports it and you have not selected Process partial paths.
Select Flatten all arrays if you want to flatten arrays in the source file. New columns are created for
each array element and the data is presented as one row at execution time. If this box is not selected,
any arrays in the source file are normalized and the data is presented as multiple rows at execution
time, with one row for each column in the array.
v Segments view. Displays column information for the tables associated with selected segments. The left
pane displays the segments you selected on the Path tab, and the right pane displays the COBOL
PICTURE clause, the starting and ending offsets, and the storage length of each column in its
associated table. Right-click in the right pane to save the segment view layout as an HTML file.
v Selection. This tab allows you to select output columns from the segments in the selected path. The
Available columns list displays the columns from the segments you selected on the Path tab, and the
Selected columns list displays the columns to be output from the stage.
The Column push option does not operate in IMS stages. Even if you have this option selected in
Designer client options, you must select columns to output from the stage on the Selection tab.
You can move a column from the Available columns list to the Selected columns list by
double-clicking the column name or highlighting the column name and clicking >. Move all columns
from a single segment by highlighting the segment name or any of its columns and clicking >>. You
can remove columns from the Selected columns list by double-clicking the column name or
highlighting the column name and clicking <. Remove all columns by clicking <<. Click Find to locate
a particular column.
You can select a group as one element if all elements of the group are CHARACTER data. If one or
more elements of the group are of another type, then they must be selected separately. If a group item
and its sublevel items are all selected, storage is allocated for the group item as well as each sublevel
item.
The Selected columns list displays the column name, segment name, SQL type, and alias for each
column. You can edit the alias to rename output columns since their names must be unique. Use the
arrow buttons to the right of the Selected columns list to rearrange the order of the columns.
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v Constraint. This tab allows you to optionally define a constraint that filters your output data. To define
a constraint, use the following fields in the grid:
– (. Select an opening parenthesis if needed.
– Column. Select a column or job parameter from the list. If you select a column that corresponds to a
field defined to IMS, the constraint expression is optimized so that IMS evaluates it. This can result
in faster and more efficient processing. (Group columns cannot be used in constraint expressions
and are not displayed.)
– Op. Select an operator or a logical function from the list. For information about using functions in
constraint expressions, see “Constraints” on page 170.
– Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint
field. When you are done building the expression, click Verify. If errors are found, you must either
correct the expression, click Clear All to start over, or cancel. You cannot save an incorrect
constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint,
any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Columns. This tab displays the output columns. It has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For more information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value. (Nullable columns are not
supported in IMS stages.)
– Description. A text description of the column.
Column definitions are read-only on the Outputs page. If you want to change the definitions, use
the Table Definition dialog box to edit the associated table definition in the repository. (Associated
tables are stored in the IMS Viewsets (PSB/PCB) folder of the repository.) Click Save As... to save
the output columns as a table definition, a CFD file, or a DCLGen file.

Relational Stages
These topics describe Relational stages, which are used to read data from or write data to a DB2 database
table on an z/OS platform.

Using a Relational Stage
Relational stages can have any number of input or output links. However, each input link supports only
one DB2 table.
Relational stages and Teradata Relational stages cannot be used in the same job due to preprocessor
restrictions. Relational stages can be used with Teradata Export and Teradata Load stages in a single job.
When you edit a Relational stage, the Relational Stage dialog box appears. This dialog box can have up
to three pages (depending on whether there are inputs to and outputs from the stage):
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v Stage. Displays the stage name, which can be edited. This page has a General tab where you can type
an optional description of the stage. The description will appear in the generated COBOL program. The
General tab has two fields:
– Generate an end-of-data row. Appears only when the stage is used as a source. Select this check
box to add an end-of-data indicator after the last row is processed on each output link. The
indicator is a built-in variable called ENDOFDATA which has a value of TRUE, meaning the last
row of data has been processed. (See “ENDOFDATA” on page 183 for more information about using
this variable). In addition, all columns are set to null.
– Access type. Displays the relational access type. DB2 is the default in Relational stages and is
read-only.
v Inputs. Specifies the table name, update action, column definitions, and optional WHERE clause for the
data input links.
v Outputs. Specifies the table to use and the associated column definitions for each data output link.
This page also specifies the SQL query used to extract the data from the tables.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Relational Input Data
When you write data to a table in DB2, the Relational stage has an input link. The properties of this link
and the column definitions of the data are defined on the Inputs page of the Relational Stage dialog box.
The Inputs page has the following field and up to four tabs, depending on the update action you specify:
v Input name. The name of the input link. Select the link you want to edit from the Input name list.
This list displays all the input links to the Relational stage. If there is only one input link, the field is
read-only.
v General. This tab is always present and is displayed by default. It contains the following parameters:
– Table name. This specifies the name of the table where the data will be written. Type a name in the
Table name text box, qualifying it with the location and owner names if necessary. Qualified names
should be entered in the format location.owner.tablename or owner.tablename. Table names cannot be
COBOL or SQL reserved words. See Chapter 15, “Reserved Words,” on page 241 for a list.
– Update action. Specifies how the data is written. Select the option you want from the list:
Insert new or update existing rows. New rows are inserted or, if the insert fails, the existing rows
are updated.
Insert rows without clearing. Inserts the new rows in the table without checking to see if they
already exist.
Replace existing rows completely. Deletes the existing rows that match the rows to be inserted,
then adds the new rows to the table.
Update existing rows only. Updates the existing data rows that match the rows to be inserted. Any
rows in the data that do not exist in the table are ignored.
Update existing rows or insert new ones. The existing data rows are updated or, if this fails, new
rows are added.
Delete rows. Deletes the existing rows if they match the predicates for the new rows.
– Description. Contains an optional description of the input link.
Note: You specify the number of rows per commit on the Environment page of the Job Properties
dialog box. This defines the number of rows to write, update, or delete before they are committed.
v Columns. This tab is always present and contains the column definitions for the data being written to
the table. This tab has a grid with the following columns:
– Column name. The name of the column.
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– Native type. The SQL data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER data, the maximum
number of characters for VARCHAR data, the total number of digits for numeric data types, and the
number of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
The columns are automatically loaded if you have mapped data from a prior, active stage. You can
also enter and edit column definitions in the columns grid, or click Load to load column definitions
from the repository. Click Save As... to save the columns as a table definition, a CFD file, or a
DCLGen file. For details about editing column definitions, see Chapter 10, “Editing Column
Metadata,” on page 207.
v Update Columns. This tab appears if you have chosen to update or replace rows in the Update action
field on the General tab. It does not appear if you select Insert rows without clearing, Replace
existing rows completely, or Delete rows. It allows you to select the columns to update and to define
the column derivations. See “Updating Input Columns” for details about updating columns.
v Where. This tab appears if you have chosen to update, replace, or delete rows in the Update action
field on the General tab. It does not appear if you select Insert rows without clearing. It allows you to
specify the filter criteria for selecting rows to update. See “Using a WHERE Clause” on page 30 for
details about constructing a WHERE clause.

Updating Input Columns
The Update Columns tab allows you to select input columns to update and to specify the column
derivations.
You can move a column from the Available columns list to the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking >. To move all
columns, click >>. You can remove single columns from the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking <. Remove all
columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected columns list to change the order of the columns being updated.
When you move a column to the Selected columns list, the default column derivation is to replace the
column. You can edit this derivation by clicking Modify. The Expression Editor appears.
Derivation expressions must return a value. You can build an expression using the items shown in the
Item type list box, including columns, job parameters, and constants. (See Chapter 7, “Programmer's
Reference,” on page 169 for definitions of these expression components.) When you click an item type,
the available items are displayed in the Item properties list box. Double-click an item to insert it in the
Expression syntax box.
You can select operators for your expression by clicking the buttons on the Operators tool palette. Click
Undo to undo the last change to the expression, or click Clear All to start over.
The Expression Editor validates expressions as they are built. If a syntax error is found, a message
appears in red and the element causing the error is underlined in the Expression syntax text box. To
perform both syntax and semantic checking, click Verify. (The Verify button is available if you select
Perform expression semantic checking in project or job properties.)
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When you are finished building an expression, click OK to save your changes. If your expression
contains errors, you will be allowed to continue without correcting the syntax, but you will be warned
that the expression is invalid.

Using a WHERE Clause
You can define a WHERE clause to select rows to update, replace, or delete based on certain criteria. If
you do not specify a WHERE clause, all of the rows in your table will be updated, replaced or deleted
depending on the update action you selected on the General tab. WHERE clauses are defined on the
Where tab.
To specify a WHERE clause, create an expression using the fields in the Where grid:
v (. Select an opening parenthesis if needed.
v Column. Select the column you want to filter on from the list.
v Op. Select an operator or a logical function from the list. For information about using functions in
WHERE clauses, see “Constraints” on page 170.
v Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks. Note that job parameters can be
used here, but they are not allowed in the WHERE clauses of Relational source stages. For details
about using job parameters in Relational WHERE clauses, see “Parameters” on page 181.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the WHERE clause, it appears in the Where field. WHERE
clauses must be Boolean expressions that return TRUE or FALSE. To validate the clause, click Verify. If
errors are found, you must either correct the expression, click Clear All to start over, or cancel. You
cannot save an incorrect WHERE clause.
The order of operators in expressions is determined by SQL standards. After you verify a WHERE clause,
any redundant parentheses might be removed. For details, see “Operators” on page 180.

Defining Relational Output Data
When you read data from a DB2 database table, the Relational stage has an output link. The properties of
this link and the column definitions of the data are defined on the Outputs page in the Relational Stage
dialog box.
The Outputs page has the following field and up to nine tabs, depending on how you choose to specify
the SQL statement to output the data:
v Output name. The name of the output link. Select the link you want to edit from the Output name list.
This list displays all the output links from the Relational stage. If there is only one output link, the
field is read-only.
v General. Contains an optional description of the link.
v Tables. This tab is displayed by default and allows you to select the tables to extract data from. The
available tables must already have definitions in the repository. If table names are qualified with an
owner name, you can select tables having the same table name.
You can move a table to the Selected tables list either by double-clicking the table name or by
highlighting the table name and clicking >. To move all tables, click >>. Remove single tables from the
Selected tables list either by double-clicking the table name or by highlighting the table name and
clicking <. Remove all tables by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected tables list to rearrange the order of the tables.
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You can select a table more than once to perform a self join. In this case, a unique alias name is
automatically generated in the Selected tables list. You can edit the alias by highlighting the alias
name and typing a new name. The length of the alias is limited to the length allowed by the version of
DB2 you are using.
v Select. This tab allows you to select the columns to extract data from. Using a tree structure, the
Available columns list displays the set of tables you selected on the Tables tab. Click the + next to the
table name to display the associated column names.
You can move a column to the Selected columns list either by double-clicking the column name or by
highlighting the column name and clicking >. To move all columns from a single table, highlight the
table name and click > or >>. Remove single columns from the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking <. Remove all
columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected columns list to rearrange the order of the columns.
If you remove a table from the Selected tables list on the Tables tab, its columns are automatically
removed from the Select tab.
The Selected columns list displays the column name, table alias, native data type, and expression for
each column. Click New to add a computed column or Modify to change the computed value of a
selected column. For details about computed columns, see “Defining Computed Columns” on page 32.
v Where. The Where grid allows you to define a WHERE clause to filter rows in the output link:
– (. Select an opening parenthesis if needed.
– Column. Select the column you want to filter on from the list.
– Op. Select an operator or a logical function from the list. For information about using functions in
WHERE clauses, see “Constraints” on page 170.
– Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks. Job parameters cannot be used here; they are
allowed only in the WHERE clauses of Relational target stages. For more information about using
job parameters in Relational WHERE clauses, see “Parameters” on page 181.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the WHERE clause, it appears in the Where field.
WHERE clauses must be Boolean expressions that return TRUE or FALSE. When you are done
building the clause, click Verify. If errors are found, you must either correct the expression, click
Clear All to start over, or cancel. You cannot save an incorrect WHERE clause.
The order of operators in expressions is determined by SQL standards. After you verify a WHERE
clause, any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Group By. This tab allows you to select the columns to group by in the output link. The Available
columns list displays the columns you selected on the Select tab. The Available columns and Group
by columns lists display the name, table alias, and native data type for each column.
You can move a column to the Group by columns list either by double-clicking the column name or
by highlighting the column name and clicking >. To move all columns, click >>. Remove single
columns from the Selected columns list either by double-clicking the column name or by highlighting
the column name and clicking <. Remove all columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Group by columns list to change the order of the columns to group by.
v Having. This tab appears only if you have selected columns to group by. It allows you to narrow the
scope of the GROUP BY clause. The Having grid allows you to specify conditions the grouped
columns must meet before they are selected:
– (. Select an opening parenthesis if needed.
– Column. Select the column you want to filter on from the list.
– Op. Select an operator or a logical function from the list.
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– Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the HAVING clause, it appears in the Having field.
HAVING clauses must be Boolean expressions that return TRUE or FALSE. When you are done
building the HAVING clause, click Verify. If errors are found, you must either correct the
expression, click Clear All to start over, or cancel. You cannot save an incorrect HAVING clause.
v Order By. This tab allows you to specify the sort order of data in selected output columns. The
Available columns and Order by columns lists display the name, table alias, and native data type for
each column. The Order column in the Order by columns list shows the sort order of column data.
You can move a column to the Order by columns list either by double-clicking the column name or by
highlighting the column name and clicking >. To move all columns, click >>. Remove single columns
from the Order by columns list either by double-clicking the column name or by highlighting the
column name and clicking <. Remove all columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Order by columns list to rearrange the column order.
To specify the sort order of data in the selected columns, click on the Order field in the Order by
columns list. Select Ascending or Descending from the list, or select nothing to sort by the database
default.
v SQL. This tab displays the SQL statement constructed from your selections on the Tables, Select,
Where, Group By, Having, and Order By tabs. You can edit the statement by typing in the SQL text
box. For more information see “Modifying the SQL Statement” on page 33.
v Columns. This tab displays the output columns generated by the SQL statement. This grid has the
following columns:
– Column name. The name of the column.
– Native type. The SQL data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER data, the maximum
number of characters for VARCHAR data, the total number of digits for numeric data types, and the
number of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
You can edit only column names on this tab, unless you modified the SQL statement on the SQL
tab. If you modified the SQL statement but no metadata has been defined in the repository for the
identified tables, then you can also add, edit, and remove columns on the Columns tab. Click Load
to load columns from a table definition in the repository or click Clear All to start over. Click Save
As... to save the columns as a table definition, a CFD file, or a DCLGen file. For details about the
conditions under which column editing is allowed, see “Modifying the SQL Statement” on page 33.

Defining Computed Columns
Computed columns are typically used to perform column aggregations or to convert column data types.
They also provide access to some DB2 functions that are not available in Aggregator or Transformer
stages.
You define or modify computed columns on the Select tab. To define a new computed column, click
New. To edit an existing computed column, highlight the column in the Selected columns list and click
Modify. (The Modify button is available only if you have already defined a computed column.)
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When you click New or Modify, the Computed Column dialog box appears. This dialog box contains the
following fields:
v As name. The name of the computed column. You must assign a unique name to the computed
column.
v Description. An optional description of the column.
v Native data type. The native data type of the column. For details about the native data types
supported in mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHARACTER data, the maximum
number of characters for VARCHAR data, the total number of digits for numeric data types, and the
number of digits in the microsecond portion of TIMESTAMP data.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
data, and zero for all other data types.
v Nullable. Specifies whether the column can contain a null value.
v Expression. Contains the expression used to compute the column value.
You can define the expression for the computed column by typing in the Expression text entry box. Click
Functions to get a list of available DB2 functions. You can select a function and click OK to insert it into
the Expression field, or simply double-click the function name.
All of the functions supported in DB2 versions 8.1 and earlier are available when you click Functions.
However, you must ensure that the functions you select are compatible with the version of DB2 you are
using, or you will get an error.
To replace <Operand> with a column name in the expression, highlight or delete <Operand> and click
Columns. You will get a list of available columns. Select one of these columns and click OK to insert it
into the Expression field, or simply double-click the column name. When you are done, click Verify to
validate the expression, then click OK to save your changes.
You cannot save an incorrect column derivation. If errors are found when your expression is validated,
you must either correct the expression or cancel the action.

Modifying the SQL Statement
InfoSphere DataStage allows you to edit the SQL statement on the SQL tab. Right-click to get a shortcut
menu with editing functions such as cut, paste, and copy. If you have a predefined SQL statement you
want to use, you can cut and paste it into the SQL text box. Job parameters cannot be used in the SQL
statement; only column names and constants (except HIGH_VALUES and LOW_VALUES) are supported.
Click Verify to validate the statement when you are done. If the entire SQL SELECT statement can be
parsed and table metadata has been defined in the repository for the identified tables, then your changes
will be propagated back to the other pages where they apply.
If the entire SQL SELECT statement can be parsed, or at least the SELECT list clause and the SELECT
FROM clause can be parsed, but no table metadata has been defined in the repository and no columns
exist on the Columns tab, then InfoSphere DataStage creates column definitions for each column in the
SELECT list using the specified column name, a default data type of Char, and length of 10. If columns
already exist on the Columns tab, they must match the columns defined in the SELECT list, including the
number of columns and attributes such as data type, length, and scale. You can use the Load and Clear
All buttons to edit, clear, or load new column definitions on the Columns tab.
If the SELECT list on the SQL tab and the columns list on the Columns tab do not match, DB2
precompiler, DB2 bind, or execution time errors will occur.
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If the SQL SELECT list clause and the SELECT FROM clause can be parsed and table metadata has been
defined in the repository for the identified tables, then the columns list on the Columns tab is cleared
and repopulated from the metadata. The Load and Clear All buttons on the Columns tab are unavailable
and no edits are allowed except for changing the column name.
If either the SQL SELECT list clause or the SELECT FROM clause cannot be parsed, then no changes are
made to columns defined on the Columns tab. You must ensure that the number of columns matches the
number defined in the SELECT list clause and that they have the correct attributes in terms of data type,
length, and scale. Use the Load or Clear All buttons to edit, clear, or load new column definitions on the
Columns tab. If the SELECT list on the SQL tab and the columns list on the Columns tab do not match,
DB2 precompiler, DB2 bind, or execution time errors will occur.
If validation is unsuccessful, you will receive an error message. You can correct the SQL statement, undo
your changes, or choose to continue without making any corrections. If you continue without making
corrections, however, only the General, SQL, and Columns tabs on the Outputs page will be active.
Note: Some DB2 syntax, such as subqueries, cannot be successfully validated by InfoSphere DataStage.
Though you will receive an error message, you should continue without making changes if you are
confident that the SQL statement is correct.

Teradata Export Stages
These topics describe Teradata Export stages, which use the Teradata FastExport utility to read data from
a Teradata database table on a z/OS platform.

Using a Teradata Export Stage
Teradata Export stages are used only as source stages and cannot receive input links. They have a single
output link to an active stage.
When you edit a Teradata Export stage, the Teradata Export Stage dialog box appears. This dialog box
has two pages:
v Stage. Displays the stage name, which can be edited. This page has three tabs.
The General tab is where you specify the Teradata connection parameters. You can also type an
optional description of the stage, which appears in the generated COBOL program. The General tab
has four fields:
– TDP id. The identifier of the Teradata database.
– Account id. The Teradata account associated with the user. This field is optional.
– User id. The user name for Teradata login.
– Password. The password associated with the login user name.
If you have already specified Teradata connection parameters in job properties, the TDP id, Account
id, User id, and Password fields display these settings as their initial values. You can edit these
fields. If your job contains multiple Teradata Export stages, each one can connect to a different
Teradata database.
The Parameters tab allows you to specify parameters that control the execution of FastExport. See
“Specifying Teradata FastExport Parameters” on page 35 for details.
The File tab contains information needed to create the flat file where FastExport writes the exported
data. See “Specifying File Options” on page 35 for details.
v Outputs. Specifies the SELECT statement used by FastExport to extract data from the Teradata table.
Click OK to close this dialog box. Changes are saved when you save the job.
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Specifying Teradata FastExport Parameters
The parameters needed to run the Teradata FastExport utility are set on the Parameters tab on the Stage
page. This tab contains the following fields:
v Min sessions. The minimum number of sessions required.
v Max sessions. The maximum number of sessions allowed.
v Tenacity. The number of hours that FastExport will attempt to log on to the Teradata database to get
the minimum number of sessions specified.
v Sleep. The number of minutes to wait between each logon attempt.
v Out limit. The maximum number of records to write to the output file.
v Block size. The maximum block size (in bytes) that should be used when returning data from the
database.
v Log table. The name of the table used for logging. The default name is ExpLog#####_date_time, where
date is the current date in CCYYMMDD format and time is the current time in HHMMSS format. The
##### is a 5-digit sequence number which is used to make the name unique in case there are multiple
Teradata Export stages in the job.
Only the Min sessions and Log table fields are required.

Specifying File Options
The File tab allows you to specify various options about the flat file that is created by FastExport to hold
the extracted data. This tab contains the following fields:
v File name. The name of the file where data will be written.
v Write option. Specifies how to write data to the file. There are four options:
– Create a new file. Creates a new file without checking to see if one already exists. This is the
default.
– Append to existing file. Adds data to the existing file.
– Overwrite existing file. Deletes the existing file and replaces it with a new file.
– Delete and recreate existing file. Deletes the existing file if it has already been cataloged and
recreates it.
v DD name. The data definition name of the file in the JCL. It can be 1 to 8 alphanumeric characters and
the first character must be alphabetic.
v Normal EOJ handling. Contains the parameter for the disposition of the data file when job upload
successfully completes. There are four options:
– CATLG. Catalogs the data set. This is the default.
– DELETE. Deletes the data set after job execution.
– KEEP. Retains the data set, but does not catalog it.
– PASS. Passes the data set to the next job step, but deletes it at the end of the job.
v Abnormal EOJ handling. Contains the parameter for the disposition of the data file when job upload
does not complete successfully. There are three options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set. This is the default.
– KEEP. Retains the data set, but does not catalog it.
v Vol ser. The volume serial number of the unit where the file will be written. Up to six alphanumeric
characters are allowed.
v Unit. Specifies the device type of the disk on which the data is to be stored. The default value is
SYSDA.
v Allocation type. Specifies the unit of allocation used when storage space is reserved for the file. There
are two options:
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– TRK. Track. This is the default.
– CYL. Cylinder. This generally allocates a greater amount of storage space than TRK.
The exact size of a track or cylinder is device dependent.
Primary allocation amount. Contains the number of tracks or cylinders to be reserved as the initial
storage for the job. The minimum is 1 and the maximum is 32768. The default value is 10.
Secondary allocation amount. Contains the number of tracks or cylinders to be reserved if the primary
allocation is insufficient for the job. The minimum is 1 and the maximum is 32768. The default value is
10.
Expiration date. Specifies the expiration date for a new data set in YYDDD or YYYY/DDD format. For
expiration dates of January 1, 2000 or later, you must use the YYYY/DDD format. JCL extension
variables can also be used.
The YY can be from 01 to 99 or the YYYY can be from 1900 to 2155. The DDD can be from 000 to 365
for nonleap years or 000 to 366 for leap years.
If you specify the current date or an earlier date, the data set is immediately eligible for replacement.
Data sets with expiration dates of 99365, 99366, 1999/365 and 1999/366 are considered permanent and
are never deleted or overwritten.
Retention period. Specifies the number of days to retain a new data set. You can type a number or use
a JCL extension variable. When the job runs, this value is added to the current date to produce an
expiration date, using 365-day years and 366-day leap years. Note that if the calculated expiration date
is December 31, 1999, the expiration date is set to January 1, 2000.

You can specify either an expiration date or a retention period, but not both. When you type a value in
one of these fields, the other field becomes unavailable. No validation is done on either field; if you type
an incorrect value, JCL errors can occur.
These parameters are used during JCL generation. All fields except Vol ser, Expiration date, and
Retention period are required.

Defining Teradata Export Output Data
When you read data from a Teradata database table, the Teradata Export stage has an output link. The
properties of this link and the column definitions of the data are defined on the Outputs page in the
Teradata Export Stage dialog box.
The Outputs page has the following field and up to nine tabs, depending on how you choose to specify
the SQL statement to output the data:
v Output name. The name of the output link. Since only one output link is allowed, this field is
read-only.
v General. Contains an optional description of the link.
v Tables. This tab is displayed by default and allows you to select the tables to extract data from. The
available tables must already have definitions in the repository.
You can move a table to the Selected tables list either by double-clicking the table name or by
highlighting the table name and clicking >. To move all tables, click >>. Remove single tables from the
Selected tables list either by double-clicking the table name or by highlighting the table name and
clicking <. Remove all tables by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected tables list to rearrange the order of the tables.
You can select a table more than once to perform a self join. In this case, a unique alias name is
automatically generated in the Selected tables list. You can edit the alias by highlighting the alias
name and typing a new name.
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v Select. This tab allows you to select the columns to extract data from. Using a tree structure, the
Available columns list displays the set of tables you selected on the Tables tab. Click the + next to the
table name to display the associated column names.
You can move a column to the Selected columns list either by double-clicking the column name or by
highlighting the column name and clicking >. To move all columns from a single table, highlight the
table name and click > or >>. Remove single columns from the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking <. Remove all
columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected columns list to rearrange the order of the columns.
If you remove a table from the Selected tables list on the Tables tab, its columns are automatically
removed from the Select tab.
The Selected columns list displays the column name, table alias, native data type, and expression for
each column. Click New to add a computed column or Modify to change the computed value of a
selected column. For details about computed columns, see “Defining Computed Columns” on page 38.
v Where. The Where grid allows you to define a WHERE clause to filter rows in the output link:
– (. Select an opening parenthesis if needed.
– Column. Select the column you want to filter on from the list.
– Op. Select an operator or a logical function from the list. For information about using functions in
WHERE clauses, see “Constraints” on page 170.
– Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the WHERE clause, it appears in the Where field.
WHERE clauses must be Boolean expressions that return TRUE or FALSE. When you are done
building the clause, click Verify. If errors are found, you must either correct the expression, click
Clear All to start over, or cancel. You cannot save an incorrect WHERE clause.
The order of operators in expressions is determined by SQL standards. After you verify a WHERE
clause, any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Group By. This tab allows you to select the columns to group by in the output link. The Available
columns list displays the columns you selected on the Select tab. The Available columns and Group
by columns lists display the name, table alias, and native data type for each column.
You can move a column to the Group by columns list either by double-clicking the column name or
by highlighting the column name and clicking >. To move all columns, click >>. Remove single
columns from the Selected columns list either by double-clicking the column name or by highlighting
the column name and clicking <. Remove all columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Group by columns list to change the order of the columns to group by.
v Having. This tab appears only if you have selected columns to group by. It allows you to narrow the
scope of the GROUP BY clause. The Having grid allows you to specify conditions the grouped
columns must meet before they are selected:
–
–
–
–

(. Select an opening parenthesis if needed.
Column. Select the column you want to filter on from the list.
Op. Select an operator or a logical function from the list.
Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
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All of these fields are editable. As you build the HAVING clause, it appears in the Having field.
HAVING clauses must be Boolean expressions that return TRUE or FALSE. When you are done
building the HAVING clause, click Verify. If errors are found, you must either correct the
expression, click Clear All to start over, or cancel. You cannot save an incorrect HAVING clause.
v SQL. This tab displays the SQL statement constructed from your selections on the Tables, Select,
Where, Group By, Having, and Order By tabs. You can edit the statement by typing in the SQL text
box. For more information see “Modifying the SQL Statement” on page 39.
v Columns. This tab displays the output columns generated by the SQL statement. This grid has the
following columns:
– Column name. The name of the column.
– Native type. The SQL data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHAR data, the maximum number
of characters for VARCHAR data, the total number of digits for numeric data types, and the number
of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
You can edit only column names on this tab, unless you modified the SQL statement on the SQL
tab. If you modified the SQL statement but no metadata has been defined in the repository for the
identified tables, then you can also add, edit, and remove columns on the Columns tab. Click Load
to load columns from a table definition in the repository or click Clear All to start over. Click Save
As... to save the columns as a table definition, a CFD file, or a DCLGen file. For details about the
conditions under which column editing is allowed, see “Modifying the SQL Statement” on page 39.

Defining Computed Columns
Computed columns are typically used to perform column aggregations or to convert column data types.
They also provide access to some Teradata functions that are not available in Aggregator or Transformer
stages.
You define or modify computed columns on the Select tab. To define a new computed column, click
New. To edit an existing computed column, highlight the column in the Selected columns list and click
Modify. (The Modify button is available only if you have already defined a computed column.)
When you click New or Modify, the Computed Column dialog box appears. This dialog box contains the
following fields:
v As name. The name of the computed column. You must assign a unique name to the computed
column.
v Description. An optional description of the column.
v Native data type. The native data type of the column. For details about the native data types
supported in mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHAR data, the maximum number of
characters for VARCHAR data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of TIMESTAMP data.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
data, and zero for all other data types.
v Nullable. Specifies whether the column can contain a null value.
v Expression. Contains the expression used to compute the column value.
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You can define the expression for the computed column by typing in the Expression text entry box. Click
Functions to get a list of available Teradata functions. You can select a function and click OK to insert it
into the Expression field, or simply double-click the function name.
To replace <Operand> with a column name in the expression, highlight or delete <Operand> and click
Columns. You will get a list of available columns. Select one of these columns and click OK to insert it
into the Expression field, or simply double-click the column name. When you are done, click Verify to
validate the expression, then click OK to save your changes.
You cannot save an incorrect column derivation. If errors are found when your expression is validated,
you must either correct the expression or cancel the action.

Modifying the SQL Statement
InfoSphere DataStage allows you to edit the SQL statement on the SQL tab. Right-click to get a shortcut
menu with editing functions such as cut, paste, and copy. If you have a predefined SQL statement you
want to use, you can cut and paste it into the SQL text box. Job parameters cannot be used in the SQL
statement; only column names and constants (except HIGH_VALUES and LOW_VALUES) are supported.
Click Verify to validate the statement when you are done. If the entire SQL SELECT statement can be
parsed and table metadata has been defined in the repository for the identified tables, then your changes
will be propagated back to the other pages where they apply.
If the entire SQL SELECT statement can be parsed, or at least the SELECT list clause and the SELECT
FROM clause can be parsed, but no table metadata has been defined in the repository and no columns
exist on the Columns tab, then InfoSphere DataStage creates column definitions for each column in the
SELECT list using the specified column name, a default data type of Char, and length of 10. If columns
already exist on the Columns tab, they must match the columns defined in the SELECT list, including the
number of columns and attributes such as data type, length, and scale. You can use the Load and Clear
All buttons to edit, clear, or load new column definitions on the Columns tab.
If the SELECT list on the SQL tab and the columns list on the Columns tab do not match, Teradata
precompiler, Teradata bind, or execution time errors will occur.
If the SQL SELECT list clause and the SELECT FROM clause can be parsed and table metadata has been
defined in the repository for the identified tables, then the columns list on the Columns tab is cleared
and repopulated from the metadata. The Load and Clear All buttons on the Columns tab are unavailable
and no edits are allowed except for changing the column name.
If either the SQL SELECT list clause or the SELECT FROM clause cannot be parsed, then no changes are
made to columns defined on the Columns tab. You must ensure that the number of columns matches the
number defined in the SELECT list clause and that they have the correct attributes in terms of data type,
length, and scale. Use the Load or Clear All buttons to edit, clear, or load new column definitions on the
Columns tab. If the SELECT list on the SQL tab and the columns list on the Columns tab do not match,
Teradata precompiler, Teradata bind, or execution time errors will occur.
If validation is unsuccessful, you will receive an error message. You can correct the SQL statement, undo
your changes, or choose to continue without making any corrections. If you continue without making
corrections, however, only the General, SQL, and Columns tabs on the Outputs page will be active.
Note: Some Teradata syntax, such as subqueries, cannot be successfully validated by InfoSphere
DataStage. Though you will receive an error message, you should continue without making changes if
you are confident that the SQL statement is correct.
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Teradata Load Stages
These topics describe Teradata Load stages, which are used to write data to a sequential file in a format
that is compatible for use with a Teradata load utility.

Using a Teradata Load Stage
Teradata Load stages are used only as target stages and have no output links. They can have multiple
input links from active stages.
When you edit a Teradata Load stage, the Teradata Load Stage dialog box appears. This dialog box has
two pages:
v Stage. Displays the stage name, which can be edited. This page has seven tabs.
The General tab displays the basic characteristics of the stage. It contains the following fields:
– Load type. Select the load utility to run. FastLoad moves large volumes of data into an empty table
in a Teradata database. MultiLoad is used to load a table in a Teradata database. TPump is used for
low-volume batch maintenance of a Teradata database.
– Table name. The name of the table where data will be written. Qualified names should be entered
in the format owner.tablename or location.owner.tablename. Table names cannot be COBOL or SQL
reserved words. See Chapter 15, “Reserved Words,” on page 241 for a list.
– Table preparation. Specifies the table action to be taken at the start of the load operation. Choose
one of the following options from the list:
None. No action taken. This is the default.
Create a new table. Creates a new table in the target database.
Drop and redefine the table. Drops the existing table and creates a new one.
Delete rows from an existing table. Deletes the rows from an existing table.
– Update action. Specifies how the data is written to the table. This field is only available if
MultiLoad or TPump are selected as the load utility. The options are:
Insert rows without clearing. Inserts the new rows in the table.
Update existing rows only. Updates the existing data rows that match the rows to be inserted. Any
rows in the data that do not exist in the table are ignored.
Update existing rows or insert new ones (Upsert). The existing data rows are updated or, if this
fails, new rows are added. This is performed using a single SQL statement for both the UPDATE
and INSERT.
Delete rows. Deletes the existing rows if they match the predicates for the current rows.
– TDP id. The identifier of the Teradata database.
– Account id. The Teradata account associated with the user. This field is optional.
– User id. The user name for Teradata login.
– Password. The password associated with the login user name.
If you have already specified Teradata connection parameters in job properties, the TDP id, Account
id, User id, and Password fields display these settings as their initial values. You can edit these
fields. If your job contains multiple Teradata Load stages, each one can connect to a different
Teradata database.
– Description. Contains an optional description of the stage, which appears in the generated COBOL
program.
The Columns tab contains the column definitions for the data being written to the table. See
“Specifying Stage Column Definitions” on page 41 for details about defining or loading column
definitions.
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The Update Columns tab is available if you have chosen to update or upsert rows in the Update
action field. It allows you to select the columns to update and define the column derivations. See
“Updating Input Columns” for details about updating columns.
TheWhere tab is available if you have chosen to update, upsert, or delete rows in the Update action
field on the General tab. It allows you to specify the filter criteria for selecting rows to update. See
“Defining a WHERE Clause” on page 42 for details about constructing a constraint.
The Parameters tab allows you to specify parameters that control the execution of the load utility.
See “Specifying Teradata Load Utility Parameters” on page 42 for details about setting these options.
The Errors tab allows you to set error handling options for the load utility. See “Specifying Error
Handling Options” on page 43 for details about setting these options.
The File tab contains information needed to create the flat file where data is written. See “Specifying
File Options” on page 43 for details.
v Inputs. Specifies the column definitions for the data input links.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Stage Column Definitions
The Columns tab on the Stage page allows you to specify the format of the data being written by
Teradata Load stages. These column definitions are then projected to the Inputs page. This tab has a grid
with the following columns:
v Column name. The name of the column.
v Native type. The SQL data type. For details about the native data types supported in mainframe source
and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHAR data, the maximum number of
characters for VARCHAR data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of TIMESTAMP data.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
data, and zero for all other data types.
v Nullable. Indicates whether the column can contain a null value.
v Description. A text description of the column.
The columns are automatically loaded if you have mapped data from a prior, active stage. You can also
enter and edit column definitions on the Columns tab, or click Load to load column definitions from the
repository. Click Save As... to save the columns as a table definition, a CFD file, or a DCLGen file. For
details about editing column definitions, see Chapter 10, “Editing Column Metadata,” on page 207.

Updating Input Columns
The Update Columns tab allows you to select input columns to update and to specify the column
derivations.
You can move a column from the Available columns list to the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking >. To move all
columns, click >>. You can remove single columns from the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking <. Remove all
columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected columns list to change the order of the columns being updated.
When you move a column to the Selected columns list, the default column derivation is to replace the
column. You can edit this derivation by clicking Modify. The Expression Editor appears.
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Derivation expressions must return a value. You can build an expression using the items shown in the
Item type list box, including columns, job parameters, and constants. (See Chapter 7, “Programmer's
Reference,” on page 169 for definitions of these expression components.) When you click an item type,
the available items are displayed in the Item properties list box. Double-click an item to insert it in the
Expression syntax box.
You can select operators for your expression by clicking the buttons on the Operators tool palette. Click
Undo to undo the last change to the expression, or click Clear All to start over.
The Expression Editor validates expressions as they are built. If a syntax error is found, a message
appears in red and the element causing the error is underlined in the Expression syntax text box. To
perform both syntax and semantic checking, click Verify. (The Verify button is available if you select
Perform expression semantic checking in project or job properties.)
When you are finished building an expression, click OK to save your changes. If your expression
contains errors, you will be allowed to continue without correcting the syntax, but you will be warned
that the expression is invalid.

Defining a WHERE Clause
You can define a WHERE clause to select rows to update or delete based on certain criteria. If you do not
specify a WHERE clause, all of the rows in your table will be updated or deleted depending on the
update action you selected on the General tab.
WHERE clauses are defined on the Where tab. To define a WHERE clause, create an expression in the
grid:
v (. Select an opening parenthesis if needed.
v Column. Select the column you want to filter on from the list.
v Op. Select an operator or a logical function from the list. For information about using functions in
WHERE clauses, see “Constraints” on page 170.
v Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the WHERE clause, it appears in the Where field. WHERE
clauses must be Boolean expressions that return TRUE or FALSE. To validate the clause, click Verify. If
errors are found, you must either correct the expression, click Clear All to start over, or cancel. You
cannot save an incorrect WHERE clause.
The order of operators in expressions is determined by SQL standards. After you verify a WHERE clause,
any redundant parentheses might be removed. For details, see “Operators” on page 180.

Specifying Teradata Load Utility Parameters
The parameters needed to run the Teradata load utility are set on the Parameters tab on the Stage page.
The fields displayed here vary depending on the load utility selected on the General tab.
For FastLoad they include:
v Min sessions. The minimum number of sessions required.
v Max sessions. The maximum number of sessions allowed.
v Tenacity. The number of hours that the load utility will attempt to log on to the Teradata database to
get the minimum number of sessions specified.
v Sleep. The number of minutes to wait between each logon attempt.
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MultiLoad parameters include all of the above plus these:
v Log table. The name of the table used for logging. The default name is LoadLog#####_date_time, where
date is the current date in CCYYMMDD format and time is the current time in HHMMSS format. The
##### is a 5-digit sequence number which is used to make the name unique in case there are multiple
such names in the job.
v Work table. The name of the work table used by the load utility. The table name must be a new,
nonexisting name for a nonrestart task, or an existing table name for a restart task. The default name is
WorkTbl#####_date_time, where date is the current date in CCYYMMDD format and time is the current
time in HHMMSS format. The ##### is a 5-digit sequence number which is used to make the name
unique in case there are multiple such names in the job.
v Checkpoint. The number of rows sent to Teradata between checkpoints. For TPump this can be 0 to 60
and for MultiLoad it can be any integer greater than 0. It can also be left blank.
TPump parameters are the same as those for FastLoad and MultiLoad, as well as some others:
v Serialize. Specifies whether operations on a given row should occur serially. Select ON or OFF.
v Latency. Specifies the flushing threshold based on the number of seconds that the oldest record has
resided in the buffer. This can be blank or an integer greater than 10.
v Pack. Specifies the number of statements to pack into a multi-statement request. Type a number from 1
to 300 or MAX.
v Rate. Specifies the maximum rate per minute at which statements should be sent to Teradata.
v Robust. Specifies whether to enable complex restarts in Teradata. Select ON or OFF.

Specifying Error Handling Options
Error handling options for the Teradata load utility are set on the Errors tab on the Stage page. The
General tab displays some or all of the following fields, depending on the load utility you select:
Error table 1. The name of the database table where error information should be inserted.
Error table 2. The name of a second database table where error information should be inserted.
Error limit (percent). The number of errors to allow before the run is terminated.
Duplicate UPDATE rows. Determines the handling of duplicate rows during an update. MARK inserts
duplicate rows into the error table and IGNORE disregards the duplicates.
v Duplicate INSERT rows. Determines the handling of duplicate rows during an insert. MARK inserts
duplicate rows into the error table and IGNORE disregards the duplicates.
v Missing UPDATE rows. Determines the handling of missing rows during an update. MARK inserts
missing rows into the error table and IGNORE does nothing.
v Missing DELETE rows. Determines the handling of missing rows during a delete. MARK inserts
missing rows into the error table and IGNORE does nothing.

v
v
v
v

v Extra UPDATE rows. Determines the handling of extra rows during an update. MARK inserts extra
rows into the error table and IGNORE does nothing.
v Extra DELETE rows. Determines the handling of extra rows during a delete. MARK inserts extra rows
into the error table and IGNORE does nothing.

Specifying File Options
The File tab allows you to specify various options about the flat file that is created to hold the data. This
tab contains the following fields:
v File name. The name of the file where data will be written.
v Write option. Allows you to specify how to write data to the load file. There are four options:
– Create a new file. Creates a new file without checking to see if one already exists. This is the
default.
– Append to existing file. Adds data to the existing file.
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– Overwrite existing file. Deletes the existing file and replaces it with a new file.
– Delete and recreate existing file. Deletes the existing file if it has already been cataloged and
recreates it.
v DD name. The data definition name of the file in the JCL. It can be 1 to 8 alphanumeric characters and
the first character must be alphabetic.
v Normal EOJ handling. Contains the parameter for the disposition of the data file when job upload
successfully completes. There are four options:
– CATLG. Catalogs the data set. This is the default.
– DELETE. Deletes the data set after job execution.
– KEEP. Retains the data set, but does not catalog it.
– PASS. Passes the data set to the next job step, but deletes it at the end of the job.
v Abnormal EOJ handling. Contains the parameter for the disposition of the data file when job upload
does not complete successfully. There are three options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set. This is the default.
– KEEP. Retains the data set, but does not catalog it.
v Vol ser. This is the name of the volume serial identifier associated with the disk where storage space is
being reserved. Up to six alphanumeric characters are allowed.
v Unit. Designates the type of disk on which the data is to be stored. The default value is SYSDA.
v Allocation type. Specifies the type of units to be reserved in the SPACE parameter to receive the data.
There are two options:
– TRK. Track. This is the default.
– CYL. Cylinder. This generally allocates a greater amount of storage space than TRK.
The exact size of a track or cylinder is device dependent.
v Primary allocation amount. Contains the number of tracks or cylinders to be reserved as the initial
storage for the job. The minimum is 1 and the maximum is 32768. The default value is 10.
v Secondary allocation amount. Contains the number of tracks or cylinders to be reserved if the primary
allocation is insufficient for the job. The minimum is 1 and the maximum is 32768. The default value is
10.
v Expiration date. Specifies the expiration date for a new data set in YYDDD or YYYY/DDD format. For
expiration dates of January 1, 2000 or later, you must use the YYYY/DDD format. JCL extension
variables can also be used.
The YY can be from 01 to 99 or the YYYY can be from 1900 to 2155. The DDD can be from 000 to 365
for nonleap years or 000 to 366 for leap years.
If you specify the current date or an earlier date, the data set is immediately eligible for replacement.
Data sets with expiration dates of 99365, 99366, 1999/365 and 1999/366 are considered permanent and
are never deleted or overwritten.
v Retention period. Specifies the number of days to retain a new data set. You can type a number or use
a JCL extension variable. When the job runs, this value is added to the current date to produce an
expiration date, using 365-day years and 366-day leap years. Note that if the calculated expiration date
is December 31, 1999, the expiration date is set to January 1, 2000.
You can specify either an expiration date or a retention period, but not both. When you type a value in
one of these fields, the other field becomes unavailable. No validation is done on either field; if you type
an incorrect value, JCL errors can occur.
These parameters are used during JCL generation. All fields except Vol ser, Expiration date, and
Retention period are required.
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Defining Teradata Load Input Data
When you write data to a table in Teradata, the Teradata Load stage has an input link. The properties of
this link and the column definitions of the data are defined on the Inputs page of the Teradata Load
Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The names of the input links to the Teradata Load stage. Use this field to select which set
of input data you want to view.
v General. Contains an optional description of the selected link.
v Columns. Contains the column definitions for the data being written to the table. This page has a grid
with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHAR data, the maximum number
of characters for VARCHAR data, the total number of digits for numeric data types, and the number
of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Column definitions are read-only on the Inputs page of Teradata Load stages. You must go back to
the Columns tab on the Stage page to make any changes.

Teradata Relational Stages
These topics describe Teradata Relational stages, which are used to read data from or write data to a
Teradata database table on a z/OS platform.

Using a Teradata Relational Stage
Teradata Relational stages can have any number of input or output links. However, each input link
supports only one Teradata table.
Jobs containing one or more Teradata Relational stages can connect to only one Teradata database. You
must specify Teradata connection parameters, including the Teradata database identifier, user id, and
password, in job properties before generating code.
Teradata Relational and Relational stages cannot be used in the same job due to preprocessor restrictions.
When you edit a Teradata Relational stage, the Teradata Relational Stage dialog box appears. This dialog
box can have up to three pages (depending on whether there are inputs to and outputs from the stage):
v Stage. Displays the stage name, which can be edited. This page has a General tab where you can type
an optional description of the stage. The description will appear in the generated COBOL program The
General tab has two fields:
– Generate an end-of-data row. Appears only when the stage is used as a source. Select this check
box to add an end-of-data indicator after the last row is processed on each output link. The
indicator is a built-in variable called ENDOFDATA which has a value of TRUE, meaning the last
row of data has been processed. (See “ENDOFDATA” on page 183 for more information about using
this variable). In addition, all columns are set to null.
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– Access type. Displays the relational access type. TERADATA is the default in Teradata Relational
stages and is read-only.
v Inputs. Specifies the table name, update action, column definitions, and optional WHERE clause for the
data input links.
v Outputs. Specifies the table to use and the associated column definitions for each data output link.
This page also specifies the SQL query used to extract the data from the tables.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Teradata Relational Input Data
When you write data to a table in Teradata, the Teradata Relational stage has an input link. The
properties of this link and the column definitions of the data are defined on the Inputs page of the
Teradata Relational Stage dialog box.
The Inputs page has the following field and up to four tabs, depending on the update action you specify:
v Input name. The name of the input link. Select the link you want to edit from the Input name list.
This list displays all the input links to the Teradata Relational stage. If there is only one input link, the
field is read-only.
v General. This tab is always present and is displayed by default. It contains the following parameters:
– Table name. This specifies the name of the table where the data will be written. Type a name in the
Table name text box, qualifying it with the location and owner names if necessary. Qualified names
should be entered in the format location.owner.tablename or owner.tablename. Table names cannot be
COBOL or SQL reserved words. See Chapter 15, “Reserved Words,” on page 241 for a list.
– Update action. Specifies how the data is written. Select the option you want from the list:
Insert new or update existing rows. New rows are inserted or, if the insert fails, the existing rows
are updated.
Insert rows without clearing. Inserts the new rows in the table without checking to see if they
already exist.
Replace existing rows completely. Deletes the existing rows that match the rows to be inserted,
then adds the new rows to the table.
Update existing rows only. Updates the existing data rows that match the rows to be inserted. Any
rows in the data that do not exist in the table are ignored.
Update existing rows or insert new ones. The existing data rows are updated or, if this fails, new
rows are added. This is performed using two SQL statements for the UPDATE and INSERT.
Delete rows. Deletes the existing rows if they match the predicates for the new rows.
Atomic upsert of rows. The existing data rows are updated or, if this fails, new rows are added.
This is performed using a single SQL statement for both the UPDATE and INSERT.
– Description. Contains an optional description of the input link.
v Columns. This tab is always present and contains the column definitions for the data being written to
the table. This tab has a grid with the following columns:
– Column name. The name of the column.
– Native type. The SQL data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHAR data, the maximum number
of characters for VARCHAR data, the total number of digits for numeric data types, and the number
of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
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– Description. A text description of the column.
The columns are automatically loaded if you have mapped data from a prior, active stage. You can
also enter and edit column definitions in the columns grid, or click Load to load column definitions
from the repository. Click Save As... to save the columns as a table definition, a CFD file, or a
DCLGen file. For details about editing column definitions, see Chapter 10, “Editing Column
Metadata,” on page 207.
v Update Columns. This tab appears if you have chosen to update or replace rows in the Update action
field on the General tab. It does not appear if you select Insert rows without clearing, Replace
existing rows completely, or Delete rows. It allows you to select the columns to update and define the
column derivations. See “Updating Input Columns” for details about updating columns.
v Where. This tab appears if you have chosen to update, replace, or delete rows in the Update action
field on the General tab. It does not appear if you select Insert rows without clearing. It allows you to
specify the filter criteria for selecting rows to update. See “Using a WHERE Clause” for details about
constructing a WHERE clause.

Updating Input Columns
The Update Columns tab allows you to select input columns to update and to specify the column
derivations.
You can move a column from the Available columns list to the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking >. To move all
columns, click >>. You can remove single columns from the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking <. Remove all
columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected columns list to change the order of the columns being updated.
When you move a column to the Selected columns list, the default column derivation is to replace the
column. You can edit this derivation by clicking Modify. The Expression Editor appears.
Derivation expressions must return a value. You can build an expression using the items shown in the
Item type list box, including columns, job parameters, and constants. (See Chapter 7, “Programmer's
Reference,” on page 169 for definitions of these expression components.) When you click an item type,
the available items are displayed in the Item properties list box. Double-click an item to insert it in the
Expression syntax box.
You can select operators for your expression by clicking the buttons on the Operators tool palette. Click
Undo to undo the last change to the expression, or click Clear All to start over.
The Expression Editor validates expressions as they are built. If a syntax error is found, a message
appears in red and the element causing the error is underlined in the Expression syntax text box. To
perform both syntax and semantic checking, click Verify. (The Verify button is available if you select
Perform expression semantic checking in project or job properties.)
When you are finished building an expression, click OK to save your changes. If your expression
contains errors, you will be allowed to continue without correcting the syntax, but you will be warned
that the expression is invalid.

Using a WHERE Clause
You can define a WHERE clause to select rows to update, replace, or delete based on certain criteria. If
you do not specify a WHERE clause, all of the rows in your table will be updated, replaced or deleted
depending on the update action you selected on the General tab.
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WHERE clauses are defined on the Where tab. To specify a WHERE clause, create an expression in the
Where grid:
v (. Select an opening parenthesis if needed.
v Column. Select the column you want to filter on from the list.
v Op. Select an operator or a logical function from the list. For information about using functions in
WHERE clauses, see “Constraints” on page 170.
v Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks. Note that job parameters can be
used here, but they are not allowed in the WHERE clauses of Teradata Relational source stages. For
more information about using job parameters in Teradata Relational WHERE clauses, see “Parameters”
on page 181.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the WHERE clause, it appears in the Where field. WHERE
clauses must be Boolean expressions that return TRUE or FALSE. To validate the clause, click Verify. If
errors are found, you must either correct the expression, click Clear All to start over, or cancel. You
cannot save an incorrect WHERE clause.
The order of operators in expressions is determined by SQL standards. After you verify a WHERE clause,
any redundant parentheses might be removed. For details, see “Operators” on page 180.

Defining Teradata Relational Output Data
When you read data from a Teradata database table, the Teradata Relational stage has an output link. The
properties of this link and the column definitions of the data are defined on the Outputs page in the
Teradata Relational Stage dialog box.
The Outputs page has the following field and up to nine tabs, depending on how you choose to specify
the SQL statement to output the data:
v Output name. The name of the output link. Select the link you want to edit from the Output name list.
This list displays all the output links from the Teradata Relational stage. If there is only one output
link, the field is read-only.
v General. Contains an optional description of the link.
v Tables. This tab is displayed by default and allows you to select the tables to extract data from. The
available tables must already have definitions in the repository.
You can move a table to the Selected tables list either by double-clicking the table name or by
highlighting the table name and clicking >. To move all tables, click >>. Remove single tables from the
Selected tables list either by double-clicking the table name or by highlighting the table name and
clicking <. Remove all tables by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected tables list to rearrange the order of the tables.
You can select a table more than once to perform a self join. In this case, a unique alias name is
automatically generated in the Selected tables list. You can edit the alias by highlighting the alias
name and typing a new name.
v Select. This tab allows you to select the columns to extract data from. Using a tree structure, the
Available columns list displays the set of tables you selected on the Tables tab. Click the + next to the
table name to display the associated column names.
You can move a column to the Selected columns list either by double-clicking the column name or by
highlighting the column name and clicking >. To move all columns from a single table, highlight the
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table name and click > or >>. Remove single columns from the Selected columns list either by
double-clicking the column name or by highlighting the column name and clicking <. Remove all
columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Selected columns list to rearrange the order of the columns.
If you remove a table from the Selected tables list on the Tables tab, its columns are automatically
removed from the Select tab.
The Selected columns list displays the column name, table alias, native data type, and expression for
each column. Click New to add a computed column or Modify to change the computed value of a
selected column. For details about computed columns, see “Defining Computed Columns” on page 50.
v Where. The Where grid allows you to define a WHERE clause to filter rows in the output link:
– (. Select an opening parenthesis if needed.
– Column. Select the column you want to filter on from the list.
– Op. Select an operator or a logical function from the list. For information about using functions in
WHERE clauses, see “Constraints” on page 170.
– Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks. Note that job parameters cannot be used here;
they are only allowed in the WHERE clauses of Teradata Relational target stages. For more
information about using job parameters in Teradata Relational WHERE clauses, see “Parameters” on
page 181.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the WHERE clause, it appears in the Where field.
WHERE clauses must be Boolean expressions that return TRUE or FALSE. When you are done
building the clause, click Verify. If errors are found, you must either correct the expression, click
Clear All to start over, or cancel. You cannot save an incorrect WHERE clause.
The order of operators in expressions is determined by SQL standards. After you verify a WHERE
clause, any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Group By. This tab allows you to select the columns to group by in the output link. The Available
columns list displays the columns you selected on the Select tab. The Available columns and Group
by columns lists display the name, table alias, and native data type for each column.
You can move a column to the Group by columns list either by double-clicking the column name or
by highlighting the column name and clicking >. To move all columns, click >>. Remove single
columns from the Selected columns list either by double-clicking the column name or by highlighting
the column name and clicking <. Remove all columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Group by columns list to change the order of the columns to group by.
v Having. This tab appears only if you have selected columns to group by. It allows you to narrow the
scope of the GROUP BY clause. The Having grid allows you to specify conditions the grouped
columns must meet before they are selected:
– (. Select an opening parenthesis if needed.
– Column. Select the column you want to filter on from the list.
– Op. Select an operator or a logical function from the list.
– Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the HAVING clause, it appears in the Having field.
HAVING clauses must be Boolean expressions that return TRUE or FALSE. When you are done
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building the HAVING clause, click Verify. If errors are found, you must either correct the
expression, click Clear All to start over, or cancel. You cannot save an incorrect HAVING clause.
v Order By. This tab allows you to specify the sort order of data in selected output columns. The
Available columns and Order by columns lists display the name, table alias, and native data type for
each column. The Order column in the Order by columns list shows the sort order of column data.
You can move a column to the Order by columns list either by double-clicking the column name or by
highlighting the column name and clicking >. To move all columns, click >>. Remove single columns
from the Order by columns list either by double-clicking the column name or by highlighting the
column name and clicking <. Remove all columns by clicking <<.
Click Find to search for a particular column in either list. Use the arrow buttons to the right of the
Order by columns list to rearrange the column order.
To specify the sort order of data in the selected columns, click on the Order field in the Order by
columns list. Select Ascending or Descending from the list, or select nothing to sort by the database
default.
v SQL. This tab displays the SQL statement constructed from your selections on the Tables, Select,
Where, Group By, Having, and Order By tabs. You can edit the statement by typing in the SQL text
box. For more information see “Modifying the SQL Statement” on page 51.
v Columns. This tab displays the output columns generated by the SQL statement. This grid has the
following columns:
– Column name. The name of the column.
– Native type. The SQL data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHAR data, the maximum number
of characters for VARCHAR data, the total number of digits for numeric data types, and the number
of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
You can edit only column names on this tab, unless you modified the SQL statement on the SQL
tab. If you modified the SQL statement but no metadata has been defined in the repository for the
identified tables, then you can also add, edit, and remove columns on the Columns tab. Click Load
to load columns from a table definition in the repository, or click Clear All to start over. Click Save
As... to save the columns as a table definition, a CFD file, or a DCLGen file. For details about the
conditions under which column editing is allowed, see “Modifying the SQL Statement” on page 51.

Defining Computed Columns
Computed columns are typically used to perform column aggregations or to convert column data types.
They also provide access to some Teradata functions that are not available in Aggregator or Transformer
stages.
You define or modify computed columns on the Select tab. To define a new computed column, click
New. To edit an existing computed column, highlight the column in the Selected columns list and click
Modify. (The Modify button is available only if you have already defined a computed column.)
When you click New or Modify, the Computed Column dialog box appears. This dialog box contains the
following fields:
v As name. The name of the computed column. You must assign a unique name to the computed
column.
v Description. An optional description of the column.
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v Native data type. The native data type of the column. For details about the native data types
supported in mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHAR data, the maximum number of
characters for VARCHAR data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of TIMESTAMP data.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
data, and zero for all other data types.
v Nullable. Specifies whether the column can contain a null value.
v Expression. Contains the expression used to compute the column value.
You can define the expression for the computed column by typing in the Expression text entry box. Click
Functions to get a list of available Teradata functions. You can select a function and click OK to insert it
into the Expression field, or simply double-click the function name.
To replace <Operand> with a column name in the expression, highlight or delete <Operand> and click
Columns. You will get a list of available columns. Select one of these columns and click OK to insert it
into the Expression field, or simply double-click the column name. When you are done, click Verify to
validate the expression, then click OK to save your changes.
You cannot save an incorrect column derivation. If errors are found when your expression is validated,
you must either correct the expression or cancel the action.

Modifying the SQL Statement
About this task
InfoSphere DataStage allows you to edit the SQL statement on the SQL tab. Right-click to get a shortcut
menu with editing functions such as cut, paste, and copy. If you have a predefined SQL statement you
want to use, you can cut and paste it into the SQL text box. Job parameters cannot be used in the SQL
statement; only column names and constants (except HIGH_VALUES and LOW_VALUES) are supported.
Click Verify to validate the statement when you are done. If the entire SQL SELECT statement can be
parsed and table metadata has been defined in the repository for the identified tables, then your changes
will be propagated back to the other pages where they apply.
If the entire SQL SELECT statement can be parsed, or at least the SELECT list clause and the SELECT
FROM clause can be parsed, but no table metadata has been defined in the repository and no columns
exist on the Columns tab, then InfoSphere DataStage creates column definitions for each column in the
SELECT list using the specified column name, a default data type of Char, and length of 10. If columns
already exist on the Columns tab, they must match the columns defined in the SELECT list, including the
number of columns and attributes such as data type, length, and scale. You can use the Load and Clear
All buttons to edit, clear, or load new column definitions on the Columns tab.
If the SELECT list on the SQL tab and the columns list on the Columns tab do not match, Teradata
precompiler, Teradata bind, or execution time errors will occur.
If the SQL SELECT list clause and the SELECT FROM clause can be parsed and table metadata has been
defined in the repository for the identified tables, then the columns list on the Columns tab is cleared
and repopulated from the metadata. The Load and Clear All buttons on the Columns tab are unavailable
and no edits are allowed except for changing the column name.
If either the SQL SELECT list clause or the SELECT FROM clause cannot be parsed, then no changes are
made to columns defined on the Columns tab. You must ensure that the number of columns matches the
number defined in the SELECT list clause and that they have the correct attributes in terms of data type,
length, and scale. Use the Load or Clear All buttons to edit, clear, or load new column definitions on the
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Columns tab. If the SELECT list on the SQL tab and the columns list on the Columns tab do not match,
Teradata precompiler, Teradata bind, or execution time errors will occur.
If validation is unsuccessful, you will receive an error message. You can correct the SQL statement, undo
your changes, or choose to continue without making any corrections. If you continue without making
corrections, however, only the General, SQL, and Columns tabs on the Outputs page will be active.
Note: Some Teradata syntax, such as subqueries, cannot be successfully validated by InfoSphere
DataStage. Though you will receive an error message, you should continue without making changes if
you are confident that the SQL statement is correct.

Complex Flat File Stages
These topics describe Complex Flat File stages, which are used to read data from complex flat file data
structures. A complex flat file can contain one or more GROUP, REDEFINES, OCCURS or OCCURS
DEPENDING ON clauses.

Using a Complex Flat File Stage
Complex Flat File stages are used only as source stages and cannot receive input links. As a source, they
read data from a flat file. Complex Flat File stages can have one or more output links, and the outputs
must be linked to active stages.
When you edit a Complex Flat File stage, the Complex Flat File Stage dialog box appears. This dialog
box has two pages:
v Stage. Displays the stage name, which can be edited. This page has up to five tabs. The General tab is
where you specify the source data attributes. You can also type an optional description of the stage,
which appears in the generated COBOL program. The General tab has the following fields:
– The File name field is the mainframe source file from which data will be read.
– Generate an end-of-data row. Select this check box to add an end-of-data indicator after the last
row is processed on each output link. The indicator is a built-in variable called ENDOFDATA which
has a value of TRUE, meaning the last row of data has been processed. (See “ENDOFDATA” on
page 183 for more information about using this variable). In addition, all columns are set to null.
– The DD name field is the data definition name of the file in the JCL. It can be 1 to 8 alphanumeric
characters and the first character must be alphabetic. The default name is DDn, where n is the
internal job number. You can edit this name.
– The Access type list defines whether the data is part of a QSAM or VSAM file. You must specify the
category your data falls into:
QSAM_SEQ_COMPLEX. QSAM file structure.
VSAM_ESDS. VSAM Entry-Sequenced Data Set file structure.
VSAM_KSDS. VSAM Key-Sequenced Data Set file structure. If this is selected, at least one column
must be defined as a Key.
VSAM_RRDS. Relative Record Data Set file structure.
– Start row. Select First row to read the source file starting with the first row, or Row number to start
reading from a specific row number. Type a whole number in the Row number field, which has a
default value of 1. There is no maximum.
– End row. Select Last row to stop reading the source file after the last row, or Row number to stop
after a specific row number. Type a whole number in the Row number field, which has a default
value of 1. There is no maximum.
– Block type. Select the block type of the source file. The default is Fixed block file, which indicates
that the source file contains fixed record lengths. Complex Flat File stages can also be used to read
variable-block files with or without OCCURS DEPENDING ON clauses.
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The Columns tab is where you specify the column definitions for the source data. See “Specifying
Stage Column Definitions” for details about defining or loading column definitions.
The File view tab displays specialized information about the columns in your source file, including
the COBOL PICTURE clause, the starting and ending offsets, and the storage length of each column.
You can right-click to save the file view layout as an HTML file.
The Pre-sort tab allows you to pre-sort your source data before passing it to the next stage in the job
design. See “Pre-Sorting Data” on page 55 for details about creating the sort control statement.
The Options tab is available only if you have chosen to pre-sort your source data on the Pre-sort
tab. See “Specifying Sort File Parameters” on page 56 for details about setting these options.
v Outputs. Specifies the column definitions for the data output links.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Stage Column Definitions
The Columns tab on the Stage page allows you to specify column definitions for the data being read by
Complex Flat File stages. These column definitions are then projected to the Outputs page.
The Columns tab contains a grid with the following information:
v Level number. The COBOL level number where the data is defined. If no level number is given, a
default value of 05 is assigned.
v Column name. The name of the column.
v Key. Indicates if the input column is a record key. Only one field can be defined as a key. Groups can
be defined as keys by defining the group field as a key. This field is required if the access type of the
source file is VSAM_KSDS.
v Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHARACTER and GROUP data, and
the total number of digits for numeric data types.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
and FLOAT data, and zero for all other data types.
v Nullable. Indicates whether the column can contain a null value. (Nullable columns are not supported
in Complex Flat File stages.)
v Description. A text description of the column.
You can add, modify, or delete column definitions in the grid using the shortcut menu. For details about
editing column definitions, see Chapter 10, “Editing Column Metadata,” on page 207.
This tab also contains three buttons:
v Save As... . Click this to save column definitions into the repository, where you can subsequently reuse
them for other stages. The Save table definition dialog box appears, allowing you to save columns as a
table definition, a COBOL file definition (CFD), or a DB2 DCLGen file (DFD).
v Clear All. Click this to clear all column definitions from the stage.
v Load. Click this to selectively load columns from a table definition in the repository:
– First, select an existing table or import a new one from the Table Definitions dialog box.
– Next, select the columns that you want to load from the Select columns from table dialog box. The
Available columns tree displays COBOL structures such as groups and arrays. If you do not want
to display all of the columns, you can specify that unwanted ones be replaced by filler columns. See
“Filler Creation and Expansion” on page 54 for details.
– If there are arrays in the column structure for which flattening is an option, the Complex file load
option dialog box appears. This lets you specify how to handle array data in the stage. See “Array
Handling” on page 54 for details.
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If the access type of the table loaded is not one of those listed in the Access type field on the Stage page,
then native data type conversions are done for all columns that have a native data type which is
unsupported in Complex Flat File stages. For more information, see Chapter 9, “Native Data Types,” on
page 197.
If you load more than one table definition, the list of columns from the subsequent tables is added to the
end of the current list. In cases where the first column of the subsequent list has a level number higher
than the last column of the current list, InfoSphere DataStage inserts an "02 FILLER" group item before
the subsequent list is loaded. (This is not done, however, if the first column being loaded already has a
level number of 02.)
Columns displayed here should reflect the actual layout of the source file. Even though you might not
want to output every column, all columns of the file layout, including fillers, should appear here. You
select the columns to output from the stage on the Outputs page.
Filler Creation and Expansion:
Mainframe table definitions frequently contain hundreds of columns, therefore to save storage space and
processing time, there is a Create fillers option in the Select columns from table dialog box.
This check box, which is selected by default, is available only when you load columns from a simple or a
complex flat file. The sequences of unselected columns are collapsed into FILLER items with the
appropriate size. The native data type is set to CHARACTER and the name set to FILLER_XX_YY, where
XX is the start offset and YY is the end offset.
Fillers for elements of a group array or an OCCURS DEPENDING ON (ODO) column have the name of
FILLER_NN, where NN is the element number. The NN begins at 1 for the first unselected group
element and continues sequentially. Any fillers that follow an ODO column are also numbered
sequentially.
You can expand fillers in the columns grid if you want to reselect any columns. Right-click the filler and
select Expand filler from the shortcut menu. The Expand Filler dialog box appears, allowing you to
select some or all of the columns from the given filler. There is no need to reload the table definition and
reselect the columns.
See Chapter 11, “Fillers,” on page 211 for examples of how fillers are created for different COBOL
structures and for details about filler expansion.
Array Handling:
When you enter or load column definitions containing arrays, the Complex file load option dialog box
appears. This dialog box offers the following options:
v Flatten selective arrays. Allows you to select arrays for flattening on an individual basis. Right-click an
array in the columns list and select Flatten or Normalize. The array icon changes for the arrays that
you select to flatten.
v Flatten all arrays. Creates new columns for each element of the array and presents the data as one row
at execution time.
v Normalize all arrays. Presents the data as multiple rows at execution time with one row for each
column in the array. This is the default.
Array columns that have redefined fields or OCCURS DEPENDING ON clauses cannot be flattened.
Even if you choose to flatten all arrays in the Complex file load option dialog box, these columns are
always normalized. Only the used occurrences of ODO columns are output from the stage.
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If a record contains zero occurrences of an ODO column, one row will be processed. The value used for
the elements that were subject to the ODO clause will be null if the element is nullable, or space or zero
(depending on data type) it the element is not nullable.
The Complex file load option dialog box does not appear if ODOs are the only type of array column in
your file. If both types of array columns are present, the dialog box appears but ODO columns are not
available for selective flattening.

Pre-Sorting Data
Pre-sorting your source data can simplify processing in active stages where data transformations and
aggregations occur. InfoSphere DataStage allows you to pre-sort data loaded into Complex Flat File stages
by utilizing the mainframe DFSORT utility during code generation.
You specify the pre-sort criteria on the Pre-sort tab. This tab is divided into two panes. The left pane
displays the available control statements, and the right pane allows you to edit the pre-sort statement that
will be added to the generated JCL. When you highlight an item in the Control statements list, a short
description of the statement is displayed in the status bar at the bottom of the dialog box.
There are two ways to create a pre-sort statement:
v Double-click an item in the Control statements list to insert it into the Statement editor box.
v Type any valid control statement directly in the Statement editor text box.
The Control statements list contains the following items:
v SORT FIELDS. Describes the sort control fields in the input records. When you select SORT, the Select
sort columns dialog box appears. This is where you select the columns to sort by and the sort order. To
move a column from the Available columns list to the Selected columns list, double-click the column
name or highlight the column name and click >. To move all columns, click >>. Remove a column
from the Selected columns list by double-clicking the column name or highlighting the column name
and clicking <. Remove all columns by clicking <<. Click Find to search for a particular column in
either list.
Array columns cannot be sorted and are unavailable for selection in the Available columns list.
Columns containing VARCHAR, VARGRAPHIC_G, or VARGRAPHIC_N data are sorted based on the
data field only; the two-byte length field is skipped. The sort uses the maximum size of the data field
and operates in the same manner as a CHARACTER column sort.
To specify the column sort order, click the Order field next to each column in the Selected columns
list. There are two options:
– Ascending. This is the default setting. Select this option to sort the input column data in ascending
order.
– Descending. Select this option to sort the input column data in descending order.
Use the arrow buttons to the right of the Selected columns list to change the order of the columns
being sorted. The first column is the primary sort column and any remaining columns are sorted
secondarily.
When you are finished, click OK to close the Select sort columns dialog box. The selected columns
and their sort order appear in the Statement editor box.
v ALTSEQ CODE. Changes the collating sequence of EBCDIC character data.
v
v
v
v

INCLUDE COND. Specifies particular records to include.
OMIT COND. Filters unwanted input records.
RECORD TYPE. Specifies the type and length of records being processed.
SUM FIELDS. Adds summary fields to the output data list.

Click Help to see the complete syntax diagrams for these control statements.
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InfoSphere DataStage does not support the following control statements on the Pre-sort tab:
v DEBUG
v END
v INREC
v MERGE
v
v
v
v

MODS
OPTION
OUTFIL
OUTREC

No syntax checking is performed on the statement entered. However, if you use an unsupported control
statement, you might get an error when the job runs even though you will not get an error during code
generation.

Specifying Sort File Parameters
The Options tab on the Stage page allows you to define the JCL parameters that are required to create
the pre-sorted mainframe file. This tab contains the following fields:
v Normal EOJ handling. Contains the parameter for the disposition of the data file when job upload
successfully completes. There are four options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set after job execution.
– KEEP. Retains the data set, but does not catalog it.
– PASS. Passes the data set to the next job step, but deletes it at the end of the job. This is the default.
v Abnormal EOJ handling. Contains the parameter for the disposition of the data file when job upload
does not complete successfully. There are three options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set. This is the default.
– KEEP. Retains the data set, but does not catalog it.
v Unit. Specifies the device type of the disk on which the data is to be stored. The default value is
SYSDA.
v Allocation type. Specifies the unit of allocation used when storage space is reserved for the file. There
are two options:
– TRK. Track. This is the default.
– CYL. Cylinder. This generally allocates a greater amount of storage space than TRK.
The exact size of a track or cylinder is device dependent.
v Primary allocation amount. Contains the number of tracks or cylinders to be reserved as the initial
storage for the job. The minimum is 1 and the maximum is 32768. The default value is 10.
v Secondary allocation amount. Contains the number of tracks or cylinders to be reserved if the primary
allocation is insufficient for the job. The minimum is 1 and the maximum is 32768. The default value is
10.
v Vol ser. The volume serial number of the unit where the file will be written. Up to six alphanumeric
characters are allowed.
v Expiration date. Specifies the expiration date for a new data set in YYDDD or YYYY/DDD format. For
expiration dates of January 1, 2000 or later, you must use the YYYY/DDD format. JCL extension
variables can also be used.
The YY can be from 01 to 99 or the YYYY can be from 1900 to 2155. The DDD can be from 000 to 365
for nonleap years or 000 to 366 for leap years.
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If you specify the current date or an earlier date, the data set is immediately eligible for replacement.
Data sets with expiration dates of 99365, 99366, 1999/365 and 1999/366 are considered permanent and
are never deleted or overwritten.
v Retention period. Specifies the number of days to retain a new data set. You can type a number or use
a JCL extension variable. When the job runs, this value is added to the current date to produce an
expiration date, using 365-day years and 366-day leap years. Note that if the calculated expiration date
is December 31, 1999, the expiration date is set to January 1, 2000.
You can specify either an expiration date or a retention period, but not both. When you type a value in
one of these fields, the other field becomes unavailable. No validation is done on either field; if you type
an incorrect value, JCL errors can occur.
These parameters are used during JCL generation. All fields except Vol ser, Expiration date, and
Retention period are required.

Defining Complex Flat File Output Data
Output links from Complex Flat File stages represent the data being output from complex flat file data
structures. The properties of such links and the column definitions of the data are described on the
Outputs page in the Complex Flat File Stage dialog box:
The Outputs page has the following field and four tabs:
v Output name. The name of the output link. Select the link you want to edit from the Output name list.
This list displays all the output links from the Complex Flat File stage. If there is only one output link,
the field is read-only.
v General. Contains an optional description of the link.
v Selection. This tab allows you to select columns to output data from. The Available columns list
displays the columns loaded from the source file, and the Selected columns list displays the columns
to be output from the stage.
If the Column push option is selected in Designer client options, all stage column definitions are
automatically propagated to each empty output link when you click OK to exit the stage. You do not
need to select columns on the Selection tab, unless you want to output only a subset of them.
However, if any stage columns are GROUP data type, the column push option works only if all
members of the group are CHARACTER data type.
You can move a column from the Available columns list to the Selected columns list by
double-clicking the column name or highlighting the column name and clicking >. To move all
columns, click >>. You can remove single columns from the Selected columns list by double-clicking
the column name or highlighting the column name and clicking <. Remove all columns by clicking <<.
Click Find to locate a particular column.
You can select a group as one element if all elements of the group are CHARACTER data. If one or
more elements of the group are of another type, then they must be selected separately. If a group item
and its sublevel items are all selected, storage is allocated for the group item as well as each sublevel
item.
The Selected columns list displays the column name and SQL type for each column. Use the arrow
buttons to the right of the Selected columns list to rearrange the order of the columns.
v Constraint. This tab is displayed by default. The Constraint grid allows you to define a constraint that
filters your output data:
– (. Select an opening parenthesis if needed.
– Column. Select a column or job parameter from the list. (Group columns cannot be used in
constraint expressions and are not displayed.)
– Op. Select an operator or a logical function from the list. For information about using functions in
constraint expressions, see “Constraints” on page 170.
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– Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint
field. When you are done building the expression, click Verify. If errors are found, you must either
correct the expression, click Clear All to start over, or cancel. You cannot save an incorrect
constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint,
any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Columns. This tab displays the output columns. It has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For more information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value. (Nullable columns are not
supported in Complex Flat File stages.)
– Description. A text description of the column.
Column definitions are read-only on the Outputs page. You must go back to the Columns tab on
the Stage page if you want to change the definitions. Click Save As... to save the output columns as
a table definition, a CFD file, or a DCLGen file.

Selecting Normalized Arrays
In most cases you will select only one column representing a normalized array as output from a Complex
Flat File stage. However, InfoSphere DataStage allows you to select more than one such column. The
following examples, which range from simple to complex, illustrate how InfoSphere DataStage processes
arrays before delivering rows to the output link.
Selecting a Single Normalized Column:
This example shows the result when you select both fields from a single normalized column as output
columns. For each record that is read from the input file, three rows are written to the output link. The
fourth row out the link causes the second record to be read from the file, starting the process over again.
Table 5. Input record
Input Record - column 1

Input Record - column 2

Input Record - column 3

05

FIELD-A

PIC X(10).

05

FIELD-B

PIC S9(5) COMP-3 OCCURS 3
TIMES.

Output Rows - column 1

Output Rows - column 2

Output Rows - column 3

Row 1:

FIELD-A

FIELD-B (1)

Row 2:

FIELD-A

FIELD-B (2)

Row 3:

FIELD-A

FIELD-B (3)

Table 6. Output rows
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Selecting a Nested Normalized Column:
This example shows the result when you select a nested array field as output. If you select FIELD-A and
FIELD-C as output columns, InfoSphere DataStage multiplies the OCCURS values at each level. In this
case, 15 rows are written to the output link.
Table 7. Input record
Input Record - column 1

Input Record - column 2

05 FIELD-A

PIC X(10).

05 FIELD-B

OCCURS 3 TIMES.

10 FIELD-C

PIC S9(5) COMP-3 OCCURS 5 TIMES.

Table 8. Output rows
Output Rows - column 1

Output Rows - column 2

Output Rows - column 2

Row 1:

FIELD-A

FIELD-C (1, 1)

Row 2:

FIELD-A

FIELD-C (1, 2)

Row 3:

FIELD-A

FIELD-C (1, 3)

Row 4:

FIELD-A

FIELD-C (1, 4)

Row 5:

FIELD-A

FIELD-C (1, 5)

Row 6:

FIELD-A

FIELD-C (2, 1)

Row 7:

FIELD-A

FIELD-C (2, 2)

Row 8:

FIELD-A

FIELD-C (2, 3)

Row 9:

FIELD-A

FIELD-C (2, 4)

Row 10:

FIELD-A

FIELD-C (2, 5)

Row 11:

FIELD-A

FIELD-C (3, 1)

Row 12:

FIELD-A

FIELD-C (3, 2)

Row 13:

FIELD-A

FIELD-C (3, 3)

Row 14:

FIELD-A

FIELD-C (3, 4)

Row 15:

FIELD-A

FIELD-C (3, 5)

Selecting Parallel Normalized Columns:
This example shows the result when you select parallel array fields as output columns. InfoSphere
DataStage determines the number of output rows using the largest subscript. As a result, the smallest
array repeats. In this case, if you select all of the input fields as output columns, five rows are written to
the output link and the smaller array restarts at the fourth row.
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Table 9. Input record
Input Record - column 1:

Input Record - column 2:

Input Record - column 3:

05

FIELD-A

PIC X(10).

05

FIELD-B

05

FIELD-C

PIC S9(5) COMP-3 OCCURS 3
TIMES.
PIC X(2) OCCURS 5 TIMES.

Table 10. Output rows
Output Row - column 1:

Output Row - column 2:

Output Row - column 3:

Output Row - column 4:

Row 1:

FIELD-A

FIELD-B (1)

FIELD-C (1)

Row 2:

FIELD-A

FIELD-B (2)

FIELD-C (2)

Row 3:

FIELD-A

FIELD-B (3)

FIELD-C (3)

Row 4:

FIELD-A

FIELD-B (1)

FIELD-C (4)

Row 5:

FIELD-A

FIELD-B (2)

FIELD-C (5)

Selecting Nested Parallel Normalized Columns:
Using a more complex scenario, this example shows the result when you select both parallel array fields
and nested array fields as output. If you select FIELD-A, FIELD-C, and FIELD-E as output columns in
this example, InfoSphere DataStage determines the number of output rows by using the largest OCCURS
value at each level and multiplying them. In this case, three is the largest OCCURS value at the outer (05)
level, and five is the largest OCCURS value at the inner (10) level. Therefore, 15 rows are written to the
output link.
Input Record:
05 FIELD-A

PIC X(10).

05 FIELD-B

OCCURS 3 TIMES.

10 FIELD-C

PIC X(2) OCCURS 4 TIMES.

05 FIELD-D

OCCURS 2 TIMES.

10 FIELD-E

PIC 9(3) OCCURS 5 TIMES.
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Output Rows:
Row 1:

FIELD-A

FIELD-C (1, 1)

FIELD-E (1, 1)

Row 2:

FIELD-A

FIELD-C (1, 2)

FIELD-E (1, 2)

Row 3:

FIELD-A

FIELD-C (1, 3)

FIELD-E (1, 3)

Row 4:

FIELD-A

FIELD-C (1, 4)

FIELD-E (1, 4)

Row 5:

FIELD-A

FIELD-C (1, 1)

FIELD-E (1, 5)

Row 6:

FIELD-A

FIELD-C (2, 1)

FIELD-E (2, 1)

Row 7:

FIELD-A

FIELD-C (2, 2)

FIELD-E (2, 2)

Row 8:

FIELD-A

FIELD-C (2, 3)

FIELD-E (2, 3)

Row 9:

FIELD-A

FIELD-C (2, 4)

FIELD-E (2, 4)

Row 10:

FIELD-A

FIELD-C (2, 1)

FIELD-E (2, 5)

Row 11:

FIELD-A

FIELD-C (3, 1)

FIELD-E (1, 1)

Row 12:

FIELD-A

FIELD-C (3, 2)

FIELD-E (1, 2)

Row 13:

FIELD-A

FIELD-C (3, 3)

FIELD-E (1, 3)

Row 14:

FIELD-A

FIELD-C (3, 4)

FIELD-E (1, 4)

Row 15:

FIELD-A

FIELD-C (3, 1)

FIELD-E (1, 5)

Notice that some of the subscripts repeat. In particular, those that are smaller than the largest OCCURS
value at each level start over, including the second subscript of FIELD-C and the first subscript of
FIELD-E.

DB2 Load Ready Flat File Stages
These topics describe DB2 Load Ready Flat File stages, which are used to write data to a sequential or
delimited flat file in a format that is compatible for use with the DB2 bulk loader facility.

Using a DB2 Load Ready Flat File Stage
DB2 Load Ready Flat File stages can have multiple input links. These input links can come from any
active stage. The stage can also be used as a source for FTP stages. In such cases, they have one output
link. Only the load data file is sent to the FTP stage. No control file is sent.
When you edit a DB2 Load Ready Flat File stage, the DB2 Load Ready Flat File Stage dialog box appears.
This dialog box can have up to three pages (depending on whether there is an output from the stage):
v Stage. Displays the name of the stage, which can be edited. This page has up to five tabs, depending
on the write option and file type you specify.
The General tab displays the basic characteristics of the stage including the load data file name, DD
name, write option, and file type. You can also type an optional description of the stage, which appears
in the generated COBOL program.
– The File name field is the name of the resulting load ready file that is used in the mainframe JCL.
– The DD name field is the data definition name of the file in the JCL. It can be 1 to 8 alphanumeric
characters and the first character must be alphabetic.
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– The Write option field allows you to specify how to write data to the load file. There are four
options:
Create a new file. Creates a new file without checking to see if one already exists. This is the
default.
Append to existing file. Adds data to the existing file.
Overwrite existing file. Deletes the existing file and replaces it with a new file.
Delete and recreate existing file. Deletes the existing file if it has already been cataloged and
recreates it.
– The Fixed width flat file and Delimited flat file buttons allow you to specify the type of file to be
written. The default is Fixed width flat file.
The Columns tab is where you specify the column definitions for the data being written by the
stage. See “Specifying Stage Column Definitions” for details about defining or loading column
definitions.
The Bulk Loader tab allows you to set parameters for running the bulk loader utility and generating
the required control file. See “Setting DB2 Bulk Loader Parameters” on page 63 for details about
setting these parameters.
The Format tab appears if you select Delimited flat file as the target file type. This allows you to
specify delimiter information for the file. See “Specifying Delimiter Information” on page 63 for
details about specifying the file format.
The Options tab appears if you have chosen to create a new file, or delete and recreate an existing
file, in the Write option field. See “Specifying Load Data File Parameters” on page 63 for details
about specifying these options.
v Inputs. Specifies the column definitions for the data input links.
v Outputs. Displays the name and an optional description of the data output link to an FTP stage.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Stage Column Definitions
The Columns tab on the Stage page allows you to specify the format of the data being written by DB2
Load Ready Flat File stages. These column definitions are then projected to the Inputs page. The
Columns tab contains a grid with the following columns:
v Column name. The name of the column.
v Native type. The native DB2 SQL type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHARACTER data, the maximum
number of characters for VARCHAR data, the total number of digits for numeric data types, and the
number of digits in the microsecond portion of TIMESTAMP data.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
PACKED and DECIMAL ZONED data, and zero for all other data types.
v Nullable. Indicates whether the column can contain a null value.
v Description. A text description of the column.
Click Load to load columns from a table definition in the repository, or type column definitions manually
and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click Clear All to
start over. For details about editing column definitions, see Chapter 10, “Editing Column Metadata,” on
page 207.
If a complex flat file is loaded, the incoming file is flattened and REDEFINE and GROUP columns are
removed. Array and OCCURS DEPENDING ON columns are flattened to the maximum size. All level
numbers are set to zero.
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Setting DB2 Bulk Loader Parameters
The Bulk Loader tab on the Stage page allows you to set parameters to run the DB2 bulk loader utility
and generate the necessary control file. This tab has the following fields:
v User name. The user ID needed to sign on to the DB2 host system.
v DB2 subsystem id. The designation for the DB2 instance on the host system. This name can be
different from the one specified at the project level.
v Table name. The physical table name to be loaded by the bulk load operation.
v Table owner. The name of the table owner.
A password is not required for the bulk load operation. The unique control statement is generated within
the JCL.

Specifying Delimiter Information
If you select Delimited flat file as the file type on the General tab, then the Format tab on the Stage
page appears. This tab allows you to specify delimiter information for the target file.
Delimiters must be single-byte, printable characters. Possible delimiters include:
v A character, such as a comma.
v An ASCII code in the form of a three-digit decimal number, from 000 to 255.
v A hexadecimal code in the form &Hxx or &hxx, where x is a hexadecimal digit (0-9, a-f, A-F).
The following restrictions apply to delimiter settings:
v You cannot specify the same character for more than one type of delimiter.
v You can specify a character constant for a delimiter only if the DB2 bulk load utility control statement
is coded in the same encoding scheme as the input file, such as UNICODE.
v If the utility control statement and the input file are not coded in the same encoding scheme, you must
use the hexadecimal representation for non-default delimiters.
v You cannot specify a binary 0 (zero) for any delimiter.
The Format tab contains the following fields:
v Column delimiter. Specifies the character that separates the data fields in the file. By default this field
contains a comma.
v String delimiter. Specifies the character used to enclose strings. By default this field contains a double
quotation mark.
String fields are delimited only if the data contains the column delimiter character. For example, if the
data is ab,c and the column delimiter is a comma, then the output will be "ab,c" assuming the string
delimiter is a double quotation mark.
Select Always delimit string data to delimit all string fields in the target file, regardless of whether the
data contains the column delimiter character or not.
v Decimal. Specifies the decimal point character used in the input file. By default this field contains a
period.

Specifying Load Data File Parameters
The Options tab on the Stage page allows you to define the JCL parameters that are required to create a
new mainframe file. This tab contains the following fields:
v Normal EOJ handling. Contains the parameter for the disposition of the data file when job execution
successfully completes. There are four options:
– CATLG. Catalogs the data set. This is the default.
– DELETE. Deletes the data set at the end of the bulk load step.
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– KEEP. Retains the data set, but does not catalog it.
– PASS. Passes the data set to an FTP job step, but deletes it at the end of the job.
v Abnormal EOJ handling. Contains the parameter for the disposition of the data file when job
execution does not complete successfully. There are three options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set. This is the default.
– KEEP. Retains the data set, but does not catalog it.
v Unit. Specifies the device type of the disk on which the data is to be stored. The default value is
SYSDA.
v Allocation type. Specifies the unit of allocation used when storage space is reserved for the file. There
are two options:
– TRK. Track. This is the default.
– CYL. Cylinder. This generally allocates a greater amount of storage space than TRK.
The exact size of a track or cylinder is device dependent.
v Primary allocation amount. Contains the number of tracks or cylinders to be reserved as the initial
storage for the job. The minimum is 1 and the maximum is 32768. The default value is 10.
v Secondary allocation amount. Contains the number of tracks or cylinders to be reserved if the primary
allocation is insufficient for the job. The minimum is 1 and the maximum is 32768. The default value is
10.
v Vol ser. The volume serial number of the unit where the file will be written. Up to six alphanumeric
characters are allowed.
v Database version. Contains the version number of the DB2 database to be updated. InfoSphere
DataStage supports DB2 versions 5.1 and later.
v Expiration date. Specifies the expiration date for a new data set in YYDDD or YYYY/DDD format. For
expiration dates of January 1, 2000 or later, you must use the YYYY/DDD format. JCL extension
variables can also be used.
The YY can be from 01 to 99 or the YYYY can be from 1900 to 2155. The DDD can be from 000 to 365
for nonleap years or 000 to 366 for leap years.
If you specify the current date or an earlier date, the data set is immediately eligible for replacement.
Data sets with expiration dates of 99365, 99366, 1999/365 and 1999/366 are considered permanent and
are never deleted or overwritten.
v Retention period. Specifies the number of days to retain a new data set. You can type a number or use
a JCL extension variable. When the job runs, this value is added to the current date to produce an
expiration date, using 365-day years and 366-day leap years. Note that if the calculated expiration date
is December 31, 1999, the expiration date is set to January 1, 2000.
You can specify either an expiration date or a retention period, but not both. When you type a value in
one of these fields, the other field becomes unavailable. No validation is done on either field; if you type
an incorrect value, JCL errors can occur.
These parameters are used during JCL generation. All fields except Vol ser, Expiration date, and
Retention period are required.

Defining DB2 Load Ready Input Data
When you write data to a flat file in DB2 Load Ready format, the DB2 Load Ready Flat File stage has an
input link. The properties of this link and the column definitions of the data are described on the Inputs
page of the DB2 Load Ready Flat File Stage dialog box.
The Inputs page has the following field and two tabs:
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v Input name. The names of the input links to the DB2 Load Ready Flat File stage. Use this field to
select which set of input data you want to view.
v General. Contains an optional description of the selected link.
v Columns. Displayed by default. Contains the column definitions for the data being written to the table.
This page has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER data, the maximum
number of characters for VARCHAR data, the total number of digits for numeric data types, and the
number of digits in the microsecond portion of TIMESTAMP data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL PACKED and DECIMAL ZONED data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Column definitions are read-only on the Inputs page in the DB2 Load Ready Flat File stage. You
must go back to the Columns tab on the Stage page to make any changes.

Defining DB2 Load Ready Output Data
When you output data from a DB2 Load Ready Flat File stage to the FTP stage, the properties of the
output link are described on the Outputs page in the DB2 Load Ready Flat File Stage dialog box. This
page has the following field and tab:
v Output name. The name of the output link. Since only one output link is allowed, the field is
read-only.
v General. Allows you to type an optional description of the output link.

Delimited Flat File Stages
These topics describe Delimited Flat File stages, which are used to read data from or write data to
delimited flat files.

Using a Delimited Flat File Stage
Delimited Flat File stages can be used as source or target stages. As a source, the stage reads data from a
delimited flat file. As a target, it writes data from an active stage into a delimited flat file. It can also be
used to land intermediate files, acting as both a source and a target stage.
Delimited Flat File stages can have multiple input and output links. The input links can come from any
active stage, and the output links can be to any active stage or to an FTP stage.
When you edit a Delimited Flat File stage, the Delimited Flat File Stage dialog box appears. This dialog
box can have up to three pages, depending on whether there are inputs to and outputs from the stage:
v Stage. Displays the name of the stage, which can be edited. This page has up to four tabs, based on
whether the stage is being used as a source or a target.
The General tab displays the basic characteristics of the stage. You can also type an optional
description of the stage, which appears in the generated COBOL program.
– The File name field is the mainframe file from which data will be read (when the stage is used as a
source) or to which data will be written (when the stage is used as a target).
– Generate an end-of-data row. Appears only when the stage is used as a source. Select this check
box to add an end-of-data indicator after the last row is processed on each output link. The
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indicator is a built-in variable called ENDOFDATA which has a value of TRUE, meaning the last
row of data has been processed. (See “ENDOFDATA” on page 183 for more information about using
this variable). In addition, all columns are set to null.
– The DD name field is the data definition name of the file in the JCL. It can be 1 to 8 alphanumeric
characters and the first character must be alphabetic.
– The Write option field allows you to specify how to write data to the target file. There are four
options:
Create a new file. Creates a new file without checking to see if one already exists. This is the
default.
Append to existing file. Adds data to the existing file.
Overwrite existing file. Deletes the existing file and replaces it with a new file.
Delete and recreate existing file. Deletes the existing file if it has already been cataloged and
recreates it.
– Start row. Appears when the stage is used as a source. Select First row to read the source file
starting with the first row, or Row number to start reading from a specific row number. Type a
whole number in the Row number field, which has a default value of 1. There is no maximum.
– End row. Appears when the stage is used as a source. Select Last row to stop reading the source file
after the last row, or Row number to stop after a specific row number. Type a whole number in the
Row number field, which has a default value of 1. There is no maximum.
The Columns tab is where you specify the column definitions for the data used in the stage. See
“Specifying Stage Column Definitions” for details about defining or loading column definitions.
The Format tab allows you to specify delimiter information for the source or target file. See
“Specifying Delimiter Information” on page 67 for details about specifying the file format.
The Options tab appears if you have chosen to create a new file, or delete and recreate an existing
file, in the Write option field. See “Specifying Target File Parameters” on page 68 for details about
specifying these options.
v Inputs. Specifies the column definitions for the data input links.
v Outputs. Specifies the column definitions for the data output links. If the output is to an FTP stage,
displays only the name and an optional description of the link.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Stage Column Definitions
The Columns tab on the Stage page allows you to specify the column definitions of the data being read
or written by Delimited Flat File stages. These column definitions are then projected to the Inputs page
when the stage is used as a target, the Outputs page when the stage is used as a source, or both pages if
the stage is being used to land intermediate files.
The Columns tab contains a grid with the following columns:
v Column name. The name of the column.
v Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHAR data, the maximum number of
characters for VARCHAR data, and the total number of digits for numeric data types.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
data, and zero for all other data types.
v Description. A text description of the column.
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Click Load to load columns from a table definition in the repository, or type column definitions manually
and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click Clear All to
start over. For details about editing column definitions, see Chapter 10, “Editing Column Metadata,” on
page 207.
If a complex flat file is loaded, the incoming file is flattened and REDEFINE and GROUP columns are
removed. Array and OCCURS DEPENDING ON columns are flattened to the maximum size. All level
numbers are set to zero.

Specifying Delimiter Information
The Format tab on the Stage page allows you to specify the format of the delimited flat file being read or
written by the stage.
You define the column and string delimiters for the source or target file in the Delimiter area. Delimiters
must be single-byte, printable characters. Possible delimiters include:
v A character, such as a comma.
v An ASCII code in the form of a three-digit decimal number, from 000 to 255.
v A hexadecimal code in the form &Hxx or &hxx, where x is a hexadecimal digit (0-9, a-f, A-F).
The Delimiter area contains the following fields:
v Column. Specifies the character that separates the data fields in the file. By default this field contains a
comma.
v Column delimiter precedes line delimiter. Indicates whether there is a delimiter after the last column.
Select this check box to specify that a column delimiter always precedes a new line.
v String. Specifies the character used to enclose strings. By default this field contains a double quotation
mark. String delimiters are handled in the following manner:
– In source stages string delimiters are removed when the source data is read. If the source data
contains the string delimiter character, each occurrence of the extra delimiter is removed. For
example, if the source data is ""abc"" and the string delimiter is a double quotation mark, the result
will be "abc". If the source data is ab""c, the result will be ab"c.
– In target stages string delimiters are generated only if the data contains the column or string
delimiter character itself. For example, if delimited target data contains the string delimiter character,
the output will contain a duplicate string delimiter in each place where the delimiter appears. If the
data is "abc" and the string delimiter is a double quotation mark, the result will be ""abc"". If the
data is ab"c, the result will be ab""c.
Similarly, if the target data contains the column delimiter character, the output is enclosed with a
string delimiter. In this case, if the data is ab,c and the column delimiter is a comma, then the
output will be "ab,c" assuming the string delimiter is a double quotation mark.
v Always delimit string data. Select this check box to always generate string delimiters in target stages,
regardless of whether the data contains the column delimiter character or not.
The Source defaults area allows you to set additional options for delimited files. It contains the following
fields:
v NULL string. Specifies characters to interpret as an SQL null value in a source file. Columns containing
these characters are initialized to zero or spaces, depending on the data type.
v Padding. Specifies the character used to pad missing columns in a source file. The default value is #.
v Missing column action. Specifies the action to take when a column is missing from the source data.
The options are:
– Pad with NULL value. Missing columns are written as null values and are initialized to zero or
spaces, depending on the data type. This is the default.
– Pad with empty value. Missing columns are written as an empty string.
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There are two check boxes at the bottom of the Format tab:
v First line is column names. Select this check box if the first row of data in the source file contains the
column names.
v Suppress row truncation warnings. If the source file contains more columns than what is defined on
the Stage page, this field allows you to block warning messages about overlong rows during run time.
By default this check box is selected.
When the stage is used as a source, all fields on the Format tab are available except Always delimit
string data. When the stage is used as a target, only the Delimiter area is available.

Specifying Target File Parameters
The Options tab on the Stage page allows you to define the JCL parameters that are required to create a
new mainframe file. This tab contains the following fields:
v Normal EOJ handling. Contains the parameter for the disposition of the data file when job execution
successfully completes. There are four options:
– CATLG. Catalogs the data set. This is the default.
– DELETE. Deletes the data set after job execution.
– KEEP. Retains the data set, but does not catalog it.
– PASS. Passes the data set to an FTP job step, but deletes it at the end of the job.
v Abnormal EOJ handling. Contains the parameter for the disposition of the data file when job
execution does not complete successfully. There are three options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set. This is the default.
– KEEP. Retains the data set, but does not catalog it.
v Unit. Specifies the device type of the disk on which the data is to be stored. The default value is
SYSDA.
v Allocation type. Specifies the unit of allocation used when storage space is reserved for the file. There
are two options:
– TRK. Track. This is the default.
– CYL. Cylinder. This generally allocates a greater amount of storage space than TRK.
The exact size of a track or cylinder is device dependent.
v Primary allocation amount. Contains the number of tracks or cylinders to be reserved as the initial
storage for the job. The minimum is 1 and the maximum is 32768. The default value is 10.
v Secondary allocation amount. Contains the number of tracks or cylinders to be reserved if the primary
allocation is insufficient for the job. The minimum is 1 and the maximum is 32768. The default value is
10.
v Vol ser. The volume serial number of the unit where the file will be written. Up to six alphanumeric
characters are allowed.
v Expiration date. Specifies the expiration date for a new data set in YYDDD or YYYY/DDD format. For
expiration dates of January 1, 2000 or later, you must use the YYYY/DDD format. JCL extension
variables can also be used.
The YY can be from 01 to 99 or the YYYY can be from 1900 to 2155. The DDD can be from 000 to 365
for nonleap years or 000 to 366 for leap years.
If you specify the current date or an earlier date, the data set is immediately eligible for replacement.
Data sets with expiration dates of 99365, 99366, 1999/365 and 1999/366 are considered permanent and
are never deleted or overwritten.
v Retention period. Specifies the number of days to retain a new data set. You can type a number or use
a JCL extension variable. When the job runs, this value is added to the current date to produce an
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expiration date, using 365-day years and 366-day leap years. Note that if the calculated expiration date
is December 31, 1999, the expiration date is set to January 1, 2000.
You can specify either an expiration date or a retention period, but not both. When you type a value in
one of these fields, the other field becomes unavailable. No validation is done on either field; if you type
an incorrect value, JCL errors might occur.
These parameters are used during JCL generation. All fields except Vol ser, Expiration date, and
Retention period are required.

Defining Delimited Flat File Input Data
When you write data to a delimited flat file, the Delimited Flat File stage has at least one input link. The
properties of these links and the column definitions of the data are described on the Inputs page of the
Delimited Flat File Stage dialog box. This page has the following field and two tabs:
v Input name. The names of the input links to the Delimited Flat File stage. Use this field to select which
set of input data you want to view.
v General. Contains an optional description of the selected link.
v Columns. Displayed by default. Contains the column definitions for the data being written to the file.
This tab has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHAR data, the maximum number
of characters for VARCHAR data, and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Description. A text description of the column.
Column definitions are read-only on the Inputs page in the Delimited Flat File stage. You must go
back to the Columns tab on the Stage page to make any changes.

Defining Delimited Flat File Output Data
When you output data from a Delimited Flat File stage, the properties of the output link are described on
the Outputs page in the Delimited Flat File Stage dialog box. This page has the following field and four
tabs:
v Output name. This list contains names of all output links from the stage. If there is only one output
link, this field is read-only. When there are multiple output links, select the one you want to edit before
modifying the data.
v Selection. This tab allows you to select columns to output data from. The Available columns list
displays the columns loaded from the source file, and the Selected columns list displays the columns
to be output from the stage.
If the Column push option is selected in Designer client options, all stage column definitions are
automatically propagated to each empty output link when you click OK to exit the stage. You do not
need to select columns on the Selection tab, unless you want to output only a subset of them.
You can move a column from the Available columns list to the Selected columns list by
double-clicking the column name or highlighting the column name and clicking >. To move all
columns, click >>. You can remove single columns from the Selected columns list by double-clicking
the column name or highlighting the column name and clicking <. Remove all columns by clicking <<.
Click Find to locate a particular column.
The Selected columns list displays the column name and SQL type for each column. Use the arrow
buttons to the right of the Selected columns list to rearrange the order of the columns.
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v Constraint. This tab is displayed by default. The Constraint grid allows you to define a constraint that
filters your output data:
– (. Select an opening parenthesis if needed.
– Column. Select a column or job parameter from the list.
– Op. Select an operator or a logical f unction from the list. For information about using functions in
constraint expressions, see “Constraints” on page 170.
– Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint
field. When you are done building the expression, click Verify. If errors are found, you must either
correct the expression, click Clear All to start over, or cancel. You cannot save an incorrect
constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint,
any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Columns. This tab displays the output columns. It has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHAR data, the maximum number
of characters for VARCHAR data, and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Column definitions are read-only on the Outputs page. You must go back to the Columns tab on the
Stage page if you want to change the definitions. Click Save As... to save the output columns as a
table definition, a CFD file, or a DCLGen file.

External Source Stages
These topics describe External Source stages, which are used to retrieve rows from an external data
source. An External Source stage represents a user-written program that is called from the COBOL
program that is generated by InfoSphere DataStage. The external source program can be written in any
language that is callable from COBOL.

Working with External Sources
External source programs allow you to read data from data sources that are not supported in InfoSphere
DataStage MVS™ Edition. After you write an external source program, you create an external source
routine in the InfoSphere DataStage repository. The external source routine specifies the attributes of the
external source program.
You create, view, or edit an external source routine using the Mainframe Routine dialog box. This dialog
box has four pages for external source routines: General, Creator, Arguments, and JCL.
There are three buttons in the Mainframe Routine dialog box:
v Close. Closes the Mainframe Routine dialog box. If you have any unsaved changes, you are prompted
to save them.
v Save. Saves the external source routine.
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v Help. Starts the Help system.

Creating an External Source Routine
You can create a new external source routine.

Procedure
1. Open the Mainframe Routine dialog box in either of these ways:
v Choose File > New from the main menu or click the New button on the toolbar. The New dialog
box appears. Click the Routines folder, select the Mainframe Routine icon, and click OK.
v Right-click the Routines folder in the repository tree and select New > Mainframe Routine from
the shortcut menu.
2. On the General page, specify general information about the external source routine:
a. Routine name. Type the name (up to 8 characters) of the external subroutine. In mainframe terms,
the routine name is the name of an entry point in a member of a load or object library. The library
member can also contain other entry points with other names. The routine name must match the
external subroutine name if Dynamic invocation (the default) is selected, and automatically
appears in the External subroutine name field.
b. Type. Select the type of routine, in this case, External Source Routine. (External target routines are
discussed in “External Target Stages” on page 77. External routines are discussed in “External
Routine Stages” on page 104.)
c. External subroutine name. Type the name of the load or object library member that contains the
subroutine or function entry point. If dynamic invocation is selected, then the external subroutine
name must match the routine name. If the invocation method is static, then the two names need
not match.
d. Invocation method. Select the invocation method for the routine. Dynamic invocation calls the
routine at runtime. Static invocation embeds the routine within a program. Dynamic is the default.
e. Library path. Type the path name of the library that contains the routine member. JCL extension
variables can be used. This field is required for static invocation.
f. Short description. Type an optional brief description of the routine. The text entered in this field
appears in the External Source stage editor.
g. Long description. Type an optional detailed description of the routine.
3. Click the Creator page to specify information about the creator and version number of the routine,
including:
a. Vendor. Type the name of the company that created the routine.
b. Author. Type the name of the person who created the routine.
c. Version. Type the version number of the routine. This is used when the routine is imported. The
Version field contains a three-part version number, for example, 2.0.0. The first part of this number
is an internal number used to check compatibility between the routine and the InfoSphere
DataStage system, and cannot be changed. The second part of this number represents the release
number. This number should be incremented when major changes are made to the routine
definition or the underlying code. The new release of the routine supersedes any previous release.
Any jobs using the routine use the new release. The last part of this number marks intermediate
releases when a minor change or fix has taken place.
d. Copyright. Type the copyright information.
4. Click the Arguments page to define routine arguments. For external source routines, arguments are
treated as fields of a record. The record is passed to the external source routine program. You can
define an unlimited number of arguments, and the columns in the argument record can have complex
data structures such as GROUP, REDEFINES, OCCURS and OCCURS DEPENDING ON clauses.
There are two ways to define routine arguments:
v To load arguments from an existing table definition, click Load... . Arguments loaded from a table
definition are not flattened when the routine type is External Source Routine on the General page.
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However, if you change the routine type from External Source Routine to External Routine,
InfoSphere DataStage will flatten the arguments, eliminating any GROUP or OCCURS that might
have existed.
v To create a new argument, type directly in the Arguments grid or, if you need to specify COBOL
attributes, open the Edit Routine Argument Meta Data dialog box in either of these ways:
– Right-click in the column area and select Edit row... from the shortcut menu.
– Press Ctrl-E.
The top pane of the Edit Routine Argument Meta Data dialog box contains the same fields that
appear on the Arguments grid, plus an additional field for the date format. Specify the following
information for each argument you want to define:
– Argument name. Type the name of the argument.
– Native type. Select the native data type of the argument from the list.
– Length. Type a number representing the length or precision of the argument.
– Scale. If the argument is numeric, type a number to define the number of digits to the right of
the decimal point.
– Nullable. Select Yes or No from the list to specify whether the argument can contain a null
value. The default is No in the Edit Routine Argument Meta Data dialog box.
– Date format. Select the date format of the argument from the list.
– Description. Type an optional description of the argument.
The bottom pane of the Edit Routine Argument Meta Data dialog box displays the COBOL page
by default. Use this page to specify any required COBOL information for the external source
argument:
– Level number. Type the COBOL level number where the data is defined. The default value is 05.
– Occurs. Type the number of the COBOL OCCURS clause.
– Usage. Select the COBOL USAGE clause from the list. This specifies which COBOL format the
column will be read in. These formats map to the formats in the Native type field, and changing
one will normally change the other. Possible values are:
COMP. Used with BINARY native types.
COMP-1. Used with single-precision FLOAT native types.
COMP-2. Used with double-precision FLOAT native types.
COMP-3. Packed decimal, used with DECIMAL native types.
COMP-5. Used with NATIVE BINARY native types.
DISPLAY. Zoned decimal, used with DISPLAY_NUMERIC or CHARACTER native types.
DISPLAY-1. Double-byte zoned decimal, used with GRAPHIC_G or GRAPHIC_N.
– Sign indicator. Select Signed or blank from the list to specify whether the argument can be
signed or not. The default is Signed for numeric data types and blank for all other types.
– Sign option. If the argument is signed, select the location of the sign in the data from the list.
Choose from the following options:
LEADING. The sign is the first byte of storage.
TRAILING. The sign is the last byte of storage.
LEADING SEPARATE. The sign is in a separate byte that has been added to the beginning of
storage.
TRAILING SEPARATE. The sign is in a separate byte that has been added to the end of storage.
The LEADING SEPARATE or TRAILING SEPARATE options will increase the storage length of
the column by one byte.
– Sync indicator. Select SYNC or blank from the list to indicate whether the argument is a
COBOL-SYNCHRONIZED clause or not. The default is blank.
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– Redefined field. Optionally specify a COBOL REDEFINES clause. This allows you to describe
data in the same storage area using a different data description. The redefining argument must
be the same length, or smaller, than the argument it redefines. Both arguments must have the
same level number, and an argument can only redefine the immediately preceding argument
with that level.
– Depending on. Optionally specify a COBOL OCCURS DEPENDING ON clause from the list.
– Storage length. Gives the storage length in bytes of the argument as defined. This field is
derived and cannot be edited.
– Picture. Gives the COBOL PICTURE clause, which is derived from the argument definition and
cannot be edited.
The buttons at the bottom of the Edit Routine Argument Meta Data dialog box allow you to
continue adding or editing arguments, or to save and close. The buttons are:
– < Previous and Next >. Displays the metadata in the previous or next argument. These buttons
are available only when a previous or next argument exists. If there are unsaved changes to the
current argument, you are prompted to save them before continuing.
– Close. Closes the Edit Routine Argument Meta Data dialog box. If you have any unsaved
changes, you are prompted to save them.
– Apply. Saves changes to the current argument.
– Reset. Removes all changes made to the argument since the last time you applied changes.
– Help. Starts the Help system.
5. Click JCL to define the JCL that is associated with the external source routine. This includes any DD
names or library names needed to run the external source program. For example:
//ORDERESS DD DSN=XQA1.ORDERHDR.FWFF, DISP=SHR

You can type directly in the Additional JCL required for the routine box, or click Load JCL... to load
the JCL from an existing file. The JCL on this page is included in the run JCL that InfoSphere
DataStage generates for your job. No syntax checking is performed on the JCL that you specify here.
6. The Save button is available after you define the JCL. When you click Save, you are prompted to
specify the folder path in the repository where the external source routine definition will be saved.

Viewing and Editing an External Source Routine
About this task
You can view and edit an external source routine in the Mainframe Routine dialog box. Open this dialog
box in one of the following ways:
v Double-click the routine in the repository tree.
v Select the routine in the repository tree and choose Repository > Properties from the main menu.
v Right-click the routine in the repository tree and choose Properties from the shortcut menu.
You can edit any of the fields and options in the Mainframe Routine dialog box. If you make any
changes, be sure to save them before closing this dialog box.

Copying an External Source Routine
About this task
You can copy an external source routine in two ways:
v Select the routine in the repository tree and choose Repository > Create copy.
v Right-click the routine in the repository tree and select Create copy from the shortcut menu.
The routine is copied and a new routine is created in the same folder of the repository tree. By default,
the name of the copy is CopyOfXXX, where XXX is the name of the chosen routine. You can use the edit
box to rename the copy immediately.
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If the invocation method of the routine is dynamic, the external subroutine name is set automatically.

Renaming an External Source Routine
About this task
You can rename an external source routine in several ways:
v Double-click the routine in the repository tree to open the Mainframe Routine dialog box. Edit the
Routine name field, click Save, then click Close.
v Select the routine in the repository tree and click again. In the edit box, type a new name or edit the
existing one. Save the name by pressing Enter or by clicking outside the edit box.
v Right-click the routine and select Rename from the shortcut menu. In the edit box, type a new name or
edit the existing one. Save the name by pressing Enter or clicking outside the edit box.
v Select the routine in the repository tree and choose Repository > Rename. In the edit box, type a new
name or edit the existing one. Save the name by pressing Enter or by clicking outside the edit box.
If the invocation method of the routine is dynamic, the external subroutine name is set automatically.

Defining the External Source Call Interface
The call interface between the COBOL program that is generated by InfoSphere DataStage and the
external source program consists of two parameters:
v The address of the control structure
v The address of the record definition
The control structure is an 8-byte area, as shown in the following example:
01
05
05
05
05

DS-EXTSRC1-CONTROL
ES-REQUEST
ES-RC
ES-EOF
ES-DATA-AREA

PIC X.
PIC S9(4) COMP.
PIC X.
PIC X(4).

The first byte indicates the type of call from the generated COBOL program to the external source
routine. Call type O opens a file, R reads a record, and C closes a file.
The next two bytes are for the return code that is sent back from the external source routine to confirm
the success or failure of the call. A zero indicates success and nonzero indicates failure.
The fourth byte is an EOF (end of file) status indicator returned by the external source routine. A Y
indicates EOF and N is for a returned row.
The last four bytes comprise a data area that can be used for re-entrant code. You can optionally use this
area to store information such as an address or a value needed for dynamic calls.

Using an External Source Stage
External Source stages are used only as source stages and cannot receive input links. They can have
multiple output links, and the outputs must be linked to active stages. Each External Source stage can call
only one external source program.
When you edit the External Source stage, the External Source Stage dialog box appears. This dialog box
has two pages:
v Stage. Displays the stage name, which can be edited. This page has four tabs:
– General. Contains an optional description of the stage, which appears in the generated COBOL
program. Select the Generate an end-of-data row check box to add an end-of-data indicator after
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the last row is processed. The indicator is a built-in variable called ENDOFDATA which has a value
of TRUE, meaning the last row of data has been processed. (See “ENDOFDATA” on page 183 for
more information about using this variable). In addition, all columns are set to null. The end-of-data
row is sent down all output links from the stage.
– Routine. Specifies the name of the external source routine and its arguments. See “Specifying the
External Source Routine” for details about specifying the routine.
– JCL. Contains the JCL for the external source routine. This tab is available after you load an external
source routine on the Routine tab. It displays any JCL you specified as part of the external source
routine in the repository. You can enter and edit JCL in the JCL statements box, or click Load JCL...
to load JCL from another file. JCL extension variables can be used. Click Reset to reset any changes
you have made to the JCL, reverting back to what was originally specified in the repository. Any
changes you make are saved when you click OK to exit the stage.
– File view. Displays the record structure of the arguments in the external source program, including
the COBOL PICTURE clause, the starting and ending offsets, and the storage length of each
argument. The total storage length is displayed in the status bar. You can right-click to search by
column name or to save the file view layout as an HTML file.
v Outputs. Specifies the column definitions for the data output links.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying the External Source Routine
The Routine tab on the Stage page allows you to select the external source routine to call, and load its
arguments. These arguments are then projected to the Outputs page.
The Routine tab displays the following information:
v Name. The name of the external source routine.
v Arguments. The arguments of the external source routine, including:
– Level number. The COBOL level number where the data is defined. If no level number is given, a
default value of 05 is assigned.
– Column name. The name of the column.
– Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load an external source routine from the repository. The routine name and arguments are
then displayed in read-only format on the Routine tab. If you want to make changes to the routine, you
must go back to the Mainframe Routine dialog box in the repository. Click Clear All to remove a routine
and its arguments from the Routine tab.
Array Handling:
If you load a routine containing arrays, the Complex file load option dialog box appears. This dialog box
offers the following options:
v Flatten selective arrays. Allows you to select arrays for flattening on an individual basis. Right-click an
array in the columns list and select Flatten or Normalize. The array icon changes for the arrays you
select to flatten.
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v Flatten all arrays. Creates new columns for each element of the array and presents the data as one row
at execution time.
v Normalize all arrays. Presents the data as multiple rows at execution time with one row for each
column in the array. This is the default.
Array columns that have redefined fields or OCCURS DEPENDING ON clauses cannot be flattened.
Even if you choose to flatten all arrays in the Complex file load option dialog box, these columns are
always normalized. Only the used occurrences of ODO columns are output from the stage.
If a record contains zero occurrences of an ODO column, one row will be processed. The value used for
the elements that were subject to the ODO clause will be null if the element is nullable, or space or zero
(depending on data type) it the element is not nullable.
The Complex file load option dialog box does not appear if ODOs are the only type of array column in
your file. If both types of array columns are present, the dialog box appears but ODO columns are not
available for selective flattening.

Defining External Source Output Data
Output links from External Source stages represent the data being output from an external data source.
The properties of such links and the column definitions of the data are defined on the Outputs page in
the External Source Stage dialog box. This page has the following field and four tabs:
v Output name. The name of the output link. Select the link you want to edit from the Output name list.
This list displays all the output links from the External Source stage. If there is only one output link,
the field is read-only.
v General. Contains an optional description of the link.
v Selection. This tab allows you to select arguments as output columns. The Available arguments list
displays the arguments loaded from the external source routine, and the Selected columns list displays
the columns to be output from the stage.
If the Column push option is selected in Designer client options, the routine arguments are
automatically selected as output columns on each empty output link when you click OK to exit the
stage. You do not need to select columns on the Selection tab, unless you want to output only a subset
of them. However, if any routine arguments are GROUP data type, the column push option works only
if all members of the group are CHARACTER data type.
You can move an argument from the Available arguments list to the Selected columns list by
double-clicking the argument name or highlighting the argument name and clicking >. To move all
arguments, click >>. You can remove single columns from the Selected columns list by double-clicking
the column name or highlighting the column name and clicking <. Remove all columns by clicking <<.
Click Find to locate a particular argument.
You can select a group as one element if all elements of the group are CHARACTER data. If one or
more elements of the group are of another type, then they must be selected separately. If a group item
and its sublevel items are all selected, storage is allocated for the group item as well as each sublevel
item.
If you select an argument that is an array element, you have the option of flattening the array or
denormalizing it at run time. If you flatten the array, a unique name is generated for each subelement
of the array. You can delete any subelements that are not needed from the Selected columns list.
The Selected columns list displays the column name and SQL type for each column. Use the arrow
buttons to the right of the Selected columns list to rearrange the order of the columns.
v Constraint. This tab is displayed by default. The Constraint grid allows you to define a constraint that
filters your output data:
– (. Select an opening parenthesis if needed.
– Column. Select a column or job parameter from the list. (Group columns cannot be used in
constraint expressions and are not displayed.)
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– Op. Select an operator or a logical function from the list. For information about using functions in
constraint expressions, see “Constraints” on page 170.
– Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint
field. When you are done building the expression, click Verify. If errors are found, you must either
correct the expression, click Clear All to start over, or cancel. You cannot save an incorrect
constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint,
any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Columns. This tab displays the output columns. It has a grid with the following columns:
– Column name. The name of the column.
– Key. Indicates if the column is a record key.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Column definitions are read-only on the Outputs page. You must go back to the Mainframe
Routine dialog box in the repository if you want to make changes to the external source routine
arguments. Click Save As... to save the output columns as a table definition, a CFD file, or a
DCLGen file.

External Target Stages
These topics describe External Target stages, which are used to write rows to a given data target. An
External Target stage represents a user-written program that is called from the COBOL program that is
generated by InfoSphere DataStage. The external target program can be written in any language that is
callable from COBOL.

Working with External Targets
External target programs allow you to write data to data targets that are not supported in InfoSphere
DataStage MVS Edition. After you write an external target program, you create an external target routine
in the InfoSphere DataStage repository. The external target routine specifies the attributes of the external
target program.
You create, view, or edit an external target routine using the Mainframe Routine dialog box. This dialog
box has four pages for external target routines: General, Creator, Arguments, and JCL.
There are three buttons in the Mainframe Routine dialog box:
v Close. Closes the Mainframe Routine dialog box. If you have any unsaved changes, you are prompted
to save them.
v Save. Saves the external target routine.
v Help. Starts the Help system.
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Creating an External Target Routine
You can create a new external target routine.

Procedure
1. Open the Mainframe Routine dialog box in either of these ways:
v Choose File > New from the main menu or click the New button on the toolbar. The New dialog
box appears. Click the Routines folder, select the Mainframe Routine icon, and click OK.
v Right-click the Routines folder in the repository tree and select New > Mainframe Routine from
the shortcut menu.
2. On the General page, specify general information about the external target routine:
a. Routine name. Type the name (up to 8 characters) of the external subroutine. In mainframe terms,
the routine name is the name of an entry point in a member of a load or object library. The library
member can also contain other entry points with other names. The routine name must match the
external subroutine name if Dynamic invocation (the default) is selected, and automatically
appears in the External subroutine name field.
b. Type. Select the type of routine, in this case, External Target Routine. (External source routines are
discussed in “External Source Stages” on page 70. External routines are detailed in “External
Routine Stages” on page 104.)
c. External subroutine name. Type the name of the load or object library member that contains the
subroutine or function entry point. If dynamic invocation is selected, then the external subroutine
name must match the routine name. If the invocation method is static, then the two names need
not match.
d. Invocation method. Select the invocation method for the routine. Dynamic invocation calls the
routine at runtime. Static invocation embeds the routine within a program. Dynamic is the default.
e. Library path. Type the path name of the library that contains the routine member. JCL extension
variables can be used. This field is required for static invocation.
f. Short description. Type an optional brief description of the routine. The text entered in this field
appears in the External Target stage editor.
g. Long description. Type an optional detailed description of the routine.
3. Click the Creator page to specify information about the creator and version number of the routine,
including:
a. Vendor. Type the name of the company that created the routine.
b. Author. Type the name of the person who created the routine.
c. Version. Type the version number of the routine. This is used when the routine is imported. The
Version field contains a three-part version number, for example, 2.0.0. The first part of this number
is an internal number used to check compatibility between the routine and the InfoSphere
DataStage system, and cannot be changed. The second part of this number represents the release
number. This number should be incremented when major changes are made to the routine
definition or the underlying code. The new release of the routine supersedes any previous release.
Any jobs using the routine use the new release. The last part of this number marks intermediate
releases when a minor change or fix has taken place.
d. Copyright. Type the copyright information.
4. Click the Arguments page to define routine arguments. For external target routines, arguments are
treated as fields of a record. The record is passed to the external target routine program. You can
define an unlimited number of arguments. The columns in the argument record cannot contain
complex data structures such as GROUP, REDEFINES, OCCURS and OCCURS DEPENDING ON
clauses.
There are two ways to define routine arguments:
v To load arguments from an existing table definition, click Load... . Arguments loaded from a table
definition are flattened as necessary.
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v To create a new argument, type directly in the Arguments grid or, if you need to specify COBOL
attributes, open the Edit Routine Argument Meta Data dialog box in either of these ways:
– Right-click in the column area and select Edit row... from the shortcut menu.
– Press Ctrl-E.
The top pane of the Edit Routine Argument Meta Data dialog box contains the same fields that
appear on the Arguments grid, plus an additional field for the date format. Specify the following
information for each argument you want to define:
–
–
–
–

Argument name. Type the name of the argument.
Native type. Select the native data type of the argument from the list.
Length. Type a number representing the length or precision of the argument.
Scale. If the argument is numeric, type a number to define the number of digits to the right of
the decimal point.
– Nullable. Select Yes or No from the list to specify whether the argument can contain a null
value. The default is No in the Edit Routine Argument Meta Data dialog box.
– Date format. Select the date format of the argument from the list.
– Description. Type an optional description of the argument.
The bottom pane of the Edit Routine Argument Meta Data dialog box displays the COBOL page
by default. Use this page to specify any required COBOL information for the external target
argument:
– Usage. Select the COBOL USAGE clause from the list. This specifies which COBOL format the
column will be read in. These formats map to the formats in the Native type field, and changing
one will normally change the other. Possible values are:
COMP. Used with BINARY native types.
COMP-1. Used with single-precision FLOAT native types.
COMP-2. Used with double-precision FLOAT native types.
COMP-3. Packed decimal, used with DECIMAL native types.
COMP-5. Used with NATIVE BINARY native types.
DISPLAY. Zoned decimal, used with DISPLAY_NUMERIC or CHARACTER native types.
DISPLAY-1. Double-byte zoned decimal, used with GRAPHIC_G or GRAPHIC_N.
– Sign indicator. Select Signed or blank from the list to specify whether the argument can be
signed or not. The default is Signed for numeric data types and blank for all other types.
– Sign option. If the argument is signed, select the location of the sign in the data from the list.
Choose from the following options:
LEADING. The sign is the first byte of storage.
TRAILING. The sign is the last byte of storage.
LEADING SEPARATE. The sign is in a separate byte that has been added to the beginning of
storage.
TRAILING SEPARATE. The sign is in a separate byte that has been added to the end of storage.
The LEADING SEPARATE or TRAILING SEPARATE options will increase the storage length of
the column by one byte.
– Storage length. Gives the storage length in bytes of the argument as defined. This field is
derived and cannot be edited.
– Picture. Gives the COBOL PICTURE clause, which is derived from the argument definition and
cannot be edited.
The buttons at the bottom of the Edit Routine Argument Meta Data dialog box allow you to
continue adding or editing arguments, or to save and close. The buttons are:
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– < Previous and Next >. Displays the metadata in the previous or next argument. These buttons
are available only when a previous or next argument exists. If there are unsaved changes to the
current argument, you are prompted to save them before continuing.
– Close. Closes the Edit Routine Argument Meta Data dialog box. If you have any unsaved
changes, you are prompted to save them.
– Apply. Saves changes to the current argument.
– Reset. Removes all changes made to the argument since the last time you applied changes.
– Help. Starts the Help system.
5. Click JCL to define the JCL associated with the external target routine. This includes any DD names
or library names needed to run the external target program. For example:
// POJCL DD DSN=POSYS.SALESORD.FWFF
//
DISP=(NEW,CATLG,DELETE),
//
UNIT=SYSDA,
//
SPACE=(TRK,(10,10),RLSE),
//
DCB=(LRECL=204,BLKSIZE=2040,RECFM=FB)

You can type directly in the Additional JCL required for the routine box, or click Load JCL... to load
the JCL from an existing file. The JCL on this page is included in the run JCL that InfoSphere
DataStage generates for your job. No syntax checking is performed on the JCL you specify here.
6. The Save button is available after you define the JCL. When you click Save, you are prompted to
specify the folder path in the repository where the external target routine definition will be saved.

Viewing and Editing an External Target Routine
About this task
You can view and edit an external target routine in the Mainframe Routine dialog box. Open this dialog
box in one of the following ways:
v Double-click the routine in the repository tree.
v Select the routine in the repository tree and choose Repository > Properties from the main menu.
v Right-click the routine in the repository tree and choose Properties from the shortcut menu.
You can edit any of the fields and options in the Mainframe Routine dialog box. If you make any
changes, be sure to save them before closing this dialog box.

Copying an External Target Routine
About this task
You can copy an external target routine in two ways:
v Select the routine in the repository tree and choose Repository > Create copy.
v Right-click the routine in the repository tree and select Create copy from the shortcut menu.
The routine is copied and a new routine is created in the same folder of the repository tree. By default,
the name of the copy is called CopyOfXXX, where XXX is the name of the chosen routine. An edit box
appears, allowing you to rename the copy immediately.
If the invocation method of the routine is dynamic, the external subroutine name is set automatically.

Renaming an External Target Routine
About this task
You can rename an external target routine in several ways:
v Double-click the routine in the repository tree to open the Mainframe Routine dialog box. Edit the
Routine name field, click Save, then click Close.
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v Select the routine in the repository tree and click again. In the edit box, type a new name or edit the
existing one. Save the name by pressing Enter or by clicking outside the edit box.
v Right-click the routine and select Rename from the shortcut menu. In the edit box, type a new name or
edit the existing one. Save the name by pressing Enter or clicking outside the edit box.
v Select the routine in the repository tree and choose Repository > Rename. In the edit box, type a new
name or edit the existing one. Save the name by pressing Enter or by clicking outside the edit box.
If the invocation method of the routine is dynamic, the external subroutine name is set automatically.

Defining the External Target Call Interface
The call interface between the COBOL program that is generated by InfoSphere DataStage and the
external target program consists of two parameters:
v The address of the control structure
v The address of the record definition
The control structure is an 8-byte area, as shown in the following example:
01
05
05
05
05

DS-EXTTGT1-CONTROL
ET-REQUEST
ET-RC
ET-EOF
ET-DATA-AREA

PIC X.
PIC S9(4) COMP.
PIC X.
PIC X(4).

The first byte indicates the type of call from the generated COBOL program to the external target routine.
Call type O opens a file, W writes a record, and C closes a file.
The next two bytes are for the return code that is sent back from the external target routine to confirm
the success or failure of the call. A zero indicates success and nonzero indicates failure.
The fourth byte is an EOF (end of file) status indicator returned by the external target routine. A Y
indicates EOF and N is for a returned row.
The last four bytes comprise a data area that can be used for re-entrant code. You can optionally use this
area to store information such as an address or a value needed for dynamic calls.

Using an External Target Stage
External Target stages are used only as target stages and have no output links. They can have multiple
input links from active stages. Each External Target stage can call only one external target program.
When you edit the External Target stage, the External Target Stage dialog box appears. This dialog box
has two pages:
v Stage. Displays the stage name, which can be edited. This page has four tabs:
– General. Contains an optional description of the stage, which appears in the generated COBOL
program.
– Routine. Specifies the name of the external target routine and deploys its arguments. See
“Specifying the External Target Routine” on page 82 for details about specifying the routine.
– JCL. Contains the JCL for the external target routine. This tab is available after you load an external
target routine on the Routine tab. It displays any JCL you specified as part of the external target
routine in the repository. You can enter and edit JCL in the JCL statements box, or click Load JCL...
to load JCL from another file. JCL extension variables can be used. Click Reset to reset any changes
you have made to the JCL, reverting back to what was originally specified in the repository. Any
changes you make are saved when you click OK on the Stage page.
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– File view. Displays the record structure of the arguments in the external target program, including
the COBOL PICTURE clause, the starting and ending offsets, and the storage length of each
argument. The total storage length is displayed in the status bar. You can right-click to search by
column name or to save the file view layout as an HTML file.
v Inputs. Shows the column definitions for the data input links.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying the External Target Routine
The Routine tab on the Stage page allows you to select the external target routine to call, and load its
arguments. These arguments are then projected to the Inputs page.
The Routine tab displays the following information:
v Name. The name of the external target routine.
v Arguments. The arguments of the external target routine, including:
– Column name. The name of the column.
– Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load an external target routine from the repository. The routine name and arguments are
then displayed in read-only format on the Routine tab. If you want to make changes to the routine, you
must go back to the Mainframe Routine dialog box in the repository. Click Clear All to remove a routine
and its arguments from the Routine tab.
If you have pushed columns from a previous stage in the job design, they are displayed in the
Arguments grid and you can simply type the routine name in the Name field. However, you still must
define the external target routine in the repository before generating code.

Defining External Target Input Data
Input links to External Target stages represent the data being written to an external data target. The
column definitions of the data are displayed on the Inputs page in the External Target Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link. Select the link you want from the Input name list. This list
displays all the links to the External Target stage. If there is only one input link, the field is read-only.
v General. Contains an optional description of the link.
v Columns. This tab displays the input columns. It has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and the total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.

82

Mainframe Job Developer's Guide

– Description. A text description of the column.
Column definitions are read-only on the Inputs page. You must go back to the Mainframe Routine
dialog box in the repository if you want to make changes to the external target routine arguments.

Fixed-width Flat File Stages
These topics describe Fixed-width Flat File stages, which are used to read data from or write data to a
simple flat file. A simple flat file does not contain GROUP, REDEFINES, OCCURS, or OCCURS
DEPENDING ON clauses.

Using a Fixed-width Flat File Stage
Fixed-width Flat File stages can be used as source stages or target stages. As a source, this stage reads
data from a simple flat file. As a target, it writes data from an active stage into a simple flat file. It can
also be used to land intermediate files, acting as both a source and a target stage.
Fixed-width Flat File stages can have multiple input links and multiple output links. The input links
must come from an active stage, and the output links can be to any active stage or the FTP stage.
When you edit a Fixed-width Flat File stage, the Fixed-width Flat File Stage dialog box appears. This
dialog box can have up to three pages, depending on whether there are inputs to and outputs from the
stage:
v Stage. Displays the stage name, which can be edited. This page has up to five tabs, based on whether
the stage is being used as a source or a target.
The General tab allows you to specify the data file name, DD name, write option, and starting and
ending rows. You can also type an optional description of the stage, which appears in the generated
COBOL program.
– The File name field is the mainframe file from which data will be read (when the stage is used as a
source) or to which data will be written (when the stage is used as a target).
– Generate an end-of-data row. Appears only when the stage is used as a source. Select this check
box to add an end-of-data indicator after the last row is processed on each output link. The
indicator is a built-in variable called ENDOFDATA which has a value of TRUE, meaning the last
row of data has been processed. (See “ENDOFDATA” on page 183 for more information about using
this variable). In addition, all columns are set to null.
– The DD name field is the data definition name of the file in the JCL. It can be 1 to 8 alphanumeric
characters and the first character must be alphabetic.
– The Write option field in a target stage allows you to select how to place the data in the target file.
The available options are:
Create a new file. Creates a new file without checking to see if one already exists. This is the
default.
Append to existing file. Adds data to the existing file.
Overwrite existing file. Deletes the existing file and replaces it with a new file.
Delete and recreate existing file. Deletes the existing file if it has already been cataloged and
recreates it.
– Start row. Select First row to read the source file starting with the first row, or Row number to start
reading from a specific row number. Type a whole number in the Row number field, which has a
default value of 1. There is no maximum.
– End row. Select Last row to stop reading the source file after the last row, or Row number to stop
after a specific row number. Type a whole number in the Row number field, which has a default
value of 1. There is no maximum.
The Columns tab is where you specify the stage column definitions. See “Specifying Stage Column
Definitions” on page 84 for details about defining or loading column definitions.
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The File view tab displays specialized information about the stage columns, including the COBOL
PICTURE clause, the starting and ending offsets, and the storage length of each column. You can
right-click to save the file view layout as an HTML file.
The Pre-sort tab appears only when the stage is used as a source. It allows you to pre-sort your
source data before passing it to the next stage in the job design. See “Pre-Sorting Data” on page 85
for details about creating the sort control statement.
The Options tab is available in source stages if you have chosen to pre-sort the source data, or in
target stages if you have chosen to create a new file, or delete and recreate an existing file, in the
Write option field. See “Specifying Target File Parameters” on page 86 for details about setting these
options.
v Inputs. Specifies the column definitions for the data input links.
v Outputs. Specifies the column definitions for the data output links.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Stage Column Definitions
You must specify column definitions for the data used in Fixed-width Flat File stages on the Columns tab
on the Stage page, no matter whether you are using the stage as a source, a target, or both. These column
definitions specify the format of the data being read or written by the stage. They are then projected to
the Inputs page when the stage is used as a target, the Outputs page when the stage is a source, or both
pages if the stage is being used to land intermediate files.
The Columns tab contains a grid with the following information:
v Column name. The name of the column.
v Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The data precision. This is the number of characters for CHARACTER data and the total
number of digits for numeric data types.
v Scale. The data scale factor. This is the number of digits to the right of the decimal point for DECIMAL
and FLOAT data, and zero for all other data types.
v Nullable. Indicates whether the column can contain a null value.
v Description. A text description of the column.
You can add, modify, or delete column definitions in the grid using the shortcut menu. For details about
editing column definitions, see Chapter 10, “Editing Column Metadata,” on page 207.
This tab also contains three buttons:
v Save As... . Click this to save column definitions into the repository, where you can subsequently reuse
them for other stages. The Save table definition dialog box appears, allowing you to save columns as a
table definition, a COBOL file definition (CFD), or a DB2 DCLGen file (DFD).
v Clear All. Click this to clear all column definitions from the stage.
v Load. Click this to selectively load columns from a table definition in the repository:
– First, select an existing table or import a new one from the Table Definitions dialog box.
– Next, select the columns that you want to load from the Select columns from table dialog box. The
Available columns tree displays COBOL structures such as groups and arrays. If you do not want
to display all of the columns, you can specify that unwanted ones be replaced by filler columns. See
“Filler Creation and Expansion” on page 85 for details.
If a complex flat file is loaded, the incoming file is flattened and REDEFINE and GROUP columns are
removed. The array and OCCURS DEPENDING ON columns are flattened to the maximum size. All
level numbers are set to zero.
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If the access type of the table loaded is not QSAM_SEQ_FLAT, then native data type conversions are
done for all columns that have a native data type which is not one of those supported in Fixed-width Flat
File stages. For more information, see Chapter 9, “Native Data Types,” on page 197.
Columns displayed here should reflect the actual layout of the source file. Even though you might not
want to output every column, all of the columns of the file layout, including fillers, should appear here.
You select the columns to output from the stage on the Outputs page.
Filler Creation and Expansion:
Mainframe table definitions frequently contain hundreds of columns, therefore to save storage space and
processing time, there is a Create fillers option in the Select columns from table dialog box.
This option is selected by default when you load columns from a simple flat file. The sequences of
unselected columns are collapsed into FILLER items with the appropriate size. The native data type is set
to CHARACTER and the name set to FILLER_XX_YY, where XX is the start offset and YY is the end
offset.
You can expand fillers in the columns grid if you want to reselect any columns. Right-click the filler and
select Expand filler from the shortcut menu. The Expand Filler dialog box appears, allowing you to
select some or all of the columns from the given filler. There is no need to reload the table definition and
reselect the columns.
See Chapter 11, “Fillers,” on page 211 for examples of how fillers are created for different COBOL
structures and for details about filler expansion.

Pre-Sorting Data
Pre-sorting your source data can simplify processing in active stages where data transformations and
aggregations occur. InfoSphere DataStage allows you to pre-sort data loaded into Fixed-width Flat File
stages by utilizing the mainframe DFSORT utility during code generation.
You specify the pre-sort criteria on the Pre-sort tab. This tab is divided into two panes. The left pane
displays the available control statements, and the right pane allows you to edit the pre-sort statement that
will be added to the generated JCL. When you highlight an item in the Control statements list, a short
description of the statement is displayed in the status bar at the bottom of the dialog box.
There are two ways to create a pre-sort statement:
v Double-click an item in the Control statements list to insert it into the Statement editor box.
v Type any valid control statement directly in the Statement editor text box.
The Control statements list contains the following items:
v SORT FIELDS. Describes the sort control fields in the input records. When you select SORT, the Select
sort columns dialog box appears. This is where you select the columns to sort by and the sort order.
To move a column from the Available columns list to the Selected columns list, double-click the
column name or highlight the column name and click >. To move all columns, click >>. Remove a
column from the Selected columns list by double-clicking the column name or highlighting the column
name and clicking <. Remove all columns by clicking <<. Click Find to search for a particular column
in either list.
Array columns cannot be sorted and are unavailable for selection in the Available columns list.
To specify the column sort order, click the Order field next to each column in the Selected columns
list. There are two options:
– Ascending. This is the default setting. Select this option to sort the input column data in ascending
order.
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– Descending. Select this option to sort the input column data in descending order.
Use the arrow buttons to the right of the Selected columns list to change the order of the columns
being sorted. The first column is the primary sort column and any remaining columns are sorted
secondarily.
When you are finished, click OK to close the Select sort columns dialog box. The selected columns
and their sort order appear in the Statement editor box.
v
v
v
v
v

ALTSEQ CODE. Changes the collating sequence of EBCDIC character data.
INCLUDE COND. Specifies particular records to include.
OMIT COND. Filters unwanted input records.
RECORD TYPE. Specifies the type and length of records being processed.
SUM FIELDS. Adds summary fields to the output data list.

Click Help to see the complete syntax diagrams for these control statements.
InfoSphere DataStage does not support the following control statements on the Pre-sort tab:
v DEBUG
v END
v INREC
v MERGE
v MODS
v OPTION
v OUTFIL
v OUTREC
No syntax checking is performed on the statement entered. However, if you use an unsupported control
statement, you might get an error when the job runs even though you will not get an error during code
generation.

Specifying Target File Parameters
The Options tab on the Stage page allows you to define the JCL parameters that are required to create a
pre-sorted mainframe file in source stages or a new mainframe file in target stages.
This tab contains the following fields:
v Normal EOJ handling. Contains the parameter for the disposition of the data file when job upload
successfully completes. There are four options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set after job execution.
– KEEP. Retains the data set, but does not catalog it.
– PASS. Passes the data set to the next job step, but deletes it at the end of the job. This is the default.
v Abnormal EOJ handling. Contains the parameter for the disposition of the data file when job upload
does not complete successfully. There are three options:
– CATLG. Catalogs the data set.
– DELETE. Deletes the data set. This is the default.
– KEEP. Retains the data set, but does not catalog it.
v Unit. Specifies the device type of the disk on which the data is to be stored. The default value is
SYSDA.
v Allocation type. Specifies the unit of allocation used when storage space is reserved for the file. There
are two options:
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– TRK. Track. This is the default.
– CYL. Cylinder. This generally allocates a greater amount of storage space than TRK.
The exact size of a track or cylinder is device dependent.
v Primary allocation amount. Contains the number of tracks or cylinders to be reserved as the initial
storage for the job. The minimum is 1 and the maximum is 32768. The default value is 10.
v Secondary allocation amount. Contains the number of tracks or cylinders to be reserved if the primary
allocation is insufficient for the job. The minimum is 1 and the maximum is 32768. The default value is
10.
v Vol ser. The volume serial number of the unit where the file will be written. Up to six alphanumeric
characters are allowed.
v Expiration date. Specifies the expiration date for a new data set in YYDDD or YYYY/DDD format. For
expiration dates of January 1, 2000 or later, you must use the YYYY/DDD format. JCL extension
variables can also be used.
The YY can be from 01 to 99 or the YYYY can be from 1900 to 2155. The DDD can be from 000 to 365
for nonleap years or 000 to 366 for leap years.
If you specify the current date or an earlier date, the data set is immediately eligible for replacement.
Data sets with expiration dates of 99365, 99366, 1999/365 and 1999/366 are considered permanent and
are never deleted or overwritten.
v Retention period. Specifies the number of days to retain a new data set. You can type a number or use
a JCL extension variable. When the job runs, this value is added to the current date to produce an
expiration date, using 365-day years and 366-day leap years. Note that if the calculated expiration date
is December 31, 1999, the expiration date is set to January 1, 2000.
You can specify either an expiration date or a retention period, but not both. When you type a value in
one of these fields, the other field becomes unavailable. No validation is done on either field; if you type
an incorrect value, JCL errors might occur.
These parameters are used during JCL generation. All fields except Vol ser, Expiration date, and
Retention period are required.

Defining Fixed-width Flat File Input Data
When you write data to a simple flat file, the Fixed-width Flat File stage has at least one input link. The
properties of this link and the column definitions of the data are described on the Inputs page of the
Fixed-width Flat File Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The names of the input links to the Fixed-width Flat File stage. Use this field to select
which set of input data you want to view.
v General. Contains an optional description of the selected link.
v Columns. Contains the column definitions for the data being written to the file. This tab has a grid
with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For more information about the native data types supported in
mainframe source and target stages, see "Native Data Types."
– Length. The data precision. This is the number of characters for CHARACTER data and the total
number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
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Column definitions are read-only on the Inputs page in the Fixed-width Flat File stage. You must go
back to the Columns tab on the Stage page if you want to make changes.
If the stage has multiple input links, the columns on all the input links should be the same as the
stage columns.

Defining Fixed-width Flat File Output Data
When you output data from a Fixed-width Flat File stage, the properties of the output links and the
column definitions of the data are described on the Outputs page in the Fixed-width Flat File Stage
dialog box.
This dialog box has the following field and four tabs:
v Output name. This list contains names of all output links from the stage. If there is only one output
link, this field is read-only. When there are multiple output links, select the one you want to edit before
modifying the data.
v Selection. This tab allows you to select columns to output data from. The Available columns list
displays the columns loaded from the source file, and the Selected columns list displays the columns
to be output from the stage.
If the Column push option is selected in Designer client options, all stage column definitions are
automatically propagated to each empty output link when you click OK to exit the stage. You do not
need to select columns on the Selection tab, unless you want to output only a subset of them.
You can move a column from the Available columns list to the Selected columns list by
double-clicking the column name or highlighting the column name and clicking >. To move all
columns, click >>. You can remove single columns from the Selected columns list by double-clicking
the column name or highlighting the column name and clicking <. Remove all columns by clicking <<.
Click Find to locate a particular column.
The Selected columns list displays the column name and SQL type for each column. Use the arrow
buttons to the right of the Selected columns list to rearrange the order of the columns.
v Constraint. This tab is displayed by default. The Constraint grid allows you to define a constraint that
filters your output data:
– (. Select an opening parenthesis if needed.
– Column. Select a column or job parameter from the list.
– Op. Select an operator or a logical function from the list. For information about using functions in
constraint expressions, see “Constraints” on page 170.
– Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint
field. When you are done building the expression, click Verify. If errors are found, you must either
correct the expression, click Clear All to start over, or cancel. You cannot save an incorrect
constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint,
any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Columns. This tab displays the output columns. It has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER data and the total
number of digits for numeric data types.
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– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Column definitions are read-only on the Outputs page. You must go back to the Columns tab on the
Stage page if you want to change the definitions. Click Save As... to save the output columns as a
table definition, a CFD file, or a DCLGen file.

Multi-format Flat File Stages
These topics describe Multi-format Flat File stages, which are used to read data from files containing
multiple record types. The source data can contain one or more GROUP, REDEFINES, OCCURS or
OCCURS DEPENDING ON clauses.

Using a Multi-format Flat File Stage
Multi-format Flat File stages are used only as source stages and cannot receive input links. They can have
multiple output links to active stages.
When you edit a Multi-format Flat File stage, the Multi-format Flat File Stage dialog box appears. This
dialog box has two pages:
v Stage. Displays the stage name, which can be edited. This page has four tabs. The General tab is
where you specify details about the source data file, including:
– File name. Type the name of the mainframe source file to read data from.
– Generate an end-of-data row. Select this check box to add an end-of-data indicator after the last
row is processed on each output link. The indicator is a built-in variable called ENDOFDATA which
has a value of TRUE, meaning the last row of data has been processed. (See “ENDOFDATA” on
page 183 for more information about using this variable). In addition, all columns are set to null.
– DD name. Type the data definition name of the file in the JCL. This can be 1 to 8 alphanumeric
characters and the first character must be alphabetic. The default name is DDn, where n is the
internal job number. You can edit this name.
– Access type. Select the access type of the source file from the list. There are four choices:
QSAM_SEQ_COMPLEX. QSAM file structure.
VSAM_ESDS. VSAM Entry-Sequenced Data Set file structure.
VSAM_KSDS. VSAM Key-Sequenced Data Set file structure. If this is selected, at least one column
must be defined as a Key.
VSAM_RRDS. Relative Record Data Set file structure.
– Start row. Select First row to read the source file starting with the first row, or Row number to start
reading from a specific row number. Type a whole number in the Row number field, which has a
default value of 1. There is no maximum.
– End row. Select Last row to stop reading the source file after the last row, or Row number to stop
after a specific row number. Type a whole number in the Row number field, which has a default
value of 1. There is no maximum.
– Block type. Select the block type of the source file. The default is Variable block file, which
indicates that the source file contains variable record lengths. Multi-format Flat File stages can also
be used to read fixed-block files, which contain records of the same length.
– Maximum file record size. Specify the maximum record size in the source file. The size must be
greater than or equal to the storage length of the largest record in the source file, regardless of
whether that record is loaded into the stage. If no value is specified, it is set to the storage length of
the largest record loaded into the stage after clicking OK.
– Description. Type an optional description, which will appear in the generated COBOL program.
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The Records tab is where you specify the record definitions for the source data. See “Specifying
Stage Record Definitions” for details about defining or loading record definitions.
The Records ID tab allows you to specify record ID constraints. See “Specifying Record ID
Constraints” on page 92 for details.
The Records view tab displays specialized information about the record types in your source file,
including the COBOL PICTURE clause, the starting and ending offsets, and the storage length of
each record. You can right-click to save the records view layout as an HTML file.
v Outputs. Specifies the column definitions for the data output links.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Stage Record Definitions
You can create record definitions.

About this task
The Records tab on the Stage page allows you to specify multiple record definitions for the data being
read by Multi-format Flat File stages. These record definitions are then projected to the Outputs page.
The Records tab displays the record definitions in the left pane and the columns associated with each
record in the right pane.

Procedure
1. Create a new record type in one of the following ways:
v Click New record.
v Right-click in the left pane and select New record from the shortcut menu.
A new record is created with the default name of NEWRECORD. You can edit this name either by
double-clicking the name or choosing Rename from the shortcut menu. Record names cannot be
COBOL reserved words (see Chapter 15, “Reserved Words,” on page 241 for a list).
2. Select the Master check box if the record is the master. Only one master record is permitted.
3. After you create a record, you define the columns associated with the record. You can manually type
column definitions in the Columns grid, or click Load to selectively load columns from a table
definition in the repository.
To load columns:
a. Select an existing table or import a new one from the Table Definitions dialog box.
b. Select the columns that you want to load from the Select columns from table dialog box. The
Available columns tree displays COBOL structures such as groups and arrays. If you do not want
to display all of the columns, you can specify that unwanted ones be replaced by filler columns.
See “Filler Creation and Expansion” on page 91 for details.
c. If there are arrays in the column structure for which flattening is an option, the Complex file load
option dialog box appears. This lets you specify how to handle array data in the stage. See “Array
Handling” on page 91 for details.
The Columns grid displays the column information associated with the selected record definition,
including:
d. Level number. The COBOL level number where the data is defined. If no level number is given, a
default value of 05 is assigned.
e. Column name. The name of the column.
f. Key. This field is required if the access type of the source file is VSAM_KSDS.
g. Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
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h. Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and the total number of digits for numeric data types.
i. Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
j. Nullable. Indicates whether the column can contain a null value. (Nullable columns are not
supported in Multi-format Flat File stages.)
k. Description. A text description of the column.
4. To edit column definitions, type directly in the grid or select Edit Row... from the shortcut menu. This
opens the Edit Column Meta Data dialog box, allowing you to define COBOL-specific column
information. For details about using this dialog box see Chapter 10, “Editing Column Metadata,” on
page 207.
5. To remove a record definition and its columns, select the record name in the left pane and click Clear
All.

Results
Record definitions and columns displayed here should reflect the actual layout of the source file. Even
though you might not want to output every column, all columns in the file layout, including fillers,
should appear here. You select the columns to output from the stage on the Outputs page.
Filler Creation and Expansion:
Mainframe table definitions frequently contain hundreds of columns, therefore to save storage space and
processing time, there is a Create fillers option in the Select columns from table dialog box.
This option, which is selected by default, is available only when you load columns from a simple or
complex flat file. The sequences of unselected columns are collapsed into FILLER items with the
appropriate size. The native data type is set to CHARACTER and the name set to FILLER_XX_YY, where
XX is the start offset and YY is the end offset.
Fillers for elements of a group array or an OCCURS DEPENDING ON (ODO) column have the name of
FILLER_NN, where NN is the element number. The NN begins at 1 for the first unselected group
element and continues sequentially. Any fillers that follow an ODO column are also numbered
sequentially.
You can expand fillers in the columns grid if you want to reselect any columns. Right-click the filler and
select Expand filler from the shortcut menu. The Expand Filler dialog box appears, allowing you to
select some or all of the columns from the given filler. There is no need to reload the table definition and
reselect the columns.
See Chapter 11, “Fillers,” on page 211 for examples of how fillers are created for different COBOL
structures and for details about filler expansion.
Array Handling:
When you enter or load column definitions containing arrays, the Complex file load option dialog box
appears. This dialog box offers the following options:
v Flatten selective arrays. Allows you to select arrays for flattening on an individual basis. Right-click an
array in the columns list and select Flatten or Normalize. The array icon changes for the arrays that
you select to flatten.
v Flatten all arrays. Creates new columns for each element of the array and presents the data as one row
at execution time.
v Normalize all arrays. Presents the data as multiple rows at execution time with one row for each
column in the array. This is the default.
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Array columns that have redefined fields or OCCURS DEPENDING ON clauses cannot be flattened.
Even if you choose to flatten all arrays in the Complex file load option dialog box, these columns are
always normalized. Only the used occurrences of ODO columns are output from the stage.
If a record contains zero occurrences of an ODO column, one row will be processed. The value used for
the elements that were subject to the ODO clause will be null if the element is nullable, or space or zero
(depending on data type) it the element is not nullable.
The Complex file load option dialog box does not appear if ODOs are the only type of array column in
your file. If both types of array columns are present, the dialog box appears but ODO columns are not
available for selective flattening.

Specifying Record ID Constraints
For each record defined on the Records tab, you must specify a record ID constraint from its columns.
This is done on the Records ID tab.
Columns that are identified in the record ID clause must be in the same physical storage location across
records. Specify the constraint using the following fields:
v (. Select an opening parenthesis if needed.
v Column. Select the record ID column from the list, which displays all columns from the selected record
type.
v Op. Select an operator from the list.
v Column/Value. Type the identifying value for the record ID column. Character values must be
enclosed in single quotation marks.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint field.
When you are done building the expression, click Verify. If errors are found, you must either correct the
expression, click Clear All to start over, or cancel. You cannot save an incorrect constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint, any
redundant parentheses might be removed. For details, see “Operators” on page 180.

Defining Multi-format Flat File Output Data
Output links from Multi-format Flat File stages represent the data being extracted from files containing
multiple record types. Each output link can have columns from multiple record definitions, and columns
from the same record definition can be output to multiple links. The properties of such links and the
column definitions of the data are described on the Outputs page in the Multi-format Flat File Stage
dialog box.
The Outputs page has the following field and four tabs:
v Output name. The name of the output link. Select the link you want to edit from the Output name list.
This list displays all the output links from the Multi-format Flat File stage. If there is only one output
link, the field is read-only.
v General. Contains an optional description of the link.
v Selection. Displayed by default. This tab allows you to select columns to output from multiple record
types. The Available columns list displays the record definitions loaded into the stage and their
corresponding columns, and the Selected columns list displays the columns to be output from the
stage.
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The Column push option does not operate in Multi-format Flat File stages. Even if you have this
option selected in Designer client options, you must select columns to output from the stage on the
Selection tab.
You can move a column from the Available columns list to the Selected columns list by
double-clicking the column name or highlighting the column name and clicking >. Move all columns
from a single record definition by highlighting the record name or any of its columns and clicking >>.
You can remove columns from the Selected columns list by double-clicking the column name or
highlighting the column name and clicking <. Remove all columns by clicking <<. Click Find to locate
a particular column.
You can select a group as one element if all elements of the group are CHARACTER data. If one or
more elements of the group are of another type, then they must be selected separately. If a group item
and its sublevel items are all selected, storage is allocated for the group item as well as each sublevel
item.
The Selected columns list displays the column name, record name, SQL type, and alias for each
column. You can edit the alias to rename output columns since their names must be unique. Use the
arrow buttons to the right of the Selected columns list to rearrange the order of the columns.
v Constraint. This tab allows you to optionally define a constraint that filters your output data. Define a
constraint in the Constraint grid using the following fields:
– (. Select an opening parenthesis if needed.
– Column. Select a column or job parameter from the list. (Group columns cannot be used in
constraint expressions and are not displayed.)
– Op. Select an operator or a logical function from the list. For information about using functions in
constraint expressions, see “Constraints” on page 170.
– Column/Value. Select a column or job parameter from the list, or double-click in the cell to type a
value. Character values must be enclosed in single quotation marks.
– ). Select a closing parenthesis if needed.
– Logical. Select AND or OR from the list to continue the expression in the next row.
All of these fields are editable. As you build the constraint expression, it appears in the Constraint
field.
Click Default to set the constraint to match the record ID constraint on the Records ID tab for those
records selected as output. Default is available only when the Constraint grid is empty.
When you are done building the expression, click Verify. If errors are found, you must either correct
the expression, click Clear All to start over, or cancel. You cannot save an incorrect constraint.
The order of operators in expressions is determined by SQL standards. After you verify a constraint,
any redundant parentheses might be removed. For details, see “Operators” on page 180.
v Columns. This tab displays the output columns. It has a grid with the following columns:
– Column name. The name of the column.
– Native type. The native data type. For more information about the native data types supported in
mainframe source and target stages, see Chapter 9, “Native Data Types,” on page 197.
– Length. The data precision. This is the number of characters for CHARACTER and GROUP data,
and total number of digits for numeric data types.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
DECIMAL and FLOAT data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value. (Nullable columns are not
supported in Multi-format Flat File stages.)
– Description. A text description of the column.
Column definitions are read-only on the Outputs page. You must go back to the Records tab on the
Stage page if you want to change the definitions. Click Save As... to save the output columns as a
table definition, a CFD file, or a DCLGen file.
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Selecting Normalized Arrays
You can select multiple normalized array columns as output from Multi-format Flat File stages, just as
you can in Complex Flat File stages. For information about how InfoSphere DataStage processes arrays
before delivering rows to the output link, see “Selecting Normalized Arrays” on page 58.

Aggregator Stages
These topics describe Aggregator stages, which group data from a single input link and perform
aggregation functions such as count, sum, average, first, last, min, and max. The aggregated data is
output to a processing stage or a target stage via a single output link.

Using an Aggregator Stage
Aggregator stages have only one input link and one output link. The input link must come from a source
stage.
When you edit an Aggregator stage, the Aggregator Stage dialog box appears. This dialog box has three
pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has a
General tab which contains an optional description of the stage.
v Inputs. Specifies the column definitions for the data input link.
v Outputs. Specifies the column definitions for the data output link. This page has an Aggregation tab
where you specify the aggregation functions. The Mapping tab is where you define the mappings
between input and output columns.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Aggregator Input Data
Data to be aggregated is passed from a previous stage in the job design and into the Aggregator stage via
a single input link. The properties of this link and the column definitions of the data are described on the
Inputs page in the Aggregator Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link to the Aggregator stage. Since only one input link is allowed,
the link name is read-only.
v General. Contains an optional description of the link.
v Columns. Displayed by default. Contains a grid displaying the column definitions for the data being
written to the stage:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Input column definitions are read-only in the Aggregator stage. You must go back to the stage on
your input link if you want to change the column definitions.
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Defining Aggregator Output Data
When you output data from an Aggregator stage, the properties of the output link and the column
definitions of the data are defined on the Outputs page in the Aggregator Stage dialog box.
The Outputs page has the following field and four tabs:
v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Displayed by default. Select the aggregation type on this tab and type an optional description
of the link. The Type field contains two options:
– Group by sorts the input rows and then aggregates the data.
– Control break aggregates the data without sorting the input rows. This is the default option.
v Aggregation. Contains a grid specifying the columns to group by and the aggregation functions for the
data being output from the stage. See “Aggregating Data” for details about defining the data
aggregation.
v Mapping. Specifies the mapping of input columns to output columns. See “Mapping Data” on page 96
for details about defining mappings.
v Columns. Contains the column definitions for the data on the output link. This grid has the following
columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
You can Load columns from a table definition in the repository, or type column definitions manually
and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click Clear All
to start over. For details about editing column definitions, see Chapter 10, “Editing Column
Metadata,” on page 207.

Aggregating Data
Your data sources might contain many thousands of records, especially if they are being used for
transaction processing. For example, suppose you have a data source containing detailed information
about sales orders. Rather than passing all of this information through to your data warehouse, you can
summarize the information to make analysis easier.
The Aggregator stage allows you to group by and summarize the information about the input link. You
can select multiple aggregation functions for each column. In this example, you could average the values
in the QUANTITY_ORDERED, QUANTITY_SOLD, UNIT_PRICE, and DISC_AMT columns, sum the
values in the ITEM_ORDER_AMT, ITEM_SALES_AMT, and BACK_ORDER_QTY columns, return only
the first values in PRODUCT_ID and PROD_DESC columns, and return only the last values in
ORDER_YY and ORDER_MM columns.
The Aggregation tab is used to select columns to group by and specify the aggregation functions to
perform on the input data. Every column output from an Aggregator stage must be either grouped by or
aggregated.
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The grid on this tab has the following columns:
v Column name. The name of the column.
v Group By. Specifies whether to group by the data in the column. The default is to group by all
columns except those being aggregated. The Group By box is automatically cleared when you select an
aggregation function for a column.
v Min. Returns the lowest value in the column.
v Max. Returns the highest value in the column.
v Count. Counts the number of values in the column. (Records containing null values do not increase the
count.)
v Sum. Totals the values in the column. This function is only available for numeric SQL data types.
v Average. Averages the values in the column. This function is only available for numeric SQL data
types.
v First. Returns the first value in the column. This function is only available with Control break
aggregation.
v Last. Returns the last value in the column. This function is only available with Control break
aggregation.
v SQL Type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
You cannot change the SQL data type on the Aggregation tab. You must go back to the stage on your
input link if you want to change the column definitions.
Table 11 shows the meta data for the columns created by the aggregation functions.
Table 11. Aggregation Column Metadata
Function

Column Name

SQL Type

Precision

Scale

Nullable

Min

x_MIN

1

Same as input

Same as input

Same as input

Yes

Max

x_MAX

Same as input

Same as input

Same as input

Yes

Count

x_COUNT

Decimal

18

x_SUM

Sum

Decimal

0

No

18

2

Same as input

Yes

2

Input column
scale + 2 (max
18)2

Yes

Average

x_AVG

Decimal

18

First

x_FIRST

Same as input

Same as input

Same as input

Yes

Last

x_LAST

Same as input

Same as input

Same as input

Yes

1

x represents the name of the input column being aggregated.

2

If Support extended decimal is selected in project properties, then the precision (or the maximum scale
of an average) is the maximum decimal size specified.

Mapping Data
The Mapping tab is used to define the mappings between input and output columns being passed
through the Aggregator stage.
You can bypass this step if the Column push option is selected in Designer client options. Output
columns are automatically created for each output link, and mappings between corresponding input and
output columns are defined, when you click OK to exit the stage.
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This tab is divided into two panes, the left for the input link (and any job parameters that have been
defined) and the right for the output link, and it shows the columns and the relationships between them.
In the left pane, the input column names are prefixed with the aggregation function being performed. If
more than one aggregation function is being performed on a single column, the column name will be
listed for each function being performed. Names of grouped columns are displayed without a prefix.
In the right pane, the output column derivations are also prefixed with the aggregation function. The
output column names are suffixed with the aggregation function.
You can drag the splitter bar between the two panes to resize them relative to one another. Vertical scroll
bars allow you to scroll the view up or down the column lists, as well as up or down the panes.
You can define column mappings from the Mapping tab in two ways:
v drag-and-drop. This specifies that an output column is directly derived from an input column. See
“Using drag-and-drop” for details.
v Auto-Match. This automatically sets output column derivations from their matching input columns,
based on name or location. See “Using Column Auto-Match” on page 98 for details.
Derivation expressions cannot be specified on the Mapping tab. If you need to perform data
transformations, you must include a Transformer stage elsewhere in your job design.
As mappings are defined, the output column names change from red to black. A relationship line is
drawn between the input column and the output column.
Find Facility:
About this task
If you are working on a complex job, there is a find facility to help you locate a particular column or
expression.
To use the find facility:
Procedure
1. Open the Find dialog box in either of these ways:
v Click Find on the Mapping tab.
v Select Find from the link shortcut menu.
2. Click one of the following tabs:
v Column Names. Allows you to find a particular column.
v Expression Text. Allows you to locate the occurrence of a particular string within an output column
expression.
3. Select a link from the Link name list. (You can search for expression text only on the output link.)
4. Type the text to search for in the Find what field.
5. Optional: Select the Match case and Match whole word check boxes to narrow your search.
6. Optional: On the Expression Text tab, select Empty Expression to search for the next empty
expression.
Using drag-and-drop:
About this task
A simple way to specify mappings is to use the Mapping tab's drag-and-drop functionality. You can drag
columns from your input link to your output link to define each mapping.
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To use drag-and-drop:
Procedure
1. Click the source cell to select it.
2. Click the selected cell again and, without releasing the mouse button, drag the mouse pointer to the
desired location within the target link.
3. Release the mouse button to drop the selected cell.
Results
You can also click the title bar displaying the name of the link and, without releasing the mouse button,
drag the mouse pointer to the first Derivation cell within the target link. This will map all input columns
to the output columns based on location.
Using Column Auto-Match:
About this task
You can use the column auto-match facility to automatically set columns on an output link to be derived
from matching columns on an input link.
To use auto-match:
Procedure
1. Click AutoMap on the Mapping tab to open the Column Auto-Match dialog box.
2. Click Location match or Name match in the Match type area.
If you click Location match, this will set output column derivations to the input link columns in the
equivalent positions. It starts with the first input link column going to the first output link column,
and works its way down until there are no more input columns left.
If you click Name match, you need to specify additional information for the input and output
columns:
v Input columns:
– Match all columns or Match selected columns. Click one of these to specify whether all input
link columns should be matched, or only those currently selected on the input link.
– Ignore aggregate prefix. Select this check box to perform the match based on the column names,
ignoring the aggregate prefix.
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Output columns:
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Ignore case. Select this check box to specify that case should be ignored when matching names. The
setting of this also affects the Ignore prefix and Ignore suffix settings. For example, if you specify
that the prefix IP will be ignored and select Ignore case, then both IP and ip will be ignored.
3. Click OK to proceed with the auto-matching.
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Results
Auto-matching does not take into account any data type incompatibility between matched columns; the
derivations are set regardless.

Business Rule Stages
These topics describe Business Rule stages, which are used to perform complex transformations using
SQL business rule logic. They provide access to the control-flow features of SQL, such as conditional and
looping statements, and give you greater transaction control over a job using SQL's COMMIT and
ROLLBACK statements. You can also use Business Rule stages to terminate job processing using an EXIT
statement or to display information in COBOL using a DISPLAY statement.

Using a Business Rule Stage
Business Rule stages have one input link and any number of output links. The input link can come from
a source stage or a processing stage. The output links can be to other processing stages or target stages.
When you edit a Business Rule stage, the Business Rule Stage dialog box appears. This dialog box has
three pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has three
tabs:
– General. Allows you to type an optional description of the stage.
– Variables. Used to define stage variables. See “Defining Stage Variables” for details.
– Definition. Used to specify the business rule logic for the stage. See “Specifying Business Rule
Logic” on page 100 for details.
v Inputs. Specifies the column definitions for the data input link.
v Outputs. Specifies the column definitions for the data output links.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Stage Variables
You can declare and use your own variables within a Business Rule stage, just as you do in a
Transformer stage. These stage variables are accessible only from the Business Rule stage in which they
are declared. Any stage variables you declare are available on the Definition tab, where they can be used
in the business rule logic for the stage.
If an initial value is not specified for a stage variable, it has an initial value of NULL. The variable is
initialized before the first input row is processed. If the business rule logic specified on the Definition tab
assigns a value to the stage variable for any given input row, the variable retains its value for subsequent
rows until it is reassigned another value.
You declare stage variables on the Variables tab in the Business Rule Stage dialog box. Declare a stage
variable using the grid:
v Name. The name of the stage variable. Variable names must begin with an alphabetic character (a-z,
A-Z) and can only contain alphanumeric characters (a-z, A-Z, 0-9).
v Initial Value. The initial value of the variable. If the initial value is a string, it must be enclosed in
single quotation marks.
v SQL type. The SQL data type of the variable. Choose the SQL type from the list. For details about the
data types supported in mainframe jobs, see Chapter 8, “Data Type Definitions and Mappings,” on
page 185.
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v Precision. The precision of the variable. This is the number of characters for Char data, the maximum
number of characters for VarChar data, the total number of digits for numeric data types, and the
number of digits in the microsecond portion of Timestamp data.
v Scale. The data scale factor of the variable. This is the number of digits to the right of the decimal
point for Decimal data, and zero for all other data types.
v Description. An optional description of the variable.
Click Load to load a set of stage variables from the table definition in the repository. You can also enter
and edit stage variables manually and click Save As... to save them as a table definition, a CFD file, or a
DCLGen file. Click Clear All to start over.

Specifying Business Rule Logic
Business Rule stages allow you to perform complex data transformations using SQL business rule logic.
You specify this logic on the Definition tab.
The Definition tab is divided into four panes:
v Templates. Lists the programming components you can use in a business rule, including:
– Columns. The columns on the input and output links.
– Parameters. Any job parameters you have defined.
– Variables. Any stage variables you have defined on the Variables tab, as well as the built-in
variables ENDOFDATA and SQLCA.SQLCODE.
– SQL Constructs. The available SQL constructs. See “SQL Constructs” on page 101 for SQL statement
definitions.
– Built-in Routines. SQL3 functions including data type conversion, date and time, logical, numerical
and string functions.
– Constants. Built-in constants including CURRENT_DATE, CURRENT_TIME,
CURRENT_TIMESTAMP, HIGH_VALUES, LOW_VALUES, X, and NULL.
For definitions of the built-in variables, functions, and constants in InfoSphere DataStage, see
Chapter 7, “Programmer's Reference,” on page 169.
v Business rule editor. Displays the business rule as you define it. A business rule consists of an SQL
statement list, which is a sequence of SQL statements terminated by semicolons. Any comments must
begin with /* and end with */.
v Operators. Displays the available operators, including arithmetic, logical, relational, and string
concatenation operators. Operator definitions are provided in Chapter 7, “Programmer's Reference,” on
page 169.
v Status. Displays status messages about any syntax or semantic errors found in the business rule logic.
You can double-click a syntax error to highlight the location of the error in the Business rule editor
text box.
There are two ways to create a business rule:
v Type directly in the Business rule editor text box. You can insert code fragments by selecting or
dragging items from the Templates and Operators panes. Standard editing functions such as cut, copy,
paste, delete, select all, and replace are available from the shortcut menu, which you can access by
right-clicking anywhere in the box.
v Click Build Rule to automatically generate the SET and INSERT statements (and constraints if any
exist) to map input columns to output columns. A Rule page opens, where you define the mappings
between input columns, output columns, and any stage variables that exist.
To define the column mappings, use a drag-and-drop operation or click the Auto-Match button to map
columns based on name or location. You can also double-click the Derivation cell next to an output
column or stage variable to create derivation expressions using the Expression Editor. For more
information about using the Expression Editor, see “Defining Expressions” on page 156.

100

Mainframe Job Developer's Guide

Click the Comment page to type comments that you want to insert into the Business rule editor pane.
After the mappings are defined, the necessary SET and INSERT statements appear where the cursor is
positioned in the Business rule editor text box. To define another set of mappings, click the Build Rule
button again. Any previously defined mappings are not displayed.
After you create a business rule, click Verify to check the syntax and semantics of the business rule. Any
errors are displayed in the Status pane.
Output columns are initialized to NULL before the first input row is processed. If the business rule logic
assigns a value to an output column for any given input row, the column retains its value for subsequent
rows until it is reassigned another value.
If the Column push option is selected in Designer client options and you close the Business Rule stage
without specifying any logic on the Definition tab, the stage automatically generates business rule logic
to copy all input link columns to any empty output links.

SQL Constructs
When you define the business rule logic on the Definition tab, you can choose from a number of SQL
constructs in the Templates pane. Table 12 describes the syntax descriptions and semantic rules for these
SQL constructs.
Table 12. SQL Constructs
Name

Description

BEGIN END Block

Groups statements together. Acts as an organization tool and does not affect the
business rule logic.
Syntax:
[<beginning label>:] BEGIN <block body> END [<ending label>]
block body is an SQL statement list
Semantic Rules:
A block label is an SQL identifier that gives a name for the block. Block labels are
optional. If an ending label is specified, it must match the beginning label.

SET Statement

Evaluates an expression and assigns the result to a variable or an output link
column.
Syntax:
SET <target> = <source>
target is an output link column or a variable
source is an expression or NULL
Semantic Rules:
If the data types of the source and target are not equivalent, the source is
automatically converted to the target's data type before assignment. If the source
is not convertible to the target data type, an error will occur. The conversions that
are supported are the same as those allowed by the CAST function. For details
about the CAST function, see Chapter 7, “Programmer's Reference,” on page 169.

Chapter 5. Mainframe Job Stages

101

Table 12. SQL Constructs (continued)
Name

Description

INSERT Statement

Sends columns down an output link.
Syntax:
INSERT INTO <output link>
Semantic Rules:
A business rule must contain at least one INSERT statement for each output link.
To verify that data has been successfully written to an output link, check the
variable SQLCA.SQLCODE after the INSERT statement. A nonzero value
indicates an error.

DISPLAY Statement

Writes values to the SYSPRINT spooler.
Syntax:
DISPLAY (<value list>)
value list is <expression> [,<expression>]...
Semantic Rules:
Expression values are written to the SYSPRINT spooler from left to right on one
line, terminated by a carriage return. Noncharacter values are displayed as if they
were converted to VARCHAR.

IF Statement

Allows conditional execution of SQL statements.
Syntax:
IF <condition>
condition is a
THEN clause is
ELSE clause is

<THEN clause> [<ELSE clause>] END IF
comparison whose value determines the program flow.
the statement to be executed if the condition is true.
the statement to be executed if the condition is false.

Semantic Rules:
A condition must be a Boolean expression. If the condition evaluates to TRUE,
the business rule executes the SQL statements in the THEN clause. If the
condition evaluates to FALSE or UNKNOWN (NULL), the business rule executes
the SQL statements in the ELSE clause if present.
LOOP Statement

Executes the loop body repeatedly until a LEAVE statement is executed to exit
the loop.
Syntax:
<beginning label> : LOOP <loop body> END LOOP [<ending label>]
loop body is an SQL statement list
Semantic Rules:
A loop label is an SQL identifier that gives a name for the loop. The ending label
is optional. If an ending label is specified, it must match the beginning label. The
loop body must contain a LEAVE statement.
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Table 12. SQL Constructs (continued)
Name

Description

LEAVE Statement

Exits a loop.
Syntax:
LEAVE <loop label>
loop label is an SQL identifier that gives a name for a loop
Semantic Rules:
A LEAVE statement must be used in a loop body. It exits the loop, allowing
program execution to resume at the statement following the END LOOP. The
loop label must match the label of the nearest LOOP statement that contains the
LEAVE statement.

COMMIT Statement

Commits any inserts, updates, and deletes made to relational tables in a job.
Syntax:
COMMIT
Semantic Rules:
To use a COMMIT statement, a job must contain a target Relational or Teradata
Relational stage.

ROLLBACK Statement

Cancels any inserts, updates, and deletes made to relational tables in a job since
the last COMMIT statement.
Syntax:
ROLLBACK
Semantic Rules:
To use a ROLLBACK statement, a job must contain a target Relational or
Teradata Relational stage.

EXIT Statement

Performs an implicit COMMIT and terminates the job with the status.
Syntax:
EXIT (<status>)
Semantic Rules:
The exit status must be an integer expression. Its value is returned to the
operating system.

Defining Business Rule Input Data
Data from the input link is passed from a previous stage in the job design to the Business Rule stage. The
properties of this link and the column definitions of the data are described on the Inputs page in the
Business Rule Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link to the Business Rule stage. Since only one input link is
allowed, the link name is read-only.
v General. Contains an optional description of the link.
v Columns. Contains a grid displaying the column definitions for the data being written to the stage.
This grid has the following columns:
– Column name. The name of the column.
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– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Input column definitions are read-only in the Business Rule stage. You must go back to the stage on
your input link if you want to change the column definitions.

Defining Business Rule Output Data
When you output data from a Business Rule stage, the properties of the output links and the column
definitions of the data are defined on the Outputs page in the Business Rule Stage dialog box.
The Outputs page has the following field and two tabs:
v Output name. The name of the output link. If there is only one output link, this field is read-only. If
there are multiple output links, select the one you want to edit from the list.
v General. Contains an optional description of the link.
v Columns. Contains the column definitions for the data on the output links. This grid has the following
columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to selectively load columns from a table definition in the repository. You can also type
column definitions manually and click Save As... to save them as a table definition, a CFD file, or a
DCLGen file. Click Clear All to start over. For details about editing column definitions, see
Chapter 10, “Editing Column Metadata,” on page 207.

External Routine Stages
These topics describe External Routine stages, which are used to call COBOL subroutines in libraries
external to InfoSphere DataStage MVS Edition. Before you edit an External Routine stage, you must first
define the routine in the InfoSphere DataStage repository.

Working with Mainframe Routines
In mainframe jobs, routines allow you to incorporate complex processing or functionality specific to your
environment in the COBOL programs generated by InfoSphere DataStage. Some possible uses of an
external routine could include a call to a statistical analysis program, an interface to a database type not
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supported by InfoSphere DataStage MVS Edition, or a call to an existing COBOL program that performs
a specialized function. Such a routine can be written in any language that can be called by a COBOL
program, such as COBOL, Assembler, or C.
You create, view, or edit a mainframe routine using the Mainframe Routine dialog box. This dialog box
has three pages for external routines: General, Creator, and Arguments.
There are three buttons in the Mainframe Routine dialog box:
v Close. Closes the Mainframe Routine dialog box. If you have any unsaved changes, you are prompted
to save them.
v Save. Saves the routine.
v Help. Starts the Help system.

Creating an External Routine
You can create an external routine.

Procedure
1. Open the Mainframe Routine dialog box in either of these ways:
v Choose File > New from the main menu or click the New button on the toolbar. The New dialog
box appears. Click the Routines folder, select the Mainframe Routine icon, and click OK.
v Right-click the Routines folder in the repository tree and select New > Mainframe Routine from
the shortcut menu.
2. On the General page, specify general information about the external source routine:
a. Routine name. Type the name (up to 8 characters) of the function or subroutine. In mainframe
terms, the routine name is the name of an entry point in a member of a load or object library. The
library member can also contain other entry points with other names. The routine name must
match the external subroutine name if Dynamic invocation (the default) is selected, and
automatically appears in the External subroutine name field.
b. Type. Select the type of routine, in this case, External Routine. (External source routines are
detailed in “External Source Stages” on page 70. External target routines are detailed in “External
Target Stages” on page 77.)
c. External subroutine name. Type the name of the load or object library member that contains the
subroutine or function entry point. If dynamic invocation is selected, then the external subroutine
name must match the routine name. If the invocation method is static, then the two names need
not match.
d. Invocation method. Select the invocation method for the routine. Dynamic invocation calls the
routine at runtime. Static invocation embeds the routine within the program. Dynamic is the
default.
e. Library path. Type the path name of the library that contains the routine member. JCL extension
variables can be used. This field is required for static invocation.
f. Short description. Type an optional brief description of the routine. The text entered in this field
appears in the External Routine stage editor.
g. Long description. Type an optional detailed description of the routine.
3. Click the Creator page to specify information about the creator and version number of the routine,
including:
a. Vendor. Type the name of the company that created the routine.
b. Author. Type the name of the person who created the routine.
c. Version. Type the version number of the routine. This is used when the routine is imported. The
Version field contains a three-part version number, for example, 2.0.0. The first part of this number
is an internal number used to check compatibility between the routine and the InfoSphere
DataStage system, and cannot be changed. The second part of this number represents the release
number. This number should be incremented when major changes are made to the routine
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definition or the underlying code. The new release of the routine supersedes any previous release.
Any jobs using the routine use the new release. The last part of this number marks intermediate
releases when a minor change or fix has taken place.
d. Copyright. Type the copyright information.
4. Click the Arguments page to define routine arguments. Arguments are optional for mainframe
external routines. There are two ways to define routine arguments:
v To load arguments from an existing routine, click Load... .
v To create a new argument, type directly in the Arguments page grid or, if you need to specify
COBOL attributes, open the Edit Routine Argument Meta Data dialog box in either of these ways:
– Right-click in the column area and select Edit row... from the shortcut menu.
– Press Ctrl-E.
The top pane of the Edit Routine Argument Meta Data dialog box contains the same fields that
appear on the Arguments grid. Specify the following information for each argument you want to
define:
– Argument name. Type the name of the argument to be passed to the routine.
– I/O type. Select the direction to pass the data. There are three options:
Input. A value is passed from the data source to the external routine. The value is mapped to an
input row element.
Output. A value is returned from the external routine to the stage. The value is mapped to an
output column.
Both. A value is passed from the data source to the external routine and returned from the
external routine to the stage. The value is mapped to an input row element, and later mapped to
an output column.
– Native type. Select the native data type of the argument value from the list.
– Length. Type a number representing the length or precision of the argument.
– Scale. If the argument is numeric, type a number to define the number of digits to the right of
the decimal point.
– Description. Type an optional description of the argument.
The bottom pane of the Edit Routine Argument Meta Data dialog box displays the COBOL page
by default. Use this page to specify any required COBOL information for the mainframe
argument:
– Usage. Select the COBOL USAGE clause from the list. This specifies which COBOL format the
column will be read in. These formats map to the formats in the Native type field, and changing
one will normally change the other. Possible values are:
COMP. Used with BINARY native types.
COMP-1. Used with single-precision FLOAT native types.
COMP-2. Used with double-precision FLOAT native types.
COMP-3. Packed decimal, used with DECIMAL native types.
COMP-5. Used with NATIVE BINARY native types.
DISPLAY. Zoned decimal, used with DISPLAY_NUMERIC or CHARACTER native types.
DISPLAY-1. Double-byte zoned decimal, used with GRAPHIC_G or GRAPHIC_N.
– Sign indicator. Select Signed or blank from the list to specify whether the argument can be
signed or not. The default is Signed for numeric data types and blank for all other types.
– Sign option. If the argument is signed, select the location of the sign in the data from the list.
Choose from the following:
LEADING. The sign is the first byte of storage.
TRAILING. The sign is the last byte of storage.
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LEADING SEPARATE. The sign is in a separate byte that has been added to the beginning of
storage.
TRAILING SEPARATE. The sign is in a separate byte that has been added to the end of storage.
The LEADING SEPARATE or TRAILING SEPARATE options will increase the storage length of
the column by one byte.
– Sync indicator. Select SYNC or blank from the list to indicate whether the argument is a
COBOL-SYNCHRONIZED clause or not. The default is blank.
– Storage length. Gives the storage length in bytes of the argument as defined. This field is
derived and cannot be edited.
– Picture. Gives the COBOL PICTURE clause, which is derived from the argument definition and
cannot be edited.
The buttons at the bottom of the Edit Routine Argument Meta Data dialog box allow you to
continue adding or editing arguments, or to save and close. The buttons are:
– < Previous and Next >. Displays the metadata in the previous or next argument. These buttons
are available only when a previous or next argument exists. If there are unsaved changes to the
current argument, you are prompted to save them before continuing.
– Close. Closes the Edit Routine Argument Meta Data dialog box. If you have any unsaved
changes, you are prompted to save them.
– Apply. Saves changes to the current argument.
– Reset. Removes all changes made to the argument since the last time you applied changes.
– Help. Starts the Help system.
5. When you are finished, click Save in the Mainframe Routine dialog box. You are prompted to specify
the folder path in the repository where the routine definition will be saved.

Viewing and Editing a Routine
About this task
You can view and edit a subroutine definition in the Mainframe Routine dialog box. Open this dialog box
in one of the following ways:
v Double-click the routine in the repository tree.
v Select the routine in the repository tree and choose Repository > Properties from the main menu.
v Right-click the routine in the repository tree and choose Properties from the shortcut menu.
You can edit any of the fields and options in the Mainframe Routine dialog box. If you make any
changes, be sure to save them before closing this dialog box.

Copying a Routine
About this task
You can copy a routine in two ways:
v Select the routine in the repository tree and choose Repository > Create copy.
v Right-click the routine in the repository tree and select Create copy from the shortcut menu.
The routine is copied and a new routine is created in the same folder of the repository tree. By default,
the name of the copy is CopyOfXXX, where XXX is the name of the chosen routine. Use the edit box to
rename the copy immediately.

Renaming a Routine
About this task
You can rename an existing routine in several ways:

Chapter 5. Mainframe Job Stages

107

v Double-click the routine in the repository tree to open the Mainframe Routine dialog box. Edit the
Routine name field, click Save, then click Close.
v Select the routine in the repository tree and click again. In the edit box, type a new name or edit the
existing one. Save the name by pressing Enter or by clicking outside the edit box.
v Right-click the routine and select Rename from the shortcut menu. In the edit box, type a new name or
edit the existing one. Save the name by pressing Enter or clicking outside the edit box.
v Select the routine in the repository tree and choose Repository > Rename. In the edit box, type a new
name or edit the existing one. Save the name by pressing Enter or by clicking outside the edit box.
If you rename a routine and the invocation method is dynamic, the external subroutine name is
automatically set to match the routine name.

Using an External Routine Stage
External Routine stages have only one input link and one output link. Input links can come from source
stages or processing stages, and output links can be to processing stages or target stages. Each External
Routine stage can call only one routine.
When you edit the External Routine stage, the External Routine Stage dialog box appears. This dialog box
has three pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has a
General tab which contains an optional description of the stage.
v Inputs. Specifies the column definitions for the data input link.
v Outputs. Specifies the column definitions for the data output link. This page has a Rtn. Mapping tab
where you define the mappings between input columns and input arguments. The Mapping tab is
where you define the mappings between input columns, output arguments, and output columns.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining External Routine Input Data
Data to be sent through this stage is passed from a previous stage in the job design and into the External
Routine stage via a single input link. The properties of this link and the column definitions of the data
are described on the Inputs page in the External Routine Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link to the External Routine stage. Since only one input link is
allowed, the link name is read-only.
v General. Contains an optional description of the link.
v Columns. Displayed by default. Contains a grid displaying the column definitions for the data being
written to the stage:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
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Input column definitions are read-only in the External Routine stage. You must go back to the stage
on your input link if you want to change the column definitions.

Defining External Routine Output Data
When you output data from an External Routine stage, the properties of the output link and the column
definitions of the data are defined on the Outputs page in the External Routine Stage dialog box.
The Outputs page has the following field and four tabs:
v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Displayed by default. This tab allows you to select the routine to be called and type an
optional description of the link. It contains the following fields:
– Routine name. The name of the routine. The list displays all routines saved in the folder you
selected.
– Pass arguments as record. Select this check box to pass the routine arguments as a single record,
with everything at the 01 level.
– Routine description. Displays a read-only description of the routine as defined in the repository.
v Rtn. Mapping. Specifies the mapping of input columns to input arguments. This tab is made available
when you select a routine on the General tab. For details about defining routine mappings, see
“Mapping Routines and Data.”
v Mapping. Specifies the mapping of input columns and output arguments to output columns. See
“Mapping Routines and Data” for details about defining mappings.
v Columns. Contains the column definitions for the data on the output link. This grid has the following
columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load columns from a table definition in the repository, or type column definitions
manually and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click
Clear All to start over. For details about editing column definitions, see Chapter 10, “Editing
Column Metadata,” on page 207.

Mapping Routines and Data
There are two sets of mappings that can be performed in External Routine stages. The first set defines the
mappings from input columns to input arguments, and is performed on the Rtn. Mapping tab. The
second set defines the mappings from input columns and output arguments to output columns, and is
performed on the Mapping tab.
The Rtn. Mapping tab is available only if the routine you select on the General tab contains arguments
with an I/O type of Input or Both. This page is divided into two panes, the left for input columns (and
any job parameters that have been defined), and the right for input arguments, and shows the
relationships between them.
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The Mapping tab is similarly divided into two panes. The left pane displays input columns, routine
arguments that have an I/O type of Output or Both, and any job parameters that have been defined. The
right pane displays output columns. When you simply want to move values that are not used by the
external routine through the stage, you map input columns to output columns. As you define the
mappings, relationship lines appear between the two panes.
If the Column push option is selected in Designer client options, and you click OK on the Stage page
without editing the Mapping tab, InfoSphere DataStage automatically creates output columns and defines
mappings from the input columns to the output columns. Any output arguments that exist are not
mapped.
On both the Rtn. Mapping and Mapping tabs you can drag the splitter bar between the two panes to
resize them relative to one another. Vertical scroll bars allow you to scroll the view up or down the
column lists, as well as up or down the panes.
You can define mappings from the Rtn. Mapping and Mapping tabs in two ways:
v drag-and-drop. This specifies that the argument or column is directly derived from an input column or
argument. See “Using drag-and-drop” for details.
v Auto-Match. This automatically sets output column derivations from their matching input columns,
based on name or location. See “Using Column Auto-Match” on page 111 for details.
Derivation expressions cannot be specified on the Rtn. Mapping or Mapping tabs. If you need to
perform data transformations, you must include a Transformer stage elsewhere in your job design.
As mappings are defined, the output column names change from red to black. A relationship line is
drawn between the input column and input argument on the Rtn. Mapping tab, or between the input
column or output argument and the output column on the Mapping tab.
Find Facility:
About this task
If you are working on a complex job, there is a find facility to help you locate a particular column or
expression.
To use the find facility:
Procedure
1. Open the Find dialog box in either of these ways:
v Click Find on the Mapping tab.
v Select Find from the link shortcut menu.
2. Click one of the following tabs:

3.
4.
5.
6.

v Column Names. Allows you to find a particular column.
v Expression Text. Allows you to locate the occurrence of a particular string within an output column
expression.
Select a link from the Link name list. (You can search for expression text only on the output link.)
Type the text to search for in the Find what field.
Optional: Select the Match case and Match whole word check boxes to narrow your search.
Optional: On the Expression Text tab, select Empty Expression to search for the next empty
expression.

Using drag-and-drop:
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About this task
A simple way to specify mappings is to use the drag-and-drop functionality on the Rtn. Mapping and
Mapping tabs. You can drag columns from your input link to your output link to define each mapping.
To use drag-and-drop:
Procedure
1. Click the source cell to select it.
2. Click the selected cell again and, without releasing the mouse button, drag the mouse pointer to the
desired location within the target link.
3. Release the mouse button to drop the selected cell.
Results
You can also click the title bar displaying the name of the link and, without releasing the mouse button,
drag the mouse pointer to the first Derivation cell within the target link. This will map all input columns
to the output columns based on location.
Using Column Auto-Match:
About this task
The column auto-match facility allows you to automatically set columns on an output link to be derived
from matching columns on an input link.
To use auto-match:
Procedure
1. Click AutoMap on the Mapping tab to open the Column Auto-Match dialog box.
2. Click Location match or Name match from the Match type area.
If you click Location match, this will set output column derivations to the input link columns in the
equivalent positions. It starts with the first input link column going to the first output link column,
and works its way down until there are no more input columns left.
If you click Name match, you need to specify further information for the input and output columns
as follows:
v Input columns:
– Match all columns or Match selected columns. Click one of these to specify whether all input
link columns should be matched, or only those currently selected on the input link.
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Output columns:
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Ignore case. Select this check box to specify that case should be ignored when matching names. The
setting of this also affects the Ignore prefix and Ignore suffix settings. For example, if you specify
that the prefix IP will be ignored and select Ignore case, then both IP and ip will be ignored.
3. Click OK to proceed with the auto-matching.
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Note: Auto-matching does not take into account any data type incompatibility between matched
columns; the derivations are set regardless.

FTP Stages
These topics describe FTP (file transfer protocol) stages, which are used to transfer files to another
machine. This stage collects the information required to generate the job control language (JCL) to
perform the file transfer. File retrieval from the target machine is not supported.

Using an FTP Stage
The FTP stage is a post-processing stage that can have one or more input links. The input links can come
from Fixed-width Flat File stages, DB2 Load Ready stages, or Delimited Flat File stages. FTP stages do
not have output links.
When you edit an FTP stage, the FTP Stage dialog box appears. This dialog box has the following pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has a
General tab that allows you to specify the attributes of the target machine where your file will be
transferred. See “Specifying Target Machine Attributes” below for details.
v Inputs. Specifies the file name of the data input link, as well as the destination file name and platform
type.
Click OK to close this dialog box. Changes are saved when you save the job.

Specifying Target Machine Attributes
The General tab on the Stage page allows you to define the attributes of the target machine. It contains
the following fields:
v Machine Profile. A configured name that identifies the machine connection. Select a machine name
from the list. This list box contains all the machine profiles defined in the Machine Profiles folder of
the repository. For details about creating new machine profiles, see “Creating a Machine Profile” on
page 164.
If you change the information for an existing machine profile, the changes are used only in the FTP
stage and are not propagated back to the saved profile.
v File exchange method. The method of file transfer to be used. Select FTP (the default) or
Connect:Direct.
v Host name/IP address. The IP address or a fully qualified host name for the target machine. This field
is automatically filled in if you select an existing machine profile.
v Port. The network port ID for the FTP or Connect:Direct connection. The default port is 21 for FTP or
1364 for Connect:Direct.
v User name. The user name or account to use for target system login. This field is automatically filled
in if you select an existing machine profile.
v Password. The password associated with the user name for target system login. This field is
automatically filled in if you select an existing machine profile.
v Transfer mode. The file transfer mode. The transfer mode must match the characteristic of the input
data files. All input files must have the same mode, and only one mode can be utilized per transfer.
You can specify your own transfer mode or choose one of the following options, depending on the file
exchange method.
FTP options are:
– Block. Transfers files as a series of data blocks. The blocks are preceded by one or more header
bytes which contain a descriptor code and a count field indicating the total length of the data block.
– Compress. Compresses files before transferring them.
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– Stream. Transfers files as a stream of bytes. There is no restriction on the representation type used;
record structures are allowed.
Connect:Direct options are:
– Compress. Compresses text data or single-character repetitive data before transfer.
– Compress Extended. Searches for repetitive strings of characters in the data and compresses them to
codes. Use this option when line transmission speeds are limited, CPU is available, and data is
repetitive.
v Transfer type. The file transfer type. The transfer type must match the characteristic of the input data
files. All input files must have the same type, and only one type can be utilized per transfer. You can
specify your own transfer type or choose one of the following options:
– ASCII. Used for text files.
– EBCDIC. Used for EBCDIC (Extended Binary Coded Decimal Interchange Code) data, which is
generally found in IBM mainframe environments.
– Binary. Used for nontext files such as program files and images.
v FTP Service. The FTP service type. Active FTP service is for an active connection, which is generally
used when command processing is required. This is the default. The Passive option is available if you
need to establish a connection through a firewall that does not allow inbound communication.
v Description. An optional description of the stage.

Defining FTP Input Data
Data from the input links is passed from previous source stages in the job design to the FTP stage. The
properties of these links, the target platform, and the source and destination file names are defined on the
Inputs page in the FTP Stage dialog box.
The Inputs page has the following field and tab:
v Input name. The name of the input link to the FTP stage. Select the link you want to edit from the
Input name list. This list displays all the input links to the FTP stage. If there is only one input link,
the field is read-only.
v General. Displays the input and destination file names, the target platform, and an optional description
of the link.
– The File name field is read-only and displays the name of the file being passed from the previous
stage in the job design.
– The Destination file name field is where you specify the name of the file on the target system.
– The Transfer to field allows you to select the type of machine where data will be transferred. The
default is Mainframe.

Join Stages
These topics describe Join stages, which are used to join data from two input tables and produce one
output table. You can use the Join stage to perform inner joins, outer joins, or full joins.
v An inner join returns only those rows that have matching column values in both input tables. The
unmatched rows are discarded.
v An outer join returns all rows from the outer table even if there are no matches. You define which of
the two tables is the outer table.
v A full join returns all rows that match the join condition, plus the unmatched rows from both input
tables.
Unmatched rows returned in outer joins or full joins have NULL values in the columns of the other link.
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Using a Join Stage
Join stages have two input links and one output link. The two input links must come from source stages.
The joined data can be output to another processing stage or a passive stage.
When you edit a Join stage, the Join Stage dialog box appears. This dialog box has three pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has a
General tab where you define the join specifications and type an optional description of the stage.
In the Join type area, you can select to perform an inner join, an outer join, or a full join. Inner join is
the default option.
In the Outer link list, select the input link that will be the outer table if you are performing an outer
join. The columns from this link, called the primary link, are preserved in the join. If you are
performing an inner join, the other (nonselected) link, called the secondary link, is the inner table
where the join technique is applied.
The Join technique list is where you specify the algorithm for performing the join. Four options are
available:
– Auto. The join technique is automatically chosen by InfoSphere DataStage based on the information
you specify in the stage. This is the default option.
– Hash. An in-memory hash table is built on the secondary input table (that is, the input link not
selected as the outer link). This technique requires an equality join condition, where a column (or an
expression based on a column) from the primary link equals a column (or an expression based on a
column) from the secondary link. Compound equality join conditions are allowed.
For information about hash table memory requirements, see “Calculating Hash Table Memory
Requirements” on page 237.
– Nested. Each row of the secondary input table is read sequentially to determine if the column value
matches that of the primary input table.
– Two File Match. The primary and secondary input tables are read sequentially one time to
determine if column values match. Both input tables must be sorted on the matching keys, and the
primary table cannot have duplicates.
This technique requires an equality join condition, where a column (or an expression based on a
column) from the primary link equals a column (or an expression based on a column) from the
secondary link. A compound equality join condition is allowed.
If the join condition contains an expression, the input tables must be sorted on the expression result.
For example, if a SUBSTRING expression is specified, the input tables must be sorted on the
SUBSTRING portion of the column.
v Inputs. Specifies the column definitions for the data input links.
v Outputs. Specifies the column definitions for the data output link. This page has a Join Condition tab
where you define the join condition. The Mapping tab is used to define the mappings between input
and output columns.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Join Input Data
Data from the two input links is passed from previous source stages in the job design to the Join stage.
The properties of these links and the column definitions of the data are described on the Inputs page in
the Join Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link to the Join stage. Select the link you want to edit from the
Input name list. This list displays the two input links to the Join stage.
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v General. Shows the input type and contains an optional description of the link. The Input type field is
read-only and indicates whether the input link is the outer (primary) link or the inner (secondary) link,
as specified on the Stage page.
v Columns. Displayed by default. Contains a grid displaying the column definitions for the data being
written to the stage. This grid has the following columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Input column definitions are read-only in the Join stage. You must go back to the stages on your
input links if you want to change the column definitions.

Defining Join Output Data
When you output data from a Join stage, the properties of the output link and the column definitions of
the data are defined on the Outputs page in the Join Stage dialog box.
The Outputs page has the following field and four tabs:
v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Contains an optional description of the link.
v Join Condition. Displayed by default. Contains the join condition. See “Defining the Join Condition”
on page 116 for details about specifying the join condition.
v Mapping. Specifies the mapping of input columns to output columns. See “Mapping Data” on page
116 for details about defining mappings.
v Columns. Contains the column definitions for the data on the output link. This grid has the following
columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load columns from a table definition in the repository, or type column definitions
manually and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click
Clear All to start over. For details about editing column definitions, see Chapter 10, “Editing
Column Metadata,” on page 207.
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Defining the Join Condition
The Join Condition tab is where you to specify how to join the data from the two input tables, such as:
Table1.SALES_REP_ID = Table2.SLS_REP_NBR

Create an expression using the Join Condition grid:
v (. Select an opening parenthesis if needed.
v Column. Select a column from the list. The list displays the column names from both input links.
v Op. Select an operator or a logical function from the list. For definitions of these items, see Chapter 7,
“Programmer's Reference,” on page 169.
v Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these columns are editable. As you build the join condition, it appears in the Join condition field.
Join conditions must be Boolean expressions that return TRUE or FALSE. To validate the expression, click
Verify. If errors are found, you must either correct the expression, click Clear All to start over, or cancel.
You cannot save an incorrect join condition.
The order of operators in expressions is determined by SQL standards. After you verify a join condition,
any redundant parentheses might be removed. For details, see “Operators” on page 180.

Mapping Data
The Mapping tab is used to define the mappings between input and output columns being passed
through the Join stage.
You can bypass this step if the Column push option is selected in Designer client options. Output
columns are automatically created for each output link, and mappings between corresponding input and
output columns are defined, when you click OK to exit the stage.
This tab is divided into two panes, the left for the input links (and any job parameters that have been
defined) and the right for the output link, and it shows the columns and the relationships between them.
You can drag the splitter bar between the two panes to resize them relative to one another. Vertical scroll
bars allow you to scroll the view up or down the column lists, as well as up or down the panes.
You can define column mappings from the Mapping tab in two ways:
v drag-and-drop. This specifies that an output column is directly derived from an input column. See
“Using drag-and-drop” on page 117 for details.
v Auto-Match. This automatically sets output column derivations from their matching input columns,
based on name or location. See “Using Column Auto-Match” on page 117 for details.
Derivation expressions cannot be specified on the Mapping tab. If you need to perform data
transformations, you must include a Transformer stage elsewhere in your job design.
As mappings are defined, the output column names change from red to black. A relationship line is
drawn between the input column and the output column.
Find Facility:
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About this task
If you are working on a complex job, there is a find facility to help you locate a particular column or
expression.
To use the find facility:
Procedure
1. Open the Find dialog box in either of these ways:
v Click Find on the Mapping tab.
v Select Find from the link shortcut menu.
2. Click one of the following tabs:
v Column Names. Allows you to find a particular column.
v Expression Text. Allows you to locate the occurrence of a particular string within an output column
expression.
3. Select a link from the Link name list. (You can search for expression text only on the output link.)
4. Type the text to search for in the Find what field.
5. Optional: Select the Match case and Match whole word check boxes to narrow your search.
6. Optional: On the Expression Text tab, select Empty Expression to search for the next empty
expression.
Using drag-and-drop:
About this task
A simple way to specify mappings is to use the Mapping tab's drag-and-drop functionality. You can drag
columns from your input link to your output link to define each mapping.
To use drag-and-drop:
Procedure
1. Click the source cell to select it.
2. Click the selected cell again and, without releasing the mouse button, drag the mouse pointer to the
desired location within the target link.
3. Release the mouse button to drop the selected cell.
Results
You can also click the title bar displaying the name of the link and, without releasing the mouse button,
drag the mouse pointer to the first Derivation cell within the target link. This will map all input columns
to the output columns based on location.
Using Column Auto-Match:
About this task
The column auto-match facility allows you to automatically set columns on an output link to be derived
from matching columns on an input link.
To use auto-match:
Procedure
1. Click AutoMap on the Mapping tab to open the Column Auto-Match dialog box.
2. Click Location match or Name match from the Match type area.
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If you click Location match, this will set output column derivations to the input link columns in the
equivalent positions. It starts with the first input link column going to the first output link column,
and works its way down until there are no more input columns left.
If you click Name match, you need to specify further information for the input and output columns
as follows:
v Input columns:
– Match all columns or Match selected columns. Click one of these to specify whether all input
link columns should be matched, or only those currently selected on the input link.
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Output columns:
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Ignore case. Select this check box to specify that case should be ignored when matching names. The
setting of this also affects the Ignore prefix and Ignore suffix settings. For example, if you specify
that the prefix IP will be ignored and select Ignore case, then both IP and ip will be ignored.
3. Click OK to proceed with the auto-matching.
Note: Auto-matching does not take into account any data type incompatibility between matched
columns; the derivations are set regardless.

Join Examples
Join stages allow you to perform three types of joins: inner joins, outer joins, and full joins. The following
example illustrates the different results produced by each type of join.
Suppose you have a table containing information about sales orders. Each sales order includes the
customer identification number, product, and order total, as shown in Table 13.
Table 13. Sales Orders
Customer ID

Product

Order Total

10

Paint

$25

20

Primer

$15

30

Paintbrushes

$10

30

Rollers

$10

40

Wallpaper

$50

50

Masking Tape

$5

90

Drop cloths

$15

Another table contains detailed customer information, as shown in Table 14.
Table 14. Customers
Customer ID

Customer Name

City

State

10

AAA Painting

San Jose

California

20

ABC Paint Pros

Portland

Oregon
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Table 14. Customers (continued)
Customer ID

Customer Name

City

State

30

Mural Art

Sacramento

California

40

Ocean Design Co.

Monterey

California

50

Smith & Son Painters

Reno

Nevada

60

West Coast Interiors

San Francisco

California

You specify a join condition that matches the two tables on customer identification number and returns
the customer and sales order information.
An inner join returns the results shown in Table 15. Since the last row in each table is unmatched, both
are discarded.
Table 15. Inner Join Result
Customer Name

City

State

Product

Order Total

AAA Painting

San Jose

California

Paint

$25

ABC Paint Pros

Portland

Oregon

Primer

$15

Mural Art

Sacramento

California

Paintbrushes

$10

Mural Art

Sacramento

California

Rollers

$10

Ocean Design Co.

Monterey

California

Wallpaper

$50

Smith & Son Painters

Reno

Nevada

Masking Tape

$5

An outer join, where the customer table is the outer link, returns the six matching rows as well as the
unmatched rows from the customer table, shown in Table 16. Notice that the unmatched rows contain
null values in the product and order total columns.
Table 16. Outer Join Result
Customer Name

City

State

Product

Order Total

AAA Painting

San Jose

California

Paint

$25

ABC Paint Pros

Portland

Oregon

Primer

$15

Mural Art

Sacramento

California

Paintbrushes

$10

Mural Art

Sacramento

California

Rollers

$10

Ocean Design Co.

Monterey

California

Wallpaper

$50

Smith & Son Painters

Reno

Nevada

Masking Tape

$5

West Coast Interiors

San Francisco

California

(Null)

(Null)

By contrast, a full join returns all the rows that match the join condition, as well as unmatched rows from
both input links. The results are shown in Table 17.
Table 17. Full Join Result
Customer Name

City

State

Product

Order Total

AAA Painting

San Jose

California

Paint

$25

ABC Paint Pros

Portland

Oregon

Primer

$15

Mural Art

Sacramento

California

Paintbrushes

$10

Mural Art

Sacramento

California

Rollers

$10
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Table 17. Full Join Result (continued)
Customer Name

City

State

Product

Order Total

Ocean Design Co.

Monterey

California

Wallpaper

$50

Smith & Son Painters

Reno

Nevada

Masking Tape

$5

(Null)

(Null)

(Null)

Drop cloths

$15

West Coast Interiors

San Francisco

California

(Null)

(Null)

Link Collector Stages
These topics describe Link Collector stages, which are used to combine data from multiple input links
into a single output link. The number of columns on the output link must be the same as the number of
columns on each of the input links. Data from the input links is appended to the output link, preserving
the number of columns and increasing the number of rows.
In mainframe Link Collector stages you do not specify a collection algorithm as you do in server Link
Collector stages. If you want to collect data using the sort/merge method provided in server jobs, use a
Join stage instead of a Link Collector stage and specify the Two File Match join technique. In mainframe
jobs there is no equivalent to the Round-Robin data collection method provided in server jobs.

Using a Link Collector Stage
Link Collector stages have two or more input links and one output link. Input links can come from
source stages or processing stages, and the output link can be to another processing stage or a target
stage. Circular relationships between Link Collector stages and other stages in a job design are not
allowed.
When you edit a Link Collector stage, the Link Collector Stage dialog box appears. This dialog box has
three pages:
v Stage. Displays the stage name, which can be edited. This page has a General tab where you can type
an optional description of the stage.
v Inputs. Specifies the column definitions for the data input links.
v Outputs. Specifies the column definitions for the data output link.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Link Collector Input Data
Link Collector stages can have multiple input links. The properties of these links and the column
definitions of the data are described on the Inputs page in the Link Collector stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link. Select the link you want to edit from the Input name list.
This list displays all of the input links to the Link Collector stage.
v General. Contains an optional description of the link.
v Columns. Contains a grid displaying the column definitions for the data on the input links. The grid
has the following columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
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– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Input column definitions are read-only in the Link Collector stage. You must go back to the stages
on your input links if you want to change the column definitions.
Note that the number of columns on each input link must be the same and must match the number
of columns on the output link.

Defining Link Collector Output Data
When you output data from a Link Collector stage, the properties of the output link and the column
definitions of the data are defined on the Outputs page in the Link Collector Stage dialog box.
The Outputs page has the following field and two tabs:
v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Contains an optional description of the link.
v Columns. Contains a grid displaying the column definitions for the data on the output link. This grid
has the following columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load columns from a table definition in the repository, or type column definitions
manually and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click
Clear All to start over.
Note that the number of columns on the output link must be identical to the number of columns on
each of the input links. For details about editing column definitions, see Chapter 10, “Editing
Column Metadata,” on page 207.

Mapping Data
In Link Collector stages, input columns are automatically mapped to output columns based on position.
Data types between input and output columns must be convertible, and data conversion is automatic.
If the Column push option is selected in Designer client options and the output link columns do not
exist, then the output columns are automatically created from the columns on the first input link when
you click OK to exit the stage.
The order in which the input links are processed by the Link Collector stage depends on the job design.
The stage typically sends all rows of one input link down the output link before processing another input
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link. Since the stage does not store input rows, it sends an input row down the output link as soon as the
row is received. Therefore the order in which rows are sent down the output link depends on when the
rows arrive on the input links.
End-of-data rows are treated as normal input rows. If there are end-of-data rows on multiple input links,
they are sent down the output link in the order they come in. Therefore an end-of-data row is not
necessarily the last row sent down the output link.
If some of a Link Collector stage's input links can be traced back to a common Transformer stage without
any passive stage in between, then the order in which these input link rows are processed depends on
the output link ordering in the Transformer stage.

Lookup Stages
These topics describe Lookup stages, which allow you to perform table lookups. A singleton lookup
returns the first single row that matches the lookup condition. A cursor lookup returns all rows that
match the lookup condition. InfoSphere DataStage also allows conditional lookups, which are performed
only when a pre-lookup condition is true.

Using a Lookup Stage
Lookup stages have two input links and one output link. The primary input link can come from a
processing stage or a source stage. The other input link, called the reference link, must come from a
source stage. The reference link appears on the Designer client canvas with a dotted line to distinguish it
from the primary link. Output data can be sent to another processing stage or a target stage.
When you edit a Lookup stage, the Lookup Stage dialog box appears. This dialog box has three pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has three
tabs:
– General. This is where you define the lookup specifications and type an optional description of the
stage.
The Lookup type area lets you choose to perform a singleton or a cursor lookup. Singleton Lookup
is the default.
The Lookup technique list is where you select the Auto or Hash lookup technique. Auto lookups
allow InfoSphere DataStage to choose the technique based on the information you specify. This is
the default option. If you select Auto and the reference link is a Relational or Teradata Relational
stage, InfoSphere DataStage passes the lookup condition to the database for processing. If the
reference link is a Complex Flat File stage with a VSAM_KSDS file structure, it performs a serial
read of the file, using the VSAM START command where possible to reduce the number of records
read. In all other cases, selecting Auto results in a hash lookup if possible or else a serial read of the
file.
Hash lookups are performed using an in-memory hash table built on the reference link. This
technique can only be used with an equality lookup condition, where a field from the primary link
equals a field from the reference link. For information about hash table memory requirements, see
“Calculating Hash Table Memory Requirements” on page 237.
– Pre-lookup Condition. This is where you specify a pre-lookup condition for conditional lookups.
See “Performing Conditional Lookups” on page 123 for details about defining a pre-lookup
condition.
– Lookup Condition. Contains the lookup expression. See “Defining the Lookup Condition” on page
123 for details about specifying the lookup condition.
v Inputs. Specifies the column definitions for the data input links.
v Outputs. Specifies the column definitions for the data output link and the mappings between input
and output columns.
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Click OK to close this dialog box. Changes are saved when you save the job.

Performing Conditional Lookups
Conditional lookups are based on a pre-lookup condition that must be met before a lookup is performed.
They can improve the performance of a job by allowing you to skip the execution of a lookup if the
lookup data is not needed or is already available. See “Lookup Examples” on page 127 for details about
specifying conditional lookups to meet your requirements.
If no pre-lookup condition is specified in a Lookup stage, then the lookup is always performed for each
row of the primary input link.
Pre-lookup conditions are specified on the Pre-lookup Condition tab on the Stage page. In the Action if
pre-lookup condition fails list, you specify how to handle data that does not meet the pre-lookup
condition. There are three options:
v Skip Row. Prevents the row from being output from the stage.
v Use Previous Values. Sends the values from the previous lookup down the output link. This option is
only available for singleton lookups. If the previous lookup failed or there was no previous lookup,
then the action taken depends on your selection in the Action if lookup condition fails field on the
Lookup Condition tab. See Table 26 on page 129 for more information about the results produced by
various option combinations.
v Null Fill. Sends the row down the output link with the lookup values set to NULL if the pre-lookup
condition fails.
The default value is blank in the Action if pre-lookup condition fails field. This is allowed only if no
pre-lookup condition is specified.
You define the pre-lookup condition using the following fields on the expression grid:
v (. Select an opening parenthesis if needed.
v Column. Select a column from the primary input link, a job parameter, or the ENDOFDATA variable
from the list. ENDOFDATA refers to the value from the primary input link. (See “ENDOFDATA” on
page 183 for more information about using this variable).
v Op. Select an operator or a logical function from the list. For definitions of these items, see Chapter 7,
“Programmer's Reference,” on page 169.
v Column/Value. Select a column from the primary input link or double-click in the cell to type a value.
Character values must be enclosed in single quotation marks.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these columns are editable. The pre-lookup condition can reference job parameters, constants, and
columns of the primary input link, but cannot use columns of the reference link. As you build the
expression, it appears in the Pre-lookup condition field.
Lookup conditions must be Boolean expressions that return TRUE or FALSE. To validate the expression,
click Verify. An error message will appear if errors are found. To start over, click Clear All.
The order of operators in expressions is determined by SQL standards. After you verify a lookup
condition, any redundant parentheses might be removed. For details, see “Operators” on page 180.

Defining the Lookup Condition
The Lookup stage gives you flexibility in creating your job design. You can perform singleton or cursor
lookups, as well as conditional lookups, depending on your requirements. You can also use the Lookup
stage to validate the accuracy of input data.
Chapter 5. Mainframe Job Stages

123

Lookup expressions are defined on the Lookup Condition tab. In the Action if lookup condition fails
list, you select an option for handling a failed lookup. There are three options:
v Skip Row. Skips the row and goes to the next one. This is the default.
v Abort Program. Stops the program.
v Null Fill. Fills the columns of the reference link with null values and continues to the next stage with
the row from the primary link.
You define the lookup condition using the following fields in the expression grid:
v (. Select an opening parenthesis if needed.
v Column. Select a column from the list. The list displays the column names from both input links.
v Op. Select an operator or a logical function from the list. For definitions of these items, see Chapter 7,
“Programmer's Reference,” on page 169.
v Column/Value. Select a column from the list or double-click in the cell to type a value. Character
values must be enclosed in single quotation marks.
v ). Select a closing parenthesis if needed.
v Logical. Select AND or OR from the list to continue the expression in the next row.
All of these columns are editable. As you build the lookup expression, it appears in the Lookup
condition field. Lookup conditions must be Boolean expressions that return TRUE or FALSE. To validate
the expression, click Verify. If errors are found, you must either correct the expression, click Clear All to
start over, or cancel. You cannot save an incorrect lookup condition.
The order of operators in expressions is determined by SQL standards. After you verify a lookup
condition, any redundant parentheses might be removed. For details, see “Operators” on page 180.
Sorting the Reference Link:
If the reference file contains multiple rows that match the lookup condition, you should sort the file
before performing a singleton lookup using the Auto technique. The sort should be based on the columns
used in the lookup condition, as well as any other columns you might need to ensure correct results.
Sorting the reference file is not necessary when using the Hash technique or performing a cursor lookup.

Defining Lookup Input Data
Data from the primary link and the reference link is passed from previous stages in the job design to the
Lookup stage. The properties of these links and the column definitions of the data are described on the
Inputs page in the Lookup Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link to the Lookup stage. Select the link you want to edit from the
Input name list. This list displays the two input links to the Lookup stage.
v General. Shows the input type and contains an optional description of the link. The Input type field is
read-only and indicates whether the input link is the stream (primary) link or the reference link.
v Columns. Displayed by default. Contains a grid displaying the column definitions for the data being
written to the stage:
– Column name. The name of the column.
– SQL type. The SQL data type. See Chapter 8, “Data Type Definitions and Mappings,” on page 185
for details about the data types supported in mainframe jobs.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
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– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Input column definitions are read-only in the Lookup stage. You must go back to the stages on your
input links if you want to change the column definitions.

Defining Lookup Output Data
When you output data from a Lookup stage, the properties of the output link and the column definitions
of the data are defined on the Outputs page in the Lookup Stage dialog box.
The Outputs page has the following field and three tabs:
v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Contains an optional description of the link.
v Mapping. Specifies the mapping of input columns to output columns. See “Mapping Data” for details
about defining mappings.
v Columns. Contains the column definitions for the data being output from the stage. This grid has the
following columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load columns from a table definition in the repository, or type column definitions
manually and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click
Clear All to start over. For details about editing column definitions, see Chapter 10, “Editing
Column Metadata,” on page 207.

Mapping Data
The Mapping tab is used to define the mappings between input and output columns being passed
through the Lookup stage.
You can bypass this step if the Column push option is selected in Designer client options. Output
columns are automatically created for each output link, and mappings between corresponding input and
output columns are defined, when you click OK to exit the stage.
This tab is divided into two panes, the left for the input links (and any job parameters that have been
defined) and the right for the output link, and it shows the columns and the relationships between them.
You can drag the splitter bar between the two panes to resize them relative to one another. Vertical scroll
bars allow you to scroll the view up or down the column lists, as well as up or down the panes.
You can define column mappings from the Mapping tab in two ways:
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v drag-and-drop. This specifies that an output column is directly derived from an input column. See
“Using drag-and-drop” for details.
v Auto-Match. This automatically sets output column derivations from their matching input columns,
based on name or location. See “Using Column Auto-Match” on page 127 for details.
Derivation expressions cannot be specified on the Mapping tab. If you need to perform data
transformations, you must include a Transformer stage elsewhere in your job design.
As mappings are defined, the output column names change from red to black. A relationship line is
drawn between the input column and the output column.
Find Facility:
About this task
If you are working on a complex job, there is a find facility to help you locate a particular column or
expression.
To use the find facility:
Procedure
1. Open the Find dialog box in either of these ways:
v Click Find on the Mapping tab.
v Select Find from the link shortcut menu.
2. Click one of the following tabs:
v Column Names. Allows you to find a particular column.
v Expression Text. Allows you to locate the occurrence of a particular string within an output column
expression.
3. Select a link from the Link name list. (You can search for expression text only on the output link.)
4. Type the text to search for in the Find what field.
5. Optional: Select the Match case and Match whole word check boxes to narrow your search.
6. Optional: On the Expression Text tab, select Empty Expression to search for the next empty
expression.
Using drag-and-drop:
About this task
A simple way to specify mappings is to use the Mapping tab's drag-and-drop functionality. You can drag
columns from your input link to your output link to define each mapping.
To use drag-and-drop:
Procedure
1. Click the source cell to select it.
2. Click the selected cell again and, without releasing the mouse button, drag the mouse pointer to the
desired location within the target link.
3. Release the mouse button to drop the selected cell.
Results
You can also click the title bar displaying the name of the link and, without releasing the mouse button,
drag the mouse pointer to the first Derivation cell within the target link. This will map all input columns
to the output columns based on location.
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Using Column Auto-Match:
About this task
The column auto-match facility allows you to automatically set columns on an output link to be derived
from matching columns on an input link.
To use auto-match:
Procedure
1. Click AutoMap on the Mapping tab to open the Column Auto-Match dialog box.
2. Click Location match or Name match from the Match type area.
If you click Location match, this will set output column derivations to the input link columns in the
equivalent positions. It starts with the first input link column going to the first output link column,
and works its way down until there are no more input columns left.
If you click Name match, you need to specify further information for the input and output columns
as follows:
v Input columns:
– Match all columns or Match selected columns. Click one of these to specify whether all input
link columns should be matched, or only those currently selected on the input link.
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Output columns:
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Ignore case. Select this check box to specify that case should be ignored when matching names. The
setting of this also affects the Ignore prefix and Ignore suffix settings. For example, if you specify
that the prefix IP will be ignored and select Ignore case, then both IP and ip will be ignored.
3. Click OK to proceed with the auto-matching.
Note: Auto-matching does not take into account any data type incompatibility between matched
columns; the derivations are set regardless.

Lookup Examples
Table lookups allow you to take a value that is a code in your source table and look up the information
associated with that code in a reference table. For example, suppose you have a table containing
information about products. For each product there is a supplier code. You have another table with
supplier information. In this case you could use a table lookup to translate the supplier code into a
supplier name.
Table 18 provides a simple example of supplier codes on the primary link, and Table 19 on page 128
provides a simple example of the supplier information on the reference link:
Table 18. Primary Link
Product

Supplier Code

Paint

A

Primer

B
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Table 18. Primary Link (continued)
Product

Supplier Code

Paintbrushes

D

Wallpaper

E

Table 19. Reference Link
Supplier Code

Supplier Name

A

Anderson

B

Brown, C.

B

Brown, M.

C

Carson

E

Edwards

A cursor lookup using the Auto technique and Skip Row option produces the results shown in Table 20.
Table 20. Auto Cursor Lookup Result
Product

Supplier Name

Paint

Anderson

Primer

Brown, C.

Primer

Brown, M.

Wallpaper

Edwards

A cursor lookup using the Hash technique and Skip Row option produces the results shown in either
Table 21 or Table 22, depending on how the hash table is built.
Table 21. Hash Cursor Lookup Result (A)
Product

Supplier Name

Paint

Anderson

Primer

Brown, C.

Primer

Brown, M.

Wallpaper

Edwards

Table 22. Hash Cursor Lookup Result (B)
Product

Supplier Name

Paint

Anderson

Primer

Brown, M.

Primer

Brown, C.

Wallpaper

Edwards

A singleton lookup using the Auto technique and Skip Row option produces the results shown in
Table 23.
Table 23. Auto Singleton Lookup Result
Product

Supplier Name

Paint

Anderson
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Table 23. Auto Singleton Lookup Result (continued)
Product

Supplier Name

Primer

Brown, C.

Wallpaper

Edwards

A singleton lookup using the Hash technique and Skip Row option produces the results shown in either
Table 24 or Table 25, depending on how the hash table is built.
Table 24. Hash Singleton Lookup Result (A)
Product

Supplier Name

Paint

Anderson

Primer

Brown, C.

Wallpaper

Edwards

Table 25. Hash Singleton Lookup Result (B)
Product

Supplier Name

Paint

Anderson

Primer

Brown, M.

Wallpaper

Edwards

In the singleton lookup examples, if you had chosen the Null Fill option instead of Skip Row as the
action for a failed lookup, there would be another row in each table for the product Paintbrushes with a
NULL for supplier name.

Conditional Lookup Examples
When performing conditional lookups, be careful to consider the results of your selections in the Action
if pre-lookup condition fails and Action if lookup condition fails fields. Certain combinations of
options might not make sense for some business cases. Table 26 describes the results of various option
combinations.
Table 26. Action if Lookup Fails Option Combinations
Result of Pre-lookup
Condition

Action If Pre-lookup
Condition Fails

Result of Previous
Lookup

Action If Lookup
Condition Fails

Resulting Action
Taken

TRUE

Any

Successful

Any

Lookup

TRUE

Any

Failed

Skip Row

Lookup

TRUE

Any

Failed

Null Fill

Lookup

TRUE

Any

Failed

Abort Program

Abort Program

FALSE

Skip Row

Successful

Any

Skip Row

FALSE

Skip Row

Failed

Skip Row

Skip Row

FALSE

Skip Row

Failed

Null Fill

Skip Row

FALSE

Skip Row

Failed

Abort Program

Abort Program

FALSE

Null Fill

Successful

Any

Null Fill

FALSE

Null Fill

Failed

Skip Row

Null Fill

FALSE

Null Fill

Failed

Null Fill

Null Fill

FALSE

Null Fill

Failed

Abort Program

Abort Program
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Table 26. Action if Lookup Fails Option Combinations (continued)
Result of Pre-lookup
Condition

Action If Pre-lookup
Condition Fails

Result of Previous
Lookup

Action If Lookup
Condition Fails

Resulting Action
Taken

FALSE

Use Previous Values

Successful

Any

Use Previous Values

FALSE

Use Previous Values

Failed

Skip Row

Skip Row

FALSE

Use Previous Values

Failed

Null Fill

Null Fill

FALSE

Use Previous Values

Failed

Abort Program

Abort Program

As an example, suppose you design a job that uses a conditional lookup to find supplier data that is
missing from a product table. The product table is the primary link to the Lookup stage and the supplier
data is the reference link, as shown in the following job design.

Data for the ProductData primary link is shown in Table 27. Notice that the column Supplier_Name has
missing data.
Table 27. Primary Link
Record #

Supplier_Code

Supplier_Name

Product

1

A

Anderson

Paint

2

B

Brown

Paint

3

B

Brown

Primer

4

B

5

C

6

C

7

D

Paint

8

D

Varnish
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Brushes
Wallpaper
Carson

Wallpaper

Table 27. Primary Link (continued)
Record #

Supplier_Code

Supplier_Name

Product

9

E

Edwards

Wallpaper

10

F

Fisher

Brushes

11

X

Xcel

Stain

12

Z

Zack

Primer

13

X

Varnish

14

Z

Brushes

Data for the SupplierInfo reference link is shown in Table 28:
Table 28. Reference Link
Supplier_Code

Supplier_Name

A

Anderson

B

Brown

C

Carson

D

Donner

E

Edwards

F

Fisher

G

Green

The Lookup stage is configured such that if the supplier name is blank on the primary link, the lookup is
performed to fill in the missing supplier information. The lookup type is Singleton Lookup and the
lookup technique is Auto.
The pre-lookup condition is:
ProductData.SUPPLIER_NAME = ’ ’

The lookup condition is:
ProductData.SUPPLIER_CODE = SupplierInfo.SUPPLIER_CODE

On the Mapping tab of the Lookup stage, the columns Supplier_Code and Supplier_Name from the
primary link and Supplier_Name from the reference link are mapped to the output link, as shown:
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Next the data passes to a Transformer stage, where the columns are mapped to the output link. The
column derivation for Supplier_Name uses IF THEN ELSE logic to determine the correct output:
IF LookupOut.SUPPLIER_NAME= ’ ’ THEN
LookupOut.SUPPLIER_NAME_2
ELSE LookupOut.SUPPLIER_NAME
END

In other words, if Supplier_Name from the primary link is blank, then the output is the value from the
reference link. Otherwise it is the value from the primary link.
The Transformer stage appears as follows:
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Depending on your selections in the Action if pre-lookup condition fails and Action if lookup
condition fails fields, both the lookup results and the final results of the job can vary greatly, as
demonstrated in the following examples.

Null Fill, Skip Row Combination
If the action specified for a failed pre-lookup condition is Null Fill and the action for a failed lookup is
Skip Row, the lookup results are:
Table 29. Lookup Results
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

1

A

Anderson

(Null)

2

B

Brown

(Null)

3

B

Brown

(Null)

4

B

Brown

5

C

Carson

6

C

7

D

Donner

8

D

Donner

9

E

Edwards

(Null)

10

F

Fisher

(Null)

Carson

(Null)
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Table 29. Lookup Results (continued)
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

11

X

Xcel

(Null)

12

Z

Zack

(Null)

Records 1-3, 6, and 9-12 failed the pre-lookup condition but are passed through the stage due to the Null
Fill action. In these records, the column Supplier_Name_2 is filled with a null value. Records 13 and 14
passed the pre-lookup condition, but failed the lookup condition because the supplier codes do not
match. Since Skip Row is the specified action for a failed lookup, neither record is output from the stage.
The final output after data passes through the Transformer stage is:
Table 30. Final Output
Supplier_Code

Supplier_Name

Product

A

Anderson

Paint

B

Brown

Paint

B

Brown

Primer

B

Brown

Brushes

C

Carson

Wallpaper

C

Carson

Wallpaper

D

Donner

Paint

D

Donner

Varnish

E

Edwards

Wallpaper

F

Fisher

Brushes

X

Xcel

Stain

Z

Zack

Primer

Skip Row, Skip Row Combination
Using the same data, the same pre-lookup condition, and the same lookup condition, but changing the
action for a failed pre-lookup condition to Skip Row, produces the following lookup results:
Table 31. Lookup Results
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

4

B

Brown

5

C

Carson

7

D

Donner

8

D

Donner

Records 1-3, 6, and 9-12 from the primary link failed the pre-lookup condition and are not passed on due
to the Skip Row action. Records 4, 5, 7, and 8 passed the pre-lookup condition and have successful
lookup results. Records 13 and 14 passed the pre-lookup condition but failed in the lookup because the
supplier codes do not match. They are omitted as output from the stage due to the Skip Row action for a
failed lookup.
The final output after data passes through the Transformer stage is:
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Table 32. Final Output
Supplier_Code

Supplier_Name

Product

B

Brown

Brushes

C

Carson

Wallpaper

D

Donner

Paint

D

Donner

Varnish

Use Previous Values, Skip Row Combination
In this example, the action for a failed pre-lookup condition is Use Previous Values. This means output
data mapped from the reference link is used repeatedly until the data from a subsequent lookup changes.
The results produced with this option can vary depending on the content and order of the primary link.
Using the same data as before, the results of the lookup are:
Table 33. Lookup Results
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

4

B

Brown

5

C

Carson

6

C

7

D

Donner

8

D

Donner

9

E

Edwards

Donner

10

F

Fisher

Donner

11

X

Xcel

Donner

12

Z

Zack

Donner

Carson

Carson

Records 1-3 from the primary link failed the pre-lookup condition and are not passed on. This is because
there are no previous values to use and the action for a failed lookup is Skip Row. Records 4, 5, 7, and 8
passed the pre-lookup condition and have successful lookup results. Records 6 and 9-12 failed the
pre-lookup condition, however, in Records 9-12 the results include incorrect values in the column
Supplier_Name_2 because of the Use Previous Values action. Records 13 and 14 are omitted because they
failed the lookup condition and the action is Skip Row.
The final output after data passes through the Transformer stage is:
Table 34. Final Output
Supplier_Code

Supplier_Name

Product

B

Brown

Brushes

C

Carson

Wallpaper

C

Carson

Wallpaper

D

Donner

Paint

D

Donner

Varnish

E

Edwards

Wallpaper

F

Fisher

Brushes

X

Xcel

Stain

Z

Zack

Primer
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Use Previous Values, Skip Row Combination 2
This example is the same as the last one except that the data on the primary link is reordered. The fourth
record has become the first record, as shown in Table 35.
Table 35. Primary Link
Record #

Supplier_Code

Supplier_Name

Product

1

B

2

A

Anderson

Paint

3

B

Brown

Paint

4

B

Brown

Primer

5

C

6

C

7

D

Paint

8

D

Varnish

9

E

Edwards

Wallpaper

10

F

Fisher

Brushes

11

X

Xcel

Stain

12

Z

Zack

Primer

13

X

Varnish

14

Z

Brushes

Brushes

Wallpaper
Carson

Wallpaper

This time the results of the Lookup stage are as follows:
Table 36. Lookup Results
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

1

B

2

A

Anderson

Brown

3

B

Brown

Brown

4

B

Brown

Brown

5

C

6

C

7

D

Donner

8

D

Donner

9

E

Edwards

Donner

10

F

Fisher

Donner

11

X

Xcel

Donner

12

Z

Zack

Donner

Brown

Carson
Carson

Carson

Since the first record met the pre-lookup condition, a lookup was successfully performed and previous
values were used until another lookup was performed. If the first lookup had failed, the results would be
the same as in the last example.
The final output after data passes through the Transformer stage is:
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Table 37. Final Output
Supplier_Code

Supplier_Name

Product

B

Brown

Brushes

A

Anderson

Paint

B

Brown

Paint

B

Brown

Primer

C

Carson

Wallpaper

C

Carson

Wallpaper

D

Donner

Paint

D

Donner

Varnish

E

Edwards

Wallpaper

F

Fisher

Brushes

X

Xcel

Stain

Z

Zack

Primer

Use Previous Values, Null Fill Combination
In this example the action if the pre-lookup condition fails is still Use Previous Values, but the action if
the lookup condition fails is changed to Null Fill. The data is the same as in the first three examples. The
results of the lookup are:
Table 38. Lookup Results
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

1

A

Anderson

(Null)

2

B

Brown

(Null)

3

B

Brown

(Null)

4

B

Brown

5

C

Carson

6

C

7

D

Donner

8

D

Donner

9

E

Edwards

Donner

10

F

Fisher

Donner

11

X

Xcel

Donner

12

Z

Zack

Donner

13

X

(Null)

14

Z

(Null)

Carson

Carson

Notice that Records 1-3 are present even though there are not previous values to assign. This is the result
of using Null Fill as the action if the lookup fails. Also notice that Records 13 and 14 are present even
though they failed the lookup; this is also the result of the Null Fill option.
The final output after data passes through the Transformer stage is:

Chapter 5. Mainframe Job Stages

137

Table 39. Final Output
Supplier_Code

Supplier_Name

Product

A

Anderson

Paint

B

Brown

Paint

B

Brown

Primer

B

Brown

Brushes

C

Carson

Wallpaper

C

Carson

Wallpaper

D

Donner

Paint

D

Donner

Varnish

E

Edwards

Wallpaper

F

Fisher

Brushes

X

Xcel

Stain

Z

Zack

Primer

X

(Null)

Varnish

Z

(Null)

Brushes

Null Fill, Null Fill Combination
In this example, the action for both a failed pre-lookup condition and a failed lookup condition is Null
Fill. The lookup results are as follows:
Table 40. Lookup Results
Record #

Supplier_Code

Supplier_Name

Supplier_Name_2

1

A

Anderson

(Null)

2

B

Brown

(Null)

3

B

Brown

(Null)

4

B

Brown

5

C

Carson

6

C

7

D

Donner

8

D

Donner

9

E

Edwards

(Null)

10

F

Fisher

(Null)

11

X

Xcel

(Null)

12

Z

Zack

(Null)

13

X

(Null)

14

Z

(Null)

Carson

(Null)

Records 1-3, 6, and 9-12 fail the pre-lookup condition but are passed on due to the Null Fill action.
Records 4, 5, 7, and 8 pass the pre-lookup condition and have successful lookup results. Records 13 and
14 pass the pre-lookup condition, fail the lookup condition, and are passed on due to the Null Fill action
if the lookup condition fails.
The final output after data passes through the Transformer stage is:
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Table 41. Final Output
Supplier_Code

Supplier_Name

Product

A

Anderson

Paint

B

Brown

Paint

B

Brown

Primer

B

Brown

Brushes

C

Carson

Wallpaper

C

Carson

Wallpaper

D

Donner

Paint

D

Donner

Varnish

E

Edwards

Wallpaper

F

Fisher

Brushes

X

Xcel

Stain

Z

Zack

Primer

X

Varnish

Z

Brushes

Sort Stages
These topics describe Sort stages, which perform sorting on input columns from a single input link. The
sorted columns are output to a processing stage or a target stage via a single output link.

Using a Sort Stage
Sort stages have only one input link and one output link. The input link must come from a source stage.
The sorted data can be output to another processing stage or a target stage.
When you edit a Sort stage, the Sort Stage dialog box appears. This dialog box has three pages:
v Stage. Displays the name of the stage you are editing. The stage name is editable. This page has a
General tab where you can type an optional description of the stage.
v Inputs. Specifies the column definitions for the data input link.
v Outputs. Specifies the column definitions for the data output link. This page has a Sort By tab where
you select the columns to be sorted and specify the sort order. The Mapping tab is where you define
the mappings between input and output columns.
Click OK to close this dialog box. Changes are saved when you save the job.

Defining Sort Input Data
Data to be sorted is passed from a previous stage in the job design and into the Sort stage via a single
input link. The properties of this link and the column definitions of the data are described on the Inputs
page in the Sort Stage dialog box.
The Inputs page has the following field and two tabs:
v Input name. The name of the input link to the Sort stage. Since only one input link is allowed, the link
name is read-only.
v General. Contains an optional description of the link.
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v Columns. Displayed by default. Contains a grid displaying the column definitions for the data being
written to the stage:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Input column definitions are read-only in the Sort stage. You must go back to the stage on your
input link if you want to change the column definitions.

Defining Sort Output Data
When you output data from a Sort stage, the properties of the output link and the column definitions of
the data are defined on the Outputs page in the Sort Stage dialog box.
The Outputs page has the following field and four tabs:
v Output name. The name of the output link. Since only one output link is allowed, the link name is
read-only.
v General. Contains an optional description of the link.
v Sort By. Displayed by default. Contains a list of available columns to sort and specifies the sort order.
See “Sorting Data” for details about defining the sort order.
v Mapping. Specifies the mapping of input columns to output columns. See “Mapping Data” on page
141 for details about defining mappings.
v Columns. Contains the column definitions for the data on the output link. This grid has the following
columns:
– Column name. The name of the column.
– SQL type. The SQL data type. For details about the data types supported in mainframe jobs, see
Chapter 8, “Data Type Definitions and Mappings,” on page 185.
– Length. The data precision. This is the number of characters for Char data, the maximum number of
characters for VarChar data, the total number of digits for numeric data types, and the number of
digits in the microsecond portion of Timestamp data.
– Scale. The data scale factor. This is the number of digits to the right of the decimal point for
Decimal data, and zero for all other data types.
– Nullable. Indicates whether the column can contain a null value.
– Description. A text description of the column.
Click Load to load columns from a table definition in the repository, or type column definitions
manually and click Save As... to save them as a table definition, a CFD file, or a DCLGen file. Click
Clear All to start over. For details about editing column definitions, see Chapter 10, “Editing
Column Metadata,” on page 207.

Sorting Data
The data sources for your data warehouse might organize information in a manner that is efficient for
managing day-to-day operations, but is not helpful for making business decisions. For example, suppose
you want to analyze information about new employees. The data in your employee database contains
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detailed information about all employees, including their employee number, department, job title, hire
date, education level, salary, and phone number. Sorting the data by hire date and manager will get you
the information you need faster.
The Sort stage allows you to sort columns on the input link to suit your requirements. Sort specifications
are defined on the Sort By tab.
You can move a column from the Available columns list to the Selected columns list by double-clicking
the column name or highlighting the column name and clicking >. To move all columns, click >>. You
can remove single columns from the Selected columns list by double-clicking the column name or
highlighting the column name and clicking <. Remove all columns by clicking <<. Click Find to search
for a particular column in either list.
After you have selected the columns to be sorted on the Sort By tab, you must specify the sort order.
Click the Sort Order field next to each column in the Selected columns list. A list appears with two sort
options:
v Ascending. This is the default setting. Select this option if the input data in the specified column
should be sorted in ascending order.
v Descending. Select this option if the input data in the specified column should be sorted in descending
order.
Use the arrow buttons to the right of the Selected columns list to change the order of the columns being
sorted. The first column is the primary sort column and any remaining columns are sorted secondarily.

Mapping Data
The Mapping tab is used to define the mappings between input and output columns being passed
through the Sort stage.
You can bypass this step if the Column push option is selected in Designer client options. Output
columns are automatically created for each output link, and mappings between corresponding input and
output columns are defined, when you click OK to exit the stage.
This tab is divided into two panes, the left for the input link (and any job parameters that have been
defined) and the right for the output link, and it shows the columns and the relationships between them.
You can drag the splitter bar between the two panes to resize them relative to one another. Vertical scroll
bars allow you to scroll the view up or down the column lists, as well as up or down the panes.
You can define column mappings from the Mapping tab in two ways:
v drag-and-drop. This specifies that an output column is directly derived from an input column. See
“Using drag-and-drop” on page 142 for details.
v Auto-Match. This automatically sets output column derivations from their matching input columns,
based on name or location. See “Using Column Auto-Match” on page 142 for details.
Derivation expressions cannot be specified on the Mapping tab. If you need to perform data
transformations, you must include a Transformer stage elsewhere in your job design.
As mappings are defined, the output column names change from red to black. A relationship line is
drawn between the input column and the output column.
Find Facility:
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About this task
If you are working on a complex job, there is a find facility to help you locate a particular column or
expression.
To use the find facility:
Procedure
1. Open the Find dialog box in either of these ways:
v Click Find on the Mapping tab.
v Select Find from the link shortcut menu.
2. Click one of the following tabs:
v Column Names. Allows you to find a particular column.
v Expression Text. Allows you to locate the occurrence of a particular string within an output column
expression.
3. Select a link from the Link name list. (You can search for expression text only on the output link.)
4. Type the text to search for in the Find what field.
5. Optional: Select the Match case and Match whole word check boxes to narrow your search.
6. Optional: On the Expression Text tab, select Empty Expression to search for the next empty
expression.
Using drag-and-drop:
About this task
A simple way to specify mappings is to use the Mapping tab's drag-and-drop functionality. You can drag
columns from your input link to your output link to define each mapping.
To use drag-and-drop:
Procedure
1. Click the source cell to select it.
2. Click the selected cell again and, without releasing the mouse button, drag the mouse pointer to the
desired location within the target link.
3. Release the mouse button to drop the selected cell.
Results
You can also click the title bar displaying the name of the link and, without releasing the mouse button,
drag the mouse pointer to the first Derivation cell within the target link. This will map all input columns
to the output columns based on location.
Using Column Auto-Match:
About this task
The column auto-match facility allows you to automatically set columns on an output link to be derived
from matching columns on an input link.
To use auto-match:
Procedure
1. Click AutoMap on the Mapping tab to open the Column Auto-Match dialog box.
2. Click Location match or Name match from the Match type area.
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If you click Location match, this will set output column derivations to the input link columns in the
equivalent positions. It starts with the first input link column going to the first output link column,
and works its way down until there are no more input columns left.
If you click Name match, you need to specify further information for the input and output columns
as follows:
v Input columns:
– Match all columns or Match selected columns. Click one of these to specify whether all input
link columns should be matched, or only those currently selected on the input link.
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Output columns:
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Ignore case. Select this check box to specify that case should be ignored when matching names. The
setting of this also affects the Ignore prefix and Ignore suffix settings. For example, if you specify
that the prefix IP will be ignored and select Ignore case, then both IP and ip will be ignored.
3. Click OK to proceed with the auto-matching.
Note: Auto-matching does not take into account any data type incompatibility between matched
columns; the derivations are set regardless.

Transformer Stages
These topics describe Transformer stages, which perform data conversions on extracted data. The data is
then passed to another active stage or to a stage that writes data to a target file or database.
The Transformer stage editor is similar for mainframe, server, and parallel jobs, but the functionality
differs. Only the mainframe functionality is described in this topic. For server or parallel functionality, see
the respective guides.

Using a Transformer Stage
Transformer stages have one input link and one or more output links. If you right-click on a Transformer
stage from the Designer client canvas, the shortcut menu displays various options for editing the stage:
v Selecting Properties opens the Transformer Editor.
v If the stage has links, selecting a link name from the Input Links or Output Links menu option opens
the Transformer Editor with the selected link highlighted.
v If columns have already been defined on the input link to the stage, you can select Propagate Columns
to propagate columns from the input link to a selected output link. This saves time if you are simply
passing columns through the stage without performing data transformations.
v If columns have already been defined on both the input and output links, you can select Auto-Match
Columns to automatically map the input columns to the selected output link columns that have
matching names.
When you edit a Transformer stage, the Transformer Editor appears. In the following example, there is
one input link and two output links. Metadata has been defined for the input link, but not for the output
links:
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Transformer Editor Components
The Transformer Editor has the following components.

Toolbar
The Transformer toolbar appears at the top of the Transformer Editor. It contains the following buttons
from left to right:
v Stage Properties
v Constraints
v Show All or Selected Relations
v Show/Hide Stage Variables
v Cut
v Copy
v
v
v
v
v
v

Paste
Find/Replace
Load Column Definition
Save Column Definition
Column Auto-Match
Output Link Execution Order
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Link Area
The top area displays links to and from the Transformer stage, showing their columns and the
relationships between them.
The link area is where all column definitions and stage variables are defined.
The link area is divided into two panes; you can drag the splitter bar between them to resize the panes
relative to one another. There is also a horizontal scroll bar, allowing you to scroll the view left or right.
The left pane shows the input link and the right pane shows output links and stage variables. For all
types of link, key fields are shown in bold. Output columns that have no derivation defined are shown in
red (or the color defined in Tools > Options...).
Within the Transformer Editor, a single link can be selected at an one time. When selected, the link's title
bar is highlighted, and arrowheads indicate any selected columns.

Metadata Area
The bottom area shows the column metadata for input and output links. Again this area is divided into
two panes: the left showing input link metadata and the right showing output link metadata.
The metadata for each link is shown in a grid contained within a tabbed page. Click the tab to bring the
required link to the front. This link is also selected in the link area.
If you select a link in the link area, its metadata page is brought to the front automatically.
You can edit the grids to change the column metadata on the output links only. You can also add and
delete output link metadata. For details about editing column metadata, see Chapter 10, “Editing Column
Metadata,” on page 207.

Shortcut Menus
The Transformer Editor shortcut menus are displayed by right-clicking the links in the links area. There
are three slightly different menus, depending on whether you right-click an input link, an output link, or
a stage variable.
The input link shortcut menu enables you to:
v Open the Properties dialog box to type a description of the link.
v Open the Column Auto-Match dialog box.
v
v
v
v

Display the Find/Replace dialog box.
Select all columns on the link.
Display the Select dialog box.
Copy a column on the link.

The output link shortcut menu enables you to:
v
v
v
v
v
v
v

Open the Properties dialog box to type a description of the link.
Open the Constraints dialog box to specify a constraint.
Open the Column Auto-Match dialog box.
Display the Find/Replace dialog box.
Select all columns on the link.
Display the Select dialog box.
Edit several derivations in one operation.
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v
v
v
v

Edit, validate, or clear a derivation.
Append or insert a new column into the selected link.
Delete columns on the link.
Cut, copy, and paste a column or derivation on the link.

The stage variable shortcut menu enables you to:
v Open the Stage Properties dialog box to specify a variable.
v Open the Column Auto-Match dialog box.
v Display the Find/Replace dialog box.
v Select all stage variables.
v Display the Select dialog box.
v Edit several derivations in one operation.
v Edit, validate, or clear a derivation.
v Append or insert a new stage variable.
v Delete a stage variable.
v Cut, copy, and paste a stage variable or derivation.
If you display the shortcut menu from the links area background, you can:
v Open the Stage Properties dialog box to type a description of the stage, specify a variable, or specify
the order of output link processing.
v Open the Constraints dialog box to specify a constraint.
v Open the Link Ordering tab of the Stage Properties dialog box to reorder output link processing.
v Toggle between displaying stage variables and hiding them.
v Toggle between viewing link relations for all links, or for the selected link only.
Right-clicking in the metadata area of the Transformer Editor opens the standard grid-editing shortcut
menus.

Transformer Stage Properties
The Transformer stage has a Properties dialog box which allows you to specify details about how the
stage operates. This dialog box has three pages:
v Stage. This is used to specify general information about the stage. The Stage page has three tabs:
– General. Allows you to type an optional description of the stage.
– Variables. Allows you to specify stage variables for use in the stage. See “Defining Local Stage
Variables” on page 155 for details about defining stage variables.
– Link Ordering. Allows you to specify the order in which the output links are processed. See
“Specifying Output Link Order” on page 155 for details about link ordering.
v Inputs. Allows you to type an optional description of the data on the input link. The Transformer stage
can have only one input link.
v Outputs. Allows you to type an optional description for each of the output links from the stage.

Transformer Stage Basic Concepts
This section explains some of the basic concepts of using a Transformer stage. Before you edit a
Transformer stage, you must have already defined the data being passed into the stage from your input
link. You will use the Transformer Editor to define the data that will be output by the stage and how it
will be transformed.
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Input Links
Data is passed to the Transformer stage via a single input link. The input link can come from a passive or
active stage. Input data to a Transformer stage is read-only. You must go back to the stage on your input
link if you want to change the column definitions.

Output Links
You can have any number of output links from the Transformer stage.
You might want to pass some data straight through the Transformer stage unaltered, but it's likely that
you'll want to transform data from some input columns before outputting it from the Transformer stage.
Each output link column is defined in the column's Derivation cell within the Transformer Editor. To
simply pass data through the Transformer stage, you can drag an input column to an output column's
Derivation cell. To transform the data, you can define an expression using the Expression Editor.
In addition to specifying derivation details for individual output columns, you can also specify
constraints that operate on entire output links. A constraint is an expression based on the SQL3 language
that specifies criteria that the data must meet before it can be passed to the output link. For data that
does not meet the criteria, you can use a constraint to designate another output link as the reject link. The
reject link will contain columns that did not meet the criteria for the other output links.
Each output link is processed in turn. If the constraint expression evaluates to TRUE for an input row, the
data row is output on that link. Conversely, if a constraint expression evaluates to FALSE for an input
row, the data row is not output on that link.
Constraint expressions on different links are independent. If you have more than one output link, an
input row might result in a data row being output from some, none, or all of the output links.
For example, consider the data that comes from a paint shop. It could include information about any
number of different colors. If you want to separate the colors into different files, you would set up
different constraints. You could output the information about green and blue paint on LinkA, red and
yellow paint on LinkB, and black paint on LinkC.
When an input row contains information about yellow paint, the LinkA constraint expression evaluates to
FALSE and the row is not output on LinkA. However, the input data does satisfy the constraint criterion
for LinkB and the rows are output on LinkB.
If the input data contains information about white paint, this does not satisfy any constraint and the data
row is not output on Links A, B, or C. However, you could designate another link to serve as the reject
link. The reject link is used to route data to a table or file that is a "catch-all" for rows that are not output
on any other link. The table or file containing these rejects is represented by another stage in the job
design.

Editing Transformer Stages
The Transformer Editor allows you to perform the following operations within a Transformer stage:
v Create new columns on output links
v Delete columns from output links
v Move columns within output links
v Edit output column metadata
v Define output column derivations
v Define link constraints and handle rejects
v Specify the order in which the output links are processed
v Define local stage variables
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Using drag-and-drop
About this task
Many of the Transformer stage edits can be made simpler by using the Transformer Editor's
drag-and-drop functionality. You can drag columns from any link to any other link. Common uses are:
v Copying input columns to output links
v Moving columns within output links
v Copying derivations in output links
To use drag-and-drop:

Procedure
1. Click the source cell to select it.
2. Click the selected cell again and, without releasing the mouse button, drag the mouse pointer to the
desired location within the target link. An insert point appears on the target link to indicate where the
new cell will go.
3. Release the mouse button to drop the selected cell.

Results
You can drag-and-drop multiple columns or derivations. Use the standard Explorer keys when selecting
the source column cells, then proceed as for a single cell.
You can add a column to the end of an existing derivation by holding down the Ctrl key as you drag the
column. This opens the Expression Editor, allowing you to continue editing the column derivation.

Find and Replace Facility
If you are working on a complex job where several links, each containing several columns, go in and out
of the Transformer stage, you can use the find/replace facility to help locate a particular column or
expression and change it.
The find/replace facility allows you to:
v Find and replace a column name
v Find and replace expression text
v Find the next empty expression
v Find the next expression that contains an error
To use the find/replace facility, open the Find and Replace dialog box by:
v Clicking the Find/Replace button on the toolbar.
v Selecting Find/Replace from the link shortcut menu.
v Pressing Ctrl-F.
The Find and Replace dialog box has three tabs:
v Expression Text. Allows you to locate the occurrence of a particular string within an expression, and
replace it if required. You can search up or down, and choose to match case, search the selected link
only, or neither. You can also choose to replace all occurrences of the string within an expression.
v Column Names. Allows you to find a particular column and rename it if required. You can search up
or down, and choose to match case, match whole words, or search the selected link only.
v Expression Types. Allows you to find the next empty expression or the next expression that contains
an error. You can search up or down and choose to search the selected link only. You can also press
Ctrl-M to find the next empty expression or Ctrl-N to find the next erroneous expression.
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The find and replace results are shown in the color specified in Tools > Options... .
Press F3 to repeat the last search you made without opening the Find and Replace dialog box.

Select Facilities
If you are working on a complex job where several links, each containing several columns, go in and out
of the Transformer stage, you can use the select column facility to select multiple columns.
The select facility enables you to:
v Select all columns/stage variables whose expressions contain text that matches the text specified.
v Select all column/stage variables whose name contains the text specified (and, optionally, matches a
specified type).
v Select all columns/stage variables with a certain data type.
v Select all columns with missing or invalid expressions.
To use the select facility, choose Select from the link shortcut menu. The Select dialog box appears. It has
three tabs:
v Expression Text. This allows you to select all columns/stage variables whose expressions contain text
that matches the text specified. The text specified is a simple text match, taking into account the Match
case setting.
v Column Names. This allows you to select all columns/stage variables whose name contains the text
specified. There is an additional Data type list that will limit the columns selected to those with that
data type. You can use the Data type list on its own to select all columns of a certain data type. For
example, all string columns can be selected by leaving the text field blank, and selecting String as the
data type. The data types in the list are generic data types, where each of the column SQL data types
belong to one of these generic types.
v Expression Types. This allows you to select all columns with either empty expressions or invalid
expressions.

Creating and Deleting Output Columns
About this task
You can create output columns from the Transformer stage using any of the following methods:
v Select the output link, then click the Load Column Definition button on the toolbar. Double-click a
table from the Table Definitions dialog box, then select columns from the Select Columns dialog box.
v Use drag-and-drop or copy-and-paste functionality to create a new column by copying from an
existing column on another link.
v Use the shortcut menu to create a new column definition.
v Edit the grids in the link's metadata tab to insert a new column.
When copying columns, a new column is created with the same metadata as the column it was copied
from.
To delete a column from within the Transformer Editor, select the column you want to delete and click
Cut or select Delete Column from the shortcut menu.
If you map input columns to output columns in a Transformer stage, and you later delete the input link
on the Designer client canvas, your output column derivations are not automatically cleared. You can
selectively delete output column derivations using the methods described above, or choose Select All
from the shortcut menu and click Cut to clear everything.
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Moving Output Columns Within a Link
About this task
You can move columns within an output link using either a drag-and-drop or a cut-and-paste operation.
Select the required column, then drag it to its new location, or cut it and paste it in its new location.

Editing Output Column Metadata
You can edit output column metadata from within the grid in the bottom of the Transformer Editor.
Select the tab for the link metadata that you want to edit, then use the standard InfoSphere DataStage
edit grid controls.
The metadata shown does not include column derivations, since these are edited in the links area.

Defining Output Column Derivations
You can define the derivation of output columns from within the Transformer Editor in five ways:
v If you want a new output column to be directly derived from an input column, with no
transformations performed, then you can drag or copy an input column to an output link. The output
columns will have the same names as the input columns from which they were derived.
v If the output column already exists, you can drag or copy an input column to the output column's
Derivation field. This specifies that the column is directly derived from an input column, with no
transformations performed.
v You can use the column auto-match facility to automatically set that output columns are derived from
their matching input columns.
v You might need one output link column derivation to be the same as another output link column
derivation. In this case you can drag or copy the derivation cell from one column to another.
v In many cases you will need to transform data before deriving an output column from it. For these
purposes you can use the Expression Editor. To display the Expression Editor, double-click on the
required output link column Derivation cell. (You can also open the Expression Editor by selecting
Edit Derivation from the shortcut menu.)
If a derivation is displayed in red (or the color defined in Tools > Options...) it means that the
Transformer Editor considers it incorrect. (In some cases this might simply mean that the derivation does
not meet the InfoSphere DataStage usage pattern rules, but will actually function correctly.)
When an output column has a derivation defined that contains any input columns, then a relationship
line is drawn between the input column and the output column. There can be multiple relationship lines
either into or out of columns. You can choose whether to view the relationships for all links, or just the
relationships for the selected links, using the button on the toolbar.
Column Auto-Match Facility:
The column auto-match facility allows you to automatically set columns on an output link to be derived
from matching columns on an input link. You can use this feature to quickly fill in output link
derivations by routing data from corresponding input columns, then go back and edit individual link
columns where you want a different derivation.
Procedure
1. Open the Column Auto-Match dialog box in either of these ways:
v Click the Column Auto-Match button on the Transformer Editor toolbar.
v Select Auto Match from the input link header or output link header shortcut menu.
2. Select the output link that you want to match columns for from the list.
3. Click Location match or Name match from the Match type area.
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If you click Location match, this will set output column derivations to the input link columns in the
equivalent positions. It starts with the first input link column going to the first output link column,
and works its way down until there are no more input columns left.
If you click Name match, you need to specify further information for the input and output columns
as follows:
v Input columns:
– Match all columns or Match selected columns. Click one of these to specify whether all input
link columns should be matched, or only those currently selected on the input link.
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Output columns:
– Ignore prefix. Optionally specifies characters at the front of the column name that should be
ignored during the matching procedure.
– Ignore suffix. Optionally specifies characters at the end of the column name that should be
ignored during the matching procedure.
v Ignore case. Select this check box to specify that case should be ignored when matching names. The
setting of this also affects the Ignore prefix and Ignore suffix settings. For example, if you specify
that the prefix IP will be ignored and select Ignore case, then both IP and ip will be ignored.
4. Click OK to proceed with the auto-matching.
Results
Auto-matching does not take into account any data type incompatibility between matched columns; the
derivations are set regardless.
You can also auto-match columns from the Designer client canvas. Right-click the Transformer stage icon,
select Auto-Match Columns from the shortcut menu, and choose the target output link. With this option,
the matching is done automatically based on column names, without opening the Transformer Editor or
the Column Auto-Match dialog box.

Editing Multiple Derivations
You can make edits across several output column or stage variable derivations by choosing Derivation
Substitution... from the shortcut menu. This opens the Expression Substitution dialog box.
The Expression Substitution dialog box allows you to make the same change to the expressions of all the
currently selected columns within a link. For example, if you wanted to add a call to the trim() function
around all the string output column expressions in a link, you could do this in two steps. First, use the
Select dialog box to select all the string output columns. Then use the Expression Substitution dialog box
to apply a trim() call around each of the existing expression values in those selected columns.
You are offered a choice between Whole expression substitution and Part of expression substitution.
Whole Expression:
About this task
With this option the whole existing expression for each column is replaced by the replacement value
specified. This replacement value can be a completely new value, but will typically be a value based on
the original expression value. When specifying the replacement value, the existing value of the column's
expression can be included in this new value by including $1. This can be included any number of times.
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For example, when adding a trim() call around each expression of the currently selected column set,
having selected the required columns, you would:
Procedure
1. Select the Whole expression option.
2. Type a replacement value of:
trim($1)
3. Click OK.
Results
Where a column's original expression was:
DSLink3.col1

This will be replaced by:
trim(DSLink3.col1)

This is applied to the expressions in each of the selected columns.
If you need to include the actual text $1 in your expression, type it as $$1.
Part of Expression:
About this task
With this option, only part of each selected expression is replaced rather than the whole expression. The
part of the expression to be replaced is specified by selecting Regular expression to match.
It is possible that more that one part of an expression string could match the regular expression specified.
If Replace all occurrences of a match within the expression is checked, then each occurrence of a match
will be updated with the replacement value specified. If it is not checked, then just the first occurrence is
replaced.
When replacing part of an expression, the replacement value specified can include that part of the
original expression being replaced. To do this, the regular expression specified must have round brackets
around its value. $1 in the replacement value will then represent that matched text. If the regular
expression is not surrounded by round brackets, then $1 will simply be the text $1.
For complex regular expression usage, subsets of the regular expression text can be included in round
brackets rather than the whole text. In this case, the entire matched part of the original expression is still
replaced, but $1, $2 and so on can be used to refer to each matched bracketed part of the regular
expression specified.
Following is an example of the Part of expression replacement.
Suppose a selected set of columns have derivations that use input columns from DSLink3. For example,
two of these derivations could be:
DSLink3.OrderCount + 1
If (DSLink3.Total > 0) Then DSLink3.Total Else -1

You might want to protect the usage of these input columns from null values, and use a zero value
instead of the null. To do this:
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Procedure
1. Select the columns you want to substitute expressions for.
2. Select the Part of expression option.
3. Specify a regular expression value of:
(DSLink3\.[a-z,A-Z,0-9]*)
This will match strings that contain DSLink3. followed by any number of alphabetic characters or
digits. (This assumes that column names in this case are made up of alphabetic characters and digits).
The round brackets around the whole expression means that $1 will represent the whole matched text
in the replacement value.
4. Specify a replacement value of:
NullToZero($1)
This replaces just the matched substrings in the original expression with those same substrings, but
surrounded by the NullToZero call.
5. Click OK to apply this to all the selected column derivations.
Results
From the examples above:
DSLink3.OrderCount + 1

would become:
NullToZero(DSLink3.OrderCount) + 1

and
If (DSLink3.Total > 0) Then DSLink3.Total Else -1

would become:
If (NullToZero(DSLink3.Total) > 0) Then DSLink3.Total Else -1

If the Replace all occurrences of a match within the expression option is selected, the second expression
will become:
If (NullToZero(DSLink3.Total) > 0)
Then NullToZero(DSLink3.Total)
Else -1

The replacement value can be any form of expression string. For example, in the case above, the
replacement value could have been:
(If (StageVar1 > 50000) Then $1 Else ($1 + 100))

In the first case above, the expression
DSLink3.OrderCount + 1

would become:
(If (StageVar1 > 50000) Then DSLink3.OrderCount
Else (DSLink3.OrderCount + 100)) + 1

Defining Constraints and Handling Rejects
You can define limits for output data by specifying a constraint. In mainframe jobs, constraints are
expressions based on the SQL3 language and are defined using the Expression Editor. Constraints are
Boolean expressions that return TRUE or FALSE.
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You can specify a constraint for each output link from a Transformer stage. You can also use a constraint
to specify that a particular link is to act as a reject link. Reject links output rows that have not been
written on any other output links from the Transformer stage.
To define a constraint or specify a reject link, open the Transformer Stage Constraints dialog box in one of
the following ways:
v Click the Constraints button on the toolbar.
v Double-click an output link's Constraint field.
v Select Constraints from the background or header shortcut menus.
Define a constraint by double-clicking the Constraint field next to the output link name. This opens the
Expression Editor dialog box. After you have defined a constraint, it will appear below the output link's
title bar in the Transformer Editor. When the job runs, the constraint expression will be checked against
the row data. If the data does not satisfy the constraint, the row will not be written to that link.
Define a reject link by entering an expression in the Constraint field that tests the variable
REJECTEDCODE for failure in any of the previous links. To build the expression, use the constant
DSE_TRXCONSTRAINT, which indicates that a row was rejected because the link constraint was not
satisfied. An example would be:
OutLink.REJECTEDCODE = DSE_TRXCONSTRAINT

You can use the AND and OR operators to build a compound expression that tests constraints on
multiple output links. Note that the reject link(s) must be last in the execution order. Any data on rows
not written to any other output link in the stage is then written to the reject link(s), using the column
mappings you have specified.
For example, suppose you have a job that writes out regional data to a relational database. You want to
create a reject link as well as an error log. Your job design might look like this:

Let's assume that the links are executed in order: Link1, Link2, Link3. A constraint on Link1 checks that
the correct region codes are being used. Link2, the reject link, captures rows which are rejected from
Link1 because the region code is incorrect. The constraint expression for Link2 would be:
Link1.REJECTEDCODE = DSE_TRXCONSTRAINT

Link3, the error log, captures rows that were rejected from the Relational target stage because of a DBMS
error rather than a failed constraint. The expression for Link3 would be:
Link1.REJECTEDCODE = DSE_TRXLINK
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You could then insert an additional output column on Link3 to return the DBMS error code. The
derivation expression for this column would be:
Link1.DBMSCODE

By looking at the value in this column, you would be able to determine the reason why the row was
rejected.

Specifying Output Link Order
About this task
You can specify the order in which output links process a row. The initial order of the links is the order
in which they are added to the stage.
To reorder output links:

Procedure
1. Open the Link Ordering tab of the Transformer Stage Properties dialog box in one of the following
ways:
v Click the Output Link Execution Order button on the Transformer Editor toolbar.
v Choose Reorder Output Links from the background shortcut menu.
v Click the Stage Properties button on the Transformer Editor toolbar, or choose Stage Properties
from the background shortcut menu and click the Link Ordering tab.
2. Use the arrow buttons to rearrange the list of links in the execution order required.
3. When you are satisfied with the order, click OK.

Defining Local Stage Variables
You can declare a stage variable.

About this task
You can declare and use your own variables within a Transformer stage. Such variables are accessible
only from the Transformer stage in which they are declared. They can be used as follows:
v They can be assigned values by expressions.
v They can be used in expressions that define an output column derivation.
v Expressions evaluating a variable can include other variables or the variable being evaluated itself.
Any stage variables you declare are shown in a table in the right pane of the links area. The table looks
similar to an output link. Stage variables are not shown in the output link metadata area at the bottom of
the right pane.
You can display or hide the table by clicking the Show/Hide Stage Variables button on the Transformer
toolbar or making the selection from the background shortcut menu.
The table lists the stage variables together with the expressions used to derive their values. Link lines join
the stage variables with input columns used in the expressions. Links from the right side of the table
connect the variables to the output columns that use them.

Procedure
1. Open the Transformer Stage Properties dialog box in one of the following ways:
v Select Insert New Stage Variable from the stage variable shortcut menu. A new variable is added
to the stage variables table in the links pane. The variable is given the default name StageVar and
default data type Decimal (18, 4). You can edit these properties using the Transformer Stage
Properties dialog box, as described in the next step.
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v Click the Stage Properties button on the Transformer toolbar.
v Select Stage Properties from the background shortcut menu.
v Select Stage Variable Properties from the stage variable shortcut menu.
2. Click the Variables tab. The Variables tab contains a grid showing currently declared variables, their
initial values, SQL type, precision, scale, and an optional description. Use the standard grid controls to
add or edit variables. Click Load... to load stage variables from a table definition in the repository, or
click Save As... to save them as a table definition in the repository. Click Clear All to start over.
Variable names must begin with an alphabetic character (a-z, A-Z) and can only contain alphanumeric
characters (a-z, A-Z, 0-9). The initial value is required and must be an absolute value in mainframe
jobs. If the initial value is a string, it must be enclosed in single quotation marks.
3. Click OK. The new variable appears in the stage variable table in the links pane.

Results
You can perform most of the same operations on a stage variable as you can on an output column (see
“Defining Output Column Derivations” on page 150). A shortcut menu offers the same commands. You
cannot, however, paste a stage variable as a new column, or paste a column as a new stage variable.

The InfoSphere DataStage Expression Editor
The InfoSphere DataStage Expression Editor helps you specify correct expressions when you edit
Transformer stages. The Expression Editor can be opened from:
v Output link Derivation cells
v Stage variable Derivation cells
v Transformer Stage Constraints dialog box
To open the Expression Editor, double-click the Derivation or Constraint field, or select Edit Derivation
from the shortcut menu.

Defining Expressions
There are two ways to define expressions using the Expression Editor: typing directly in the Expression
syntax text box, or building the expression using the available items and operators shown in the bottom
pane.

Procedure
1. Click a branch in the Item type box. The available items are displayed in the Item properties list. The
Expression Editor offers the following programming components:
v Columns. Input columns. The column name, data type, and link name are displayed under Item
properties. When you select a column, any description that exists will appear at the bottom of the
Expression Editor dialog box.
v Variables. The built-in variables SQLCA.SQLCODE, ENDOFDATA, REJECTEDCODE and
DBMSCODE, as well as any local stage variables you have defined. The variable name and data
type are displayed under Item properties.
v Built-in Routines. SQL3 functions including data type conversion, date and time, logical,
numerical, and string functions. Function syntax is displayed under Item properties. When you
select a function, a description appears at the bottom of the Expression Editor dialog box.
v Parameters. Any job parameters that you have defined. The parameter name and data type are
displayed under Item properties.
v Constants. Built-in constants including CURRENT_DATE, CURRENT_TIME,
CURRENT_TIMESTAMP, DSE_NOERROR, DSE_TRXCONSTRAINT, DSE_TRXLINK, NULL,
HIGH_VALUES, LOW_VALUES, and X. The DSE_ constants are available only for constraint
expressions, and NULL is available only for derivation expressions.
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For definitions of these programming components, see Chapter 7, “Programmer's Reference,” on
page 169.
2. Double-click an item in the Item properties list to insert it into the Expression syntax box.
3. Click one of the buttons on the Operators toolbar to insert an operator in the Expression syntax box.
(For operator definitions, see Chapter 7, “Programmer's Reference,” on page 169.)

Results
As you build the expression, you can click Undo to undo the last change or Clear All to start over. Click
OK to save the expression when you are finished.

Validating the Expression
About this task
The Expression Editor validates expressions as they are built. If a syntax error is found, a message
appears in red and the element causing the error is underlined in the Expression syntax text box. To
check for both syntax and semantic errors, first select Perform expression semantic checking in project or
job properties, then click Verify in the Expression Editor. You can save an expression without correcting
errors, but you will be warned that the expression is invalid.

Exiting the Expression Editor
About this task
You can exit the Expression Editor in one of the following ways:
v Click OK (which accepts changes).
v Click Cancel (which discards changes).
v Close the Expression Editor dialog box (which discards changes).
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Chapter 6. Code Generation and Job Upload
These topics describe how to generate code for a mainframe job and upload the job to the mainframe
machine. When you have edited all the stages in a job design, you can validate the job design and
generate code. You then transfer the code to the mainframe to be compiled and run.

Generating Code
About this task
When you have finished developing a mainframe job, you are ready to generate code for the job. To
generate code, open a job in the Designer client and do one of the following:
v Choose File > Generate Code.
v Click the Generate Code button on the toolbar.
The Code generation dialog box appears. This dialog box contains the following fields and buttons:
v Code generation path. The base location for the COBOL program and JCL files. Each mainframe job
holds the COBOL program and JCL files in a subdirectory of the base location reflecting the engine tier
host name, project name, and job. For example, where the base location is:
C:\IBM\InformationServer\Clients\Classic\Gencode
a complete path name might be:
C:\IBM\InformationServer\Clients\Classic\Gencode\R101\datastage\mjob1

v

v
v
v

You can also specify the code generation location in Designer client options. If you have already
entered a path name there, it will automatically appear in the Code generation path field. If you have
not, then a default path name is created. You can edit this path name.
Cobol program file name. The name comprises up to eight alphanumeric characters. The first
character must be alphabetic. The default name is DSn, where n is the internal job number. You can
edit this name.
Compile JCL file name. This can be up to eight alphanumeric characters. The default name is DSnC,
where n is the internal job number. You can edit this name.
Run JCL file name. This can be up to eight alphanumeric characters. The default name is DSnX, where
n is the internal job number. You can edit this name.
Trace runtime information. Choose one of the options to produce runtime information regarding the
program flow or data being read and written:
– None. No information is generated. This is the default.
– Program flow. The COBOL program is generated with a DISPLAY of every paragraph name as it is
executed. The paragraph names are indented to reflect the nesting of PERFORMs.
– Data flow. Data is printed as it is being read or written. For all source and target stages except
Relational, the entire buffer is printed without columns being identified. For Relational stages,
individual column values in the SELECT, INSERT, or UPDATE statements are printed.
– Program and Data flow. Both the program flow and the data flow are printed.

v IMS Program Type. This field is available only if there is an IMS stage in the job. Select the type of
IMS program to generate: BMP or DLI (the default).
v Generate COPY statements for customization. Select this check box if you want to customize the
COBOL program that is generated by InfoSphere DataStage. You can use this option to perform a task
at the beginning of the program, the end, or both. For details see “Code Customization” on page 160.
v Copy library prefix. This field allows you to manage several versions of the COPYLIB members used
for code customization. For more information, see “Code Customization” on page 160.
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v Generate. Click this to validate your job design and generate the COBOL program and JCL files. After
you begin, the Generate button changes to a Cancel button, allowing you to stop the code generation.
The Progress bar displays the progress of the code generation process, and relevant status messages
about job validation and code generation appear in the Status box.
v View. Click this to view the generated COBOL and JCL files. You can select the file you want to view
from a pop-up menu that is available after code is successfully generated. Microsoft Notepad is the
default viewer, but you can specify a different tool in Designer client options. Choose Tools >
Options..., select the Mainframe branch under Default in the options tree, and in the Source Viewer
field, type or browse for the path name of your preferred tool.
v Upload job... . This button is available after you successfully generate code. It opens the Remote
System dialog box, allowing you to connect to the target mainframe for job upload.
v Close. Click this to close the Code generation dialog box. The code generation path and the names of
the generated COBOL and JCL files are automatically saved with the job.
v Help. Click this to start the Help system.

Job Validation
Code generation first validates your job design. If all stages validate successfully, then code is generated.
If validation fails, code generation stops and error messages are displayed for all stages that contain
errors. Stages with errors are then highlighted in red on the Designer client canvas.
Status messages about validation are displayed in the Status box.
Validation of a mainframe job design involves:
v Checking that all stages in the job are connected in one continuous flow, and that each stage has the
required number of input and output links
v Checking the expressions used in each stage for syntax and semantic correctness
v Checking the column mappings to ensure they are data type compatible
Note: During code generation InfoSphere DataStage sets flags indicating which stages validate
successfully. After you generate code for a job, if you view a stage in your job design without making
changes, click Cancel instead of OK to close the stage editor. Next time you generate code, job
validation will bypass this stage, saving time. (This does not apply if you selected Autosave job before
compile/generate in Designer client options.)

Generated Files
Three files are produced during code generation:
v A COBOL program file, which contains the actual COBOL code that has been generated. Only one
COBOL program is generated for a job, regardless of how many stages it contains.
v A JCL compile file, which contains the JCL that controls the compilation of the COBOL code on the
target mainframe machine.
v A JCL run file, which contains the JCL that controls the running of the job on the mainframe after it
has been compiled.
After code generation is successful, the Status box displays the names and locations of the generated
files, and indicates the database name and user name used by each relational stage.

Code Customization
There are three ways you can customize code in InfoSphere DataStage mainframe jobs:
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v You can change the text associated with various warning and error messages. This text is in the
ARDTMSG1, ARDTMSG2, ARDTIMSG, and RTLMSGS COPYLIB members.
v You can use the Generate COPY statements for customization check box in the Code generation
dialog box to generate other COPY statements. This method allows you to insert your own code into
the program by using the ARDTUFCT, ARDTUFDF, ARDTUDAT, ARDTUBGN, ARDTUEND, and
ARDTUCOD COPYLIB members.
v You can use the Copy library prefix field in the Code generation dialog box to manage several
versions of the COPYLIB members mentioned above.
Note that these options are not dependent on one another. You can use any or all of these methods to
customize the generated code.

Changing Warning and Error Message Text
All COBOL programs generated by InfoSphere DataStage include three COPY statements. These
statements are generated into the WORKING-STORAGE section and are used for COBOL data structures
that contain message text strings:
v COPY ARDTMSG1. This statement is used for process log message texts. These are the messages that
are displayed at the end of the job and show run statistics.
v COPY ARDTMSG2. This statement is used for messages related to file processing errors.
v COPY ARDTIMSG. This statement is used for messages related to IMS errors.
v COPY RTLMSGS. This statement is used for messages related to errors and warnings from the
runtime library.
If you change the text in these members, be sure that you do not change the data structures themselves.

Generating COPY Statements for Customization
When you select Generate COPY statements for customization in the Code generation dialog box,
InfoSphere DataStage provides several places in the generated COBOL program that you can customize.
You can add code to be executed at program initialization, program termination, or both. However, you
cannot add code that would affect the row-by-row processing of the generated program.
When you use this method, six additional COPY statements are added to the generated COBOL program:
v COPY ARDTUFCT. This statement is generated at the end of the FILE-CONTROL paragraph in the
ENVIRONMENT DIVISION. You can use this to add SELECT statements to the program.
v COPY ARDTUFDF. This statement is generated at the end of the FILE SECTION in the DATA
DIVISION. You can use this to add FD statements to the program.
v COPY ARDTUDAT. This statement is generated just before the PROCEDURE DIVISION statement.
You can use this to add WORKING-STORAGE variables and a LINKAGE SECTION to the program.
v COPY ARDTUBGN. This statement is generated just after the PROCEDURE DIVISION statement. You
can use this to add your own program initialization code. If you included a LINKAGE SECTION in
ARDTUDAT, you can use this to add the USING clause to the PROCEDURE DIVISION statement.
v COPY ARDTUEND. This statement is generated just before each GOBACK statement. You can use this
to add your own program termination code.
v COPY ARDTUCOD. This statement is generated as the last statement in the COBOL program. You use
this to add your own paragraphs to the code. These paragraphs are those which are PERFORMed from
the code in ARDTUBGN and ARDTUEND.
InfoSphere DataStage provides default versions of these COPYLIB members. As provided, ARDTUFCT,
ARDTUFDF, ARDTUDAT, ARDTUEND, and ARDTUCOD contain only comments, and ARDTUBGN
contains comments and a period.
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Using the COPYLIB Prefix
The Copy library prefix field in the Code generation dialog box allows you to create several versions of
the included COPYLIB members. This is useful if some of your InfoSphere DataStage jobs require one
type of customization and some require another.
By default, the prefix for the COPY members is ARDT. If this prefix is used, the COPY statements are
generated as described above. If you specify your own prefix in the Copy library prefix field, the COPY
statements are generated as follows:
COPY
COPY
COPY
COPY
COPY
COPY
COPY
COPY
COPY
COPY

prefixMSG1.
prefixMSG2.
prefixIMSG.
prefixMSGS.
prefixUFCT.
prefixUFDF.
prefixUDAT.
prefixUBGN.
prefixUEND.
prefixUCOD.

The prefix must be 1-4 characters long and convertible to uppercase. The first character of the prefix must
be A-Z, #, $, or @. The other characters must be A-Z, 0-9, #, $, or @. If you change the prefix, you must
make sure that COPYLIB members exist with those names; note that COPYLIB members are subject to
COBOL validation rules.

COPY Statement Results
Your selections in the Code generation dialog box determine how the COPY statements are generated
into the COBOL program. You can select the Generate COPY statements for customization check box,
you can specify your own prefix in the Copy library prefix field, or you can do both. Table 42 describes
the actual COPY statements that are generated based on your selections.
Table 42. Actual COPY Statements Generated

"Generate COPY Statements for
Customization" check box is not
selected

Default COPYLIB Prefix (ARDT)
Used

User-Specified COPYLIB Prefix

COPY ARDTMSG1
COPY ARDTMSG2
COPY RTLMSGS

COPY prefixMSG1
COPY prefixMSG2
COPY prefixMSGS

"Generate COPY Statements for
COPY ARDTMSG1
Customization" check box is selected COPY ARDTMSG2
COPY RTLMSGS
COPY ARDTUFCT
COPY ARDTUFDF
COPY ARDTUDAT
COPY ARDTUBGN
COPY ARDTUEND
COPY ARDTUCOD

COPY
COPY
COPY
COPY
COPY
COPY
COPY
COPY
COPY

prefixMSG1
prefixMSG2
prefixMSGS
prefixUFCT
prefixUFDF
prefixUDAT
prefixUBGN
prefixUEND
prefixUCOD

Uploading Jobs
After you successfully generate code for a mainframe job, you can upload the files to the target
mainframe, where the job is compiled and run. If you make changes to a job, you must regenerate code
before you can upload the job.
To upload a job, open the Remote System dialog box in one of the following ways:
v Open the job and choose File > Upload Job from the main menu.
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v Click Upload job... in the Code generation dialog box after you have successfully generated code.
Use the Remote System dialog box to specify information about connecting to the target mainframe
system. This dialog box contains the following fields:
v Machine profile. A configured name that identifies the mainframe machine connection. Select a
machine name from the list. This list contains all the machine profiles defined in the Machine Profiles
folder of the repository. For details about creating new machine profiles, see “Working with Machine
Profiles” on page 164.
v Platform. The mainframe platform type. Since z/OS is the only platform currently supported, this field
is read-only.
v IP Host name/address. The IP address or a fully qualified host name.
v User name. The user name or account to use for host system login.
v Password. The password associated with the user name for host system login.
v Source library. The library on the remote system where mainframe source jobs will be transferred.
Compile JCL library. The library on the remote system where JCL compile files will be transferred.
Run JCL library. The library on the remote system where JCL run files will be transferred.
Object library location. The library on the remote system where compiler output will be transferred.
Load library location. The library on the remote system where executable programs will be transferred.
DBRM library location. The library on the remote system where information about a DB2 program
will be transferred.
v Jobcard accounting information. Identification information for the jobcard.
v FTP Service. The FTP service type. Active FTP service is for an active connection, which is generally
used when command processing is required. This is the default. The Passive option is available if you
need to establish a connection through a firewall that does not allow inbound communication.
v
v
v
v
v

v Port. The network port ID for the FTP connection. The default port is 21.
v Transfer type. The FTP transfer type. Select ASCII, BINARY, or quote type B 1, or specify your own
transfer type using the FTP quote command.
If you select an existing machine profile in the Remote System dialog box, the host name and address,
user name and password, and library locations are automatically filled in. You can edit these fields, but
your changes are not saved. When you are finished, click Connect to establish the mainframe connection.
After you have successfully connected to the target machine, the Job Upload dialog box appears, allowing
you to actually upload the job. This dialog box has two display areas: one for the Local System and one
for the Remote System. It contains the following fields:
v Jobs. The name of the job that you are currently working on.
v Files in job. The files belonging to the selected job. This field is read-only.
v Select Transfer Files. The files to upload. You can choose from three options:
– All. Uploads the COBOL source, compile JCL, and run JCL files.
– JCL Only. Uploads only the compile JCL and run JCL files.
– COBOL Only. Uploads only the COBOL source file.
v Source library. The name of the source library on the remote system that you specified in the Remote
System dialog box. You can edit this field, but your changes are not saved.
v Compile library. The name of the compile library on the remote system that you specified in the
Remote System dialog box. You can edit this field, but your changes are not saved.
v Run library. The name of the run library on the remote system that you specified in the Remote
System dialog box. You can edit this field, but your changes are not saved.
v Transferred files. The files transferred to the remote system. This field is read-only.
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When you are ready to start uploading a job, click Start Transfer. The names of the files in the job appear
in the Files in job box. After the files are uploaded, the file names appear in the Transferred files box.
Note: Before uploading a job, check to see if the directory on the target machine is full. If the directory is
full, the files cannot be uploaded. However, the file names still appear in the Transferred files box if you
click Start Transfer. You should compress the partitioned data sets on the target machine in this situation.
If you want to upload a job to another mainframe machine, click New Connection. The Remote System
dialog box appears, allowing you to select a different machine connection.

COBOL Compiler Options
InfoSphere DataStage uses the following COBOL compiler options when compiling the generated COBOL
source: APOST, LIB, NONAME, NODYNAM, and RENT. For a complete explanation of each option, see
the latest edition of IBM COBOL for OS/360 and VM Programming Guide.

Working with Machine Profiles
A machine profile defines the connection to a mainframe machine. Machine profiles are created in the
InfoSphere DataStage repository. You can choose to create a machine profile before you upload a job, or
you can specify the connection details and library names in the Remote System dialog box at upload time
(however, these specifications are not saved). If you will be uploading jobs to the same machine
frequently, it might be faster to create a machine profile in advance.
If you are generating operational met data, then you can also use a machine profile to specify the
connection details of the machine where the XML file will be transferred.
When you create, view, or edit a machine profile in the Machine Profiles folder of the repository, the
Machine Profile dialog box appears. This dialog box has three pages: General, Connection, and Libraries.
There are three buttons in the Machine Profile dialog box:
v OK. Saves changes to the machine profile and closes the Machine Profile dialog box.
v Cancel. Discards changes to the machine profile and closes the Machine Profile dialog box.
v Help. Starts the Help system.

Creating a Machine Profile
To create a new machine profile, open the Machine Profile dialog box in one of the following ways:
v Choose File > New from the main menu or click the New button on the toolbar. The New dialog box
appears. Click the Other folder and select the Machine Profile icon.
v Right-click the Machine Profiles folder in the repository tree and select New > Other > Machine
Profile from the shortcut menu.
The General page is displayed by default. Specify general information about the machine profile,
including:
v Machine profile name. Type the name of the machine profile.
v Platform type. Select the platform type. z/OS is the only platform currently supported.)
v Short description. Type an optional brief description of the machine profile. The text entered in this
field is displayed when you print a report.
v Long description. Type an optional detailed description of the routine.
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Next, select the Connection page to specify the connection parameters for the mainframe machine.
Specify mainframe connection parameters, including:
v IP Host name/address. Type the IP address or a fully qualified host name.
v Port. If necessary, change the network port ID for the FTP connection. The default port is 21.
v User name. Type the user name or account to use for host system login.
v FTP transfer type. Specify the file transfer type. Select ASCII for text files, Binary for non-text files, or
specify your own transfer type.
v Password. Type the password associated with the user name for host system login.
v FTP Service. Select the FTP service type. There are two options:
– Active. Active FTP connection. This is the default and is generally used when command processing
is required.
– Passive. Establishes an FTP connection through a firewall that does not allow inbound
communication.
The Mainframe operational metadata area allows you to specify details about the XML file that is
created if you select Generate operational metadata in project or job properties. You can then use a
machine profile to load these details in the Operational metadata page of the Job Properties dialog box.
There are two fields in this area:
v XML file target directory. Type the name of the target directory, relative to the default FTP directory,
where the XML file should be placed. Specify the name in the appropriate DOS mode, including any
slash marks that are required. If the directory name contains blanks, enclose the full name in single
quotation marks. If you leave this field blank, the XML file is placed in the default FTP directory on
the InfoSphere DataStage client workstation.
v Dataset name for XML file. Type the data set name for the XML file on the mainframe machine. Be
sure to create this file on the mainframe before you run the COBOL program.
Note: If you create a machine profile just for operational metadata, then no entries are needed in the
fields on the Libraries page of the Machine Profile dialog box.
Select the Libraries page to complete the machine profile. This page displays the names of the libraries on
the mainframe machine where jobs will be transferred, including:
v Source library. Type the name of the library where the mainframe source jobs should be placed.
Compile JCL library. Type the name of the library where JCL compile files should be placed.
Run JCL library. Type the name of the library where JCL run files should be placed.
Object library. Type the name of the library where compiler output should be placed.
DBRM library. Type the name of the library where information about a DB2 program should be
placed.
v Load library. Type the name of the library where executable programs should be placed.

v
v
v
v

v Jobcard accounting information. Type identification information for the jobcard.
Click OK to save the machine profile. You must specify a user name and password on the Connection
page before you are allowed to save a new machine profile.

Viewing and Editing a Machine Profile
About this task
To view or edit an existing machine profile, open the Machine Profile dialog box in one of the following
ways:
v Select a machine profile in the repository tree and choose Repository > Properties.
v Right-click a machine profile in the repository tree and select Properties from the shortcut menu.
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v Double-click the machine profile in the repository tree.
You can edit any of the fields and options in the Machine Profile dialog box. If you make any changes,
be sure to save them before closing the this dialog box.

Copying a Machine Profile
About this task
You can copy an existing machine profile in two ways:
v Select the machine profile in the repository tree and choose Repository > Create copy.
v Right-click the machine profile in the repository tree and select Create copy from the shortcut menu.
The machine profile is copied and a new machine profile is created in the same folder of the repository
tree. By default, the name of the copy is called CopyOfXXX, where XXX is the name of the chosen
machine profile. Use the edit box to rename the copy immediately.

Renaming a Machine Profile
About this task
You can rename a machine profile in several ways:
v Double-click the machine profile in the repository tree to open the Machine Profile dialog box. Edit the
Machine profile name field and click Close.
v Select the machine profile in the repository tree and click again. In the edit box, type a new name or
edit the existing one. Save the name by pressing Enter or by clicking outside the edit box.
v Right-click the machine profile and select Rename from the shortcut menu. In the edit box, type a new
name or edit the existing one. Save the name by pressing Enter or clicking outside the edit box.
v Select the machine profile in the repository tree and choose Repository > Rename. In the edit box, type
a new name or edit the existing one. Save the name by pressing Enter or by clicking outside the edit
box.

Compiling Multiple Jobs
About this task
You can compile and upload multiple mainframe jobs at once using the compiler wizard. There are two
ways to invoke the wizard:
v Choose Tools > Multiple Job Compile from the main menu.
v In the InfoSphere DataStage client folder, double-click the file dsjcwiz.exe (for example,
C:\IBM\InformationServer\Clients\Classic\dsjcwiz.exe). Type your login details in the Attach to
Project dialog box to attach to your project.
The compiler wizard starts.

Procedure
1. Specify the type of job to compile on the Job Selection Criteria window:
a. Mainframe is selected by default in the Job Selection area, along with other job types if you have
other InfoSphere DataStage components installed.
b. If you want to automatically select all jobs that have not been compiled, select the Only select
uncompiled jobs check box.
c. If you want to choose which jobs to compile, select the Show Manual Selection page check box. If
this check box is cleared, the wizard selects all jobs in the project, or all uncompiled jobs if you
selected Only select uncompiled jobs.
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2. Click Next >. If you selected the Show Manual Selection page check box, the Job Selection Override
window opens. Select the jobs you want to compile and skip to step 5. Otherwise the Compiler
Options window opens.
3. In the Upload Profile list, select the machine profile for job upload or click Don't Upload Job to skip
job upload.
4. If your jobs already have a code generation path specified in the Code generation dialog box, select
Use Job-level Code Generation Path to have the wizard use the existing path. Otherwise, clear this
check box and specify a new path in the Code Generation Base Directory field. The default path is
C:\IBM\InformationServer\Clients\Classic. Click Browse to browse for a different path. If you
change the path, your jobs will be saved with the new path.
5. Click Next >. The Compile Process window opens. Click Start Compile to begin compilation. As each
job is compiled, status messages are displayed in the Status field. If compilation fails, you can select
the failed job to view details and error messages in the Compilation Output area.
6. Click Finish to close the wizard. If you selected the Show Compile report when Finished check box,
the job compilation report opens in your default text editor. It displays the compilation start and
finish times, the number of jobs that succeeded or failed, and compilation details for any failed jobs.

Results
You can also compile multiple jobs from the command line of the InfoSphere DataStage client machine by
invoking the file dscc.exe in the InfoSphere DataStage client directory. The dscc command takes several
arguments.
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Chapter 7. Programmer's Reference
This appendix provides a programmer's reference guide for InfoSphere DataStage MVS Edition. It
describes the programming components that are available for mainframe jobs.

Programming Components
There are different types of programming components used within mainframe jobs. They fall into two
categories:
v Built-in. InfoSphere DataStage MVS Edition comes with several built-in programming components that
you can reuse within your mainframe jobs as required. These variables, functions, and constants are
used to build expressions. They are only accessible from the Expression Editor, and the underlying
code is not visible.
v External. You can use certain external components, such as COBOL library functions, from within
InfoSphere DataStage MVS Edition. This is done by defining a routine which in turn calls the external
function from an External Source, External Target, or External Routine stage.
The following sections discuss programming terms you will come across when programming mainframe
jobs.

Constants
A constant is a value that is fixed during the execution of a program, and can be reused in different
contexts. Table 43 describes the constants that are available in mainframe jobs.
Table 43. Mainframe Job Constants
Constant

Definition

CURRENT_DATE

Returns the current date at the time of execution.

CURRENT_TIME

Returns the current time at the time of execution.

CURRENT_TIME(<Precision>)

Returns the current time to the specified precision at the
time of execution.

CURRENT_TIMESTAMP

Returns the current timestamp at the time of execution.

CURRENT_TIMESTAMP (<Precision>)

Returns the current timestamp to the specified precision
at the time of execution.

DSE_NOERROR1

The row was successfully inserted into the link.

DSE_TRXCONSTRAINT
DSE_TRXLINK
NULL

1

1

The database rejected the row.

2

The value is null.

HIGH_VALUES
LOW_VALUES

The link constraint test failed.

3

3

X

A string value in which all bits are set to 1.
A string value in which all bits are set to 0.
A string literal containing pairs of hexadecimal digits,
such as X'0D0A'. Follows standard SQL syntax for
specifying a binary string value.

1

Only available in constraint expressions to test the variable REJECTEDCODE. See "Variables" for more
information.
2

Only available in derivation expressions.

© Copyright IBM Corp. 2000, 2011

169

3

Only available by itself in output column derivations, as the initial value of a stage variable, or as the
argument of a CAST function. The constant cannot be used in an expression except as the argument of a
CAST function. The data type of the output column or stage variable must be Char or VarChar.

Constraints
A constraint is a rule that determines what values can be stored in the columns of a table. Using
constraints prevents the storage of invalid data in a table.
Constraints are Boolean expressions that return TRUE or FALSE. Constraints are defined on:
v the Transformer Stage Constraints dialog box
v the Constraints tab in Complex Flat File, Multi-format Flat File, IMS, Fixed-width Flat File, Delimited
Flat File, and External Source stages
v the Where tab in Relational, Teradata Relational, and Teradata Export stages
Transformer stage constraints are defined using the Expression Editor, which provides access to all of the
built-in constants, functions, variables, and operators in InfoSphere DataStage.
Source stage constraints and WHERE clauses are built using a grid, which provides access to InfoSphere
DataStage operators and most built-in logical functions. You can make selections in the grid, or you can
manually type the constraint by double-clicking in one of the cells. Manually-specified constraints can
include any of InfoSphere DataStage built-in functions except for IF THEN ELSE, IS DATE, IS NOT
DATE, and IS NUMERIC. See “Functions” on page 171 for detailed descriptions of these functions.

Expressions
An expression is an element of code that defines a value. The word expression is used both as a specific
part of SQL3 syntax, and to describe portions of code that you can specify when defining a job.
Expressions can contain:
v Column names
v Variables
v
v
v
v

Functions
Parameters
String or numeric constants
Operators

In mainframe jobs, expressions are used to define constraints, column derivations, stage variable
derivations, SQL clauses, and key expressions. Table 44 describes how and where you define expressions
in mainframe job stages.
Table 44. Mainframe Job Expressions
Stage

Expression Editor

Expression Grid

Complex Flat File

Constraint tab

Multi-format Flat File

Constraint tab

IMS

Constraint tab

Fixed-width Flat File

Constraint tab

Delimited Flat File

Constraint tab

External Source

Constraint tab

Relational

Update Columns tab

Where tab, Group By tab, Having
tab, Order By tab

Teradata Relational

Update Columns tab

Where tab, Group By tab, Having
tab, Order By tab
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Table 44. Mainframe Job Expressions (continued)
Stage

Expression Editor

Teradata Export

Expression Grid
Where tab, Group By tab, Having
tab

Teradata Load

Update Columns tab

Transformer

Derivation cell for output columns
and stage variables, Transformer
Stage Constraints dialog box

Business Rule

Derivation cell for output columns
and stage variables

Where tab

Join

Join Condition tab

Lookup

Pre-lookup Condition tab, Lookup
Condition tab

Details about defining expressions are provided in the chapters describing the individual stage editors.

Functions
Functions take arguments and return a value. The word function is applied to two components in
InfoSphere DataStage mainframe jobs:
v Built-in functions. These are special SQL3 functions that are specific to InfoSphere DataStage MVS
Edition. You can access these built-in functions via the Built-in Routines branch of the Item type
project tree, which is available in the Expression Editor or on the Definition tab of the Business Rule
Stage dialog box. These functions are defined in the following sections.
v DB2 functions. These are functions supported only in DB2 data sources. When defining computed
columns in Relational, Teradata Relational, and Teradata Export stages, you can access the DB2
functions by clicking Functions in the Computed Column dialog box. See your DB2 documentation for
function definitions.

Date Type Conversion Functions
Table 45 describes the built-in data type conversion functions that are available in mainframe jobs.
Table 45. Data Type Conversion Functions
Function

Syntax

Description

CAST

CAST(<Operand>AS CHAR
(<Length>))

Converts the value of <Operand> to
Char data type.

CAST

CAST(<Operand>AS VARCHAR
(<Length>))

Converts the value of <Operand> to
VarChar data type.

CAST

CAST(<Operand>AS SMALLINT)

Converts the value of <Operand> to
SmallInt data type.

CAST

CAST(<Operand>AS INT)

Converts the value of <Operand> to
Integer data type.

CAST

CAST(<Operand>AS DECIMAL
(<Precision>, <Scale>))

Converts the value of <Operand> to
Decimal data type with the specified
precision and scale.

CAST

CAST(<Operand>AS DATE)

Converts the value of <Operand> to
Date data type.1

CAST

CAST(<Operand>AS TIME
(<TimePrecision>))

Converts the value of <Operand> to
Time data type with the specified
precision.2
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Table 45. Data Type Conversion Functions (continued)
Function

Syntax

Description

CAST

CAST(<Operand>AS
TIMESTAMP(<Timestamp-Precision>))

Converts the value of <Operand> to
Timestamp data type with the
specified precision.3

CAST

CAST(<Operand>AS NCHAR
(<Length>))

Converts the value of <Operand> to
NChar data type.4

CAST

CAST(<Operand>AS NCHAR
VARYING (<Length>))

Converts the value of <Operand> to
NVarChar data type.4

1

The format of <Operand> must be consistent with the default date format specified in project or job
properties.
2

The format of <Operand> must be in InfoSphere DataStage MVS Edition's internal time form, HH:MM:SS.

3

The format of <Operand> must be in InfoSphere DataStage MVS Edition's internal timestamp form,
CCYY-MM-DD HH:MM:SS.NNNNNN. If the date portion does not exist, the result is set to the current
date. If the time portion does not exist, the result is set to 00:00:00.
4

The data type of <Operand> must be NChar or NVarChar.

Date and Time Functions
Table 46 describes the built-in date and time functions that are available in mainframe jobs.
Table 46. Date and Time Functions
Function

Syntax

Description

DATE

DATE `yyyy-mm-dd'

Treats the constant specified by
`yyyy-mm-dd' as a Date data type
rather than a Char data type.

EXTRACT

EXTRACT(YEAR FROM <DateTime>) Returns the numeric value of the
year from <DateTime>.1

EXTRACT

EXTRACT(MONTH FROM
<DateTime>)

Returns the numeric value of the
month from <DateTime>.1,2

EXTRACT

EXTRACT(DAY FROM <DateTime>)

Returns the numeric value of the day
from <DateTime>.1

EXTRACT

EXTRACT(HOUR FROM
<DateTime>)

Returns the numeric value of the
hour from <DateTime>.3

EXTRACT

EXTRACT(MINUTE FROM
<DateTime>)

Returns the numeric value of the
minute from <DateTime>.3

EXTRACT

EXTRACT(SECOND FROM
<DateTime>)

Returns the numeric value of the
second (including fractional seconds)
from <DateTime>.3

TIME

TIME `hh:mm:ss'

Treats the constant specified by
`hh:mm:ss' as a Time data type rather
than a Char data type.

TIMESTAMP

TIMESTAMP `yyyy-mm-dd hh:mm:ss'

Treats the constant specified by
`yyyy-mm-dd hh:mm:ss' as a
Timestamp data type rather than a
Char data type.

1

The data type of <DateTime> must be Date or Timestamp.
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2

If the value of MONTH or DAY in <DateTime> is less than 10, and you CAST the extracted value as
Char(2), the leading zero is dropped. Use the concatenation function to restore it if necessary.
3

The data type of <DateTime> must be Time or Timestamp.

Logical Functions
Table 47 describes the built-in logical functions that are available in mainframe jobs. IF THEN ELSE can
stand alone or can be nested within other IF THEN ELSE statements. The rest of the logical functions can
only be used as the argument of an IF THEN ELSE statement.
Table 47. Logical Functions
Function

Syntax

Description

BETWEEN

<Expression1>BETWEEN
<Expression2>AND <Expression3>

Returns TRUE if <Expression2> is less
than or equal to <Expression1> and
<Expression1> is less than or equal to
<Expression3>. Otherwise, it returns
FALSE.

NOT BETWEEN

<Expression1>NOT
BETWEEN<Expression2>
AND<Expression3>

Returns TRUE if <Expression1> is less
than <Expression2> or <Expression1>
is greater than <Expression3>.
Otherwise, it returns FALSE.

IF THEN ELSE

IF<BooleanExpression>
THEN<Expression1>
ELSE<Expression2>END

If <BooleanExpression> is true, returns
the value of <Expression1>.
Otherwise, it returns the value of
<Expression2>.

IN

<Expression1>IN (<Expression2>,
<Expression3>,..., <ExpressionN>)

Returns TRUE if the value of
<Expression1> is in the list of values.
Otherwise, it returns FALSE.

NOT IN

<Expression1>NOT IN (<Expression2>, Returns TRUE if the value of
<Expression3>,..., <ExpressionN>)
<Expression1> is not in the list of
values. Otherwise, it returns FALSE.

IS DATE

<Expression>IS DATE

Returns TRUE if the value of
<Expression> is a DATE. Otherwise it
returns FALSE.1

IS NOT DATE

<Expression>IS NOT DATE

Returns TRUE if the value of
<Expression> is not a DATE.
Otherwise it returns FALSE.1

IS FALSE

<Expression>IS FALSE

Returns TRUE if the value of
<Expression> is false. Otherwise it
returns FALSE.

IS NOT FALSE

<Expression>IS NOT FALSE

Returns TRUE if the value of
<Expression> is not false. Otherwise it
returns FALSE.

IS HIGH_ VALUES

<String>IS HIGH_VALUES

Returns TRUE if the value of
<String> is 0xFFFF. Otherwise, it
returns FALSE.

IS NOT HIGH_ VALUES

<String>IS NOT HIGH_VALUES

Returns TRUE if the value of
<String> is not 0xFFFF. Otherwise, it
returns FALSE.

IS LOW_ VALUES

<String>IS LOW_VALUES

Returns TRUE if the value of
<String> is 0x0000. Otherwise, it
returns FALSE.
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Table 47. Logical Functions (continued)
Function

Syntax

Description

IS NOT LOW_ VALUES

<String>IS NOT LOW_VALUES

Returns TRUE if the value of
<String> is not 0x0000. Otherwise, it
returns FALSE.

IS NULL

<BooleanExpression>IS NULL

Returns TRUE if the value of
<Expression1> is NULL. Otherwise, it
returns FALSE.

IS NOT NULL

<BooleanExpression>IS NOT NULL

Returns TRUE if <Expression1> is not
NULL. Otherwise, it returns FALSE.

IS NUMERIC

<String> IS NUMERIC or <Decimal>
IS NUMERIC

Returns TRUE if the value of
<String> or <Decimal> can be
converted to a numeric data type.
Otherwise, it returns FALSE.

IS TRUE

<Expression>IS TRUE

Returns TRUE if the value of
<Expression> is true. Otherwise it
returns FALSE.

IS NOT TRUE

<Expression>IS NOT TRUE

Returns TRUE if the value of
<Expression> is not true. Otherwise it
returns FALSE.

1

The data type of <Expression> must be Char, Date or VarChar, and the format of the date value must be
CCYY-MM-DD.

Numerical Functions
Table 48 describes the built-in numerical function that is available in mainframe jobs.
Table 48. Numerical Functions
Function

Syntax

Description

ROUND

ROUND(<Expression>,
<Integer_value>)

<Expression> is rounded to
<Integer_value> places right of the
decimal point. If <Integer_value> is
negative, <Expression> is rounded to
the absolute value of <Integer_value>
places to the left of the decimal
point.1,2

1

The data type of <Expression> must be BINARY or DECIMAL. (Note that DISPLAY NUMERIC and
FLOAT data types are automatically converted to Decimal type after being read from a flat file.)
2

If <Expression> is null, the result is the null value.

ROUND Examples
The ROUND function can be used to round a constant value, a single column value, a simple expression,
or any intermediate value within a complex expression. For decimal data, it rounds a value to the right
or left of a decimal point. For binary data, it rounds a value to the left of the decimal point.
If the absolute value of <Integer_value> is larger than the number of digits to the left of the decimal point,
the result will be zero. If the absolute value of <Integer_value> is larger than the number of digits to the
right of the decimal point, no rounding will occur. If <Expression> is a BINARY data type and
<Integer_value> is positive, no rounding will occur.
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The first example shows how the same number is rounded to different decimal places using the ROUND
function:
Expression

Result

ROUND(876.543,2)

876.54

ROUND(876.543,1)

876.5

ROUND(876.543,0)

877

ROUND(876.543,-1)

880

ROUND(876.543,-2)

900

ROUND(876.543,-3)

1000

ROUND(876.543,-4)

0

The next example demonstrates how positive and negative numbers are rounded using zero decimal
places:
Expression

Result

ROUND(6.9,0)

7

ROUND(6.1,0)

6

ROUND(-6.1,0)

-6

ROUND(-6.9,0)

-7

The last example shows how the ROUND function operates in an expression. The results vary depending
on whether you round the intermediate values within the expression or only the result. Suppose you
want to calculate the sum of two columns multiplied by a third column. For example:
(COL1 + COL2) * COL3

You can round the result only, the sum of COL1 and COL2 only, or all three numbers plus the result.
Suppose COL1 is 35.555555, COL2 is 15.55, and COL3 is .555000. The results would vary as shown:
Expression

Result

ROUND((COL1 + COL2) * COL3, 2)

28.36

ROUND(ROUND(COL1 + COL2), 2) * COL3, 2)

28.37

ROUND((ROUND(COL1, 2) + ROUND(COL2, 2)) *
ROUND(COL3, 2), 2)

28.62

String Functions
Table 49 describes the built-in string functions that are available in mainframe jobs. Strings must contain
displayable character data. The hexadecimal value `00'x will cause a string function to stop.
Table 49. String Functions
Function

Syntax

Description

AND_BITS

AND_BITS(<String1>, <String2>)

Returns a value that is the result of a
bitwise AND-ing of <String1> and
1
<String2>.

CHARACTER_LENGTH

CHARACTER_LENGTH(<String>)

Returns the number of characters in
2
<String>.
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Table 49. String Functions (continued)
Function

Syntax

Description

LOWER

LOWER(<String>)

Returns the value of <String>
converted to lowercase.2

LPAD

LPAD(<String1>, <StringLength>,
<String2>)

Returns a string of <StringLength>
characters that consists of <String1>
padded to the left with <String2>
characters. If <String2> is omitted,
3
the default is to pad with blanks.

OR_BITS

OR_BITS(<String1>, <String2>)

Returns a value that is the result of a
bitwise OR-ing of <String1> and
<String2>.1

POSITION

POSITION(<String1>IN <String2>)

Returns the first position at which
<String1> occurs within <String2>.4

RPAD

RPAD(<String1>, <StringLength>,
<String2>)

Returns a string of <StringLength>
characters that consists of <String1>
padded to the right with <String2>
characters. If <String2> is omitted,
the default is to pad with blanks.3

SUBSTRING

SUBSTRING(<String>
FROM<StartPosition>)

Returns the portion of <String> that
begins at the byte indicated by
<StartPosition> and ends at the end of
<String>.5

SUBSTRING

SUBSTRING(<String>
FROM<StartPosition>
FOR<StringLength>)

Returns the portion of <String> that
begins at the byte indicated by
<StartPosition> and continues for
<StringLength> bytes or to the end of
<String> if <StringLength> is
omitted.5

TRIM

TRIM(<String>)

Returns the portion of <String> with
leading and trailing blanks removed.6

TRIM

TRIM(<Character>FROM <String>)

Returns the portion of <String> with
both leading and trailing <Character>
removed.6

TRIM

TRIM(BOTH FROM <String>)

Returns the portion of <String> with
both leading and trailing blanks
removed.6

TRIM

TRIM(BOTH<Character>
FROM<String>)

Returns the portion of <String> with
both leading and trailing <Character>
removed.6

TRIM

TRIM(LEADING FROM <String>)

Returns the portion of <String> with
leading blanks removed.6

TRIM

TRIM(LEADING <Character>FROM
<String>)

Returns the portion of <String> with
leading <Character> removed.6

TRIM

TRIM(TRAILING FROM <String>)

Returns the portion of <String> with
trailing blanks removed.6

TRIM

TRIM(TRAILING <Character>FROM
<String>)

Returns the portion of <String> with
trailing <Character> removed.6

UPPER

UPPER(<String>)

Returns the value of <String>
converted to uppercase.2
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Table 49. String Functions (continued)
Function

Syntax

Description

XOR_BITS

XOR_BITS(<String1>, <String2>)

Returns a value that is the result of a
bitwise exclusive OR-ing of <String1>
and <String2>.1

1

The data type of <String1> and <String2> must be Char or VarChar. If both arguments are Char, the data
type of the result is Char; otherwise it is VarChar. If both arguments are non-nullable, the result is
non-nullable; otherwise it is nullable. The precision of the result is equal to the smaller precision of the
two arguments. Note that the precision of the result dictates the number of bytes used in the operation
and the number of bytes returned by the function; also note that it is expressed as a number of bytes, not
bits. NULL is returned by the function if either argument is NULL.
2

The data type of <String> must be Char, VarChar, NChar, or NVarChar.

3

If the data type of <Expression> is not Char, VarChar, NChar, or NVarChar, then <Expression> is
converted to VarChar data type with a maximum length of <StringLength> before padding occurs. If the
data type of <Expression> is NChar or NVarChar, then the data type of <String> must also be NChar or
NVarChar. <StringLength> must be an integer greater than zero.

4

The data types of <String1> and <String2> must be Char, VarChar, NChar, or NVarChar.

5

The data type of <String> must be Char, VarChar, NChar, or NVarChar. The data types of <StartPosition>
and <StringLength> must be numeric with a scale of 0. If <String>, <StartPosition>, or <StringLength> is
NULL, the result is NULL. If <StringLength> is less than or equal to zero, the result is NULL.
6

The data type of <String> and <Character> must be Char, VarChar, NChar, or NVarChar. The length of
<Character> must be 1.

Multibyte String Functions
Table 50 describes the multibyte string functions that are available in mainframe jobs. These are available
only if National Language Support (NLS) is installed as part of the InfoSphere DataStage server.
Table 50. Multibyte String Functions
Function

Syntax

Description

CHARACTER_LENGTH_MB

CHARACTER_LENGTH_MB

Returns the number of characters in
1,
<String>. 2

(<String>)
LOWER_MB

LOWER_MB(<String>)

Returns the value of <String>
converted to lowercase.1

POSITION_MB

POSITION_MB(<String1>
IN<String2>)

Returns the first position at which
<String1> occurs within <String2>.2,3

SUBSTRING_MB

SUBSTRING_MB(<String>
FROM<StartPosition>)

Returns the portion of <String> that
begins at the character indicated by
<StartPosition> and ends at the end of
<String>.4

SUBSTRING_MB

SUBSTRING_MB(<String>
FROM<StartPosition>
FOR<StringLength>)

Returns the portion of <String> that
begins at the character indicated by
<StartPosition> and continues for
<StringLength> characters.4

TRIM_MB

TRIM_MB(<String>)

Returns the portion of <String> with
leading and trailing blanks removed.5
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Table 50. Multibyte String Functions (continued)
Function

Syntax

Description

TRIM_MB

TRIM_MB(<Character>
FROM<String>)

Returns the portion of <String> with
both leading and trailing <Character>
removed.5

TRIM_MB

TRIM_MB(BOTH FROM <String>)

Returns the portion of <String> with
both leading and trailing blanks
removed.5

TRIM_MB

TRIM_MB(BOTH<Character>
FROM<String>)

Returns the portion of <String> with
both leading and trailing <Character>
removed.5

TRIM_MB

TRIM_MB(LEADING FROM
<String>)

Returns the portion of <String> with
leading blanks removed.5

TRIM_MB

TRIM_MB(LEADING
<Character>FROM <String>)

Returns the portion of <String> with
leading <Character> removed.5

TRIM_MB

TRIM_MB(TRAILING FROM
<String>)

Returns the portion of <String> with
trailing blanks removed.5

TRIM_MB

TRIM_MB(TRAILING
<Character>FROM <String>)

Returns the portion of <String> with
trailing <Character> removed.5

UPPER_MB

UPPER_MB(<String>)

Returns the value of <String>
converted to uppercase.1

1

The data type of <String> must be Char, VarChar, NChar, or NVarChar.

2

The number for these functions is expressed in terms of characters, not bytes. Embedded SHIFT-OUT or
SHIFT-IN keys are ignored.
3

The data types of <String1> and <String2> must be Char, VarChar, NChar, or NVarChar.

4

The data type of <String> must be Char, VarChar, NChar, or NVarChar. The data types of <StartPosition>
and <StringLength> must be numeric with a scale of 0. If <String>, <StartPosition>, or <StringLength> is
NULL, the result is NULL. If <StringLength> is less than or equal to zero, the result is NULL.
5

The data type of <String> and <Character> must be Char, VarChar, NChar, or NVarChar. The length of
<Character> must be 1.

LPAD and RPAD Examples
The LPAD and RPAD string padding functions are useful for right-justifying character data or
constructing date strings in the proper format. For example, suppose you wanted to convert an integer
field to a right-justified character field with a width of 9 characters. You would use the LPAD function in
an expression similar to this:
LPAD(ItemData.quantity,9)

Another example is to convert integer fields for year, month, and day into a character field in
YYYY-MM-DD date format. The month and day portions of the character field must contain leading
zeroes if their integer values have less than two digits. You would use the RPAD function in an
expression similar to this:
CAST(Item.Data.ship_year AS CHAR(4))||
LPAD(ItemData.ship_month,2,’0’)||’-’||
LPAD(ItemData.ship_day,2,’0’)

178

Mainframe Job Developer's Guide

To right-justify a DECIMAL(5,2) value to a width of 10 characters, you would specify the LPAD function
as follows:
LPAD(value,10)

This would yield results similar to this:
Value

Result

12.12

12.12

100.00

100.00

-13.13

-13.13

-200.00

-200.00

To include a plus sign for positive numbers, you would specify the expression as follows:
IF value > 0
THEN LPAD(’+’ || CAST(value AS VARCHAR(6)),10)
ELSE LPAD(value,10)
END

The results would then be similar to this:
Value

Result

12.12

+12.12

100.00

+100.00

-13.13

-13.13

-200.00

-200.00

SUBSTRING Rules
The SUBSTRING and SUBSTRING_MB functions perform substring extraction according to SQL3
guidelines. The operations are identical, but the orientations are different. Use the SUBSTRING_MB
function when you want to perform character-oriented substring extraction. This function handles
multibyte characters, so if your string contain multibyte character data, use this function. Use the
SUBSTRING function when you want to do byte-oriented substring extraction.
The SUBSTRING function is implemented using COBOL statements, whereas the SUBSTRING_MB
function is implemented as a call to a runtime library routine. The implications of this are that the
byte-oriented SUBSTRING function performs better than the character-oriented SUBSTRING_MB
function.
If the <StartPosition> or the implied end position is outside the bounds of <String>, these functions return
only the portion that is within the bounds. For example:
SUBSTRING(’ABCDE’ FROM 1)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM 0)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -1)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -2)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -3)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM 1 FOR 4)

returns ’ABCD’

SUBSTRING(’ABCDE’ FROM 0 FOR 4)

returns ’ABC’

SUBSTRING(’ABCDE’ FROM -1 FOR 4)

returns ’AB’
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SUBSTRING(’ABCDE’ FROM -2 FOR 4)

returns ’A’

SUBSTRING(’ABCDE’ FROM -3 FOR 4)

returns ’’

SUBSTRING(’ABCDE’ FROM 1 FOR 23)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM 0 FOR 23)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -1 FOR 23)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -2 FOR 23)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -3 FOR 23)

returns ’ABCDE’

SUBSTRING(’ABCDE’ FROM -21 FOR 23)

returns ’A’

Operators
An operator performs an operation on one or more expressions (the operands). InfoSphere DataStage
mainframe jobs support the following types of operators:
v Arithmetic operators
v String concatenation operator
v Relational operators
v Logical operators
The order of operators in expressions is determined by SQL standards. Specifically, AND has higher
precedence than OR. Any redundant parentheses might be removed after verification. This applies to
constraints in flat file source stages, WHERE clauses in relational source stages, join conditions, and
lookup conditions. For example, if you define the following expression:
(A AND B) OR (C AND D)

InfoSphere DataStage removes all of the parentheses in this case, since it first evaluates A AND B, then C
AND D, and finally compares the results of the two. The expression will appear like this:
A AND B OR C AND D

However, if you define an expression similar to this:
A AND (B OR C) AND D

InfoSphere DataStage does not remove the parentheses here because the result of the expression (B OR C)
is evaluated first.
Table 51 describes the operators that are available in mainframe jobs and their location.
Table 51. Mainframe Job Operators
Operator

Definition

Expression Editor

Expression Grid

(

Opening parenthesis

U

U

)

Closing parenthesis

U

U

||

Concatenate

U

<

Less than

U

U

>

Greater than

U

U

<=

Less than or equal to

U

U

>=

Greater than or equal to

U

U

=

Equality

U

U

<>

Inequality

U

U

AND

And

U

U
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Table 51. Mainframe Job Operators (continued)
Operator

Definition

Expression Editor

Expression Grid

OR

Or

U

U

NOT

Not

U

BETWEEN

Between

U

U

NOT BETWEEN

Not between

U

U

IN

In

U

U

NOT IN

Not in

U

U

IS NULL

NULL

U

U

IS NOT NULL

Not NULL

U

U

+

Addition

U

-

Subtraction

U

*

Multiplication

U

/

Division

U

Parameters
Job parameters represent processing variables. They are defined, edited, and deleted on the Parameters
page of the Job Properties dialog box. The actual parameter values are placed in a separate file that is
uploaded to the mainframe and accessed when the job is run.
You can use job parameters in column derivations and constraints. They appear in the Expression Editor,
on the Definition tab in Business Rule stages, on the Mapping tab in active stages, and in the Constraint
grid in Complex Flat File, Delimited Flat File, Fixed-width Flat File, IMS, Multi-format Flat File, and
External Source stages.
In Relational and Teradata Relational stages, you can use job parameters on the Where tab of the Inputs
page, but not on the Where tab of the Outputs page. This is because job parameters are available only
when the stage is used as a target. If you want to use a job parameter in the SQL SELECT statement of a
Relational or Teradata Relational source stage, add a Transformer stage after the Relational or Teradata
Relational stage in your job design, and define a constraint that compares a source column to the job
parameter. The source column and job parameter must have the same data type and length, no implicit
or explicit casting can occur, and there cannot be an ORDER BY clause in the SQL SELECT statement. If
these requirements are met, InfoSphere DataStage pushes the constraint back to the SELECT statement
and the filtering is performed by the database.
If the source column and job parameter are not the same data type and length, you can convert them
using one of the following techniques:
v Create a computed column in the Relational or Teradata Relational stage that has the same data type
and length as the job parameter. Define an expression for the computed column using one of the DB2
or Teradata functions to convert the original column to the correct data type and length. You can then
use the computed column in the Transformer stage constraint.
v Convert the job parameter to the data type and length of the Relational or Teradata Relational source
column. Use the CAST function to convert the job parameter to the correct data type and length in the
Transformer stage constraint. When code is generated, the EXEC SQL statement will include the job
parameter in the WHERE clause.
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Routines
In mainframe jobs, routines specify a COBOL function that exists in a library external to InfoSphere
DataStage. Mainframe routines are stored in the Routines folder of the repository, where you can create,
view, or edit them using the Mainframe Routine dialog box. For details about creating routines, see
“External Routine Stages” on page 104.

Variables
Variables are used to temporarily store values in memory. You can then use the values in a series of
operations. This can save programming time because you can easily change the values of the variables as
your requirements change.
Built-in job variables are described in Table 52. You can also declare and use your own variables in
Transformer and Business Rule stages. Such variables are accessible only from the Transformer stage or
Business Rule stage in which they are declared. For details about declaring local stage variables, see
“Transformer Stages” on page 143 and “Business Rule Stages” on page 99.
Table 52 describes the built-in variables that are available for mainframe jobs.
Table 52. Mainframe Job Variables
Variable

Definition

linkname.REJECTEDCODE

Returns the InfoSphere DataStage error code or
DSE_NOERROR if not rejected.

linkname.DBMSCODE

Returns the DBMS error code.

ENDOFDATA

Returns TRUE if the last row of data has been processed
or FALSE if the last row of data has not been processed.

SQLCA.SQLCODE

Returns 0 if data was successfully written to an output
link. A nonzero value indicates an error.

REJECTEDCODE and DBMSCODE
These variables are available only in Transformer stages. They are displayed under the Variables branch
of the Expression Editor for all output links except the first link in the execution order. They are used to
check the results of links that have already been executed. For example, if you have three output links,
only the last two can be used to evaluate results. The second link can check the results of the first link,
and the third link can check the results of the first two links. Click the Output Link Execution Order
button on the Transformer Editor toolbar to reorder the output links to meet your requirements.
There are three ways to use the variable REJECTEDCODE in constraint expressions:
v If link1.REJECTEDCODE = DSE_TRXCONSTRAINT, the data on link1 does not satisfy the constraint. This
expression can be used when any stage type follows the Transformer stage in the job design.
v If link1.REJECTEDCODE = DSE_NOERROR, the constraint on link1 was satisfied, regardless of the stage type
that follows the Transformer stage in the job design. However, when this expression is used in a job
where a Relational stage follows the Transformer stage in the job design, then it not only indicates that
the constraint on link1 was satisfied, it also indicates that the row was successfully inserted or updated
into the database.
v If link1.REJECTEDCODE = DSE_TRXLINK, the row was rejected by the next stage, which must be a
Relational stage. You can check the value of DBMSCODE to find the cause of the error.
For more information about using REJECTEDCODE and DBMSCODE in Transformer stage constraints,
see “Defining Constraints and Handling Rejects” on page 153.
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ENDOFDATA
ENDOFDATA can be used in the following places:
v Output column derivations in Transformer stages
v Stage variable derivations in Transformer stages
v Constraint expressions in Transformer stages
v SQL business rule logic in Business Rule stages
v Pre-lookup condition expressions in Lookup stages
The syntax for ENDOFDATA varies depending on the type of expression. For column and stage variable
derivations, use the IS TRUE or IS FALSE logical function to test ENDOFDATA as shown:
IF ENDOFDATA IS TRUE THEN ’B’ ELSE ’A’ END
IF ENDOFDATA IS FALSE THEN ’B’ ELSE ’A’ END

For constraint expressions, SQL business rule logic, and pre-lookup conditions, use the following syntax:
ENDOFDATA IS TRUE
ENDOFDATA IS FALSE

Do not use numeric expressions to test ENDOFDATA.
When the end-of-data indicator is passed to an active stage, the way it is handled varies depending on
the stage type. In Transformer, Business Rule, Link Collector, and Lookup stages, the end-of-data row is
processed just like any other row. In Join, Aggregator, Sort, and External Routine stages, the end-of-data
row is not processed along with the rest of the data but is simply passed through the stage. End-of-data
rows are ignored on the reference link to Lookup stages and on the inner link to Join stages.

SQLCA.SQLCODE
SQLCA.SQLCODE is available in the same places as ENDOFDATA:
v Output column derivations in Transformer stages
v Stage variable derivations in Transformer stages
v Constraint expressions in Transformer stages
v SQL business rule logic in Business Rule stages
v Pre-lookup condition expressions in Lookup stages
Typically this variable is used to determine whether data is successfully written to an output link. In a
Business Rule stage, you would add SQLCA.SQLCODE after the INSERT statement in the business rule
logic to check whether an output link to a Relational stage succeeded. You can also use it to detect a
lookup failure. In this case you would check the value of SQLCA.SQLCODE before doing an INSERT into
an output link.
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Chapter 8. Data Type Definitions and Mappings
This appendix describes the data types supported in InfoSphere DataStage MVS Edition, the permissible
data type mappings, and how data type mappings are implemented.

Data Type Definitions
Table 53 describes the data types supported in InfoSphere DataStage MVS Edition.
Table 53. InfoSphere DataStage MVS Edition Data Types
Data Type

Description

Precision

Scale

Date Mask

Char

A string of characters

The number of
characters

Zero

Any date mask
whose length ≤
precision

VarChar

A 2-byte binary
integer plus a string
of characters

The maximum
number of characters
in the string

Zero

None

NChar

A string of DBCS
characters

The number of
characters

Zero

None

NVarChar

A 2-byte binary
integer plus a string
of DBCS characters

The maximum
number of characters
in the string

Zero

None

SmallInt

A 2-byte binary
integer

The number of
decimal digits (1 ≤ n
≤ 4)

Zero

None

Integer

A 4-byte binary
integer

The number of
decimal digits (5 ≤ n
≤ 9)

Zero

Any numeric date
mask whose length ≤
precision

Decimal

A number in packed
decimal format,
signed or unsigned

The number of
decimal digits (1 ≤ n
≤ 18)1

The number of digits
to the right of the
decimal point (0 ≤ n ≤
18)1

If scale = 0, then any
numeric date mask
whose length ≤
precision; if scale > 0,
then none

Date

Three 2-byte binary
numbers (for CCYY,
MM, DD)

10

Zero

None (default date
format assumed)

Time

Three 2-byte binary
numbers (for HH,
MM, SS)

8

Zero

None

Timestamp

Six 2-byte binary
numbers (for CCYY,
MM, DD, HH, MM,
SS) and a 4-byte
binary number (for
microseconds)

26

Zero

None

1

If Support extended decimal is selected in project properties, then the precision and scale can be up to
the maximum decimal size specified.

© Copyright IBM Corp. 2000, 2011
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Data Type Mappings
Table 54 shows the data type mappings permitted in InfoSphere DataStage MVS Edition and the
techniques used for conversion. COBOL refers to one or more COBOL statements, such as MOVE or
COMPUTE. DSXX2YY refers to a function in the runtime library that converts a value from one data type
to another. For details about these conversion techniques, see “Data Type Mapping Implementations.”
Table 54. InfoSphere DataStage MVS Edition Data Type Mappings
TARGET
Small
Int

Integer

Decimal

Date

COBOL

DSC2SI

DSC2I

DSC2D

DSC2DT DSC2TM DSC2TS

COBOL

DSC2SI

DSC2I

DSC2D

DSC2DT DSC2TM DSC2TS

SOURCE

Char

Var Char NChar

Char

COBOL

VarChar

COBOL

NVar
Char

NChar

COBOL

COBOL

NVarChar

COBOL

COBOL

Time

SmallInt

DSSI2C

DSSI2C

COBOL

COBOL

COBOL

Integer

DSI2C

DSI2C

COBOL

COBOL

COBOL

COBOL

COBOL

Decimal

DSD2C

DSD2C

COBOL

COBOL

COBOL

COBOL

COBOL

Date

COBOL

COBOL

COBOL

COBOL

COBOL

Time

COBOL

COBOL

COBOL

COBOL

Timestamp COBOL

COBOL

COBOL

Timestamp

COBOL

COBOL
COBOL

Processing Rules
Mapping a nullable source to a non-nullable target is allowed. However, the assignment of the source
value to the target is allowed only if the source value is not actually NULL. If it is NULL, then a message
is written to the process log and program execution is halted.
When COBOL MOVE and COMPUTE statements are used during the assignment, the usual COBOL rules
for these statements apply. This includes data format conversion, truncation, and space filling rules.

Data Type Mapping Implementations
Table 55 through Table 64 on page 194 describe how data type mappings are implemented in InfoSphere
DataStage MVS Edition.
Table 55. Char Data Type Mappings
Char Source

Implementation

Char > Char

COBOL statements - The source is moved to the target.
Truncation occurs if the length of the target is less than
the length of the source. Spaces are padded in the target
if the length of the target is greater than the length of the
source.

Char > VarChar

COBOL statements - The Char value is moved to the
VarChar value. Truncation occurs if the maximum length
of the VarChar is less than the length of the Char. The
length of the VarChar is set to the lesser of the length of
the Char or the maximum length of the VarChar.

Char > NChar

This mapping is not allowed.
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Table 55. Char Data Type Mappings (continued)
Char Source

Implementation

Char > NVarChar

This mapping is not allowed.

Char > SmallInt

DSC2SI - Convert a character string to a small integer.
The Char is scanned for an integer number string of this
pattern: zero or more spaces, an optional plus or minus
sign, one or more decimal digits, zero or more spaces.
Any unexpected character that is found disrupts the
pattern and terminates the scan for the number. If the
scan is terminated before any decimal digits are found,
then zero is assigned to the SmallInt. If the number is too
big to fit into a SmallInt, the high-order digits are
truncated.

Char > Integer

DSC2I - Convert a character string to an integer. The
Char is scanned for an integer number string of this
pattern: zero or more spaces, an optional plus or minus
sign, one or more decimal digits, zero or more spaces.
Any unexpected character that is found disrupts the
pattern and terminates the scan for the number. If the
scan is terminated before any decimal digits are found,
then zero is assigned to the Integer. If the number is too
big to fit into an Integer, the high-order digits are
truncated.

Char > Decimal

DSC2D - Convert a character string to a packed decimal
number. The Char is scanned for a decimal number
string of this pattern: zero or more spaces; an optional
plus or minus sign; either: (a) one or more decimal
digits, (b) one or more decimal digits, a decimal point,
and one or more decimal digits, or (c) a decimal point
and one or more decimal digits; and finally zero or more
spaces. Any unexpected character that is found disrupts
the pattern and terminates the scan for the number. If the
scan is terminated before any decimal digits are found,
then zero is assigned to the Decimal. If the number is too
big to fit into the Decimal, the high-order digits are
truncated. If the Char has more digits to the right of the
decimal point than are specified in the scale of the
Decimal, only the number of digits specified in the scale
are used.

Char > Date

DSC2DT - Convert a character string to a date. The Char
must have a length of at least 10 and be consistent with
the default date format, left-aligned in the Char area.
(The separator characters need not be dashes.)

Char > Time

DSC2TM - Convert a character string to a time. The Char
must be in time form, HH:MM:SS, left-aligned in the
Char area. (The separator characters need not be
periods.)

Char > Timestamp

DSC2TS - Convert a character string to a timestamp. The
Char must be in timestamp form, CCYY-MM-DD
HH:MM:SS.NNNNNN, left-aligned in the Char area. (The
separator characters need not be dashes and periods.)
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Table 56. VarChar Data Type Mappings
VarChar Source

Implementation

VarChar > Char

COBOL statements - The actual VarChar value is moved
to the Char. Truncation occurs if the actual length of the
VarChar is greater than the length of the Char. Spaces are
padded in the Char if the length of the Char is greater
than the actual length of the VarChar.

VarChar > VarChar

COBOL statements - The source value is moved to the
target value. Truncation occurs if the actual length of the
source is greater than the maximum length of the target.
The length of the target is set to the lesser of the actual
length of the source or the maximum length of the
target.

VarChar > NChar

This mapping is not allowed.

VarChar > NVarChar

This mapping is not allowed.

VarChar > SmallInt

DSC2SI - Convert a character string to a small integer.
The VarChar is scanned for an integer number string of
this pattern: zero or more spaces, an optional plus or
minus sign, one or more decimal digits, zero or more
spaces. Any unexpected character that is found disrupts
the pattern and terminates the scan for the number. If the
scan is terminated before any decimal digits are found,
then zero is assigned to the SmallInt. If the number is too
big to fit into a SmallInt, the high-order digits are
truncated.

VarChar > Integer

DSC2I - Convert a character string to an integer. The
VarChar is scanned for an integer number string of this
pattern: zero or more spaces, an optional plus or minus
sign, one or more decimal digits, zero or more spaces.
Any unexpected character that is found disrupts the
pattern and terminates the scan for the number. If the
scan is terminated before any decimal digits are found,
then zero is assigned to the Integer. If the number is too
big to fit into an Integer, the high-order digits are
truncated.

VarChar > Decimal

DSC2D - Convert a character string to a packed decimal
number. The VarChar is scanned for a decimal number
string of this pattern: zero or more spaces; an optional
plus or minus sign; either: (a) one or more decimal
digits, (b) one or more decimal digits, a decimal point,
and one or more decimal digits, or (c) a decimal point
and one or more decimal digits; and finally zero or more
spaces. Any unexpected character that is found disrupts
the pattern and terminates the scan for the number. If the
scan is terminated before any decimal digits are found,
then zero is assigned to the Decimal. If the number is too
big to fit into the Decimal, the high-order digits are
truncated. If the Char has more digits to the right of the
decimal point than are specified in the scale of the
Decimal, only the number of digits specified in the scale
are used.

VarChar > Date

DSC2DT - Convert a character string to a date. The
VarChar must consistent with the default date format,
left-aligned in the VarChar area. (The separator
characters need not be dashes.)
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Table 56. VarChar Data Type Mappings (continued)
VarChar Source

Implementation

VarChar > Time

DSC2TM - Convert a character string to a time. The
VarChar must be in time form, HH:MM:SS, left-aligned
in the VarChar area. (The separator characters need not
be periods.)

VarChar > Timestamp

DSC2TS - Convert a character string to a timestamp. The
VarChar must be in timestamp form, CCYY-MM-DD
HH:MM:SS.NNNNNN, left-aligned in the VarChar area.
(The separator characters need not be dashes and
periods.) There can be from zero to six digits to the right
of the decimal point; if there are zero digits, there should
not be a decimal point.

Table 57. NChar Data Type Mappings
NChar Source

Implementation

NChar > Char

This mapping is not allowed.

NChar > VarChar

This mapping is not allowed.

NChar > NChar

COBOL statements - The source is moved to the target.
Truncation occurs if the length of the target is less than
the length of the source. Spaces are padded in the target
if the length of the target is greater than the length of the
source.

NChar > NVarChar

COBOL statements - The NChar value is moved to the
NVarChar value. Truncation occurs if the maximum
length of the NVarChar is less than the length of the
NChar. The length of the NVarChar is set to the lesser of
the length of the NChar or the maximum length of the
NVarChar.

NChar > SmallInt

This mapping is not allowed.

NChar > Integer

This mapping is not allowed.

NChar > Decimal

This mapping is not allowed.

NChar > Date

This mapping is not allowed.

NChar > Time

This mapping is not allowed.

NChar > Timestamp

This mapping is not allowed.

Table 58. NVarChar Data Type Mappings
NChar Source

Implementation

NVarChar > Char

This mapping is not allowed.

NVarChar > VarChar

This mapping is not allowed.

NVarChar > NChar

COBOL statements - The actual NVarChar value is
moved to the NChar. Truncation occurs if the actual
length of the NVarChar is greater than the length of the
NChar. Spaces are padded in the NChar if the length of
the NChar is greater than the actual length of the
NVarChar.
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Table 58. NVarChar Data Type Mappings (continued)
NChar Source

Implementation

NVarChar > NVarChar

COBOL statements - The source value is moved to the
target value. Truncation occurs if the actual length of the
source is greater than the maximum length of the target.
The length of the target is set to the lesser of the actual
length of the source or the maximum length of the
target.

NVarChar > SmallInt

This mapping is not allowed.

NVarChar > Integer

This mapping is not allowed.

NVarChar > Decimal

This mapping is not allowed.

NVarChar > Date

This mapping is not allowed.

NVarChar > Time

This mapping is not allowed.

NVarChar > Timestamp

This mapping is not allowed.

Table 59. SmallInt Data Type Mappings
SmallInt Source

Implementation

SmallInt > Char

DSSI2C - Convert a small integer to a character string.
The SmallInt is converted to a string of digits (with a
minus sign as the first character if the number is
negative). This string is left-aligned in the Char area. If
the length of the string is less than the length of the Char
area, spaces are used to pad on the right. If the length of
the string is greater than the length of the Char area, the
high-order digits are truncated.

SmallInt > VarChar

DSSI2C - Convert a small integer to a character string.
The SmallInt is converted to a string of digits (with a
minus sign as the first character if the number is
negative). This string is left-aligned in the VarChar area.
If the length of the string is greater than the length of the
VarChar area, the high-order digits are truncated.

SmallInt > NChar

This mapping is not allowed.

SmallInt > NVarChar

This mapping is not allowed.

SmallInt > SmallInt

COBOL statements - Move source to target.

SmallInt > Integer

COBOL statements - Move source to target.

SmallInt > Decimal

COBOL statements - Move source to target. If the
SmallInt value is greater than the maximum or less than
the minimum of the Decimal, a warning message is
printed in the process log.

SmallInt > Date

This mapping is not allowed.

SmallInt > Time

This mapping is not allowed.

SmallInt > Timestamp

This mapping is not allowed.
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Table 60. Integer Data Type Mappings
Integer Source

Implementation

Integer > Char

DSI2C - Convert an integer to a character string. The
Integer is converted to a string of digits (with a minus
sign as the first character if the number is negative). This
string is left-aligned in the Char area. If the length of the
string is less than the length of the Char area, spaces are
used to pad on the right. If the length of the string is
greater than the length of the Char area, the high-order
digits are truncated.

Integer > VarChar

DSI2C - Convert an integer to a character string. The
integer is converted to a string of digits (with a minus
sign as the first character if the number is negative). This
string is left-aligned in the VarChar area. If the length of
the string is greater than the length of the VarChar area,
the high-order digits are truncated.

Integer > NChar

This mapping is not allowed.

Integer > NVarChar

This mapping is not allowed.

Integer > SmallInt

COBOL statements - Move source to target. If the integer
value is greater than the maximum or less than the
minimum of the SmallInt, a warning message is printed
in the process log.

Integer > Integer

COBOL statements - Move source to target.

Integer > Decimal

COBOL statements - Move source to target. If the integer
value is greater than the maximum or less than the
minimum of the Decimal, a warning message is printed
in the process log.

Integer > Date

COBOL statements - If the Integer has a date mask, the
Date is computed from the Integer according to the
mask. If the Integer has no date mask, the Integer is
assumed to represent a day number (where days are
numbered sequentially from 0001-01-01, which is day
number 1) and is converted to a Date.

Integer > Time

COBOL statements - The Integer is assumed to represent
a second number (where seconds are numbered
sequentially from midnight, so 00.00.00 is 0, 00.00.01 is 1,
and so on) and is converted to a Time.

Integer > Timestamp

This mapping is not allowed.

Table 61. Decimal Data Type Mappings
Decimal Source

Implementation

Decimal > Char

DSD2C - Convert a decimal to a character string. The
string is left-aligned in the Char area and has this format:
a minus sign if the number is negative, followed by zero
or more decimal digits, and, if the packed decimal has a
nonzero scale value, a decimal point followed by "scale"
number of digits. If the length of the string is less than
the length of the Char area, spaces are used to pad on
the right. If the length of the string is greater than the
length of the Char area, the high-order digits are
truncated.
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Table 61. Decimal Data Type Mappings (continued)
Decimal Source

Implementation

Decimal > VarChar

DSD2C - Convert a decimal to a character string. The
string is left-aligned in the VarChar area and has this
format: a minus sign if the number is negative, followed
by zero or more decimal digits, and, if the packed
decimal has a nonzero scale value, a decimal point
followed by "scale" number of digits. If the length of the
string is greater than the maximum length of the
VarChar area, the high-order digits are truncated.

Decimal > NChar

This mapping is not allowed.

Decimal > NVarChar

This mapping is not allowed.

Decimal > SmallInt

COBOL statements - Move source to target. If the value
of the Decimal is greater than the maximum or less than
the minimum of the SmallInt, a warning message is
printed in the process log.

Decimal > Integer

COBOL statements - Move source to target. If the value
of the Decimal is greater than the maximum or less than
the minimum of the Integer, a warning message is
printed in the process log.

Decimal > Decimal

COBOL statements - Move source to target. If the value
of the source Decimal is greater than the maximum or
less than the minimum of the target Decimal, a warning
message is printed in the process log.

Decimal > Date

COBOL statements - If the Decimal has a date mask, the
Date is computed from the Decimal according to the
mask. If the Decimal has no date mask, the Decimal is
assumed to represent a day number (where days are
numbered sequentially from 0001-01-01, which is day
number 1) and is converted to a Date.

Decimal > Time

COBOL statements - This mapping converts a Decimal to
a Time that represents the number of seconds since
midnight. The precision of the Decimal must be at least
5. (For example, 0 becomes 00.00.00 which is midnight,
61 becomes 00.01.01, 86399 becomes 23.59.59)

Decimal > Timestamp

COBOL statements - This mapping converts a Decimal to
a Timestamp that represents the number of seconds since
midnight on 0001-01-01. The precision of the Decimal
should be at least 18, or the maximum size specified in
project properties if extended decimal support is selected.
If you want to include milliseconds, the scale of the
Decimal should be no more than 6.

Table 62. Date Data Type Mappings
Date Source

Implementation

Date > Char

COBOL statements - If the Char has a date mask, the
Date is formatted into the Char area according to that
format. If the target does not have a date mask, the
length of the Char must be at least 10 and the Date is
formatted into the Char area consistent with the default
date format. If the Char area is larger than the length
needed according to the date mask, the Date is
left-aligned in the Char area and padded on the right
with spaces.
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Table 62. Date Data Type Mappings (continued)
Date Source

Implementation

Date > VarChar

COBOL statements - The maximum length of the
VarChar must be at least 10. The Date is formatted into
the VarChar area consistent with the default date format.

Date > NChar

This mapping is not allowed.

Date > NVarChar

This mapping is not allowed.

Date > SmallInt

This mapping is not allowed.

Date > Integer

COBOL statements - If the Integer has a date mask, the
Date is moved to the Integer and formatted according to
the mask. If the Integer has no date mask, the Date is
converted to an Integer that represents the day number,
where days are numbered sequentially from 0001-01-01
(which is day number 1).

Date > Decimal

COBOL statements - If the Decimal has a date mask, the
Date is moved to the Decimal and formatted according
to the mask. If the Decimal has no date mask, the Date is
converted to a day number, where days are numbered
sequentially from 0001-01-01 (which is day number 1). If
the day number is greater than the maximum or less
than the minimum of the target Decimal, a warning
message is printed in the process log.

Date > Date

COBOL statements - Move source to target.

Date > Time

This mapping is not allowed.

Date > Timestamp

This mapping is not allowed.

Table 63. Time Data Type Mappings
Time Source

Implementation

Time > Char

COBOL statements - The time is formatted into the Char
area according to the HH:MM:SS format. The length of
the Char area must be at least 8. If the Char area is larger
than 8, the time is left-aligned in the Char area and
padded on the right with spaces.

Time > VarChar

COBOL statements - The time is formatted into the
VarChar area according to the HH:MM:SS format. The
maximum length of the VarChar area must be at least 8.

Time > NChar

This mapping is not allowed.

Time > NVarChar

This mapping is not allowed.

Time > SmallInt

This mapping is not allowed.

Time > Integer

COBOL statements - This mapping converts a Time to an
Integer that represents the number of seconds since
midnight. (For example, 00.00.00 is midnight and
becomes 0, 00.01.01 becomes 61, 23.59.59 becomes 86399.)

Time > Decimal

COBOL statements - This mapping converts a Time to a
Decimal that represents the number of seconds since
midnight. The precision of the Decimal must be at least
5. (For example, 00.00.00 is midnight and becomes 0,
00.01.01 becomes 61, 23.59.59 becomes 86399.)

Time > Date

This mapping is not allowed.

Time > Time

COBOL statements - Move source to target.
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Table 63. Time Data Type Mappings (continued)
Time Source

Implementation

Time > Timestamp

This mapping is not allowed.

Table 64. Timestamp Data Type Mappings
Timestamp Source

Implementation

Timestamp > Char

COBOL statements - The Timestamp is formatted into
the Char area according to the CCYY-MM-DD
HH:MM:SS.NNNNNN format. The length of the Char
area must be at least 26. If the length of the Char area is
greater than 26, the Timestamp is left-aligned in the Char
area and padded on the right with spaces.

Timestamp > VarChar

COBOL statements - The Timestamp is formatted into
the VarChar area according to the CCYY-MM-DD
HH:MM:SS.NNNNNN format. The maximum length of
the VarChar area must 26.

Timestamp > NChar

This mapping is not allowed.

Timestamp > NVarChar

This mapping is not allowed.

Timestamp > SmallInt

This mapping is not allowed.

Timestamp > Integer

This mapping is not allowed.

Timestamp > Decimal

COBOL statements - The Timestamp is formatted into
the Decimal area as a floating point value that represents
the number of seconds since midnight on 0001-01-01. The
precision of the Decimal should be 18, or the maximum
size specified in project properties if extended decimal
support is selected. If you want to include milliseconds,
the scale of the Decimal should be no more than 6. Since
float is not precise, you might lose precision in the value
being converted.

Timestamp > Date

This mapping is not allowed.

Timestamp > Time

This mapping is not allowed.

Timestamp > Timestamp

COBOL statements - Move source to target.

Mapping Dates
Table 65 describes some of the conversion rules that apply when dates are mapped from one format to
another.
Table 65. Date Mappings
Input Format

Output Format

Rule

Example

MMDDYY

DD-MON-CCYY

01 ≤ MM ≤ 12, otherwise
140199 > 01-UNK-1999
output is unknown (`UNK')
010120 > 01-JAN-2020

CCYY

YY

CC is removed

1999 > 99
2020 > 20
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Table 65. Date Mappings (continued)
Input Format

Output Format

Rule

Example

YY

CCYY

Depends on the century
break year specified in job
properties. If YY < century
break year, CC = 20; if YY
≥ century break year, CC =
19.

If century break year is 30,
then:
29 > 2029
30 > 1930

Any input column with a date mask becomes a Date data type and is converted to the job-level default
date format.
No conversions apply when months, days, and years are mapped to the same format (that is, MM to MM
or CCYY to CCYY). If the input dates are invalid, the output dates will also be invalid.
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Chapter 9. Native Data Types
This appendix describes the native data types that InfoSphere DataStage MVS Edition supports in
mainframe source and target stages.

Source Stages
Table 66 describes the native data types supported in Complex Flat File, Fixed-width Flat File,
Multi-format Flat File, External Source, and External
Table 66. Complex Flat File, Fixed-width Flat File, Multi-format Flat File, External Source, and External Routine Stage
Native Types
Native Data Type

Description

BINARY

COBOL supports three sizes of binary integers: 2-byte, 4-byte, and 8-byte. The
COBOL picture for each of these sizes is S9(p)COMP, where p is the precision
specified in the column definition. COBOL allocates a 2-byte binary integer when
the precision is 1 to 4, a 4-byte binary integer when the precision is 5 to 9, and an
8-byte binary integer when the precision is 10 to 18 (or higher if extended
decimal support is selected in project properties).
Tables can be defined with columns of any size binary integer. The generated
COBOL programs can read all three sizes, but internally they are converted to
packed decimal numbers with the specified precision for further processing.
If a column of BINARY type has a date format specified, then the column value
is converted to internal date form and the column type is changed to Date for
further processing.

CHARACTER

InfoSphere DataStage MVS Edition supports reading strings of character data.
If a column of CHARACTER type has a date format specified, then the column
value is converted to internal date form and the column type is changed to Date
for further processing.

DECIMAL

DECIMAL numbers are numbers in packed decimal format. InfoSphere DataStage
MVS Edition provides support for these numbers.
If a column of DECIMAL type has a date format specified, then the column value
is converted to internal date form and the column type is changed to Date for
further processing.

DISPLAY NUMERIC

The generated COBOL programs can read DISPLAY NUMERIC numbers, but
internally they are converted to packed decimal numbers for further processing.
The precision and scale of the numbers are not changed, so no precision is lost in
doing this conversion.
If a column of DISPLAY NUMERIC type has a date format specified, then the
column value is converted to internal date form and the column type is changed
to Date for further processing.
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Table 66. Complex Flat File, Fixed-width Flat File, Multi-format Flat File, External Source, and External Routine Stage
Native Types (continued)
Native Data Type

Description

FLOAT

The generated COBOL programs can read single- and double-precision floating
point numbers, but internally they are converted to packed decimal numbers for
further processing. The precision and scale of the column definition are used for
the packed decimal number. This means that precision can be lost when moving
a FLOAT to this number.
For example, suppose C is defined to be a single-precision floating point column
(that is, its COBOL picture is COMP-1) having a precision of 5 and scale of 2.
This would cause a packed decimal number to be created as PIC S9(3)V9(2)
COMP-3. Suppose that the file contains three records with values of 54.0,
-2266.46, and .0078125 for C. No precision is lost when the first value is moved to
the packed decimal. The second value becomes -266.46, thus losing the precision
on the left. The third value becomes .00, losing the precision on the right.

GRAPHIC-G

The generated COBOL programs can read data with picture clause symbol G and
USAGE DISPLAY-1. The associated data must be DBCS characters in the range
from X'00' through X'FF'. The DBCS data can be defined explicitly or implicitly.
Internally, they are converted to NChar for further processing. The picture clause
in the column definition represents the length in the correct format, DBCS length.

GRAPHIC-N

The generated COBOL programs can read data with picture clause symbol N.
USAGE DISPLAY-1 is assumed and does not need to be specified. The associated
data must be DBCS characters in the range from X'00' through X'FF'. The DBCS
data can be defined explicitly or implicitly.
Internally, they are converted to NChar for further processing. The picture clause
in the column definition represents the length in the correct format, DBCS length.

GROUP

This data type is available only in Complex Flat File, Multi-format Flat File,
External Source, and External Routine stages. InfoSphere DataStage MVS Edition
treats groups as character strings. The length of the character string is the size of
the group, which is the sum of the sizes of all elements of the group. This is in
accordance with standard COBOL usage.

NATIVE BINARY

The generated COBOL programs can read native binary data with 2, 4, or 8 bytes.
The COBOL picture clause is S9(p)COMP-5, where p is the precision specified in
the column definition. A scaling factor can be specified as well. COBOL allocates
a 2-byte binary integer when the precision is 1 to 4, a 4-byte binary integer when
the precision is 5 to 9, and an 8-byte binary integer when the precision is 10 to 18
(or higher if extended decimal support is selected in project properties).
Numeric values are not limited to the value implied by the number of nines in
the picture clause. Internally NATIVE BINARY data is converted to packed
decimal numbers for further processing. If the precision is 1 to 4, the data is
converted to Decimal(5), if the precision is 5 to 9, the data is converted to
Decimal(10, and if the precision is 10 to 18, the data is converted to Decimal(18).
If a column of NATIVE BINARY type has a date format specified, then the
column value is converted to internal date form and the column type is changed
to Date for further processing.

VARCHAR

InfoSphere DataStage MVS Edition supports reading variable-length strings of
character data.
If a column of VARCHAR type has a date format specified, then the column
value is converted to internal date form and the column type is changed to Date
for further processing.
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Table 66. Complex Flat File, Fixed-width Flat File, Multi-format Flat File, External Source, and External Routine Stage
Native Types (continued)
Native Data Type

Description

VARGRAPHIC_G

The generated COBOL programs can read data with picture clause symbol G and
USAGE DISPLAY-1. The associated data must be DBCS characters in the range
from X'00' through X'FF'. The DBCS data can be defined explicitly or implicitly.
Internally, they are converted to NVarChar for further processing. The picture
clause in the column definition represents the length in the correct format, DBCS
length.

VARGRAPHIC_N

The generated COBOL programs can read data with picture clause symbol N.
USAGE DISPLAY-1 is assumed and does not need to be specified. The associated
data must be DBCS characters in the range from X'00' through X'FF'. The DBCS
data can be defined explicitly or implicitly.
Internally, they are converted to NVarChar for further processing. The picture
clause in the column definition represents the length in the correct format, DBCS
length.

Routine stages.
Table 67 describes the native data types supported in Delimited Flat File source stages.
Table 67. Delimited Flat File Source Stage Native Types
Native Data Type

Description

CHAR

A string of characters with blank characters trimmed from the right.

DECIMAL

A value in this format: a minus sign if the value is negative, a string of decimal
digits, and, if the scale of the number is nonzero, then a decimal point followed
by a string of digits.

INT

A minus sign if the value is negative, followed by a string of decimal digits.

NCHAR

A string of DBCS characters.

NVARCHAR

A variable-length string of DBCS characters.

SMALLINT

The same format as an INT value.

VARCHAR

The same format as a CHAR value.

Table 68 describes the native data types that InfoSphere DataStage MVS Edition supports for selecting
columns in DB2 tables.
Table 68. Relational Source Stage Native Types
Native Data Type

Description

CHARACTER

InfoSphere DataStage MVS Edition supports selecting strings of characters.

DATE

InfoSphere DataStage MVS Edition supports the ISO (CCYY-MM-DD), USA
(MM/DD/YY), and European (DD.MM.CCYY) date formats supported by DB2.
The default date format of the job must equal the date format of the DB2
subsystem used. Further date processing is done using the internal form. When a
DATE column value is processed by InfoSphere DataStage MVS Edition, it is
selected from DB2 in the default date form, and then converted to an internal
form that is independent of the original format of the DATE. Further date
processing is done using the internal form.
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Table 68. Relational Source Stage Native Types (continued)
Native Data Type

Description

DECIMAL

DECIMAL numbers are numbers in packed decimal format. InfoSphere DataStage
MVS Edition provides full support for these numbers. If you selected Support
extended decimal in project properties, and you import a DCLGen file containing
DECIMAL data with precision greater than the maximum decimal size specified,
InfoSphere DataStage changes the precision of the DECIMAL to the maximum
size specified.

GRAPHIC

This is a string of DBCS characters and is supported in InfoSphere DataStage
MVS Edition.

INTEGER

This represents a 4-byte binary integer and is supported in InfoSphere DataStage
MVS Edition. When importing DCLGen files, InfoSphere DataStage captures
INTEGER data with precision up to 10. However, due to COBOL restrictions, the
precision is changed to 9 when loading such data into mainframe jobs.

NUMERIC

NUMERIC is a synonym for DECIMAL.

SMALLINT

This represents a 2-byte binary integer. The generated COBOL programs can
select columns of SMALLINT type, but internally they are converted to 4-byte
binary integers for further processing. No precision is lost in the conversion.
When importing DCLGen files, InfoSphere DataStage captures SMALLINT data
with precision up to 5. However, due to COBOL restrictions, the precision is
changed to 4 when loading such data into mainframe jobs.

TIME

When InfoSphere DataStage MVS Edition processes a TIME column value, it
selects it from DB2 in the standard form (HH.MM.SS) and then converts it to an
internal form. Further time processing is done using the internal form.

TIMESTAMP

When InfoSphere DataStage MVS Edition processes a TIMESTAMP column value,
it selects it from DB2 in the standard form (CCYY-MM-DD-HH.MM.SS.NNNNNN)
and then converts it to an internal form. Further timestamp processing is done
using the internal form.

VARCHAR

InfoSphere DataStage MVS Edition supports variable-length strings of characters.

VARGRAPHIC

InfoSphere DataStage MVS Edition supports selecting variable-length strings of
DBCS characters, but internally it converts them to NVarChar type for further
processing.

Table 69 describes the native data types supported in Teradata Export and Teradata Relational source
stages.
Table 69. Teradata Export Stage and Teradata Relational Source Stage Native Types
Native Data Type

Description

BYTEINT

This represents a 1-byte binary integer and is converted to a 2-byte integer for
processing.

CHAR

InfoSphere DataStage MVS Edition supports selecting strings of character data.

DATE

InfoSphere DataStage MVS Edition uses the ISO (CCYY-MM-DD) format
supported by Teradata. When a DATE column value is processed by InfoSphere
DataStage MVS Edition, it is selected from Teradata and then converted to an
internal form that is independent of the original format of the DATE. Further date
processing is done using the internal form.

DECIMAL

DECIMAL numbers are numbers in packed decimal format. InfoSphere DataStage
MVS Edition provides full support for these numbers.

FLOAT

This is a double-precision floating point number and is supported in InfoSphere
DataStage MVS Edition.

GRAPHIC

This is a string of DBCS characters and is supported in InfoSphere DataStage
MVS Edition.
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Table 69. Teradata Export Stage and Teradata Relational Source Stage Native Types (continued)
Native Data Type

Description

INTEGER

This represents a 4-byte binary integer and is supported in InfoSphere DataStage
MVS Edition.

SMALLINT

This represents a 2-byte binary integer. InfoSphere DataStage MVS Edition
generates COBOL programs that can select columns of SMALLINT type, but
internally it converts them to 4-byte binary integers for further processing. No
precision is lost in the conversion.

TIME

When InfoSphere DataStage MVS Edition processes a TIME column value, it
selects it from Teradata in the standard form (HH.MM.SS) and then converts it to
an internal form. Further time processing is done using the internal form.

TIMESTAMP

When InfoSphere DataStage MVS Edition processes a TIMESTAMP column value,
it selects it from Teradata in the standard form (CCYY-MM-DDHH.MM.SS.NNNNNN) and then converts it to an internal form. Further
timestamp processing is done using the internal form.

VARCHAR

InfoSphere DataStage MVS Edition supports variable-length strings of characters.

VARGRAPHIC

This is a variable-length string of DBCS characters. InfoSphere DataStage MVS
Edition support selecting strings of this type, but internally it converts them to
NVarChar type for further processing.

Target Stages
Table 70 describes the native data types that InfoSphere DataStage MVS Edition supports for writing data
to Fixed-width Flat File and External Target stages.
Table 70. Fixed-width Flat File Target Stage and External Target Stage Native Types
Native Data Type

Description

BINARY

Depending on the precision of the column, this is a 2-byte, 4-byte, or 8-byte
binary integer.

CHARACTER

A string of characters.

DECIMAL

A packed decimal number.

DISPLAY NUMERIC

A display numeric number.

FLOAT

A single- or double-precision floating point number.

GRAPHIC-G

A DBCS data type when picture clause symbol G is used and USAGE DISPLAY-1
is specified.

GRAPHIC-N

A DBCS data type when picture clause symbol N is used. USAGE DISPLAY-1 is
assumed and does not need to be specified.

NATIVE BINARY

Depending on the precision of the column, this is a 2-byte, 4-byte, or 8-byte
native binary integer.

When a fixed-width flat file column of one of these data types is defined as nullable, two fields are
written to the file:
v A one-byte null indicator
v The column value
When the indicator has a value of 1, the column value is null and any value in the next field (that is, the
column value) is ignored. When the indicator has a value of 0, the column is not null and its value is in
the next field.
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Table 71 describes the native data types that InfoSphere DataStage MVS Edition supports for writing data
to delimited flat files.
Table 71. Delimited Flat File Target Stage Native Types
Native Data Type

Description

CHAR

A string of characters with blank characters trimmed from the right.

DECIMAL

A value in this format: a minus sign if the value is negative, a string of decimal
digits, and, if the scale of the number is nonzero, then a decimal point followed
by a string of digits.

INT

A minus sign if the value is negative, followed by a string of decimal digits.

NCHAR

A string of DBCS characters.

NVARCHAR

A variable-length string of DBCS characters.

SMALLINT

The same format as an INT value.

VARCHAR

The same format as a CHAR value.

Table 72 describes the native data types that InfoSphere DataStage MVS Edition supports for writing data
to a DB2 load-ready flat file.
Table 72. DB2 Load Ready Flat File Stage Native Types
Native Data Type

Description

CHARACTER

A string of characters.

DATE EXTERNAL

A date consistent with the default date format.

DECIMAL PACKED

A packed decimal number.

DECIMAL ZONED

A display numeric number.

GRAPHIC

A string of DBCS characters.

INTEGER

A 4-byte binary integer.

NUMERIC

A synonym of DECIMAL.

SMALLINT

A 2-byte binary integer.

TIME EXTERNAL

A time of the format HH.MM.SS.

TIMESTAMP EXTERNAL

A timestamp of the format CCYY-MM-DD-HH.MM.SS.NNNNNN.

VARCHAR

A 2-byte binary integer containing the length of the string, followed by a string of
characters of the same length.

VARGRAPHIC

Variable-length graphic string. This is a sequence of DBCS characters. The length
control field indicates the maximum number of DBCS characters, not bytes.

Table 73 describes the native data types that InfoSphere DataStage MVS Edition supports for inserting
and updating columns of DB2 tables.
Table 73. Relational Target Stage Native Types
Native Data Type

Description

CHARACTER

A string of characters.

DATE

A date consistent with the default date format.

DECIMAL

A packed decimal number.

GRAPHIC

A string of DBCS characters.

INTEGER

A 4-byte binary integer.

NUMERIC

A synonym of DECIMAL.
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Table 73. Relational Target Stage Native Types (continued)
Native Data Type

Description

SMALLINT

A 2-byte binary integer.

TIME

A time in DB2 format: HH.MM.SS.

TIMESTAMP

A timestamp in DB2 format: CCYY-MM-DD-HH.MM.SS.NNNNNN.

VARCHAR

A variable-length string of characters.

VARGRAPHIC

A variable-length string of DBCS characters.

Table 74 describes the native data types that InfoSphere DataStage MVS Edition supports for writing data
to a Teradata file.
Table 74. Teradata Target Stage Native Types
Native Data Type

Description

BYTEINT

A 1-byte binary integer.

CHARACTER

A string of characters.

DATE

A date consistent with the default date format.

DECIMAL

A packed decimal number.

GRAPHIC

A string of DBCS characters.

INTEGER

A 4-byte binary integer.

NUMERIC

A synonym of DECIMAL.

SMALLINT

A 2-byte binary integer.

TIME

A time in Teradata format: HH:MM:SS.NNNNNN.

TIMESTAMP

A timestamp in Teradata format: CCYY-MM-DD HH:MM:SS.NNNNNN.

VARCHAR

A variable-length string of characters.

VARGRAPHIC

A variable-length string of DBCS characters.

Storage Lengths
Table 75 describes the SQL type conversion, precision, scale, and storage length for COBOL native data
types. The COBOL PICTURE clauses in the table are for signed numbers, however, unsigned numbers are
handled in a similar manner.
Table 75. COBOL Native Types
Native Data
Type

Native Length COBOL Usage
(bytes)
Representation

SQL Type

Precision (p) Scale (s)

Storage
Length
(bytes)

BINARY

2

PIC S9 to S9(4) COMP

SmallInt

1 to 4

n/a

2

4

PIC S9(5) to S9(9) COMP

Integer

5 to 9

n/a

4

8

PIC S9(10) to S9(18)
COMP

Decimal

10 to 18

n/a

8

CHARACTER

n

PIC X(n)

Char

n

n/a

n

DECIMAL

(p+s)/2+1

PIC S9(p)V9(s) COMP-3

Decimal

p+s

s

(p+s)/2+1

DISPLAY_
NUMERIC

p+s

PIC S9(p)V9(s)

Decimal

p+s

s

(p+s)/2+1
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Table 75. COBOL Native Types (continued)
Native Data
Type

Native Length COBOL Usage
(bytes)
Representation

Storage
Length
(bytes)

SQL Type

Precision (p) Scale (s)
p+s
(default 18)
p+s
(default 18)

s
(default 4)
s
(default 4)

4

FLOAT (single) 4

PIC COMP-1

Decimal

(double)

8

PIC COMP-2

Decimal

GRAPHIC_G

n*2

PIC G(n) DISPLAY-1

NChar

n

n/a

n*2

GRAPHIC_N

n*2

PIC N(n)

NChar

n

n/a

n*2

GROUP

n (sum of all
the column
lengths that
make up the
group)

Char

n

n/a

n

NATIVE
BINARY

2

PIC S9 to S9(4) COMP-5

SmallInt

1 to 4

n/a

2

4

PIC S9(5) to S9(9)
COMP-5

Integer

5 to 9

n/a

4

Decimal

10 to 18

n/a

8

8

8

PIC S9(10) to S9(18)
COMP-5
VARCHAR

n+2

PIC S9(4) COMP PIC X(n) VarChar

n+2

n/a

n+2

VARGRAPHIC
_G

(n*2)+2

PIC S9(4) COMP PIC
G(n) DISPLAY-1

NVarChar

n+2

n/a

(n*2)+2

VARGRAPHIC
_N

(n*2)+2

PIC S9(4) COMP PIC
N(n)

NVarChar

n+2

n/a

(n*2)+2

Table 76 describes the SQL type conversion, precision, scale, and storage length for DB2 native data types.
The COBOL usage representation is used only when DB2 table definitions are loaded into a flat file stage.
Table 76. DB2 Native Types
Native Data
Type

Native Length COBOL Usage
(bytes)
Representation

SQL Type

Precision (p) Scale(s)

Storage
Length
(bytes)

CHARACTER

n

PIC X(n)

Char

n

n/a

n

DATE

10

PIC X(10)

Date

10

n/a

10

DECIMAL

p/2+1

PIC S9(p)V9(s)
COMP-3

Decimal

p+s

s

(p+s)/2+1

GRAPHIC

n*2

PIC G(n) DISPLAY-1

NChar

n

n/a

n*2

INTEGER

4

PIC S9(9) COMP

Integer

9

n/a

4

NUMERIC

p

PIC S9(p)V9(s)

Decimal

p+s

s

n

SMALLINT

2

PIC S9(4) COMP

SmallInt

2

n/a

2

TIME

8

PIC X(8)

Time

8

n/a

8

TIMESTAMP

26

PIC x(26)

Timestamp

26

n/a

26

VARCHAR

n+2

PIC S9(4) COMP

VarChar

n+2

n/a

n+2

NVarChar

n+2

n/a

(n*2)+2

PIC X(n)
VARGRAPHIC (n*2)+2

PIC S9(4) COMP
PIC G(n) DISPLAY-1
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Table 77 describes the SQL type conversion, precision, scale, and storage length for Teradata native data
types. The COBOL usage representation is used only when Teradata table definitions are loaded into a
flat file stage.
Table 77. Teradata Native Types
Native Data
Type

Native Length COBOL Usage
(bytes)
Representation

SQL Type

Precision (p) Scale(s)

Storage
Length
(bytes)

BYTEINT

1

PIC S9(3) COMP

Integer

3

n/a

2

CHAR

n

PIC X(n)

Char

n

n/a

n

DATE

10

PIC X(10)

Date

10

n/a

10

DECIMAL

p/2+1

PIC S9(p)V9(s)
COMP-3

Decimal

p+s

s

(p+s)/2+1

FLOAT
(double)

8

PIC COMP-2

Decimal

p+s (default
18)

s (default 4)

8

GRAPHIC

n*2

PIC G(n) DISPLAY-1

NChar

n

n/a

n*2

INTEGER

4

PIC S9(9) COMP

Integer

9

n/a

4

SMALLINT

2

PIC S9(4) COMP

SmallInt

2

n/a

2

TIME

8

PIC X(8)

Time

8

n/a

8

TIMESTAMP

26

PIC X(26)

Timestamp

26

n/a

26

VARCHAR

n+2

PIC S9(4) COMP

VarChar

n+2

n/a

n+2

NVarChar

n+2

n/a

(n*2)+2

PIC X(n)
VARGRAPHIC (n*2)+2

PIC S9(4) COMP
PIC G(n) DISPLAY-1

Variable Calculation for Decimal Arithmetic
The following examples illustrate how InfoSphere DataStage MVS Edition computes the precision and
scale of intermediate variables for use in decimal arithmetic.
Let Dn represent a DECIMAL(Pn, Sn) number, where Pn is the precision and Sn is the scale. The
precision is equal to the magnitude plus the scale. The magnitude, Mn, is the number of digits left of the
decimal point, and the scale is the number of digits right of the decimal point.

Addition and Subtraction (D1 + D2 or D1 - D2)
Result scale = MAX(S1, S2) Result precision = MAX(M1, M2) + Result scale + 1 bit
Example: DECIMAL(5,1) + DECIMAL(5,3) = DECIMAL(8,3)
This allows room for 9999.9 + 99.999 = 10099.899

Multiplication (D1 * D2)
Result scale = S1 + S2 Result precision = P1 + P2
Example: DECIMAL(5,1) * DECIMAL(5,3) = DECIMAL(10,4)
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This allows room for 9999.9 * 99.999 = 999980.0001

Division (D1 / D2)
Result scale = S1 + M2 Result precision = P1 + P2
Example: DECIMAL(5,1) / DECIMAL(5,3) = DECIMAL(10, 3)
This allows room for 9999.9 / 0.001 = 9999900.000 and 0.1 / 99.999 = 0.001
In all cases, the COBOL code generator might adjust the result size if the calculated precision exceeds the
maximum size supported by the COBOL compiler. In other words, if the result precision (Pn) is greater
than the maximum decimal size defined for the project, any intermediate resultant variable will be
defined as a double-precision float (COMP-2 in COBOL terms) instead of packed decimal (COMP-3 in
COBOL terms) of the calculated precision (Pn) and scale (Sn). Double-precision float is imprecise, so there
might be a loss of digit precision.
Another, more complicated, example provides further explanation:
Final = ((D1 + D2) * (D3 / D4)) * D5
where D1 is DECIMAL(5,1)
D2 is DECIMAL(5,3)
D3 is DECIMAL(5,1)
D4 is DECIMAL(5,3)
D5 is DECIMAL(6,4)
Result1 = D1 + D2
Result1 scale = MAX(S1, S2) = 3
Result1 precision = MAX(M1, M2) + Result1 scale + 1 bit = 8
Result1 is DECIMAL(8,3)
Result2 = D3 / D4
Result2 scale = S3 + M4 = 3
Result2 precision = P3 + P4 = 10
Result2 is DECIMAL(10,3)
Result3 = Result1 * Result2
Result3 scale = Result1 scale + Result2 scale = 6
Result3 precision = Result1 precision + Result2 precision = 18
Result3 is DECIMAL(18,6)
Result4 = Result3 * D5
Result4 scale = Result3 scale + S5 = 10
Result4 precision Result3 precision + P5 = 24
If COBOL compiler maximum decimal support is 18, then Result4 is a double-precision float.
If COBOL compiler maximum decimal support is 31, the Result4 is DECIMAL(24,10).
Result4 will be stored in Final (the target variable). If Final is not large enough to accommodate the
value of Result4, a warning message is issued and COBOL truncates the data value.
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Chapter 10. Editing Column Metadata
This appendix describes how to define and edit column metadata in mainframe jobs.

Editing Mainframe Column Definitions
You can define and edit column metadata in the InfoSphere DataStage repository, where it is saved as a
table definition and can be shared by all the jobs in a project. You can also save column definitions that
you specify during job design. Click Save As... on the Columns tab of any stage editor to save your
output column definitions as a table definition, a CFD file, or a DCLGen file.
You can define and edit column definitions in the following places:
v In the repository, on the Columns page in the Table Definition dialog box
v During job design, using one of the mainframe stage editors:
– in Complex Flat File, Fixed-width Flat File, Delimited Flat File, and DB2 Load Ready Flat File stages,
on the Columns tab on the Stage page
– in Multi-format Flat File stages, on the Records tab on the Stage page
– in Relational, Teradata Relational, and Teradata Export source stages, on the Columns tab on the
Outputs page (only if you have modified the SQL statement)
– in Relational, Teradata Relational, and Teradata Load target stages, on the Columns tab on the
Inputs page
– in Business Rule, Link Collector, Join, Lookup, Aggregator, Sort, and External Routine stages, on the
Columns tab on the Outputs page
– in Transformer stages, in the output link metadata area
All of these areas have a grid with fields for each of the column attributes. You can type or edit metadata
directly in the grid by double-clicking a cell. You can also use the Edit Column Meta Data dialog box,
which is described in the section “Using the Edit Column Meta Data Dialog Box” on page 208.

Propagating Column Values
About this task
InfoSphere DataStage provides an easy way to propagate values to groups of columns in mainframe jobs.
Since mainframe jobs typically involve large numbers of columns, this can save a significant amount of
time.
You can propagate column values in the Columns grid of any mainframe stage editor (except those that
are read-only) or on the Columns page of the Table Definition dialog box.

Procedure
1. Select the group of columns for the propagation, with the last column selected being the desired
source column. Press the Ctrl or Shift key while making your selections. Be sure that the source
column attributes are correct before proceeding, as they cannot be changed in the next step.
2. Right-click the source column and select Propagate values...from the shortcut menu. The Propagate
column values dialog box appears, displaying the attributes of the source column.
3. Select the check box next to each attribute you want to propagate to the target group of columns.
4. Click OK.
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Results
Before propagating the selected values, InfoSphere DataStage validates that the target column attributes
are compatible with the changes. Table 78 describes the propagation rules for each column attribute:
Table 78. Column Value Propagation Rules
Attribute

Propagation Rules

Data type

If the data type is changed from character to numeric, InfoSphere DataStage MVS
Edition maintains the precision and date mask of the target column. If the
precision of the source column exceeds the maximum limit for the target column,
the target is set to the maximum. If the source column has a character date mask
and the target is numeric, propagation does not occur.

Length

If the source column is character and the target column is numeric, and the
length of the source exceeds the maximum for the target, then the length of the
target is set to the maximum. If the source column is decimal and the target is
integer, and the length of the decimal exceeds the maximum for the integer, then
the length of the target is set to the maximum.

Scale

Both the source and target columns must be numeric for propagation to occur.
The scale of the target column cannot exceed its length.

Nullable

No restrictions.

Occurs

No restrictions.

Level number

Propagation is subject to the COBOL file definition.

Date format

The source and target columns must both be character or both be numeric for
propagation to occur. If the length of the target column is not 10, it is set to 10.

Usage

Propagation is dependent on COBOL rules.

Sign indicator

Propagation is dependent on COBOL rules.

Sign option

Propagation is dependent on COBOL rules.

Sync indicator

Propagation is dependent on COBOL rules.

During validation, a message is displayed for any columns that do not meet validation requirements;
these columns are left unchanged. For columns that pass validation, propagation occurs and a message
confirms that the changes were successfully applied.

Using the Edit Column Meta Data Dialog Box
To define or edit several column definitions, open the Edit Column Meta Data dialog box in either of
these ways:
v Right-click and select Edit row... from the shortcut menu.
v Press Ctrl-E.
There are different versions of the Edit Column Meta Data dialog box, depending on the type of
mainframe stage you are editing. The top half of the dialog box contains fields that are common to all
data sources, except where noted:
v Column name. The name of the column. This field is mandatory.
v Key. Indicates if the input column is a record key. This field applies only to Complex Flat File stages.
v Native type. The native data type. For details about the native data types supported in mainframe
source and target stages, see Chapter 9, “Native Data Types,” on page 197.
v Length. The length or data precision of the column.
v Scale. The data scale factor if the column is numeric. This defines the number of decimal places.
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v Nullable. Specifies whether the column can contain a null value.
v Date format. The date format for the column.
v Description. A text description of the column.
The bottom half of this dialog box has a COBOL tab containing fields specific to certain mainframe data
sources. Depending on the stage you are editing and the information specified at the top of the Edit
Column Meta Data dialog box, the COBOL tab displays some or all of the following fields:
v Level number. Type the COBOL level number where the data is defined. The default value is 05.
v Occurs. Type the number of the COBOL OCCURS clause.
v Usage. Select the COBOL USAGE clause from the list. This specifies which COBOL format the column
will be read in. These formats map to the formats in the Native type field, and changing one will
normally change the other. Possible values are:
– COMP. Used with BINARY native types.
– COMP-1. Used with single-precision FLOAT native types.
– COMP-2. Used with double-precision FLOAT native types.
– COMP-3. Packed decimal, used with DECIMAL native types.
– COMP-5. Used with NATIVE BINARY native types.
– DISPLAY. Zoned decimal, used with DISPLAY_NUMERIC or CHARACTER native types.
– DISPLAY-1. Double-byte zoned decimal, used with GRAPHIC_G or GRAPHIC_N.
v Sign indicator. Select Signed or blank from the list to specify whether the argument can be signed or
not. The default is Signed for numeric data types and blank for all other types.
v Sign option. If the argument is signed, select the location of the sign in the data from the list. Choose
from the following:
– LEADING. The sign is the first byte of storage.
– TRAILING. The sign is the last byte of storage.
– LEADING SEPARATE. The sign is in a separate byte that has been added to the beginning of
storage.
– TRAILING SEPARATE. The sign is in a separate byte that has been added to the end of storage.
Selecting either LEADING SEPARATE or TRAILING SEPARATE will increase the storage length of
the column by one byte.
v Sync indicator. Select SYNC or blank from the list to indicate whether the argument is a
COBOL-SYNCHRONIZED clause or not. The default is blank.
v Redefined field. Optionally specify a COBOL REDEFINES clause. This allows you to describe data in
the same storage area using a different data description. The redefining argument must be the same
length, or smaller, than the argument it redefines. Both arguments must have the same level number,
and an argument can only redefine the immediately preceding argument with that level.
v Depending on. Optionally specify a COBOL OCCURS DEPENDING ON clause from the list.
v Storage length. Gives the storage length in bytes of the argument as defined. This field is derived and
cannot be edited.
v Picture. Gives the COBOL PICTURE clause, which is derived from the argument definition and cannot
be edited.
The buttons at the bottom of the Edit Column Meta Data dialog box allow you to continue adding or
editing columns, or to save and close. The buttons are:
v < Previous and Next >. Displays the metadata in the previous or next row. These buttons are available
only when a previous or next row exists. If there are outstanding changes to the current row, you are
asked whether you want to save them before moving on.
v Close. Closes the Edit Column Meta Data dialog box. If you have any unsaved changes, you are
prompted to save them.
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v Apply. Saves changes to the current row.
v Reset. Removes all changes made to the row since the last time you applied changes.
v Help. Starts the Help system.
During job design, click OK to save the columns definitions before closing the stage editor. You can also
click Save As... on the Columns tab to save columns into the repository as a table definition, a CFD file,
or a DCLGen file. In the repository, click OK in the Table Definition dialog box to save the column
definitions before closing.
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Chapter 11. Fillers
This appendix describes how fillers are created when you load columns from COBOL file definitions that
represent simple or complex flat files. Since these file definitions can contain hundreds of columns, you
can choose to collapse sequences of unselected columns into FILLER items. This maintains the byte order
of the columns, and saves storage space and processing time.
This appendix gives examples of filler creation for different types of COBOL structures, and shows how
you can expand fillers later if you need to reselect any columns.

Creating Fillers
You can create fillers when you load columns into Complex Flat File, Fixed-width Flat File, and
Multi-format Flat File stages. In Complex Flat File and Fixed-width Flat File stages, you click Load on the
Columns tab of the Stage page. In Multi-format Flat File stages, you click Load on the Records tab of the
Stage page.
First you select a table from the Table Definitions dialog box. Next, you select columns from the Select
columns from table dialog box. This dialog box has an Available columns tree that displays COBOL
structures such as groups and arrays, and a Selected columns list that displays the columns to be loaded
into the stage. The Create fillers check box is selected by default.
When columns appear on the Columns tab, FILLER items are shown for the unselected columns. FILLER
columns have a native data type of CHARACTER and a name of FILLER_XX_YY, where XX is the start
offset and YY is the end offset. Fillers for elements of a group array or an OCCURS DEPENDING ON
(ODO) column have the name of FILLER_NN, where NN is the element number. The NN begins at 1 for
the first unselected group element and continues sequentially. Any fillers that follow an ODO column are
also numbered sequentially.
Level numbers of column definitions, including filler columns, are changed after they are loaded into the
stage. However, the underlying structure is preserved.

Filler Creation Rules
The rules for filler creation are designed to preserve the storage length of all columns being replaced by a
filler column. They allow a filler column to be expanded back to the original set of defining columns,
each having the correct name, data type, and storage length.

About this task
The following information describe the basic filler creation rules.

Procedure
1.

A filler column will replace one or more original columns with a storage length equal to the sum of
the storage length of each individual column being replaced.

2. Separate fillers are created when column level numbers decrease. For example, if an unselected
column at level 05 follows an unselected column at level 10, separate fillers are created for the
columns at the 05 and 10 levels.
3. Any ODO column and its associated `depending on' column will be automatically selected and not
replaced by a filler column.
4. If a REDEFINE column is selected, the column that it is redefining is also automatically selected and
will not be included as part of a filler column.
© Copyright IBM Corp. 2000, 2011
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5. If two fillers share the same storage offset (such as for a REDEFINE) the name of the subsequent
fillers will be FILLER_XX_YY_NN, where NN is a sequential number that begins at 1.
6. If the starting or ending column for a filler is the child of a parent that contains an OCCURS clause,
then the generated FILLER name will be FILLER_NN instead of FILLER_XX_YY.

Filler Creation Examples
The following examples explain filler creation for groups, REDEFINES, and arrays using different
scenarios for column selection. The source table contains single columns, a group that redefines a column,
a nested group with an array, and a column that redefines another column:
05
05
05

05
05
05

A
B
GRP1
10 C1
10 C2
10 GRP2
15 D1
15 D2
15 D3
E
F
G

PIC X(1).
PIC X(8).
REDEFINES B.
PIC X(1).
PIC X(1).
OCCURS 2 TIMES.
PIC X(1).
PIC X(1).
PIC X(1).
PIC X(1).
PIC 9(1) REDEFINES E.
PIC X(1).

Select a Simple Column
Suppose a simple column, A, is selected from the table. On the Columns tab, a single filler is created
with the name FILLER_2_11 and a length of 10. The length represents the sum of the lengths of columns
B (8), E (1), and G (1). GRP1 and its elements, along with column F, are excluded because they redefine
other columns that were not selected.
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

A

PIC X(1).

1

1

1

FILLER_2_11

PIC X(10).

2

11

10

Select a Column Redefined by a Group
Suppose column B is selected, which is redefined by GRP1. Two fillers are created, one for column A and
the other for columns E and G. Since GRP1 redefines column B, it is dropped along with its elements.
Column F is also dropped because it redefines column E. The dropped columns will be available during
filler expansion (see “Expanding Fillers” on page 217).
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

FILLER_2_11

PIC X(2).

10

11

2

Select a Group Column that Redefines a Column
Next, suppose a group column is selected (GRP1) that redefines another column (B). This time three
fillers are created: one for column A, one for columns C1 through D3 (which are part of GRP1), and one
for columns E and G. Column B is preserved since it is redefined by the selected group column.
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The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

PIC X(8).

2

9

8

PIC X(2).

10

11

2

FILLER_2_9
FILLER_10_11

Select a Group Element
Consider what happens when a group element (C1) is selected by itself. Three fillers are created: one for
column A, one for columns C2 through D3, and one for columns E and G. Since an element of GRP1 is
selected and GRP1 redefines column B, both column B and GRP1 are preserved.
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

C1

PIC X(1).

2

2

1

FILLER_3_9

PIC X(7).

3

9

7

PIC X(2).

10

11

2

FILLER_10_11

The next example shows what happens when a different group element is selected, in this case, column
C2. Four fillers are created: one for column A, one for column C1, one for GRP2 and its elements, and
one for columns E and G. Column B and GRP1 are preserved for the same reasons as before.
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

FILLER_2_2

PIC X(1).

2

2

1

C2

PIC X(1).

3

3

1

FILLER_4_9

PIC X(6).

4

9

6

PIC X(2).

10

11

2

FILLER_10_11

Select a Group Array Column
Consider what happens when a group array column (GRP2) is selected and passed as is. Four fillers are
created: one for column A, one for columns C1 and C2, one for columns D1 through D3, and one for
columns E and G. Since GRP2 is nested within GRP1, and GRP1 redefines column B, both column B and
GRP1 are preserved.
The file layout is:
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Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

FILLER_2_3

PIC X(2).

2

3

2

GRP2

OCCURS 2 TIMES.

4

9

6

10

11

2

FILLER_1
FILLER_10_11

PIC X(3).
PIC X(2).

If the selected array column (GRP2) is flattened, both occurrences (GRP2 and GRP2_2) are loaded into the
stage. The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

PIC X(2).

2

3

2

4

6

3

4

6

3

7

9

3

PIC X(3).

7

9

3

PIC X(2).

10

11

2

FILLER_2_3
GRP2
FILLER_1

PIC X(3).

GRP2_2
FILLER_1_2
FILLER_10_11

Select an Array Element
Suppose an element (D1) of a group array is selected. If the array GRP2 is passed as is, fillers are created
for column A, columns C1 and C2, columns D2 and D3, and columns E and G. Column B, GRP1, and
GRP2 are preserved for the same reasons as before.
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

FILLER_2_3

PIC X(2).

2

3

2

GRP2

OCCURS 2 TIMES.

4

9

6

D1

PIC X(1).

1

FILLER_1

PIC X(2).

2

FILLER_10_11

PIC X(2).

10

11

2

Select a Column Redefined by Another Column
Consider what happens when column E is selected, which is redefined by another column. Two fillers are
created: one for columns A through D3, and another for column G. Since column F redefines column E, it
is dropped, though it will be available for expansion (see “Expanding Fillers” on page 217).
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The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_9

PIC X(9).

1

9

9

E

PIC X(1).

10

10

1

FILLER_10_11

PIC X(1).

11

11

1

Now suppose the REDEFINE column (F) is selected. In this case column E is preserved since it is
redefined by column F. One filler is created for columns A through D3, and another for column G. The
file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_9

PIC X(9).

1

9

9

E

PIC X(1).

10

10

1

F

PIC 9(1) REDEFINES
E.

10

10

1

FILLER_11_11

PIC X(1).

11

11

1

Select Multiple Redefine Columns
This example describes how fillers are created for multiple redefine columns. In this case the same
column is being redefined multiple times. The source table contains a column and a group that redefine
column A, as well as two columns that redefine the group that redefines column A:
05
05
05
05
05
05

A
B
GRP1
10 C1
10 C2
D
E
F

PIC X(100).
PIC X(11) REDEFINES A.
REDEFINES A.
PIC X(10).
PIC 9(1).
PIC X(1) REDEFINES GRP1.
PIC 9(1) REDEFINES GRP1.
PIC X(1).

If columns C2 and E are selected, four fillers are created: one for column B, one for column C1, one for
column D, and one for column F. Since an element of GRP1 is selected and GRP1 redefines column A,
both column A and GRP1 are preserved. The first three fillers have the same start offset because they
redefine the same storage area.
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

A

PIC X(100).

1

100

100

FILLER_1_11

PIC X(11) REDEFINES A.

1

11

11

GRP1

REDEFINES A.

1

11

11

FILLER_1_10

PIC X(10).

1

10

10

C2

PIC 9(1).

11

11

1

FILLER_1_1

PIC X(1). REDEFINES GRP1. 1

1

1

E

PIC 9(1) REDEFINES GRP1.

1

1

1

FILLER_101_101

PIC X(1).

101

101

1
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Select Multiple Cascading Redefine Columns
This example shows filler creation for multiple redefine columns, except this time they are cascading
redefines instead of redefines of the same column. Consider the following source table, where column B
redefines column A, GRP1 redefines column B, column D redefines GRP1, and column E redefines
column D:
05
05
05
05
05
05

A
B
GRP1
10 C1
10 C2
D
E
F

PIC X(100).
PIC X(11) REDEFINES A.
REDEFINES B.
PIC X(10).
PIC 9(1).
PIC X(2) REDEFINES GRP1.
PIC 9(1) REDEFINES D.
PIC X(1).

If columns C2 and E are selected, this time only two fillers are created: one for column C1 and one for
column F. Column A, column B, GRP1, and column D are preserved because they are redefined by other
columns.
The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

A

PIC X(100).

1

100

100

B

PIC X(11) REDEFINES A.

1

11

11

GRP1

REDEFINES B.

1

11

11

FILLER_1_10

PIC X(10).

1

10

10

C2

PIC 9(1).

11

11

1

D

PIC X(2). REDEFINES GRP1.

1

2

2

E

PIC 9(1) REDEFINES D.

1

1

1

FILLER_101_101

PIC X(1).

101

101

1

Select an OCCURS DEPENDING ON Column
The final example how an ODO column is handled. Suppose the source table has the following structure:
05
05
05

05
05
05

A
B
GRP1
10 C1
10 C2
10 GRP2
15 D1
15 D2
15 D3
E
F
G

PIC X(1).
PIC X(8).
REDEFINES B.
PIC X(1).
PIC 9(1).
OCCURS 0 TO 2 TIMES DEPENDING ON C2.
PIC X(1).
PIC X(1).
PIC X(1).
PIC X(1).
PIC 9(1) REDEFINES E.
PIC X(1).

If column B is selected, four fillers are created. The file layout is:
Column

Picture Clause

Starting column

Ending column

Storage length

FILLER_1_1

PIC X(1).

1

1

1

B

PIC X(8).

2

9

8

GRP1

REDEFINES B.

2

9

8

PIC X(1).

2

2

1

FILLER_2_2
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Column

Picture Clause

Starting column

Ending column

Storage length

C2

PIC 9(1).

3

3

1

GRP2

OCCURS 0 TO 2 TIMES
DEPENDING ON C2.

4

9

6

FILLER_1
FILLER_2

PIC X(3).
PIC X(2).

3
10

11

2

Fillers are created for column A, column C1, columns D1 through D3, and columns E and G. GRP1 is
preserved because it redefines column B. Since GRP2 (an ODO column) depends on column C2, column
C2 is preserved. GRP2 is preserved because it is an ODO column.

Expanding Fillers
After you select columns to load into a Complex Flat File or a Fixed-width Flat File stage, the selected
columns and fillers appear on the Columns tab of the Stage page. For a Multi-format Flat File stage, the
columns and fillers appear on the Records tab of the Stage page. If you need to reselect any columns
represented by fillers, it is not necessary to reload your table definition. An Expand filler... option allows
you to reselect any or all of the columns from a given filler.
To expand a filler, right-click the filler column in the columns grid and select Expand filler... from the
shortcut menu. The Expand Filler dialog box opens. The contents of the given filler are displayed in the
Available columns tree, allowing you to reselect those columns you need.
Suppose the columns grid contains the following columns:
FILLER_1_1
B
GRP1
FILLER_2_9
FILLER_10_11

If you expand FILLER_2_9, the Available columns tree displays the contents of FILLER_2_9:
C1
C2
GRP2(2)
D1
D2
D3

If you select column C1, the stage columns in the grid change to this:
FILLER_1_1
B
GRP1
C1
FILLER_3_9
FILLER_10_11

If you expand FILLER_3_9 and select column C2, the columns grid now changes to this:
FILLER_1_1
B
GRP1
C1
C2
FILLER_4_9
FILLER_10_11
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If you continue to expand the fillers, eventually the columns grid will contain all of the original columns
in the table:
A
B
GRP1
C1
C2
GRP2
D1
D2
D3
E
F
G
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Chapter 12. JCL Templates
Job control language (JCL) provides instructions for executing a job on the mainframe. JCL divides a job
into one or more steps. Each step identifies:
v The program to be executed
v The libraries containing the program
v The files required by the program and their attributes
v Any inline input required by the program
v Conditions for performing a step
InfoSphere DataStage MVS Edition comes with a set of JCL templates that you customize to produce the
JCL specific to your job. The templates are used to generate compile and run JCL. This appendix
describes these JCL templates and explains how to customize them.

JCL Template Descriptions
JCL templates are in a directory called JCLTemplates under the IBM InfoSphere DataStage server install
directory. The directory contains two sets of template files: a default set that you can edit, and a master
set that is read-only. Table 79 describes the tasks that the JCL templates are suited for.
Table 79. InfoSphere DataStage JCL Templates
Template

Description

AllocateFile

Creates a new, empty file.

CleanupMod

Deletes a possible nonexistent file.

CleanupOld

Deletes an existing file.

CompileLink

1

Non-database compile and link edit.

ConnectDirect

Basic statements needed to run a Connect:Direct file
exchange step. The default version of this template is
designed for UNIX platforms, but it can be customized
for other platforms using JCL extension variables.

DB2CompileLinkBind1

Database compile, link edit, and bind.

DB2IMSRun

Basic statements needed to run both a database step and
an IMS program.

DB2Load

Database load utility.

DB2Run

Basic statements needed to run a database step.

DeleteFile

Deletes a file using the mainframe utility IDCAMS.

FTP

Basic statements needed to run an FTP step.

IMSRun

Basic statements needed to run an IMS program.

Jobcard

Basic job card used at the beginning of every job
(compile or execution).

NewFile

Defines a new file.

OldFile

Defines an existing file.

OMXfr

JCL statements needed to transfer operational metadata
XML file to the InfoSphere DataStage client workstation.

PreSort

Basic statements needed to run an external sort step.

© Copyright IBM Corp. 2000, 2011
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Table 79. InfoSphere DataStage JCL Templates (continued)
Template

Description

Run

Basic statements needed to run the main processing step.

Sort

Statements necessary for sorting.

TDCompileLink

1

Teradata compile and link.

TDFastExport

Teradata FastExport utility.

TDFastLoad

Teradata FastLoad utility.

TDMultiLoad

Teradata MultiLoad utility.

TDRun

Teradata run.

TDTPump

Teradata TPump utility.

1

InfoSphere DataStage uses the APOST, LIB, NONAME, NODYNAM, and RENT COBOL compiler
options when compiling the generated COBOL source. For a complete explanation of each option, see the
latest edition of IBM COBOL for OS/390 and VM Programming Guide.

JCL Template Usage
JCL templates are used during code generation to create the compile and run JCL files. Table 80 and
Table 81 list the templates in the order they are used for each JCL file, and provide usage details.
Table 80. Compile JCL Template Usage
Template

Usage

JobCard

One.

CompileLink, DB2CompileLinkBind, or TDCompileLink

One. DB2CompileLinkBind is used for jobs that have at
least one DB2 Relational stage, TDCompileLink is used
for jobs that have at least one Teradata Relational stage,
and CompileLink is used for all other jobs.

Table 81. Run JCL Template Usage
Template

Usage

JobCard

One.

CleanupMod

One for each target Fixed-width Flat File, Delimited Flat
File, DB2 Load Ready Flat File, or Teradata Export stage,
where Normal EOJ handling is set to DELETE.

DeleteFile

One for each target Fixed-width Flat File, Delimited Flat
File, or DB2 Load Ready Flat File stage, where the Write
option is set to Delete and recreate existing file.

PreSort

One for each Complex Flat File stage or Fixed-width Flat
File stage where sort control statements have been
specified on the Pre-sort tab.

AllocateFile

One for each target Fixed-width Flat File, Delimited Flat
File, DB2 Load Ready Flat File, or Teradata Load stage,
where Normal EOJ handling is set to DELETE.

TDFastExport

One for each Teradata Export stage.
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Table 81. Run JCL Template Usage (continued)
Template

Usage

Run, DB2Run, DB2IMSRun, IMSRun, or TDRun

One. DB2Run is used for jobs that have at least one DB2
Relational stage, IMSRun is used for jobs that have at
least one IMS stage, DB2IMSRun is used for jobs that
have both DB2 Relational and IMS stages, TDRun is used
for jobs that have at least one Teradata Relational stage,
and Run is used for all other jobs.

NewFile

One for each target Fixed-width Flat File, Delimited Flat
File, DB2 Load Ready Flat File, or Teradata Load stage,
where Normal EOJ handling is not set to DELETE.

OldFile

One for each source Fixed-width Flat File, Complex Flat
File, or Teradata Export stage, and one for each target
Fixed-width Flat File, Delimited Flat File, DB2 Load
Ready Flat File, or Teradata Load stage, where Normal
EOJ handling is set to DELETE.

Sort

One for each Sort stage and one for each Aggregator
stage where Type is set to Group by.

FTP or ConnectDirect

One for each FTP stage, depending on the file exchange
method selected.

OMXfr

One if operational metadata is being generated.

DB2Load, TDFastLoad, TDMultiLoad, or TDTPump

One for each DB2 Load Ready Flat File stage or Teradata
Load stage, depending on the load utility selected.

CleanupOld

One for each target Fixed-width Flat File, Delimited Flat
File, DB2 Load Ready Flat File, or Teradata Load stage,
where Normal EOJ handling is set to DELETE.

Customizing a JCL Template
When you start a new project, you can create a project-specific version of a JCL template by editing the
default template. After you customize a template, it is used for all of the jobs in your project.
Each JCL template contains statements that you must replace with values specific to your environment.
These statements are identified as follows:
<== REVIEW

There are two ways to view and edit JCL templates:
v Using a standard editing tool such as Microsoft Notepad
v Using the JCL Templates dialog box in the Designer client
To open the JCL Templates dialog box, choose Tools > JCL Templates from the main menu. This dialog
box contains the following fields and buttons:
v Platform type. Displays the platform type. Since z/OS is the only platform currently supported, this
field is read-only.
v Template name. Contains a list of available JCL templates in a list. See Table 79 on page 219 for
template descriptions.
v Short description. Provides a short description of the selected template.
v Template. Displays the code that the selected template contains.
v Save. This is available if you edit the code or if you subsequently reset a modified template to the
default code. Click Save to save your changes.
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v Reset. Resets the template code back to that of the master, read-only default template.
v Close. Closes the JCL Templates dialog box. If you have any unsaved changes, you are prompted to
save them.
v Help. Starts the Help system.

JCL Template Variables
Table 82 describes the variables in the JCL templates, including the level and location in InfoSphere
DataStage MVS Edition where they are specified. These variables are control words used in JCL
generation. Each variable begins with %. They should never be modified or deleted within the JCL
templates. They are automatically assigned values when you generate code for a mainframe job.
Table 82. JCL Template Variables
Variable

Definition

Specification Level

Specification Location

%abnormal

File handling for abnormal
end of job

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Designer client:

Allocation unit

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Designer client:

Block size for new files,
calculated based on record
size and the constraints
defined in the Max.
Blocking Factor and Max.
Block Size fields

Project

Administrator client:

%commands

Command syntax for
various utilities

Job

Determined by the system

%dblib

DBRM library used for job
upload

Project

Designer client:

DB2 password

Job Properties

%allocunit

%blocksize

%dbpass

Stage|Options| Abnormal
EOJ handling

Stage|Options| Allocation
type

Project Properties dialog
box| Mainframe|Max.
Blocking Factor, Max. Block
Size

Machine Profile dialog
box|Libraries|DBRM
library
Designer client:
Job Properties dialog
box|Environment| DBMS
Password

%dbsubsys
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(if not available from
above, then this value is
used)

Default Job Properties

DB2 subsystem identifier

DB2 Load Ready Flat File
stage
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Administrator client:
InfoSphere DataStage
Administration window|
Projects|Properties|
Mainframe|DBMS
Password
Designer client:
Stage|Bulk Loader|DB2
sub-system id

Table 82. JCL Template Variables (continued)
Variable

%dbtable

%dbuser

%ddname

Definition

Specification Level

Specification Location

(if not available from
above, then this value is
used)

Job Properties

Designer client:

(if not available from
above, then this value is
used)

Default Job Properties

DB2 table name

DB2 Load Ready Flat File
stage

Designer client:

DB2 Load Ready Flat File
stage

Designer client:

(if not available from
above, then this value is
used)

Job Properties

Designer client:

(if not available from
above, then this value is
used)

Default Job Properties

Data definition name

Complex Flat File,
Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

DB2 user name

Job Properties dialog
box|Environment| System
name
Administrator client:
InfoSphere DataStage
Administration
window|Projects|
Properties|Mainframe|
DBMS System Name

Stage|Bulk Loader|Table
name

Stage|Bulk Loader|User
name

Job Properties dialog
box|Environment|User
name
Administrator client:
InfoSphere DataStage
Administration window|
Projects|Properties|
Mainframe|DBMS User
Name
Designer client:
Stage|General|DD name

%ddstmts

Data definition statements
added to a run JCL
template, allowing extra
steps to be added to the
run JCL

DB2Run, DB2IMSRun, Run, Inserted by the user in the
or TDRun JCL template
run JCL step that executes
the generated COBOL
program. This is followed
by user-specified JCL which
allows other steps to be
executed.1

%deletefile

Deletion of an existing file

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

%deviceunit

Device unit for new files or Fixed-width Flat File, DB2
work datasets
Load Ready Flat File,
Delimited Flat File stages

Designer client:
Stage|General|File name
(used only when the write
option is Delete and
recreate existing file)
Designer client:
Stage|Options|UNIT
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Table 82. JCL Template Variables (continued)
Variable

Definition

Specification Level

Specification Location

%disp

Disposition for a file

Complex Flat File,
Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Determined by the system.
For Complex Flat File and
Fixed-width Flat File source
stages, SHR is used. For
Fixed-width Flat File, DB2
Load Ready Flat File, and
Delimited Flat File target
stages, the value depends
on the write option
specified: NEW is used
when creating new files,
OLD is used when
overwriting an existing file,
MOD is used when
appending to an existing
file, and REPL is used
when deleting and
recreating an existing file.

%expdate

Expiration date for a
dataset

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File,
Teradata Load stages

Designer client:
Stage|Options| Expiration
date
or
Stage|File|Expiration date
(Teradata Load)

%extdec

Extended decimal support

Project

Administrator client:
InfoSphere DataStage
Administration window|
Projects|Properties|
Mainframe|Support
extended decimal. When
this field is selected,
EXTEND is used, otherwise
COMPAT is used.

%filename

%ftpfromfile

File to name

FTP source file name

Complex Flat File,
Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Designer client:

FTP stage

Designer client:

Stage|General|File name

Inputs|General|File name
%ftphost

%ftpmode

FTP host name or IP
address

FTP stage

FTP transfer mode

FTP stage

Designer client:
Stage|General| Host
name/IP address
Designer client:
Stage|General|Transfer
mode

%ftppassword

FTP user password

FTP stage

Designer client:
Stage|General|Password
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Table 82. JCL Template Variables (continued)
Variable

Definition

Specification Level

Specification Location

%ftpport

FTP port

FTP stage

Designer client:
Stage|General|Port

%ftptofile

FTP target file name

FTP stage

Designer client:
Inputs|General|
Destination file name

%ftptype

FTP transfer type

FTP stage

Designer client:
Stage|General|Transfer
type

%ftpuser

FTP user ID

FTP stage

Designer client:
Stage|General|User name

%imsprogtype

IMS program type

Job

Designer client:
Code generation dialog
box|IMS program type

%imsid

IMS system name

IMS stage

Designer client:
Stage|View|IMS id

%imspsb

IMS PSB name

IMS stage

Designer client:
Stage|View|PSB

%jobacctg

%loadcontrol

Jobcard accounting
information

Project

DB2 database load utility
control statements

DB2 Load Ready Flat File
stage

Designer client:
Machine Profile dialog
box|Libraries|Jobcard
accounting information
Determined by the system
based on column
definitions specified in
Designer client:
Stage|Columns

%loadlib

%normal

%objlib

%omfile

Load library used for job
upload

Project

File handling for normal
end of job

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Object library used for job
upload

Project

Data set name for
operational metadata XML
file

Job Properties

Designer client:
Machine Profile dialog
box|Libraries|Load library
Designer client:
Stage|Options|Normal EOJ
handling
Designer client:
Machine Profile dialog
box|Libraries|Object
library
Designer client:
Job Properties dialog
box|Operational
metadata|Dataset name for
XML file
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Table 82. JCL Template Variables (continued)
Variable

Definition

Specification Level

Specification Location

%omipaddr

Target machine IP address
for operational metadata
XML file

Job Properties

Designer client:

Target machine password
for operational metadata
XML file

Job Properties

Target directory for
operational metadata XML
file

Job Properties

Target machine user name
for operational metadata
XML file

Job Properties

%omxml

File name for operational
metadata XML file

Job

Determined by the system
based on the execution time
of the COBOL program

%pgmname

Program name

Job

Designer client:

%ompass

%omtarget

%omuser

Job Properties dialog
box|Operational
metadata|IP address
Designer client:
Job Properties dialog
box|Operational
metadata|Password
Designer client:
Job Properties dialog
box|Operational
metadata|XML file target
directory
Designer client:
Job Properties dialog
box|Operational
metadata|User name

Code generation dialog
box|COBOL program file
name
%presort

Presort criteria for source
data

Complex Flat File,
Designer client:
Fixed-width Flat File stages
Stage|Pre-sort| Statement
editor

%primamt

Primary allocation amount

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Designer client:
Stage|Options|Primary
allocation amount

%recfm

Record format for a new
file

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Determined by the system.
For Fixed-width Flat File
and DB2 Load Ready Flat
File stages, FB is used. For
Delimited Flat File stages,
VB is used.

%reclen

Record length for a new file Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Determined by the system
based on column
definitions specified in
Designer client:
Stage|Columns
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Table 82. JCL Template Variables (continued)
Variable

Definition

Specification Level

Specification Location

%retnperiod

Retention period for a
dataset

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File,
Teradata Load stages

Designer client:
Stage|Options| Retention
period
or
Stage|File|Retention
period (Teradata Load)

%secamt

Secondary allocation
amount

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Designer client:
Stage|Options|
Secondary allocation
amount

%sortblocksize

Sort stages

%sortid

Sort in and sort out
temporary file name

Sort stages

Determined by the system

%sortreclen

Sort record length

Sort stages

Determined by the system

%sortseq

Presort processing

Complex Flat File,
Determined by the system
Fixed-width Flat File stages

%srclib

Source library used for job
upload

Project

DB2 table owner

DB2 Load Ready Flat File
stage

%tblowner

%tdpass

Teradata password

Designer client:
Machine Profile dialog
box|Libraries|Source
library2

Job Properties

Designer client:
Stage|Bulk Loader|Table
owner
Designer client:
Job Properties dialog
box|Environment|
Teradata Password

(if not specified here, then
the above value is used)
%tdtdp

Teradata Export, Teradata
Load stages

Teradata database identifier Job Properties

Designer client:
Stage|General|Password
Designer client:
Job Properties dialog
box|Environment|TDP id

%tduser

(if not specified here, then
the above value is used)

Teradata Export, Teradata
Load stages

Designer client:

Teradata user id

Job Properties

Designer client:

Stage|General|TDP id

Job Properties dialog
box|Environment| User id
(if not specified here, then
the above value is used)

Teradata Export, Teradata
Load stages

Designer client:
Stage|General|User id
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Table 82. JCL Template Variables (continued)
Variable

Definition

Specification Level

Specification Location

%volser

Volume serial name

Fixed-width Flat File, DB2
Load Ready Flat File,
Delimited Flat File stages

Designer client:

%xtrndyn

%xtrnincs

%xtrnlibrary

%xtrnname

Dynamically called external Project
routine name

Statically called external
routine INCLUDE
statements for linkage
editor

Project

External routine library
name

Project

Statically called external
routine name

Project

Stage|Options|Vol ser
Designer client:
Mainframe Routine dialog
box|General| Routine
name
Designer client:
Mainframe Routine dialog
box| General| External
subroutine name
Designer client:
Mainframe Routine dialog
box| General| Library path
Designer client:
Mainframe Routine dialog
box| General| Routine
name

1

This variable cannot be used within a %.if ... %.endif block. The user-specified JCL inserted after the
variable can include stage or JCL extension variables.
2

This variable cannot be used with JCL extension variables.

JCL Extension Variables
JCL extension variables allow you to customize the JCL generated by IBM InfoSphere DataStage. They are
available only at the job level and are similar to z/OS JCL substitution variables. You can use JCL
extension variables in the following places:
v in JCL templates
v wherever a file name is entered as input to a stage
v in the Expiration date or Retention period fields in Complex Flat File, Fixed-width Flat File, Delimited
Flat File, DB2 Load Ready Flat File, and Teradata Load stages
v in the Library path field of the Mainframe Routine dialog box
v on the JCL page of the Mainframe Routine dialog box (external source and target routines only)
v on the JCL tab of the External Source and External Target stage editors
JCL extension variables cannot be used in machine profiles or during job upload. They also cannot be
used with the variable %srclib in the JCL templates.

Defining JCL Extension Variables
You define JCL extension variables on the Extensions page of the Job Properties dialog box. Open this
dialog box by choosing Edit > Job Properties from the Designer client menu.

228

Mainframe Job Developer's Guide

Names of JCL extension variables can be any length, must begin with an alphabetic character, and can
contain only alphabetic or numeric characters. They can also be mixed uppercase and lowercase,
however, the name specified in job properties must exactly match the name used in the locations
discussed in “JCL Extension Variables” on page 228.
Suppose you define two extension variables on the Extensions page. The first one, called qualid,
represents the owner of the load library. It has a value of KVJ1. The second one, called rtlver, represents
the runtime library version. It has a value of COBOLGEN.V750.
You can insert these variables in the SYSLIB and SYSLMOD lines of the CompileLink JCL template, as
shown:
//COBCOMP
EXEC PGM=IGYCRCTL,
//
COND=(4,LT),
//
PARM=(APOST,LIB,NONAME,NODYNAM,RENT%extdec)
//SYSIN
DD DISP=SHR,DSN=%srclib(%pgmname)
//SYSLIB
DD DISP=SHR,DSN=%+rtlver..COPYLIB
//SYSLIN
DD DSN=&&OBJMOD,DISP=(NEW,PASS),
//
UNIT=SYSDA,SPACE=(TRK,(20,20),RLSE),
//
DCB=(RECFM=FB,LRECL=80,BLKSIZE=3120)
//SYSPRINT
DD SYSOUT=*
//SYSUDUMP
DD SYSOUT=*
//SYSUT1
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT2
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT3
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT4
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT5
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT6
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT7
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//SYSUT8
DD SPACE=(800,(500,500),,,ROUND),UNIT=SYSDA
//*---------------------------------------------------------------//LKED EXEC PGM=IEWL,
//
COND=(4,LT),
//
PARM=(LIST,XREF,LET,MAP,AMODE(31),RMODE(ANY)),
//
REGION=4M
//SYSLIB DD
DISP=SHR,DSN=CEE.SCEELKED
//SYSLMOD DD DISP=SHR,DSN=%+qualid..%loadlib
//ARDTLIB DD DISP=SHR,DSN=%+rtlver..LINKLIB

You must prefix the variable name with %+. Notice that two periods (..) separate the extension variables
from the other JCL variables. This is required for proper JCL generation.
When JCL is generated for the job, all occurrences of the variable %+qualid will be replaced with KVJ1,
and all occurrences of the variable %+rtlver will be replaced by COBOLGEN.V750. The other JCL
variable in the SYSLMOD line is replaced by the value specified in the Machine Profile dialog box during
job upload.

Conditional Statements in JCL Templates
InfoSphere DataStage allows you to perform conditional processing in the JCL templates. You must
modify the JCL templates to determine what JCL statements are included in the generated JCL. The
construct is:
%.if +varname op value
...
%.else
...
%.endif

In this case, +varname is formatted as +varname rather than %+varname. Do not use the % in these
names; use only the +. The names must begin with an alphabetic character and can contain only
alphabetic or numeric characters. They can also be mixed uppercase and lowercase.
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Each %. conditional construct must start in column 1 of the JCL template being modified. You can use
more than one conditional statement in a single JCL template, however, you cannot have multiple levels,
or nested conditional statements.
When an operator and a value are included in the %.if construct, one or more spaces are allowed before,
between, and after each element. The operator can be = or <>. The format of the value can be:
string_value or %+string_ext_var.
If +varname has a non-blank, non-null value assigned on the Extensions page of the Job Properties dialog
box, the test is true and the statements following %.if and preceding %.else will be generated during JCL
generation. Otherwise the statements following %.else will be generated during JCL generation.
As an example, you can use this capability to determine whether to use a production or test data set in a
job. The JCL statements could be:
%.if +qual
//%ddname DD DISP=%disp,DSN=%+qual..%filename
%.else
//%ddname DD DISP=%disp,DSN=PROD.%filename
%.endif

If the extension variable qual has the value TEST specified on the Extensions page of the Job Properties
dialog box, and the file name from the stage is CUSTOMER.DATA, the DSN that will be generated is
TEST.CUSTOMER.DATA. If qual has no value, the DSN will be PROD.CUSTOMER.DATA.

% Symbols in JCL Templates
The % symbol in JCL templates is reserved for JCL generator usage, such as control statements or
substitution variables. If InfoSphere DataStage cannot resolve the %<string>, it changes the symbol to
!<string>.
If you are customizing a JCL template and want to preserve %, you must double it. For example, if your
desired statement is this:
//* %A = %%B + %%%C

You should change it to this:
//* %%A = %%%%B + %%%%%%C

InfoSphere DataStage will then remove the second occurrence of % in each place that it appears.
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Chapter 13. Operational metadata on the mainframe
You can generate and store operational metadata when you run mainframe jobs to better understand the
data and processes involved in your data warehouse.
For detailed information on importing operational metadata into the IBM InfoSphere Information Server
repository, see IBM InfoSphere Information Server Guide to Managing Operational Metadata from Job Runs.

Generating operational metadata (mainframe jobs)
You can generate operational metadata after enabling it at the project level or job level. The job-level
setting overrides the project-level setting.
With either option, you must specify connection details for the IBM InfoSphere Information Server engine
in job properties.
During code generation, the COBOL program and run JCL capture operational metadata from the job
design. During the program run on the mainframe, the operational metadata is written to an XML file.
The XML file is then placed in a directory on the InfoSphere Information Server engine. You can then use
the Run Importer utility to import the file into the metadata repository.
Creating the XML file can increase program execution time on the mainframe. You can control when this
occurs by modifying the run JCL. This allows you to postpone XML file creation until you are satisfied
with the code generation results.

About operational metadata (mainframe jobs)
Operational metadata is a collection of events that describes the processing steps of a job.
Operational metadata for mainframe jobs includes:
v Mainframe system information
v
v
v
v
v
v
v

Job start and finish times
Job status
Project and job names
Job parameter names and values
Data set names for flat file stages
Number of records read from source stages
Number of records written to target stages

v Routine names for any External Source or External Target stages
Operational metadata does not include:
v Pre-run activities such as presort or Teradata export
v Post-run activities such as DB2 or Teradata bulk load or FTP file transfer
Note that mainframe jobs undergo optimization. The operational metadata might not have one-to-one
correspondence with the job design.

Enabling operational metadata at the project level (mainframe jobs)
You can enable operational metadata for all jobs in a project.

© Copyright IBM Corp. 2000, 2011
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Procedure
1. Open the Administrator client.
2. Click the Projects page of the InfoSphere DataStage Administration window.
3. Select the project and click Properties. (If you are starting a new project, click Add to specify the
name and location of the project, then click Properties.)
4. Click Mainframe to bring this page to the front of the Project Properties window.
5. Select Generate operational meta data.
6. Click OK to save your changes, then click Close to exit the Administrator client.

Results
Operational metadata is generated for all new jobs in your project unless you override the setting at the
job level.

Enabling operational metadata at the job level (mainframe jobs)
In the Designer client, you can override your project-level settings and enable or disable operational
metadata for a job.

Procedure
1. Open a job in the Designer client.
2. Choose Edit > Job Properties.
3. Click the General tab of the Job Properties window and select Generate operational metadata.
4. Click OK.

Specifying connection details for the IBM InfoSphere Information
Server engine
After you enable operational metadata, you must specify connection details for the engine to which the
XML file that contains operational metadata is transferred.

Before you begin
You must enable FTP and the specify the default FTP directory on the engine before the XML file can be
transferred to it.

Procedure
1. Open the Job Properties window.
2. Click the Operational metadata page.
3. In the Machine profile field, type a name that identifies the engine, or select an existing machine
profile from the list. If you load an existing machine profile, the rest of the fields on this page are
automatically filled in.
4.
5.
6.
7.
8.

232

In the IP address field, type the IP address of the engine.
In the File exchange method field, select FTP or Connect Direct.
In the User name field, type the user name for logging in to the engine.
In the Password field, type the password that is associated with the user name for engine login.
In the XML file target directory field, type the name of the target directory, relative to the default
FTP directory, where the XML file should be placed. Specify the name in the appropriate DOS,
UNIX, or Linux mode, including any slash marks that are required. If the directory name contains
blanks, enclose the full name in single quotation marks.
On Windows platforms, the XML files are saved to IBM\InformationServer\ASBNode\conf\etc\
XmlFiles.
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On UNIX and Linux platforms, the XML files are saved to opt/IBM/InformationServer/ASBNode/
conf/etc/XmlFiles.If you leave this field blank, the XML file is placed in the default FTP directory
on the engine. In that case, before you import the XML file into the repository, you must copy the
file from the default FTP directory to the directory where XML files are saved on the engine.
9. In the Dataset name for XML file field, type the data set name for the XML file on the mainframe
system. Be sure to create this file on the mainframe before you run the COBOL program. If you want
the system to generate a unique data set name each time a job runs, add (+1) after the name that
you specify. See “Using GDG to generate unique data set names” for more information.
10. Click OK to save your changes.

Results
During code generation, the XML file is generated on the mainframe as a data set. The XML file name is
determined by the system based on the date and time of COBOL program execution, such as
20060304-133249-0.xml.

What to do next
After the transfer is complete, you use the Run Importer utility to import the XML file into the metadata
repository.
For information on importing operational metadata into the repository, see IBM InfoSphere Information
Server Guide to Managing Operational Metadata from Job Runs.

Controlling XML file creation
For jobs that involve multiple cycles of code generation and program runs, you might want to postpone
XML file creation until you are satisfied with the results. You can do this by modifying the run JCL for
your job.
Open the run JCL file and find the parameter GENXMLFILE. Change the statement to:
GENXMLFILE = NO

Operational metadata is still collected during code generation, but is not written to the XML file. When
you are ready to create the XML file, change the value of GENXMLFILE to YES. The operational metadata is
then written to the XML file and transferred to the IBM Information Server engine.

Using GDG to generate unique data set names
You can use GDG to generate unique data set names.

About this task
You can use Generation Data Group (GDG) to have the system generate a unique data set name for the
XML file each time a job runs. This prevents the file from being overwritten if the disposition of the file is
OLD or SHR in the run JCL.

Procedure
1. Add (+1) to the data set name that you specify for the XML file on the Operational metadata page in
the Job Properties window or on the Connection page of the Machine Profile window. For example:
USERID.XML.OUT(+1)

2. Use IDCAMS to define the GDG base entry on the mainframe. For example:
USERID.XML.OUT

3. Modify the DD statement in the OMXML JCL template as follows:
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//OMXML

DD

DSN=%omxml,DISP=(NEW,CATLG)
UNIT=SYSDA,SPACE=(TRK,(1,1),RLSE),
DCB=(MODLDSCB,RECFM=VB,LRECL=4092,BLKSIZE=4096

where MODLDSCB is your model DSCB for your GDG data set.
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Chapter 14. Runtime Library
This appendix describes the InfoSphere DataStage runtime library (RTL) for mainframe jobs. The RTL
contains routines that are used during mainframe job execution. Depending on your job design, the
COBOL program for the job might invoke one or more of these routines.
RTL routines are used to sort data, create hash tables, create DB2 load-ready files, create delimited flat
files, and run utilities.
The RTL is installed during InfoSphere DataStage server installation. It must be installed on the execution
platform before jobs are link edited. Make sure you have completed RTL setup by following the
instructions during installation.

Sort Routines
Table 83 describes the functions that are called to initialize and open a sort so that records can be
inserted. These functions are called once.
Table 83. Start Sort Functions
Function

Description

DSSRINI

Initialization.

DSSROPI

Open for inserting records into the sort.

Table 84 describes the functions that are called for each record inserted into a sort.
Table 84. Record Insert Functions
Function

Description

DSSRSWB

Set write (insert) buffer.

DSBFWKA

Write key ascending. This is called for each ascending key field.

DSBFWKD

Write key descending. This is called for each descending key field.

DSSRWKF

Write key finish. This is called after all key fields have been processed.

DSBFWDT

Write data. This is called for each data (non-key) field.

DSSRINS

Insert record into sort.

Table 85 describes the functions that are called after all records have been inserted into a sort.
Table 85. Sort Execution Functions
Function

Description

DSSROPF

Invoke sort. This launches the actual sorting and then opens it for fetching.

DSSRSRB

Set read (fetch) buffer.

Table 86 on page 236 describes the functions that are called for each record fetched from a sort.
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Table 86. Record Fetching Functions
Function

Description

DSSRGET

Get (fetch) record from sort.

DSBFRKA

Read key ascending. This is called for each ascending key field.

DSBFRKD

Read key descending. This is called for each descending key field.

DSSRRKF

Read key finish. This is called after all key fields have been processed.

DSBFRDT

Read data. This is called for each non-key field.

Table 87 describes the function that is called to close a sort.
Table 87. Close Sort Function
Function

Description

DSSRCLS

Close.

Hash Routines
Table 88 describes the function that is called to initialize a hash table. This function is called once for each
hash table.
Table 88. Hash Table Initialization Function
Function

Description

DSHSINI

Initialization.

Table 89 describes the functions that are called to insert records into a hash table. These functions are
called once for each record.
Table 89. Record Insert Functions
Function

Description

DSHSGEN

Compute a hash value based on the right hash key.

DSHSNEW

These functions work together to add a new record to a hash table.

DSHSSET

Table 90 describes the functions that are called to retrieve a record from a hash table.
Table 90. Retrieve Record Functions
Function

Description

DSHSRST

Reset so that the first matching hash record is retrieved by DSHSGET.

DSHSGNL

Generate a hash value based on the left hash key.

DSHSGET

Get the next hash record (or the first record if DSHSRST was called).

Table 91 describes the functions that are called to perform a full join using a hash table.
Table 91. Full Join Functions
Function

Description

DSHSNXMT

Get the next unhashed record from the hash table.
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Table 91. Full Join Functions (continued)
Function

Description

DSHSNOMH

Make the record unhashed in the hash table.

Table 92 describes the function that is called to close a hash table.
Table 92. Close Hash Table Function
Function

Description

DSHSCLN

Clean up the hash table.

Calculating Hash Table Memory Requirements
InfoSphere DataStage builds a hash table for jobs that perform a lookup or join using the hash technique.
From a performance standpoint, it might be helpful to calculate the amount of space required for the
hash table. You can do this after you generate code for a job.

Procedure
1. Click View in the Code generation dialog box and select Cobol program file.
2. Look for a call to the DSHSINI RTL function. There are two arguments to this call:
a. The first argument is the hash control structure and is at an 01 level. It describes the hash keys.
The structure has a name such as HASHn or HJn where n is an integer.
b. The second argument describes the non-key data being hashed and is also at an 01 level. The
name of this structure might be HJn-INFO, HASHTBLn, or a DD name.
3. Find the initialization code for the first argument by searching the COBOL program for statements
that move values to the RKEYLENGTH field of the first argument. Then perform the following
computation:
a. Add the RKEYLENGTH values for all of the hash key fields.
b. Multiply the number of hash key fields by 2 (which represents two bytes of overhead for each
field's length and null indicator).
c. Add the results of steps a and b to get a total.
4. Next locate the initialization code for the second argument by searching for statements that move
values to the OUTLENGTH field of the second argument. Then perform the following computation:
a. Add the OUTLENGTH values for all of the fields.
b. Multiply the number of fields by 2.
c. Add the results of steps a and b to get a total.
5. Add the results of steps 3 and 4, plus 21. This is the amount of space required for each hashed row.
6. Multiply the result of step 5 by the number of rows being hashed.
7. Add 4 KB to the total. (This represents the space required for the hash table itself, regardless of the
number of rows.)

Results
The result is the space required for the hash table. Repeat these calculations for each hash table in your
job.
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Delimited Flat File Creation Routines
Table 93 describes the functions that are called to create a delimited flat file.
Table 93. Delimited Flat File Creation Functions
Function

Description

DSDLOPR

Open the file for reading.

DSDLOPN

Open the file for writing.

DSDLRD

Read a record, parse the record based on the delimiter information, and perform
data type conversions.

DSDLWRT

Write a record.

DSDLCLS

Close the file.

Utility Routines
Table 94 describes the functions that are called to perform certain utilities.
Table 94. Utility Functions
Function

Description

DSINIT

Initialize the runtime library.

DSHEXVAL

Return the hexadecimal value of a variable.

DSUTBIT

Return the value that is the result of a bitwise AND-ing, OR-ing, and exclusive
OR-ing function.

DSUTDAT

Dump a record or variable in hexadecimal and EBCDIC format.

DSUTPAR

Return the indented COBOL paragraph name.

DSUTPOS

POSITION function.

DSUTSBS

SUBSTRING function.

DSUTADR

Return the address of a variable.

DSUTNUL

Set null indicator(s) and set value to space or zero.

Data Type Conversion Routines
Table 95 describes the functions that are called to convert values from one data type to another. For
details about data type conversions, see Chapter 8, “Data Type Definitions and Mappings,” on page 185.
Table 95. Data Type Conversion Functions
Function

Description

DSC2SI

Convert a character string to a small integer.

DSC2I

Convert a character string to an integer.

DSC2D

Convert a character string to a packed decimal number.

DSC2DT

Convert a character string to a date.

DSC2TM

Convert a character string to a time.

DSC2TS

Convert a character string to a timestamp.

DSSI2C

Convert a small integer to a character string.
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Table 95. Data Type Conversion Functions (continued)
Function

Description

DSI2C

Convert an integer to a character string.

DSD2C

Convert a decimal to a character string.

DSC2DTU

Convert a character string to a date in USA date format.

DSC2DTE

Convert a character string to a date in European date format.

DSB2C

Convert a binary integer to a character string.

DSL2C

Convert a long integer to a character string.

Operational Metadata Routines
Table 96 describes the functions that are called to generate operational metadata for a mainframe job.
Table 96. Operational Metadata Functions
Function

Description

DSINIT

Read GENXMLFILE parameter from JCL to create the operational metadata XML
file.

DSPMDWR

Write operational metadata to the XML file.
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Chapter 15. Reserved Words
This appendix lists COBOL and SQL reserved words. SQL reserved words cannot be used in the names
of stages, links, tables, columns, stage variables, or job parameters.

COBOL Reserved Words
The following table lists COBOL reserved words on z/OS platforms.
Table 97. COBOL Reserved Words
A

B

ACCEPT

ALPHABETIC-LOWER

APPLY

ACCESS

ALPHABETIC-UPPER

ARE

ADD

ALPHANUMERIC

AREA

ADDRESS

ALPHANUMERIC-EDITED AREAS

ADVANCING

ALSO

ASCENDING

AFTER

ALTER

ASSIGN

ALL

ALTERNATE

AT

ALPHABET

AND

AUTHOR

ALPHABETIC

ANY

BASIS

BINARY

BOTTOM

BEFORE

BLANK

BY

BEGINNING

BLOCK
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Table 97. COBOL Reserved Words (continued)
C

D

242

CALL

COLUMN

COMPUTATIONAL-5

CANCEL

COM-REG

COMPUTE

CBL

COMMA

CONFIGURATION

CD

COMMON

CONTAINS

CF

COMMUNICATION

CONTENT

CH

COMP

CONTINUE

CHARACTER

COMP-1

CONTROL

CHARACTERS

COMP-2

CONTROLS

CLASS

COMP-3

CONVERTING

CLASS-ID

COMP-4

COPY

CLOCK-UNITS

COMP-5

CORR

CLOSE

COMPUTATIONAL

CORRESPONDING

COBOL

COMPUTATIONAL-1

COUNT

CODE

COMPUTATIONAL-2

CURRENCY

CODE-SET

COMPUTATIONAL-3

COLLATING

COMPUTATIONAL-4

DATA

DEBUG-SUB-1

DESTINATION

DATE-COMPILED

DEBUG-SUB-2

DETAIL

DATE-WRITTEN

DEBUG-SUB-3

DISPLAY

DAY

DEBUGGING

DISPLAY-1

DAY-OF-WEEK

DECIMAL-POINT

DIVIDE

DBCS

DECLARATIVES

DIVISION

DE

DELETE

DOWN

DEBUG-CONTENTS

DELIMITED

DUPLICATES

DEBUG-ITEM

DELIMITER

DYNAMIC

DEBUG-LINE

DEPENDING

DEBUG-NAME

DESCENDING
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Table 97. COBOL Reserved Words (continued)
EGCS

END-INVOKE

ENDING

EGI

END-MULTIPLY

ENTER

EJECT

END-OF-PAGE

ENTRY

ELSE

END-PERFORM

ENVIRONMENT

EMI

END-READ

EOP

ENABLE

END-RECEIVE

EQUAL

END

END-RETURN

ERROR

END-ADD

END-REWRITE

ESI

END-CALL

END-SEARCH

EVALUATE

END-COMPUTE

END-START

EVERY

END-DELETE

END-STRING

EXCEPTION

END-DIVIDE

END-SUBTRACT

EXIT

END-EVALUATE

END-UNSTRING

EXTEND

END-IF

END-WRITE

EXTERNAL

FALSE

FILLER

FOR

FD

FINAL

FROM

FILE

FIRST

FUNCTION

FILE-CONTROL

FOOTING

GENERATE

GO

GIVING

GOBACK

GLOBAL

GREATER

H

HEADING

HIGH-VALUE

HIGH-VALUES

I

I-O

INDICATE

INSPECT

I-O-CONTROL

INHERITS

INSTALLATION

ID

INITIAL

INTO

IDENTIFICATION

INITIALIZE

INVALID

IF

INITIATE

INVOKE

IN

INPUT

IS

INDEX

INPUT-OUTPUT

INDEXED

INSERT

J

JUST

JUSTIFIED

K

KANJI

KEY

E

F

G

GROUP
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Table 97. COBOL Reserved Words (continued)
L

M

N

O

P

Q
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LABEL

LIMIT

LINES

LAST

LIMITS

LINKAGE

LEADING

LINAGE

LOCAL-STORAGE

LEFT

LINAGE-COUNTER

LOCK

LENGTH

LINE

LOW-VALUE

LESS

LINE-COUNTER

LOW-VALUES

MEMORY

METHOD

MORE-LABELS

MERGE

METHOD-ID

MOVE

MESSAGE

MODE

MULTIPLE

METACLASS

MODULES

MULTIPLY

NATIVE

NO

NUMBER

NATIVE_BINARY

NOT

NUMERIC

NEGATIVE

NULL

NUMERIC-EDITED

NEXT

NULLS

OBJECT

ON

OTHER

OBJECT-COMPUTER

OPEN

OUTPUT

OCCURS

OPTIONAL

OVERFLOW

OF

OR

OVERRIDE

OFF

ORDER

OMITTED

ORGANIZATION

PACKED-DECIMAL

PIC

PROCEDURE-POINTER

PADDING

PICTURE

PROCEDURES

PAGE

PLUS

PROCEED

PAGE-COUNTER

POINTER

PROCESSING

PASSWORD

POSITION

PROGRAM

PERFORM

POSITIVE

PROGRAM-ID

PF

PRINTING

PURGE

PH

PROCEDURE

QUEUE

QUOTE
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QUOTES

Table 97. COBOL Reserved Words (continued)
R

S

RANDOM

RELATIVE

RESERVE

RD

RELEASE

RESET

READ

RELOAD

RETURN

READY

REMAINDER

RETURN-CODE

RECEIVE

REMOVAL

RETURNING

RECORD

RENAMES

REVERSED

RECORDING

REPLACE

REWIND

RECORDS

REPLACING

REWRITE

RECURSIVE

REPORT

RF

REDEFINES

REPORTING

RH

REEL

REPORTS

RIGHT

REFERENCE

REPOSITORY

ROUNDED

REFERENCES

RERUN

RUN

SAME

SIGN

STANDARD

SD

SIZE

STANDARD-1

SEARCH

SKIP1

STANDARD-2

SECTION

SKIP2

START

SECURITY

SKIP3

STATUS

SEGMENT

SORT

STOP

SEGMENT-LIMIT

SORT-CONTROL

STRING

SELECT

SORT-CORE-SIZE

SUB-QUEUE-1

SELF

SORT-FILE-SIZE

SUB-QUEUE-2

SEND

SORT-MERGE

SUB-QUEUE-3

SENTENCE

SORT-MESSAGE

SUBTRACT

SEPARATE

SORT-MODE-SIZE

SUM

SEQUENCE

SORT-RETURN

SUPER

SEQUENTIAL

SOURCE

SUPPRESS

SERVICE

SOURCE-COMPUTER

SYMBOLIC

SET

SPACE

SYNC

SHIFT-IN

SPACES

SYNCHRONIZED

SHIFT-OUT

SPECIAL-NAMES
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Table 97. COBOL Reserved Words (continued)
T

TABLE

TEXT

TITLE

TALLY

THAN

TO

TALLYING

THEN

TOP

TAPE

THROUGH

TRACE

TERMINAL

THRU

TRAILING

TERMINATE

TIME

TRUE

TEST

TIMES

TYPE

UNIT

UP

USE

UNSTRING

UPON

USING

UNTIL

USAGE

V

VALUE

VALUES

VARYING

W

WHEN

WORDS

WRITE-ONLY

WHEN-COMPILED

WORKING-STORAGE

WITH

WRITE

ZERO

ZEROES

U

Z

ZEROS

SQL Reserved Words
Table 98 lists SQL reserved words on z/OS platforms.
Table 98. SQL Reserved Words
A

B

C

246

ALL

ARRAY

AND

AS

AND_BITS

ASC

BEGIN

BIND

BETWEEN

BOTH

CACHE

CHAR_LENGTH_MB

CONCATENATE

CALL

CHARACTER

COND

CARDINALITY

CHARACTER_LENGTH

CORRESPONDING

CASE

CHARACTER_LENGTH_B

COUNT

CAST

CHARACTER_LENGTH_MB

CURRENT_DATE

CHAR

CHECK

CURRENT_TIME

CHAR_LENGTH

COMMENT

CURRENT_TIMESTAMP

CHAR_LENGTH_B

COMMIT

CURSOR
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AVG

BY

Table 98. SQL Reserved Words (continued)
D

DATAXEL

DECIMAL

DIRECTIVE_ERROR

DATE

DECLARE

DISTINCT

DAY

DEFAULT

DO

DBMS_IN_MEMORY

DELETE

DOUBLE

DEC

DESC

DOUBLEGREATETHAN

ENDOFDATA

EOF

EXPAND

ELSE

ESCAPE

EXTRACT

ELSEIF

EXCEPT

END

EXIT

FALSE

FOR

FIRST

FROM

G

GREATEEQ

GROUP

GROUP_BY

H

HASH

HINTEND

HOUR

HAVING

HINTSTART

HIGH_VALUES

HINT_ERROR

IF

INSERT

INTO

IFELSE

INT

IS

IN

INTEGER

ITERATE

IN_MEMORY

INTERSECT

INNER

INTERVAL

E

F

I

FULL

J

JOIN

L

LAST

LESSEQ

LOWER_MB

LEADING

LIKE

LOW_VALUES

LEAVE

LOOP

LPAD

LEFT

LOWER

MAX

META_HINT

MEMORY_SIZE

MIN

MERGE

MINUTE

NATURAL

NO_CACHE

NULL

NCHAR

NOT

NUMERIC

NESTED_LOOP

NOTEQ

OCTET_LENGTH

OR

ORDERED

OF

OR_BITS

OUTER

ON

ORDER

OVERLAPS

M

N

O

MONTH
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Table 98. SQL Reserved Words (continued)
P

POSITION

POSITION_MB

POSITION_B

PRECISION

REAL

ROUND

RIGHT

ROW

SAME_SOURCE

SET

SUBARRAY

SECOND

SIMPLE_NESTED_LOOP

SUBSTRING

SELECT

SMALLINT

SUBSTRING_MB

SEQUENTIALLY

STDOUT

SUM

TABLE

TIMESTEN

TRIM_B

THEN

TO

TRIM_MB

TIME

TRAILING

TRUE

TIMESTAMP

TRIM

UNION

UPDATE

UPPER_MB

UNKNOWN

UPPER

USING

V

VALUES

VARCHAR

VARYING

W

WHEN

WHERE

X

XOR_BITS

Y

YEAR

R

S

T

U
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Contacting IBM
You can contact IBM for customer support, software services, product information, and general
information. You also can provide feedback to IBM about products and documentation.
The following table lists resources for customer support, software services, training, and product and
solutions information.
Table 99. IBM resources
Resource

Description and location

IBM Support Portal

You can customize support information by choosing the
products and the topics that interest you at
www.ibm.com/support/entry/portal/Software/
Information_Management/
InfoSphere_Information_Server

Software services

You can find information about software, IT, and
business consulting services, on the solutions site at
www.ibm.com/businesssolutions/

My IBM

You can manage links to IBM Web sites and information
that meet your specific technical support needs by
creating an account on the My IBM site at
www.ibm.com/account/

Training and certification

You can learn about technical training and education
services designed for individuals, companies, and public
organizations to acquire, maintain, and optimize their IT
skills at http://www.ibm.com/software/sw-training/

IBM representatives

You can contact an IBM representative to learn about
solutions at www.ibm.com/connect/ibm/us/en/

Providing feedback
The following table describes how to provide feedback to IBM about products and product
documentation.
Table 100. Providing feedback to IBM
Type of feedback

Action

Product feedback

You can provide general product feedback through the
Consumability Survey at www.ibm.com/software/data/
info/consumability-survey

Documentation feedback

To comment on the information center, click the
Feedback link on the top right side of any topic in the
information center. You can also send comments about
PDF file books, the information center, or any other
documentation in the following ways:
v Online reader comment form: www.ibm.com/
software/data/rcf/
v E-mail: comments@us.ibm.com
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Accessing product documentation
Documentation is provided in a variety of locations and formats, including in help that is opened directly
from the product client interfaces, in a suite-wide information center, and in PDF file books.
The information center is installed as a common service with IBM InfoSphere Information Server. The
information center contains help for most of the product interfaces, as well as complete documentation
for all the product modules in the suite. You can open the information center from the installed product
or from a Web browser.

Accessing the information center
You can use the following methods to open the installed information center.
v Click the Help link in the upper right of the client interface.
Note: From IBM InfoSphere FastTrack and IBM InfoSphere Information Server Manager, the main Help
item opens a local help system. Choose Help > Open Info Center to open the full suite information
center.
v Press the F1 key. The F1 key typically opens the topic that describes the current context of the client
interface.
Note: The F1 key does not work in Web clients.
v Use a Web browser to access the installed information center even when you are not logged in to the
product. Enter the following address in a Web browser: http://host_name:port_number/infocenter/
topic/com.ibm.swg.im.iis.productization.iisinfsv.home.doc/ic-homepage.html. The host_name is the
name of the services tier computer where the information center is installed, and port_number is the
port number for InfoSphere Information Server. The default port number is 9080. For example, on a
Microsoft® Windows® Server computer named iisdocs2, the Web address is in the following format:
http://iisdocs2:9080/infocenter/topic/com.ibm.swg.im.iis.productization.iisinfsv.nav.doc/dochome/
iisinfsrv_home.html.
A subset of the information center is also available on the IBM Web site and periodically refreshed at
http://publib.boulder.ibm.com/infocenter/iisinfsv/v8r7/index.jsp.

Obtaining PDF and hardcopy documentation
v A subset of the PDF file books are available through the InfoSphere Information Server software
installer and the distribution media. The other PDF file books are available online and can be accessed
from this support document: https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1.
v You can also order IBM publications in hardcopy format online or through your local IBM
representative. To order publications online, go to the IBM Publications Center at http://
www.ibm.com/e-business/linkweb/publications/servlet/pbi.wss.

Providing feedback about the documentation
You can send your comments about documentation in the following ways:
v Online reader comment form: www.ibm.com/software/data/rcf/
v E-mail: comments@us.ibm.com
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Product accessibility
You can get information about the accessibility status of IBM products.
The IBM InfoSphere Information Server product modules and user interfaces are not fully accessible. The
installation program installs the following product modules and components:
v IBM InfoSphere Business Glossary
v IBM InfoSphere Business Glossary Anywhere
v
v
v
v
v
v

IBM
IBM
IBM
IBM
IBM
IBM

InfoSphere
InfoSphere
InfoSphere
InfoSphere
InfoSphere
InfoSphere

DataStage
FastTrack
Information Analyzer
Information Services Director
Metadata Workbench
QualityStage™

For information about the accessibility status of IBM products, see the IBM product accessibility
information at http://www.ibm.com/able/product_accessibility/index.html.

Accessible documentation
Accessible documentation for InfoSphere Information Server products is provided in an information
center. The information center presents the documentation in XHTML 1.0 format, which is viewable in
most Web browsers. XHTML allows you to set display preferences in your browser. It also allows you to
use screen readers and other assistive technologies to access the documentation.

IBM and accessibility
See the IBM Human Ability and Accessibility Center for more information about the commitment that
IBM has to accessibility.
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Notices and trademarks
This information was developed for products and services offered in the U.S.A.

Notices
IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.
IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.
For license inquiries regarding double-byte character set (DBCS) information, contact the IBM Intellectual
Property Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan
The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.
This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.
Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.
The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.
Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.
Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.
All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.
This information is for planning purposes only. The information herein is subject to change before the
products described become available.
This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.
COPYRIGHT LICENSE:
This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.
Each copy or any portion of these sample programs or any derivative work, must include a copyright
notice as follows:
© (your company name) (year). Portions of this code are derived from IBM Corp. Sample Programs. ©
Copyright IBM Corp. _enter the year or years_. All rights reserved.
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If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks of International Business Machines Corp., registered in
many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other
companies. A current list of IBM trademarks is available on the Web at www.ibm.com/legal/
copytrade.shtml.
The following terms are trademarks or registered trademarks of other companies:
Adobe is a registered trademark of Adobe Systems Incorporated in the United States, and/or other
countries.
IT Infrastructure Library is a registered trademark of the Central Computer and Telecommunications
Agency which is now part of the Office of Government Commerce.
Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo, Celeron, Intel Xeon,
Intel SpeedStep, Itanium, and Pentium are trademarks or registered trademarks of Intel Corporation or its
subsidiaries in the United States and other countries.
Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the
United States, other countries, or both.
ITIL is a registered trademark, and a registered community trademark of the Office of Government
Commerce, and is registered in the U.S. Patent and Trademark Office
UNIX is a registered trademark of The Open Group in the United States and other countries.
Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the United States, other
countries, or both and is used under license therefrom.
Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or
its affiliates.
The United States Postal Service owns the following trademarks: CASS, CASS Certified, DPV, LACSLink,
ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS and United States Postal Service. IBM
Corporation is a non-exclusive DPV and LACSLink licensee of the United States Postal Service.
Other company, product or service names may be trademarks or service marks of others.

Notices and trademarks
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Index
A
aggregating data
functions 96
types
control break 95
group by 95
Aggregator stages
aggregation column metadata 96
aggregation functions 96
control break aggregation 95
editing 94
group by aggregation 95
input data to 94
Inputs page 94
output data from 95
Outputs page 95
specifying aggregation criteria 95
Stage page 94
arguments, routine 71, 78, 106
arrays
flattening 54, 76, 91
load options
in Complex Flat File stages 54
in External Source stages 75
in IMS stages 26
normalizing 54, 76, 91
selecting as output
nested normalized columns 59
nested parallel normalized
columns 60
parallel normalized columns 59
single normalized columns 58
Assembler file definitions, importing 13
auto
joins 114
lookups 122

B
Boolean expressions
constraints 153
HAVING clauses 32, 38, 49
join conditions 116
lookup conditions 123, 124
WHERE clauses 30, 31, 37, 42, 48, 49
Business Rule stages
defining business rule logic 100
defining stage variables 99
editing 99
input data to 103
Inputs page 103
output data from 104
Outputs page 104
SQL constructs 101
Stage page 99

C
CFDs, importing

11

© Copyright IBM Corp. 2000, 2011

Char data type
definition 185
COBOL
compiler options 164
FDs, importing 11
program file name 159
reserved words 241
code customization 160
Code generation dialog box 159
code generation, see generating
code 159
column auto-match facility
in Transformer stages 150
on Mapping tab 98, 111, 117, 127, 142
column definitions
editing 207
propagating values 207
column push option
in Aggregator stages 96
in Business Rule stages 101
in Complex Flat File stages 57
in Delimited Flat File stages 69
in External Routine stages 110
in External Source stages 76
in Fixed-Width Flat File stages 88
in IMS stages 26
in Join stages 116
in Link Collector stages 121
in Lookup stages 125
in Multi-Format Flat File stages 93
in Sort stages 141
compiler options 164
compiler wizard 166
compiling multiple jobs 166
Complex file load option dialog box 54,
75, 91
Complex Flat File stages
array handling 54
data access types 52
defining constraints 57
editing 52
end-of-data indicator 25, 52
file view layout 53
output data from 57
Outputs page 57
pre-sorting data 55
selecting normalized array columns as
output 58
specifying
stage column definitions 53
Stage page 52
start row/end row option 52
Computed Column dialog box 33, 38, 50
computed columns
in Relational stages 32
in Teradata Export stages 38
in Teradata Relational stages 50
conditional lookups 122, 129
conditional statements, in JCL
templates 229

ConnectDirect
in FTP stages 112
JCL template 219
constants 169
constraints 170
in Complex Flat File stages 57
in Delimited Flat File stages 70
in External Source stages 76
in Fixed-Width Flat File stages 88
in IMS stages 27
in Multi-Format Flat File stages 93
in Transformer stages 147, 153, 155
control break aggregation 95
conversion functions, data type 171
cursor lookups
definition 122
examples 128
customer support
contacting 249
customizing
COBOL code 160
JCL templates 221

D
data type conversion functions 171
data types
allowable mappings 186
definitions 185
mapping implementations 186
native
in source stages 197
in target stages 201
storage lengths 203
date and time functions 172
Date data type
definition 185
date mappings 194
DB2 Load Ready Flat File stages
editing 61
input data to 64
Inputs page 64
output data from 65
Outputs page 65
specifying
DB2 bulk loader parameters 63
delimiter information 63
load data file parameters 63
Stage page 61
write option 62
DBMSCODE variable 155, 182
DCLGen files, importing 12
decimal arithmetic 205
Decimal data type
definition 185
defining
constraints
in Complex Flat File stages 57
Delimited Flat File stages
defining constraints 70
editing 65
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Delimited Flat File stages (continued)
end-of-data indicator 65
input data to 69
Inputs page 69
output data from 69
Outputs page 69
specifying
stage column definitions 66
target file parameters 68
Stage page 65
start row/end row option 66
write option 66
Designer client
Diagram window 1
Repository window 1
status bar 2
toolbar 2
Diagram window 1
drag-and-drop
in Transformer stages 148
on Mapping tab 97, 111, 117, 126, 142

E
Edit Column Meta Data dialog box 208
Edit Routine Argument Meta Data dialog
box 72, 79, 106
editing
Complex Flat File stages 52
end-of-data indicator
in Complex Flat File stages 25, 52
in Delimited Flat File stages 65
in External Source stages 74
in Fixed-Width Flat File stages 83
in IMS stages 25
in Multi-Format Flat File stages 89
in Relational stages 28
in Teradata Relational stages 45
ENDOFDATA variable 182, 183
expiration date, for a new data set
in DB2 Load Ready Flat File
stages 64
in Delimited Flat File stages 68
in Fixed-Width Flat File stages 56, 87
in Teradata Export stages 36
in Teradata Load stages 44
Expression Editor 170, 180
in Business Rule stages 100
in Relational stages 29
in Teradata Load stages 41
in Teradata Relational stages 47
in Transformer stages 157
expression grid 170, 180
expressions 157
definition 170
validating 157
extension variables, JCL 228
External Routine stages
editing 108
Inputs page 108
mapping routines 109
output data from 109
Outputs page 109
external routines 104, 108
copying 107
renaming 107
viewing and editing 107
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external source routines 70, 74
renaming 74
viewing and editing 73
External Source stages
array handling 75
defining constraints 76
editing 74
end-of-data indicator 74
file view layout 75
output data from 76
Outputs page 76
specifying external source routine 75
Stage page 74
external target routines 77, 81
copying 80
viewing and editing 80
External Target stages
file view layout 82
input data to 82
Inputs page 82
specifying external target routine 82
Stage page 81

F
FastExport, Teradata 34
FastLoad, Teradata 40
file view layout
in Complex Flat File stages 53
in External Source stages 75
in External Target stages 82
in Fixed-Width Flat File stages 84
in Table Definition dialog box 21
fillers
creation rules 211
expanding 217
in Fixed-Width Flat File stages 85
find facility, on Mapping tab 97, 110,
117, 126, 142
find/replace facility, in Transformer
stages 148
Fixed-Width Flat File stages
defining constraints 88
editing 83
end-of-data indicator 83
file view layout 84
filler creation and expansion 85
input data to 87
Inputs page 87
output data from 88
Outputs page 88
specifying
stage column definitions 84
Stage page 83
start row/end row option 83
write option 83
FTP stages
editing 112
file exchange method 112
input data to 113
Inputs page 113
specifying target machine
attributes 112
Stage page 112
transfer mode options 112
transfer type options 113

full joins
definition 113
example 119
functions
aggregation 96
data type conversion 171
date and time 172
definition 171
logical 173
multibyte string 177
numerical 174
string 175

G
generating code 7, 159, 160
base location, specifying 159
COBOL program 159
compile JCL 159
compiling multiple jobs 166
customizing code 160
files produced 160
job validation 160
run JCL 159
tracing runtime information 159
Generation Data Group (GDG) 233
group by aggregation 95
GROUP BY clause 31, 37, 49

H
hash
joins 114
lookups 122
hash table memory requirements 237
HAVING clause 31, 37, 49
Help system, one-line help 2
HTML file
saving file view layout as 53, 75, 82,
84
saving records view layout as 90

I
importing
Assembler file definitions 13
COBOL FDs 11
DCLGen files 12
IMS definitions 21
PL/I file definitions 15
Teradata tables 20
IMS Database (DBD) dialog box 23
IMS definitions
importing 21
viewing and editing 23
IMS Segment/Associated Table Mapping
dialog box 24
IMS stages
defining constraints 27
editing 25
end-of-data indicator 25
flattening arrays 26
output data from 25
selecting columns 26
selecting segments 26
Outputs page 25

IMS stages (continued)
partial path processing 26
Stage page 25
IMS Viewset (PSB/PCB) dialog box 24
inner joins
definition 113
example 119
input data
to Aggregator stages 94
to Business Rule stages 103
to DB2 Load Ready Flat File
stages 64
to Delimited Flat File stages 69
to External Target stages 82
to Fixed-Width Flat File stages 87
to FTP stages 113
to Join stages 120
to Link Collector stages 120
to Lookup stages 124
to Relational stages 28
to Sort stages 139
to Teradata Load stages 45
to Teradata Relational stages 46
Integer data type
definition 185

J
JCL
compile JCL 159
definition 219
run JCL 159
JCL extension variables 228
JCL templates
% variables 222
conditional statements 229
customizing 221
preserving % symbol 230
usage 220
JCL Templates dialog box 221
job parameters 5
job properties, editing 5
Job Upload dialog box 163
jobs, see mainframe jobs 162
Join stages
defining the join condition 116
editing 114
examples 118
full joins 113, 119
inner joins 113, 119
input data to 120
Inputs page 114, 120
join techniques 114
mapping data from 116, 121
outer joins 113, 119
outer link 114
output data from 115, 121
Outputs page 115, 121
Stage page 114, 120
joins
defining join conditions 116
full joins
definition 113
example 119
inner joins
definition 113
example 119

joins (continued)
outer joins
definition 113
example 119
outer link 114
techniques
auto 114
hash 114
nested 114
two file match 114

L
legal notices 255
Link Collector stages
editing 120
input data to 120
Inputs page 120
mapping data 121
output data from 121
Outputs page 121
Stage page 120
links
between mainframe stages 5
execution order, in Transformer
stages 155
local stage variables
in Transformer stages 155
logical functions 173
Lookup stages
action if lookup fails options 124
conditional lookups 122, 123, 129
cursor lookups 122, 128
defining
lookup condition 124
pre-lookup condition 123
editing 122
examples 127
input data to 124
Inputs page 124
lookup techniques 122
mapping data 125
Outputs page 125
singleton lookups 122, 128
sorting the reference link 124
Stage page 122
lookups
cursor
definition 122
examples 128
defining
lookup conditions 124
pre-lookup conditions 123
singleton
definition 122
examples 128
techniques
auto 122
hash 122
LPAD examples 178

M
Machine Profile dialog box
Connection page 165
General page 164

machine profiles 164, 166
copying 166
creating 164
mainframe jobs
creating 1
editing job properties 5
generating code 7, 159, 166
linking stages 5
programming components 169
programming resources 9
stage types 2
tool palette 2, 4
uploading 7, 162, 166
validating 160
Mainframe Routine dialog box
Arguments page 71, 78, 106
Creator page 71, 78, 105
General page 71, 78, 105
JCL page 73
mapping
data
from External Routine stages 109
from Join stages 116, 121
from Link Collector stages 121
from Lookup stages 125
from Sort stages 141
data types 186
dates 194
routines 109
metadata
editing 207
importing 11
operational 231
Multi-Format Flat File stages
data access types 89
defining constraints 93
editing 89
end-of-data indicator 89
master record 90
maximum file record size 89
output data from 92
Outputs page 92
record ID 92
records view layout 90
selecting normalized array columns as
output 94
specifying stage record definitions 90
Stage page 89
start row/end row option 89
multibyte string functions 177
MultiLoad, Teradata 40
multiple job compilation 166

N
native data types
in source stages 197
in target stages 201
storage lengths 203
NChar data type
definition 185
nested joins 114
numerical functions 174
NVarChar data type
definition 185

Index
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O

propagating column values

OCCURS DEPENDING ON clauses
in DB2 Load Ready Flat File
stages 62
in Delimited Flat File stages 67
in external source routines 71
in external target routines 78
in Fixed-Width Flat File stages 84
operational metadata
controlling XML file creation 233
definition 231
enabling
at the project level 232
generating for mainframe jobs 231
overriding
at the job level 232
specifying FTP details 232
using GDG to generate unique data
set names 233
operators 180
ORDER BY clause 32, 38, 50
outer joins
definition 113
example 119
outer link, Join stages 114
output data
from Aggregator stages 95
from Business Rule stages 104
from Complex Flat File stages 57
from DB2 Load Ready Flat File
stages 65
from Delimited Flat File stages 69
from External Routine stages 109
from External Source stages 76
from Fixed-Width Flat File stages 88
from IMS stages 25
from Join stages 115, 121
from Link Collector stages 121
from Multi-Format Flat File stages 92
from Relational stages 30
from Sort stages 140
from Teradata Export stages 36
from Teradata Relational stages 48
output links, execution order in
Transformer stages 155

P
parameters 5, 181
PL/I file definitions, importing 15
pre-sorting data
in Complex Flat File stages 55
product accessibility
accessibility 253
product documentation
accessing 251
programming components 169, 183
constants 169
constraints 170
expressions 170
functions 171, 180
operators 180
parameters 181
routines 182
variables 182
programming, in mainframe jobs 9
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207

R
records view layout
in Multi-Format Flat File stages 90
reference link, sorting in Lookup
stages 124
reject links, in Transformer stages 153,
155
REJECTEDCODE variable 100, 154, 182
Relational stages
defining computed columns 32
editing 27
end-of-data indicator 28
input data to 28
Inputs page 28
output data from 30
Outputs page 30
SQL statement
GROUP BY clause 31
HAVING clause 31
modifying 33
ORDER BY clause 32
viewing 32, 38
WHERE clause 31
Stage page 27
update action 28
updating input columns 29
WHERE clause 30
Remote System dialog box 163
Repository window 1
reserved words
COBOL 241
SQL 246
retention period, for a new data set
in DB2 Load Ready Flat File
stages 64
in Delimited Flat File stages 68
in Fixed-Width Flat File stages 57, 87
in Teradata Export stages 36
in Teradata Load stages 44
ROUND examples 174
routines
definition 182
external 104
external source 70
external target 77
RPAD examples 178
RTL, see runtime library 235
runtime information, tracing 159
runtime library 235
data type conversion routines 238
delimited flat file creation
routines 238
hash routines 236
hash table memory requirements 237
operational metadata routines 239
sort routines 235
utility routines 238

S
semantic checking 157
shortcut menus, in Transformer
Editor 145, 146

singleton lookups
definition 122
examples 128
SmallInt data type
definition 185
mappings 190
software services
contacting 249
Sort stages
editing 139
input data to 139
Inputs page 139
mapping data 141
output data from 140
Outputs page 140
specifying sort order 141
Stage page 139
sorting data
in Relational stages 32
in Sort stages 140
in Teradata Export stages 38
in Teradata Relational stages 50
SQL constructs, in Business Rule
stages 101
SQL reserved words 246
SQL statement
modifying
in Relational stages 33
in Teradata Export stages 39
in Teradata Relational stages 51
viewing
in Relational stages 32
in Teradata Export stages 38
in Teradata Relational stages 50
SQLCA.SQLCODE variable 100, 102,
182, 183
stage variables
in Business Rule stages 99
in Transformer stages 155
stages
editing
Aggregator 94
Business Rule 99
Complex Flat File 52
DB2 Load Ready Flat File 61
Delimited Flat File 65
External Routine 108
External Source 74
Fixed-Width Flat File 83
FTP 112
IMS 25
Join 114
Link Collector 120
Lookup 122
Multi-Format Flat File 89
Relational 27
Sort 139
Teradata Export 34
Teradata Load 40
Teradata Relational 45
Transformer 147
links allowed 5
types, in mainframe jobs 2
start row/end row option
in Complex Flat File stages 52
in Delimited Flat File stages 66
in Fixed-Width Flat File stages 83

start row/end row option (continued)
in Multi-Format Flat File stages 89
status bar, Designer client 2
storage lengths, data type 203
string functions 175
SUBSTRING rules 179
support
customer 249
syntax checking, in expressions 157

T
Table Definition dialog box 20
table definitions
importing 11
saving columns as 11
viewing and editing 20
target file parameters
in DB2 Load Ready Flat File
stages 63
in Delimited Flat File stages
Teradata Export stages
defining computed columns
editing 34
output data from 36
Outputs page 36
specifying
file options 35
Teradata connection
parameters 34
SQL statement
GROUP BY clause 37
HAVING clause 37
modifying 39
ORDER BY clause 38
WHERE clause 37
Teradata FastExport 34
Teradata FastLoad 40
Teradata Load stages
editing 40
input data to 45
Inputs page 45
specifying
stage column definitions
Teradata connection
parameters 40
Teradata load utility
parameters 42
Stage page 40
table preparation 40
update action 40
updating input columns 41
WHERE clause 42
Teradata MultiLoad 40
Teradata Relational stages
defining computed columns
editing 45
end-of-data indicator 45
input data to 46
Inputs page 46
output data from 48
Outputs page 48
SQL statement
GROUP BY clause 49
HAVING clause 49
modifying 51
ORDER BY clause 50

68
38

41

Teradata Relational stages (continued)
SQL statement (continued)
viewing 50
WHERE clause 49
Stage page 45
update action 46
updating input columns 47
WHERE clause 47
Teradata tables, importing 20
Teradata TPump 40
Time data type
definition 185
Timestamp data type
definition 185
tool palette, mainframe jobs 2, 4
toolbar
Designer client 2
Transformer Editor 144
TPump, Teradata 40
tracing runtime information 159
trademarks
list of 255
Transformer Editor 144
link area 145
metadata area 145
shortcut menus 145, 146
toolbar 144
Transformer stages 143
basic concepts 146
column auto-match facility 150
defining constraints 153, 155
editing 147
Expression Editor 157
find/replace facility 148
input links 147
output columns
creating and deleting 149
editing metadata 150
editing multiple derivations 151
moving 150
output links 147
reject links 153, 155
select facilities 149
specifying output link order 155
stage properties 146
stage variables 155
two file match joins 114

VarChar data type
definition 185
variables
built-in 182
definition 182
JCL extension 228
JCL template 222
stage
in Business Rule stages 99
in Transformer stages 155

W
WHERE clause 30, 31, 37, 42, 47, 49
wizard, compiler 166
write option
in DB2 Load Ready Flat File
stages 62
in Delimited Flat File stages 66
in Fixed-Width Flat File stages 83

X
XML file, operational metadata
233

231, 232,

U

50

update action
in Relational stages 28
in Teradata Load stages 40
in Teradata Relational stages
updating input columns
in Relational stages 29
in Teradata Load stages 41
in Teradata Relational stages
uploading jobs 7, 162, 166

46

47

V
validating
expressions
jobs 160

157
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